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ASG Support Numbers

ASG provides support throughout the world to resolve questions or problems regarding
installation, operation, or use of our products. We provide all levels of support during normal
business hours and emergency support during non-business hours. To expedite response time,
please follow these procedures.

Please have this information ready:

. Product name, version number, and release number
J List of any fixes currently applied
. Any alphanumeric error codes or messages written precisely or displayed

. A description of the specific steps that immediately preceded the problem

o The severity code (ASG Support uses an escalated severity system to prioritize service to
our clients. The severity codes and their meanings are listed below.)

. Verify whether you received an ASG Service Pack for this product. It may include
information to help you resolve questions regarding installation of this ASG product. The
Service Pack instructions are in a text file on the distribution media included with the
Service Pack.

If You Receive a Voice Mail Message:

1 Follow the instructions to report a production-down or critical problem.

2 Leave a detailed message including your name and phone number. A Support representative
will be paged and will return your call as soon as possible.

3 Please have the information described above ready for when you are contacted by the Support
representative.

Severity Codes and Expected Support Response Times

Severity Meaning Expected Support Response
Time
1 Production down, Within 30 minutes

critical situation
2 Major component of product disabled Within 2 hours

3 Problem with the product, but customer has ~ Within 4 hours
work-around solution

4 "How-to" questions and enhancement Within 4 hours
requests

ASG provides software products that run in a number of third-party vendor environments. Support
for all non-ASG products is the responsibility of the respective vendor. In the event a vendor
discontinues support for a hardware and/or software product, ASG cannot be held responsible for
problems arising from the use of that unsupported version.



Business Hours Support

Your Location

Phone

Fax

E-mail

United States and
Canada

Australia
England
France
Germany

Singapore

All other countries:

800.354.3578

61.2.9460.0411
44.1727.736305
33.141.028590
49.89.45716.222
65.332.2922

1.941.435.2200

941.263.2883

61.2.9460.0280
44.1727.812018
33.141.028589
49.89.45716.400
65.337.7228

Non-Business Hours - Emergency Support

Your Location

Phone

Your Location

support@asg.com

support.au@asg.com
support.uk@asg.com
support.fr@asg.com

support.de@asg.com

support.sg@asg.com

support@asg.com

Phone

United States and
Canada

Asia
Australia
Denmark
France
Germany
Hong Kong
Ireland
Israel/Bezeq
Japan/IDC

800.354.3578

65.332.2922
0011.800.9932.5536
00.800.9932.5536
00.800.3354.3578
00.800.3354.3578
001.800.9932.5536
00.800.9932.5536
014.800.9932.5536
0061.800.9932.5536

Japan/Telecom
Netherlands
New Zealand
Singapore
South Korea
Sweden/Telia
Switzerland
Thailand

United Kingdom

All other countries

0041.800.9932.5536
00.800.3354.3578
00.800.9932.5536
001.800.3354.3578
001.800.9932.5536
009.800.9932.5536
00.800.9932.5536
001.800.9932.5536
00.800.3354.3578

1.941.435.2200



ASG Web Site

Visit http://www.asg.com, ASG’s World Wide Web site.

Submit all product and documentation suggestions to ASG’s product management team at
http://www.asg.com/asp/emailproductsuggestions.asp.

If you do not have access to the web, FAX your suggestions to product management at (941)
263-3692. Please include your name, company, work phone, e-mail ID, and the name of the ASG
product you are using. For documentation suggestions include the publication number located on
the publication’s front cover.


http://www.asg.com/asp/emailproductsuggestions.asp
http://www.asg.com
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Preface

This ASG-Encore User’s Guide provides user information about ASG-Encore (herein
called Encore). Encore is an integrated re-engineering environment for COBOL
programs. The two functional components of Encore are re-engineering analysis and code
extraction. Because Encore uses ISPF/PDF as its standard interface, you should be
familiar with ISPF/PDF conventions and usage.

Allen Systems Group, Inc. (ASG) provides professional support to resolve any questions
or concerns regarding the installation or use of any ASG product. Telephone technical
support is available around the world, 24 hours a day, 7 days a week.

ASG welcomes your comments, as a preferred or prospective customer, on this
publication or on any ASG product.

Note:

This guide documents the Encore product. If other ASG-Existing Systems Workbench
(herein called ESW) products are installed at your site, features from these products may
appear in the Encore product. These features are documented in the specific ESW product
guide to which they pertain. For information about these other product features, see the
corresponding documentation for that product.

vii



ASG-Encore User’s Guide

About this Publication

viii

This publication consists of these chapters:

Chapter 1, "Introduction," contains an overview of Encore program re-engineering
analysis, extraction, and generation functions.

Chapter 2, "Product Overview," contains an overview of the Encore product,
including the user interface, help facility, sets, subsets, and target processing.

Chapter 3, "Getting Started," contains an overview of how to initiate an Encore
session, define user options, allocate an Application Knowledge Repository (AKR),
analyze a COBOL program, code extraction objectives, and Complement Module
contents.

Chapter 4, "Perform Range Extract," contains a practical demonstration of how to
perform a Perform Range extract to create a called submodule and a Complement
Module.

Chapter 5, "Computation Variable Extract," contains a practical demonstration of
how to perform a Computation Variable extract to compute the value of a variable.

Chapter 6, "Transaction Extract,”" contains a practical demonstration of how to
perform a Transaction Extract to create a replacement standalone program.

Chapter 7, "Report Extract," contains a practical demonstration of how to perform a
Report extract to:

—  Create a program that performs all of the month-end calculations for the
different types of checking accounts without producing the exception report.

—  Create a standalone program that produces the exception report.

Chapter 8. "CICS Server Extract," contains a practical demonstration of how to
perform a CICS Server extract to create a COMMAREA-based server program
from a 3270 CICS pseudo-conversational program.
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Related Publications

The documentation library for ASG-Encore consists of these publications (where nn
represents the product version number):

J ASG-Center Installation Guide (CNX0300-nn) contains installation and
maintenance information for ASG-Center, the common set of libraries shared by all
ASG-ESW products. ASG-Center must be installed before installing ASG-Encore.

o ASG-Encore Installation Guide (ENX0300-nn) contains installation and
maintenance information for ASG-Encore.

e ASG-Encore Reference Guide (ENX0400-nn) provides detailed information about
the pop-ups, screens, and commands used in ASG-Encore.

o  ASG-Encore User’s Guide (ENX0200-nn) provides user information about
ASG-Encore.

Note:
To obtain a specific version of a publication, contact the ASG Service Desk.

X
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ASG-Existing Systems Workbench (ASG-ESW)

ASG-ESW (herein called ESW) is an integrated suite of components designed to assist
organizations in enhancing, redeveloping, or re-engineering their existing systems. ESW
products use the Application Knowledge Repository (AKR) to store source program
analysis information generated by the Analytical Engine. Figure 1 represents the
components of ESW.

Figure 1 + ASG Existing Systems Workbench

Existing Systems Workbench I

HI ASG-Insight for Program Understanding |

%I ASG-Estimate for Resource Estimation |

ASG-SmartEdit for COBOL Editing
ASG-SmartEdit-Browse

ASG-SmartTest for Testing/Debugging
-TSO
- CICs

ASG-Center - IMS

- ASM

- APS

- PLI

-TCA

- DB2 Stored Procedure

N H ASG-SmartDoc for Program Documentation |
Application

Knowledge
Repository (AKR)

H| ASG-Recap for Portfolio Analysis |

H| ASG-Alliance for Application Understanding |

%| ASG-Encore |

HI ASG-AutoChange |

HI ASG-Bridge |
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This table contains the name and description of each ESW component:

ASG-Alliance Alliance The application understanding component that is
used by IT professionals to conduct an analysis of
every application in their environment. Alliance
supports the analysis and assessment of the
impact of change requests upon an entire
application. Alliance allows the programmer/
analyst to accurately perform application analysis
tasks in a fraction of the time it would take to
perform these tasks without an automated
analysis tool. The impact analysis from Alliance
provides application management with additional
information for use in determining the resources
required for application changes.

ASG-AutoChange AutoChange  The COBOL code change tool that makes
conversion teams more productive by enabling
quick and safe changes to be made to large
quantities of code. AutoChange is an interactive
tool that guides the user through the process of
making source code changes.

ASG-Bridge Bridge The bridging product that enables field expansion
for program source code, without being required
to simultaneously expand the fields in files or
databases. Because programs are converted in
smaller groups, or on a one-by-one basis, and do
not require file conversion, testing during the
conversion process is simpler and more thorough.

ASG-Center Center The common platform for all ESW products.
Center provides the common Analytical Engine to
analyze the source program and store this
information in the AKR. This common platform
provides a homogeneous environment for all
ESW products to work synergistically.

X1
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ASG-Encore Encore

The program re-engineering component for
COBOL programs. Encore includes analysis
facilities and allows you to extract code based on
the most frequently used re-engineering criteria.
The code generation facilities allow you to use the
results of the extract to generate a standalone
program, a callable module, a complement
module, and a CICS server. Prior to code
generation, you can view and modify the
extracted Logic Segment using the COBOL
editor.

ASG-Estimate Estimate

The resource estimation tool that enables the user
to define the scope, determine the impact, and
estimate the cost of code conversion for COBOL,
Assembler, and PL/I programs. Estimate locates
selected data items across an application and
determines how they are used (moves, arithmetic
operations, and compares). Time and cost factors
are applied to these counts, generating cost and
personnel resource estimates.

ASG-Insight Insight

The program understanding component for
COBOL programs. Insight allows programmers
to expose program structure, identify data flow,
find program anomalies, and trace logic paths. It
also has automated procedures to assist in
debugging program abends, changing a
computation, and resolving incorrect program
output values.

ASG-Recap Recap

The portfolio analysis component that evaluates
COBOL applications. Recap reports provide
function point analysis and metrics information,
program quality assessments, intra-application
and inter-application comparisons and
summaries, and historical reporting of function
point and metrics information. The portfolio
analysis information can also be viewed
interactively or exported to a database,
spreadsheet, or graphics package.

ASG-SmartDoc SmartDoc

The program documentation component for
COBOL programs. SmartDoc reports contain
control and data flow information, an annotated
source listing, structure charts, program summary
reports, exception reports for program anomalies,
and software metrics.

Xii
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ESW Product Herein Called  Description

ASG-SmartEdit SmartEdit The COBOL editing component that can be
activated automatically when the ISPF/PDF
Editor is invoked. SmartEdit provides
comprehensive searching, inline copybook
display, and syntax checking. SmartEdit allows
you to include an additional preprocessor (for
example, the APS generator) during syntax
checking. SmartEdit supports all versions of IBM
COBOL, CICS, SQL, and CA-IDMS.

ASG-SmartTest SmartTest The testing/debugging component for COBOL,
PL/I, Assembler, and APS programs in the TSO,
MVS Batch, CICS (including file services), and
IMS environments. SmartTest features include
program analysis commands, execution control,
intelligent breakpoints, test coverage, pseudo
code with COBOL source update, batch connect,
disassembled object code support, and full screen
memory display.

Invoking ESW Products

The method you use to invoke an ESW product depends on your system setup. If you
need assistance to activate a product, see your systems administrator. If your site starts a
product directly, use the ISPF selection or CLIST as indicated by your systems
administrator. If your site uses the ESW screen to start a product, initiate the ESW screen
using the ISPF selection or CLIST as indicated by your systems administrator and then
typing in the product command on the command line.

The product names can also vary depending on whether you access a product directly or
through ESW. See "ESW Product Integration" on page xiv for more information about
using ESW.

xiii
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To initialize ESW products from the main ESW screen, select the appropriate option on
the action bar pull-downs or type the product shortcut on the command line.

Alliance AL Understand » Application
AutoChange CC Change » Conversion Set
Bridge BR Change » ASG-Bridge
Encore (Re-engineer) EN Re-engineer P Program
Estimate ES Measure P ASG-Estimate
Insight (Understand) IN Understand » Program
Recap (Portfolio Analysis) RC Measure » Portfolio
SmartDoc (Document) DC Document » Program
SmartEdit SE Change » Program

Or

Change » Program with Options

SmartTest ST Test » Module/Transaction

ESW Product Integration

Because ESW is an integrated suite of products, you are able to access individual ESW
products directly or through the main ESW screen. As a result, you might see different
fields, values, action bar options, and pull-down options on a screen or pop-up depending
on how you accessed the screen or pop-up.

Certain ESW products also contain functionality that interfaces with other ESW products.
Using SmartTest as an example, if Alliance is installed, SmartTest provides a dynamic
link to Alliance that can be used to display program analysis information. If Insight is
installed and specified during the analyze, the Insight program analysis functions are
automatically available for viewing logic/data relationships and execution path. For
example, the Scratchpad option is available on the Options pull-down if you have Insight
installed. Access to these integrated products requires only that they be installed and
executed in the same libraries.

X1v
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Example 1. Figure 2 shows the Encore Primary screen that displays when you access

Encore directly.

The Encore Primary screen contains these eight action bar menu items: File, View,

Extract, Generate, Search, List, Options, and Help.

Figure 2 « Encore Primary Screen

File Uiew EHtract Generate 2earch List Options Help

REG-Encore
CoMRand ===
etk Eas s L S e Aotttk
Atk Boos s I e etk
A=tetoiek A=tetoiek Aebetstebek deboletck etk
Aettotk Aettotk dettsictsk destotetek etk
Hetstsick
Atttk

Copwright Allen Systens Group, Inc., an unpublished wark.
A proprietary product of ASG, Inc. Use pestricted to authorized licensees.
Visit the ASE Support Web Site at wuM.asq.coH

Figure 3 shows the Encore Primary screen that displays when you access Encore through
ESW by selecting Re-engineer P Program from the ESW action bar menu. Notice that the
Primary screen name changes to ASG-ESW - Program Re-engineering when you enter

Encore through ESW. Also, the Logic menu item displays if Insight is installed.

Figure 3 « ESW Encore Primary Screen

File Wiew Extract oGenerate Search Logic List Options Help

AZE-EIN - Prograd Re-engineering

CoMHand ===
etttk Hebbtt bbbk Aottt
Aetetotek detstetek etk Aetetetek:
Aotk Aotk Hebebbtk bbbk etk
ettt ettt debebbtk bbbk Hdk
Atttk
Aotttk

copyright Allen $ystens Group, IncC., an unpublizhed vork.
Visit the ASE SUpport Web Zite at wuw.asg.cod

A proprietary product of AEG, Inc. Use restricted to authorized licensees.
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Xvi

Example 2. Figure 4 shows the File - Analyze Submit pop-up that displays when you
access SmartTest directly. Figure 5 shows the File - Analyze Submit pop-up that displays
when you access SmartTest through ESW.

Notice that the Analyze features field in Figure 5 lists additional ESW products than
shown on Figure 4. This field is automatically customized to contain the ESW products
you have installed on your system.

The actions shown on these screens also vary. For example, the D action (ASG-SmartDoc
Options) is available on the File - Analyze Submit screen if the SmartDoc product is
installed on your system. In Figure 4, the ASG-SmartDoc Options action is not available.

Figure 4 « File - Analyze Submit Screen

File - Analyze SUbHiT
CorAdand ===

E - Edit JCL 2 - EUbHIit JCL

CoMpile and link JoL (PDE or sequential):
Data set nane 'USER1Z2.REL.CGHNTL{VIAPCOBC)

Analyze features [v-M]i
REG—EMartTests ¥ Extended Analy=isl M

AKR data set naHe 'USER1Z2, GEMERAL.AKR'
AER prograd nade [if overriding PROGRAR-IO0)

Analyze options:

CoHpile? [Y<H] « v o« v o o o o i) [¥ if needad by features)
Link load Hodule reusable® [Y-M] Y

Figure S« File - Analyze Submit Screen (Accessed through ESW)

File - Analyze ZubHit
CoHHand ===

E - Edit JCL ¥ - EubRit TJCL 0 — AEG-EHartDoc Options

Codpile and link JCL [PDE or sequentiall:
Data set naWe 'UEER1Z.REL.CNTLIHTEST)
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Publication Conventions

Preface

ASG uses these conventions in technical publications:

Convention

Represents

ALL CAPITALS

Initial Capitals on Each Word

lowercase italic
monospace

Monospace

Vertical Separator Bar (| )
with underline

Directory, path, file, dataset, member, database,
program, command, and parameter names.

Window, field, field group, check box, button, panel (or
screen), option names, and names of keys. A plus sign
(+) is inserted for key combinations (e.g., Alt+Tab).

Information that you provide according to your
particular situation. For example, you would replace
f1ilename with the actual name of the file.

Characters you must type exactly as they are shown.
Code, JCL, file listings, or command/statement syntax.

Also used for denoting brief examples in a paragraph.

Options available with the default value underlined (e.g.,
YN).
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Introduction

This chapter describes Encore program re-engineering analysis, extraction, and
generation functions, and contains these sections:

Section Page
Encore Advantages 1
Encore Overview 2

Encore Advantages

Corporations are increasingly under pressure to perform these functions:

o Integrate and web-enable their applications for better customer relations
management.

o Open up their applications through standards-conforming interfaces for better
supply-chain integration.

o Migrate their applications to newer platforms and technologies for better
throughput, as well as to accommodate the capabilities of a changing labor force.

J Identify, consolidate, and extract processing logic from their applications to explore
alternative implementations.

o Reengineer their applications to improve the accuracy, repeatability, and efficiency
of the maintenance process.

Encore provides automated support to help your IT staff achieve these objectives through
the ability to analyze and report on the information in a program, including data usage,
control flows, and PERFORM and CALL hierarchies. Encore extracts reusable,
functional code fragments from a program and has the ability to package and generate the
code fragments as separate program modules, and also regenerates the original program
to take advantage of the new modules.
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Encore Overview

Encore is the ESW re-engineering product for COBOL applications and includes these
features:

Analysis facilities that allow you to extract code based on the most frequently used
re-engineering criteria.

Code generation facilities that allow you to use the results of the analysis extract to
generate a standalone program, a callable module, and a Complement Module.
Prior to code generation, the extracted Logic Segment can be viewed and modified
using the COBOL editor.

Encore is designed to support these features:

Web enablement

Open interface

Platform and technology migration
Re-implementation of business functions

Component-based maintenance

Encore contains a Common User Access (CUA) interface with action bars, pull-down
menus, and pop-up screens that make it easy to learn and use.

Encore Components

Encore is comprised of these four functional components:

Reengineering analysis
Code extraction
Migration

Target generation



1 Introduction

Reengineering Analysis Overview

Encore re-engineering analysis displays the source code in various levels. The
re-engineering analysis component consists of these three displays:

View Methods Contents of Views

Structure Displays the hierarchical relationships within the program in a
graphical mode. You can zoom in on the actual COBOL source
represented by the graphical display.

Tree Displays the program in logical execution order. This view allows
straightforward analysis of how the program works.

Source Displays the program in source code order and offers
COBOL-intelligent browsing capabilities.

The main purpose of re-engineering analysis is to gather enough information about the
program to make the best decision regarding code isolation and extraction.
Re-engineering analysis is available through the View facility.

Extract Overview

Encore’s main focus is the Extract facility, which addresses the re-engineering aspects of
code renewal, and provides the capability to isolate and extract logical code segments
from existing programs. These are the eight methods used to isolate and extract code:

Objective Type  Purpose

Perform Range  Isolates and extracts a specific named PERFORMed range of code
within the COBOL program. See Chapter 4, "Perform Range
Extract," on page 57 for more details about Perform Range extracts.

Transaction Isolates and extracts all code required for a specific transaction (i.e.,
all code between a start point and multiple end points that is, or
could be, executed based on the values of a data variable). See
Chapter 6, "Transaction Extract," on page 157 for more details
about Transaction extracts.

Computation Isolates and extracts all code that calculates a specific data variable

Variable from the beginning of the program to a specific statement in the
program. See Chapter 5, "Computation Variable Extract," on
page 133 for more details about Computation Variable extracts.

Report Isolates and extracts all code necessary to produce a set of identified
output (WRITE) statements. See Chapter 7, "Report Extract," on
page 181 for more details about Report extracts.
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Statement Isolates and extracts a user-selected set of COBOL source

statements. See Chapter 3. "Getting Started," on page 23 for more
details about Statement extracts.

Complement Extracts the original program, excluding statements from a

previous extract. See Chapter 4, "Perform Range Extract,”" on
page 57 for more details about Complement extracts.

Common Code Identifies code common to two or more previous extracts. See

Chapter 4, "Perform Range Extract,”" on page 57 for more details
about Common Code extracts.

CICS Server Isolates and extracts all code required to generate a CICS server

program. See Chapter 8, "CICS Server Extract," on page 213 for
more details about CICS server extracts.

Migration

The most basic feature of Encore is to convert an existing MVS COBOL application to a
component-based architecture. Encore provides these capabilities for migration:

Clear separation of user interface and data access code from the business logic.

Removal of redundant logic.

Target Generation Overview

Target generation addresses the disposition of the segment created in the code extraction
phase. For target generation, Encore provides these capabilities:

Separate program generation.
Callable module generation.

Complement module generation consisting of the original program with the
extracted Logic Segment removed.

10 module generation containing all input/output functions for an FD (File
Description).

Logical COBOL segment access with an editor such as ISPF Edit or SmartEdit for
modification and customization.

Knowledge retention that helps with everyday maintenance tasks or major system
rewrites.

Logic Segment extraction used for input to CASE tools.

The target generation environment is a powerful lever against change. When business
needs call for enhancements to a specific function only one Logic Segment is impacted,
dramatically reducing the time required for analysis and change.



Product Overview

This chapter describes the user interface, help facility, multiple views, wildcard patterns,
and COBOL terms, and contains these sections:

Section Page
Introduction 5
Encore User Interface 6
Help Facility 13
Multiple Views 13
Wildcard Patterns 14
Understanding COBOL Terms 14

Introduction

Encore is an integrated re-engineering environment for COBOL programs. It is designed
to isolate and extract logical COBOL segments from existing programs. The benefits of
Encore enable you to perform these functions:

o Extract the knowledge and investment made in COBOL systems over the years.

o Manage each application by its business rule.

J Forward engineer new enhancements and systems quickly and with higher quality.
Encore operates interactively in ISPF, allowing you to identify, isolate, and extract

logical business functions from COBOL programs. These business functions, or business
rules, can then be saved for later use (e.g., enhancement or code reuse).
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Encore User Interface

The online component of Encore features Common User Access (CUA) screens, action
bars, pull-down menus, and pop-up screens that are designed to provide easy access to all
of the product features.

o An action bar contains a line of keywords, or actions, that display at the top of a
screen. Each keyword represents a category of actions that can be performed on that
screen using a pull-down menu. An action is selected by moving the cursor to the
desired keyword and pressing Enter.

o A pull-down menu is the list that displays when an action is selected on the action
bar. On a pull-down, actions followed by an ellipsis (...) display a pop-up when
selected. Actions not followed by an ellipsis immediately activate internal
commands. There are two ways to select an item on a pull-down:

—  Move the cursor to the desired keyword and press Enter.
—  Enter the number of the desired action in the input field and press Enter.

) Screens contain a full-width display of information containing a full action bar.
Encore screens are modeled after TSO/ISPF screens.

o A pop-up screen is a screen that displays when an item is selected on a pull-down
menu or another pop-up screen, or as the result of entering certain commands. It is
superimposed on your screen to allow entry of information for the requested action.
Enter the desired data or option and follow instructions on the pop-up to process the
information.-

Note:

Use the END command (default PF3 or PF15) to exit a pull-down or a pop-up without
processing any actions. If the cursor is on the action bar when PF03/15 is pressed, the
cursor is moved to the command input area of the screen.

The Action Bar

The action bar is contained on all Encore screens. Some pop-ups contain a shortened
action bar that contains fewer actions and associated options than are available on the
regular action bar.

Note:

If other ESW products are installed at your site, other actions may appear on the action
bar. For more information about these features of other products see the corresponding
product user’s guide or online help.

Selecting an action is achieved by moving the cursor with the tab, mouse, or arrow keys
to the desired keyword and pressing Enter.
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When you place the cursor on the action bar and press PF3/15 (END), it is moved to the
command line on the screen (Command = = =>). If the cursor is on a full screen, pressing
HOME moves the cursor to the first action on the action bar.

Figure 1 shows the action bar on the Encore primary screen.

Figure 1« Action Bar Format (Encore Primary Screen)

File Uiew Extract Generate Search List 0Options Help

AEG-Encore
ConAand ===
Atk Hbtebk bbbkl Hebetetek:
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Atttk Atttk Hetetebtek Hetslelk Eood
Aotttk
Aotttk

Copwright ALlen SysteMs Group, INcC., an unpublished vork.
A proprietary product of A$G, InC. Use restricted to authorized 1icensees.
Visit the ASG Support Web Site af wuw.asq.coH

Actions

File Displays the File pull-down, which is used to open and close
programs, save Logic Segments and Equates for the current
program, analyze programs prior to use by Encore, manage the
AKR, edit COBOL source programs, execute script files, fix AKR
program anomalies, and to exit Encore.

View Displays the View pull-down, which is used to view a program,
Logic Segment, or complement; view program information and
display or exclude source according to the program hierarchical
structure; change the level of information viewed; reset the
display; and exclude source from the display.

Extract Displays the Extract pull-down, which presents various available
task-oriented extract options.

Generate Displays the Generate pull-down, which is used to create a
program or callable module, build an IO module, perform a Batch
Computation, generate a CICS server, and to print or punch the
Logic Segment.

Search Displays the Search pull-down, which is used to conduct a
COBOL intelligent search of the source code for one or all
occurrences of a specified target.
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Action Description

Logic Displays the Logic pull-down, which is used to follow the

execution of a program, searching for a specific target.

Note:

The appearance of the Logic menu option on the action bar
depends on whether you have installed other ESW products, such
as Insight. If other products have not been installed, Logic does
not appear on the action bar.

List Displays the List pull-down, which is used to access prompt list
pop-ups that list information about calls, equates, performs,
programs, subsets, and segments.

Options Displays the Options pull-down, which is used to customize the
Encore environment.

Help Displays the Help pull-down, which is used to access the online
help facility.

See the ASG-Encore Reference Guide for more information about the functions available
on these pull-downs.
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Pull-Down Menus

A pull-down menu is displayed in an existing window when you select an action on the
action bar. There are two types of actions on pull-downs:

o An action followed by an ellipsis (...) displays a pop-up when selected.
J An action not followed by an ellipsis, which immediately activates an internal

command and usually re-displaying the previous screen.

For example, on the File pull-down (Figure 2), these actions display a pop-up when
selected:

. Open

. Save segment
o Analyze

J AKR utility

o Edit program
o Execute script

J Anomaly facility

Figure 2 « Pull-Down Format

File Wiew Extract Generate Search List Options Help
_ 1. Open... ASG-Encore
2. Close
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5. Analyze... Hkokak
E. AKR utility... bk skoksk stk
T. Edit program. .. Hik okoksck bkt
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9. Anomaly Facility...
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Copyright Allen Systems Group, Inc., an unpublished worl:.
A proprietary product of ASG. Inc. Use restricted to authorized licensees.
Yizit the ASG Support Web Site at www.asg.com

These actions do not display a pop-up, but rather immediately process the associated
internal command:

o Close
o Save equates

. Exit
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Screens

A screen is a full-width display of information containing a full action bar. Encore
screens are modeled after TSO/ISPF screens.

The various parts of the Source View screen are identified by the alphabetic letters shown
in Figures 3.

Figure 3 « Screen Format (Source View Screen)

File WView Extract DGenerate Search List Options Help {Rh)
Source View (B) {C) Program: VIARDEMO
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000017  ENVIRONMENT DIVISION.

0000LE  CONFIGURATION SECTION.

10
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Fields

Field Description

A The action bar is displayed at the top of the screen.
B The name of the screen.
C VIARDEMO - The name of the active program. A program must be open for

this field to be displayed. This area of the screen is also used to temporarily
display short informational or error messages.

D The command input area (command line), used to enter Encore primary
commands.
E Specifies the number of screen lines or columns to scroll. This field is

omitted on screens that cannot be scrolled, such as the primary Encore
screen. These are the scroll values:

) 1-9999 A number from 1 to 9999 can be entered to specify the
number of lines or columns to scroll.

) CSR Specifies a scroll value of one page from the cursor location.
. DATA  Specifies a scroll value of one less than a page.
) HALF  Specifies a scroll value of one half page.

) MAX  Specifies a scroll value of the top, bottom, right or left
margin.

) PAGE  Specifies a scroll value of one page.

F The long message area contains descriptive, information, or error messages.
Long messages are displayed when there are no corresponding short
messages, or when HELP is entered in the command input area while a short
message is displayed.

See the online help for more information about Encore commands.

11
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Pop-Up Screens

Fields

12

Figures 4 show an example of a pop-up screen that displays when you select an item on a
pull-down or pop-up, or as the result of entering certain commands. A pop-up is
superimposed over a screen, has a border, and usually does not have an action bar. Each
pop-up contains one or more fields.

Follow the instructions on a pop-up to process the information. Use the END command
(default PF03/15) to exit from a pop-up without processing the actions you have
performed.

Figure 4 « Pop-Up Format (View - Tree View Request Pop-Up)

File Miew Extract Generate Search List Options Help
Yiew - Tree Yiew Request
Comma
Tupe request options. Then press Enter. For a name selection list
for a range [other than 1 or 2], type a pattern ([e.g. BREC*) in the
name field.
Lewels 2 of L of depth
Contents Range
1 1. Labels 1. Procedure division
2. Labels and performs 2. ALl entry points
2. Labels, performs and GOTOs 2.  Perfranges name
4. Labels, performs, GO0TO=s and 4 Entry point name
conditionals 5. HMested program name
Mame
A pt
Options
_ FRepetition

Field Description

Text Entry Used to type textual information, such as a data name, program

Fields name, etc. The length of each text entry field is designated by an
underline. Name is an example of a text entry field shown in
Figure 4 on page 12.

Selection Fields

Numbered Allows selection of one item from a list. Enter the number of the

Selection Fields desired selection in the field input area to the left of the first
numbered item. Contents is an example of a numbered selection
field shown in Figure 4 on page 12.
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Unnumbered Selected by entering a forward slash (/) in the field input area, and

Selection Fields unselected by entering a blank space to remove the slash.
Repetition is an example of an unnumbered selection field shown
in Figure 4 on page 12.

Field Input A field input area is designated by an underline. When a pop-up is

Area first displayed, each field contains its default value. On some
pop-ups, if the default is changed the new value is retained for
subsequent sessions.

Help Facility

Encore has extensive Help facilities. Help is available for screens and pop-ups,
commands, general information, specific information, abends, messages, and fields on
certain pop-ups.

The Help Tutorial is a topic-driven sequence of display-only screens that describe the
features and capabilities of Encore. These descriptions include an overview of Encore
and its main features.

Help for screens and pop-ups describes their purpose, why they are displayed, a
description of each field, and the required input.

Help for commands describes the purpose of each command, displays the command
syntax diagram, and describes each operand and its values.

Help is also available for some input fields on certain pop-ups unique to Encore. Enter a
question mark (?) in a field to view the help screen for that field. The field help screen
describes the field and lists valid input values. The desired value can be entered on this
help screen. When the product screen is redisplayed, the entered value displays in the
proper field.

Multiple Views

The View facility presents various displays of an existing COBOL source program.
Program information can be presented in a graphic structure, logical execution, or source
code format. This facility is used to examine the program to become more familiar with
the program structure and functions, or to increase understanding of the program prior to
making a change or extracting a Logic Segment.

13
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These are the three available view methods:

View Methods Contents of Views

Structure Displays the hierarchical relationships within the program in a
graphical mode. You can zoom in on the actual COBOL source
represented by the graphical display.

Tree Displays the program in logical execution order. This view allows
straightforward analysis of how the program works.

Source Displays the program in source code order and offers
COBOL-intelligent browsing capabilities.

Wildcard Patterns

For some Encore screens, there are fields that require the entry of names. If the name field
is left blank, a selection list is displayed. Encore provides the ability to enter wildcard
patterns to reduce the selection list.

These are the wildcard pattern matching characters:

. The question mark (?) character matches any one character.

e  The asterisk (*) character matches zero or more characters.

Performing a search using the wildcard format is only valid for those name fields that are
explicitly noted.

Understanding COBOL Terms

Sets

A set is a grouping of source lines in a COBOL source program. Sets consist of subsets
and line range sets. Many Encore commands make use of one or more of these sets or
subsets. In addition, sets can be concatenated by placing a plus sign (+) between them.
For example, this set would highlight the set of lines containing 1O statements and
PARAGRAPH labels:

HIGH IO + PAR

14
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Subsets
These are the types of subsets:
) COBOL language subsets
. Screen subsets
o Tagged lines subsets

Use the LIST SUBSETS command or select List » Subsets to display the List - COBOL
Subset Names pop-up, which describes each subset.

COBOL Subsets

Encore classifies COBOL statements into subsets by grouping together COBOL verbs of
a similar nature. For example, you could refer to any lines that contain READ, WRITE,
OPEN, or CLOSE verbs by using the COBOL language subset name IO.

The COBOL subsets and their corresponding entities are described in Tagged Line
Subsets.
Screen Subsets

Screen subsets are generally the result of an interactive search request. To specify one of
these subsets, enter the entire name or the minimum abbreviation, as indicated by these
upper case letters:

HIghlighted = HI
NONHighlighted = NONH or NHI
EXcluded = EX or X

NONExcluded = NONE or NX

Tagged Line Subsets

Tagged line subsets are displayed in columns 73 through 80 of the Source View screen.
Search results show tags in Source View. Source View also marks data items that are
never referenced, tags statements that contain dead code, tags program exits, and tells you
if PERFORMed paragraphs fallthrough or return.

This tagged line subset, which refers to all lines that have information tags on them, can
be used as a subset in commands that accept subsets as targets:

TAGged

15
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This table contains COBOL subsets that accept tagged line subsets are targets:

COBOL Subsets Description

ASSIGNMENT Statements that assign a value to a data item, (e.g., MOVE, ADD,

or COMPUTE).

CALL Statements related to subprogram calls such as CALL and
CANCEL.

CICS Any CICS (Customer Information Control System) or DL/I
command-level commands.

COBOLII COBOL II, including CONTINUE, END, and INITIALIZE
verbs.

COBOL/370 Statements and clauses unique to COBOL/370, such as intrinsic

function calls, procedure pointers, and calls to the LE/370
run-time environment.

COMMENT Statements having no run-time effect, such as all lines with an
asterisk (*) in column 7, the entire IDENTIFICATION
DIVISION, and NOTE statements.

CONDITIONAL Statements or parts of statements that conditionally change the
flow of control in a program such as IF, ELSE, and WHEN.

COPY | INCLUDE COPY, COPY IDMS, SQL INCLUDE, ++INCLUDE, and -INC

statements.

DB2 | SQL EXEC SQL statements.

DDL SQL Data Definition Language statements, such as CREATE,
ALTER, DECLARE, and DROP.

DEAD Statements containing dead code and dead data.

DEADCODE Statements containing code that cannot be executed under any
conditions.

DEADDATA DATA DIVISION statements containing data names and their
aliases that are not referenced in the PROCEDURE DIVISION.

DEBUG Statements containing a DEBUG, EXHIBIT, ON, READY, or
RESET verb, as well as statements containing a D in column 7.

DEFINITION Declaratives of data items including the SPECIAL-NAMES
paragraph in the ENVIRONMENT DIVISION and the entire
DATA DIVISION.
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DIRECTIVE Statements that direct the compiler to take specific actions during
compilation such as BASIS, EJECT, and TITLE.

DL/ | DL/1 EXEC DL/I commands, ENTRY 'DLITCBL', and CALL
'CBLTDLI.

DML SQL Data Manipulation Language statements, such as SELECT,
UPDATE, INSERT, and COMMENT.

ENTRY The PROCEDURE DIVISION statement and all ENTRY

statements.

EXIT | PGMEXIT

Statements containing a STOP RUN, GOBACK, or EXIT
PROGRAM verb, and CALL statements that are indicated as
NORET (non-returning).

FALLTHROUGH  Statements of PERFORMed paragraphs or units that fall through
to the next paragraph.

GOTO Statements containing an ALTER or GOTO verb.

IDMS IDMS statements.

INPUTOUTPUT COBOL IO statements (1O, Input, or Output) including CALL

10 statements that are indicated as containing 10, Input, or Output.

INPUT

OUTPUT

LABEL Statements containing DIVISION or SECTION headers or

DIVISION PARAGRAPH labels. LABEL refers to the PROCEDURE
DIVISION line and all section and paragraph names in the

PARAGRAPH PROCEDURE DIVISION.

SECTION

MAINLINE Mainline code statements that are reachable from the
PROCEDURE DIVISION line to the program units by following
FALLTHROUGHSs and GO TOs, but not PERFORMs.

MATH Statements containing arithmetic operators and verbs.

PERFORM Statements containing the PERFORM, SORT, or MERGE verbs.

RETURN Statements of a PERFORMed paragraph range that return
control.

SORTMerge SORT/MERGE statements and related 1O procedures.

17
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Targets

Label Name

COBOL Subsets Description

STRUCTURE A group of COBOL subsets that, together, help show the general
structure of the program. These COBOL subsets include CALL,
PERFORM, DIVISION, SECTION, PARAGRAPH, EXIT, and
GO TO.

TESTED Identifies the lines of code that have been tested based on
information created and updated with TCA reports. This is only
applicable to SmartTest and Insight program views.

UNTESTED Identifies the lines of code that have not been tested based on
information created and updated with TCA reports. This is only
applicable to SmartTest and Insight program views.

A target is the object of an Encore primary command. Targets are defined in these
categories:

. Label name

. Perform range name
0 Program name

. Subset name

. Line range

J Paragraph name

J Data name

. Pattern string

A label name is any paragraph or section name of the PROCEDURE DIVISION, as well
as the literals PROCEDURE and PROC. Label name specifies all transfers of control to a
paragraph or section.

Perform Range Name

18

A Perform Range name is the name specified in a PERFORM statement. The Perform
Range consists of the source code contained in the PERFORM statement, and includes all
code that is, or could be, executed as a result of GO TOs, PERFORMs, etc., within that
PERFORM. The name of any section contained in the DECLARATIVES can also be
specified.



2 Product Overview

Program Name

Subset Name

Line Range

A program name is the name of the main program or any nested program, and includes all
the source code contained in the program. This includes all programs physically nested
inside the specified program.

A subset name is one of the COBOL language subsets, screen subsets, or tag subsets
previously described in "Screen Subsets" on page 15 .

A line range can be a single line or a group of lines. Line ranges are specified by placing
a - (hyphen) between the first and last line numbers in the range (e.g., 214-376).

Line numbers are shown in the first six columns of the Source View screen. If the
specified line number is greater than the last line in the program, the last line is assumed.

Paragraph Name

Data Name

A paragraph name is any paragraph or section name of the PROCEDURE DIVISION, as
well as the literals PROCEDURE and PROC. Paragraph name includes the entire
paragraph or section.

A data name can be any of these items:
o Elementary data name

. Table name

. File name

. Table element name

J Group name

o Special name

Any legal COBOL reference for a data element can be specified as a data name. If a
variable is redefined to another name, Encore searches for the specified variable name
and the redefined name. Any reference to an entry in a table is treated as a reference to the
entire table. When data items overlap so a name can refer to parts of multiple data items,
searches are performed on each part and all references are reported. For example, if a
group item is specified in a search command, references to the group item, as well as the
individual elements within the group are located. This is also true of modifications, uses,
or references to the data item. Encore locates valid references to the variable item as
opposed to simple pattern matching of the characters in the variable name. These
references are called aliases.

19
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Fully-qualified data names can be specified by following them with a standard COBOL
OF clause, followed by the group level data name. For example:

DATA-NAME-ELEMENT OF DATA-NAME-GROUP
or for COBOL II Release 3 (minimum supported release level) programs:
DATA-NAME-ELEMENT OF SUBPROGRAM

Multiple data names can be located at the same time by concatenating the data names
with a plus sign (+) between them. For example:

DATA-NAME1l + DATA-NAME2

Data names can be specified with one of these subordinate operands:

Operand Description

MODIFICATION Occurrences of a data item where its value is being set or
altered.

USE Occurrences of a data item where its value is being tested or
used.

DEFINITION Definitions of a data item and its aliases as specified in the
DATA DIVISION.

REFERENCE All MODIFICATION and USE occurrences.

REFERENCE also includes DEFINITION occurrences on
some commands. This is the default usage for data names.

Note:

The FINDXTND primary command also offers ALIAS/NOALIAS operands. ALIAS
includes all aliases for the specified data name and is the default.




Pattern String

2 Product Overview

A pattern string is a sequence of characters. Strings of non-alphanumeric characters can
be specified by the HEX, TEXT, and PICTURE operands. The string can be further
qualified using the WORD, PREFIX, or SUFFIX subordinate operands.

String Description

X'string'

A hexadecimal string, enclosed in single or double quotes.

T'string'

A text string, which disregards upper and lowercase,
enclosed in single or double quotes.

P'string'

A picture string, enclosed in single or double quotes. These
are the valid picture strings:

o P'=' Any character

J P'—' Any nonblank character

e  P'' Any nondisplay character

. P'#" Any numeric character

. P'-' Any non-numeric character

e  P'@' Any alphabetic character (upper or lowercase)
e  P'<' Any lowercase alphabetic character

o P'>' Any uppercase alphabetic character

e P'$' Any special character (not alphabetic or
numeric)

WORD

A string preceded and followed by any non-alphanumeric
character (except a hyphen).

PREFIX

A word that begins with the specified string.

SUFFIX

A word that ends with the specified string.
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Getting Started

This chapter describes how to initiate an Encore session, define user options, allocate an
AKR, analyze a COBOL program, code extraction objectives, and Complement Module

contents, and contains these sections:

Section Page
Introduction 23
Starting an Encore Session 25
Defining User Options 26
Allocating an AKR 33
The Analyze Facility 36
Decomposition 40
Clean-Up Tasks 45
Complement Module Contents 45
The Demonstration Program 49

Introduction

This chapter is intended for new Encore users, and describes fundamental tasks, such as
invoking an Encore session, and the preliminary tasks you need to perform prior to using

Encore.
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The steps necessary to invoke Encore vary by site, so check with the systems
administrator at your facility for startup and user profile information. Before following
along with the sample Encore session presented in this section, you should review
Chapter 1, "Introduction," on page 1 and Chapter 2, "Product Overview," on page 5 to
become familiar with the terminology used by Encore.

Y ou must define some of Encore’s parameters the first time you activate the product. The
first part of this section describes these functions:

o Activating an Encore session.
o Setting and verifying these user options from the Options pull-down:
—  Online operations parameters on the Options - Parameters Definition pop-up.

—  Log, List, Punch, and Work file allocations on the Options - Product Allocations
pop-up.

— Log, List, and Punch file processing options and provide a Job card on the
Options - Log/List/Punch Definition pop-up.

—  PF key values.
o Allocating an AKR.

o Analyzing a program.

See "Starting an Encore Session" on page 25 .

The second part of this section deals with pre and post decomposition tasks and contains
a listing of VIARDEMO, one of the demonstration program used in the other task
oriented sections of the ASG-Encore User’s Guide. See "Decomposition" on page 40 .

See the online help for detailed information about the screens and fields that are used in
these sections.



3 Getting Started

Starting an Encore Session

To start the Encore session, you need to access the ESW Primary screen and open the
Encore application. See Chapter 4, "Perform Range Extract," on page 57 for specific
logon instructions

Note:

Logon procedures and AKR information are unique to your programming environment.
If necessary, contact your systems administrator or your Encore coordinator for the
correct dataset names.

If your site starts Encore directly, use the ISPF selection or CLIST as indicated by your
systems administrator. After you activate the session, the Encore Primary screen displays,
as shown in Figure 5.

Figure S« Encore Primary screen

File View Extract Generate Search List Options Help

ASG-Encore
Commard === g
koo wokckkk stk koo
shkokokeok sekkokd skskokskieok shkokokeok
skikkok kst stk skkkok ko
ko skkakok [ T T ki

skttt
bE s

Copyright Allen Systems Group, Inc., an unpublished worlk.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Visit the A5G Support Web Site at www. asg.com

ASGIETEI TO DISFLAT INFORMATIOM REGARDIMG CUA FEATURES, FRESS EMTER.

Note:

When this screen initially displays, the ASG16761 message displays. This message
displays every time you access this screen in startup mode. To turn the message off, press
Enter to display the Encore CUA feature screen and type NO in the Display the "CUA
INFORMATION" message (at entry) in the future entry field. Press Enter to return to the
Encore Primary screen.
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The first time you enter Encore, you should customize the options to reflect the
appropriate settings for your environment. Some options are initially set to default values
established during product installation by the systems administrator.

Figure 6 shows the Options pull-down, which is used to customize the Encore
environment. Customization includes these tasks:

) Setting and verifying online operations parameters on the Options - Product
Parameters pop-up (see Figure 7 on page 27).

. Setting and verifying the Log, List, Punch, and Work file allocations in the
Options - Product Allocations pop-up (see Figure 8 on page 28).

. Setting and verifying Log, List, and Punch file processing options and providing a
Job card on the Options - Log/List/Punch Definition pop-up (see Figure 9 on page
29).

. Setting and verifying PF key values.
o Setting the default view.

o Setting and verifying output and formatting options for generated COBOL
modules.

Select Options on the action bar to display the Options pull-down. See the online help for
more information about the Options available in Encore.

Figure 6 « Options Pull-down

Options
ASG-Encore _ 1. Product Parameters...
Command ===> 2. Product Allocations...
3. Log/list/punch...
KKK KK KK KK KK K K KKK K K KKK 4. Script file allocations..
K KKK KK KKK KK KOK KRR KKK KKK KK 5. PF keys. .
KK KK KEKKK  KEKKKK 6. Modes. ..
KA KKK KHKKK  HOKKK KK 7. Equates...
KK K KK KK KK KK KKK OKOKKOK KKK KK KK KK KK K 8. Generate..
KK K KKK K KK KK K K K KK KK KK K KKKKKKKKK | = mm mm m o m e e e e e e e e o
XK KK K XK KK K KKKKKK KKK K KK
XK KK K XK KK K KKKKKK KKK K KK
XK KK K KKK KKK K KK KK KK KKK KK KK KKK KKK KK KK KK KK K KK KK KK K
XK KK K KK K KK KK KK KK KK K 3K K K K KK KK K K KK K KK KK KK KK KK K K K K

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Visit the ASG Support Web Site at www.asg.com
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Setting Online Operation Parameters

To set online operation parameters

Select Options P Product Parameters and press Enter to display the Options - Product

Parameter Definition pop-up, as shown in Figure 7.

Figure 7 « Options - Product Parameter Definition Pop-up

File View Extract Generate Search List Options Help

Options - Product Parameters

Command ===>
Type desired product parameters. Then press
3 HOK K KK K K Enter.
KKK KK K KK R K K
HOK KKK Cursor Substitution Character %
KKK K -

HOK KK KK KK K KK KKK COBOL Module Exit
KR KKK KKK K KK KR X K

KKK KK Options Default View
XXX x _ Alarm ) 1. Structure Yiew
KK KK * ¥ _ Confirm on Exit 2. Tree View
KK KK K KKK _ Save EQUATES 3. Source View
Save EDIT File 4. None

Copyright Allen '--=-----------------mmmmmm e e m e mm e e
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Visit the ASG Support Web Site at www.asg.com

Type the appropriate information in the fields and press Enter.

See the online help for more information about the fields on this pop-up.
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Allocating Log, List, Punch, and Work Files

Use the Options - Product Allocations pop-up (see Figure 8) to set or verify the DASD
volumes for the Log, List, Punch, and Work files. Some options are initially set to default

values established during product installation by the systems administrator.

To define the Log, List, Punch, and Work file DASD allocations

1 Select Options P Product Allocations and press Enter to display the

Options - Product Allocations pop-up.

Figure 8 « Options - Product Allocations Pop-up without SMS

File View Extract Generate Search Logic List Options Help
Options - Product Allocations
C | Command ===> _
Log file:
Generic unit . . SYSDA [generic group name or unit address)
Yolume serial [(blank for authorized default volume)
List file:
Generic unit . . SYSDA [generic group name or unit address)
Yolume serial [(blank for authorized default volume)
Punch file:
Generic unit . . 8SYSDA (generic group name or unit address)
Volume serial [blank for authorized default volume)
Work file:
Generic unit . SYSDA [generic group name or unit address)
Volume serial [blank for authorized default volume)
Space units CYLS [BLKS, TRKS or CYLS)
Primary space . . 1 [space units)
Secondary space 1 [space units)

2

Type the appropriate information in the fields and press Enter.

See the online help for more information about the fields on this pop-up.
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Setting Log/List/Punch Processing Options

Use the Options - Log/List/Punch Definition pop-up (see Figure 9) to set the processing
values for the Encore Log, List, and Punch files. These files are used for system message
logging, error handling, and holding the results of several Encore commands. It is not
necessary to exit Encore to process these files. Some options are initially set to default
values established during product installation by the systems administrator.

To specify the Log/List/Punch Definition options

1 Select Options » Log/List/Punch and press Enter to display the
Options - Log/List/Punch Definition pop-up.

Figure 9 « Options - Log/List/Punch Definition Pop-Up

Options - Log/List/Punch Definition
Command ===>

1 - Process log file 2 - Process list file 3 - Process punch file
4 - Customized data set name

Options Log List Punch
Process option . . . . . . FD PK K
Primary tracks e o1 1 1
Secondary tracks L. 2 5 5
Lines per page . . . . . . 56 56 56
Sysout class . . . . . . . * X *

Process options: PK [print/keep), PD [print/delete), K, or D.

Job statement information:
//NAME JOB (RCCOUNT], ' (NAME) ',

/7 MSGCLASS=R
/% INSERT '/*ROUTE PRINT NODE.USER' HERE IF NEEDED.
/7%

Note:

When the PK or PD process option is specified, you must enter a valid job card in
the Job statement information field prior to processing any Log, List, or Punch files.

2  Ifyou specify the K or PK process option, you can customize the dataset where the
log, list, or punch file is allocated. By default, Encore allocates the Log, List, and
Punch files as USERID.ENTnnnnn.VIAxxxxx, where nnnnn is a sequential
number from 00001 to 99999 and xxxxx is LOG for Log, LIST for List, and
PUNCH for Punch files. If you have specified a TSO Prefix, the prefix is appended
to the beginning of the file name allocated for the Log, List, and Punch files.
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3  Type 4 on the command line and press Enter to display the Options - Log/List/Punch
Name Customization pop-up, as shown in Figure 10.

Figure 10 » Options - Log/List/Punch Name Customization Pop-up

Options - Log/List/Punch Name Customization
Command ===>

You can define a customized name when you choose option PK (print/keep) or
K (keep) by specifying Ulser). Specifying Y(es) on Prompt later lets you

define a custom name as you process each log/list/punch file. Otherwise,

specify data set name and file mode. Then press Enter.

Options Log List Punch
File Naming . . . . . . . U ] u Ulser) or S(ystem)
Prompt later for DSN . . Y Y Y Y(es) or Nlo)

The following are needed if Ulser) and Nlo) are specified above

Log Data set name "USERID.TEST.VIALOG’ (Seq)
File Mode . . O Olverurite) or Alppend)

List Data set name (Seq)
File Mode . . _ 0(verwrite) or Al(ppend)

Punch Data set name (Seq)
File Mode . . _ Olverurite) or Alppend)

4  Type Uin the File Naming field for Log, List, or Punch to indicate a user-defined
dataset name. If you specify N in the Prompt later for DSN field, you must enter a
dataset name in the corresponding Data set name field and specify O (overwrite) or
A (append) in the File Mode field.

If you specify Y in the Prompt later for DSN field, Encore prompts you for the
dataset name during file processing.

See the online help for more information about the fields on this pop-up.
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Mapping PF Keys

To display or map your PF Keys

1

3 Getting Started

Select Options » PF Keys and press Enter to display the Options - PF Key Definition

pop-up, as shown in Figure 11.

Figure 11 » Options - PF Key Definition

File WYiew Extract Generate Search List Optiens
Options - PF Key (01-12) Definition

C Command ===2> _

Press PF3/15 [EHD) 1o exit

Mumber of PF keys: 24 Terminal type:
PFA1 HELF

PFO2 SPLIT

PFO3 END

PFE4 ZOOHIH

PFE& AFIHD

PFAGE Fr =

Help

Press Enter to process changes andfor to display alternate keys.

dZ7E

Type the appropriate PF key values in the fields. PF keys 1 through 12 are displayed

initially. Press Enter to display PF keys 13 through 24.

See the online help for more information about the fields on this pop-up.
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Options - Generate Pop-Up

To specify output and format settings for generated COBOL modules

1 Select Options » Generate and press Enter to display the Options - Generate pop-up,
as shown in Figure 12.

Figure 12 » Options - Generate Pop-Up

File View Extract Generate Search List Options Help

Options - Generate

[
Select the desired COBOL Module Generate Options.
O K
/ Display EDIT Options _ Output to Existing Library KK
COBOL Source
Full DATA DIVISION _ Retain Source Line Numbers
Retain COPY statements _  Retain PERFORMed Paragraphs

In-1ine Communication Area

KK KKK KK 2K K K 2K K K 2K K K 2K K KKK 3K KKK KKK 20K KKK KK K KK K KK K KK K

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Visit the ASG Support Web Site at www.asg.com

2  Type a forward slash (/) in the appropriate fields and press Enter.

See the online help for more information about the fields on this pop-up.
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Allocating an AKR

To allocate an AKR

1

3 Getting Started

Select File » AKR Utility and press Enter to display the File - AKR Utility pop-up,

as shown in Figure 13.

Figure 13 » File - AKR Utility Pop-Up

File View Extract Generate Search List Options Help

File - AKR Utility
Command ===>

D - Delete member
R - Rename member

Blank - Display member list
A - Allocate/expand AKR

Application Knowledge Repository (AKR):

Data set name . . 'USER.TEST.AKR'

Member . . . . . VIARDEMO (if "R" or "D" selected)
New name . . . . (if "R" selected)
Volume serial . . (if not cataloged)
Password . . . . (if password protected)

Visit the ASG Support Web Site at www.asg.com

A proprietary product of ASG, Inc. Use restricted to authorized licensees.

Specify the dataset name of an AKR in the Data set name field.

Type A in the command input area and press Enter to display the File - AKR

Allocate/Expand pop-up (see Figure 14 on page 34).

Note:

Four possible pop-ups may display because both BDAM and VSAM AKRs are
supported. The pop-up that displays depends on whether you use BDAM or VSAM

AKRs and whether SMS is used at your site.
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4  Enter the appropriate information in these required fields (see Figure 14):

a

b

(o

Type No in the Expand existing AKR field.

Specify the AKR name in AKR data set name field.

Specify a valid job card in the Job statement information field.

Figure 14 » File - AKR Allocate/Expand Pop-up

File View Extract Generate Search List Options Help

File - AKR Allocate/Expand

Space units

Command ===> _
S - Submit JCL E - Edit JCL C - Specify Catalog
Expand existing AKR . . . (Yes or No)
AKR data set name . . .
Volume . . . . . . . .
Unit . . . . . . . .. (Generic unit name)

Primary space . . . . .
Secondary space . . .

Job statement information

(Records, Tracks or Cylinders)
(Primary amount in above units)
(Secondary amount in above units]

See the online help for more information about the fields on this pop-up.

5  Submit the JCL to allocate the AKR using one of these methods:

a

Submit the JCL by typing S on the command line and pressing Enter.

Or

Edit the JCL by typing E on the command line and pressing Enter. While in the

editor, make the appropriate modifications and enter the TSO command
SUBMIT (or SUB). Return to the File - AKR Allocate/Expand pop-up by
entering the END primary command or pressing PF3.

6  Verify the AKR allocation results by examining the job output.



3 Getting Started

Verifying AKR Allocation Results

After the AKR allocation batch job has completed, review the job output to verify
successful allocation and initialization. Figure 15 and Figure 16 show output excerpt

examples with messages that indicate successful VSAM AKR allocation and
initialization.

Figure 15 « AKR Utility Log - Initialization Message Output

ASG-CENTER-OS (ESA) PR n.n LVL # # # AER UTILITY LOG DD-MMM-YYYY HH: MM: 55 PAGE 1

INIT D3NAME (U3ER.TE3IT.AKR)

A3G13161 AKR “USER.TEST.AKR” INITIALIZED.

ASG13141  FFF END OF VIASYSIN =++%

Figure 16 = AKR Utility Log - Summary Message Output

ASG-CENTER-0S (ESL) R n.n LVL # # # AKR UTILITY LOG — SUHNHMARY DD-MMM-YYYY HH: MM: 33 PAGE 2

AZG13001 1 AKR (3) INITIALIZED 0 FAILED

k3G13151  *¥F END OF SUMMARY REPORT *7°7
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The Analyze Facility

You must analyze a program before Encore can provide intelligent information about it.

The analyze process gathers information about a program, including program
relationships, logic data, and execution paths, and stores this information in the AKR.
After the analyze information is placed in the AKR, it is available to Encore in an online
environment, where it is accessed to provide valuable information about the design and
operation of the program.

Program Analyze Requirements

A Program Analyze is similar to a COBOL compile. Like a compile, these basic program
standards are required:

The correct COBOL language as specified in the /IBM COBOL Il Language
Reference and the IBM COBOL for MVS and VM Guides.

Programs that can be compiled without errors by the IBM COBOL II compiler.

— COBOL II programs that receive error (E), severe (S), or unconditional (U)
messages from the IBM compiler cannot be successfully analyzed.

Program Analyze Input

Input to the Program Analyze function includes these items:

36

JCL to compile the program.

The JCL should be the complete JCL used to compile the program, and should
perform these steps:

—  Retrieve the source from the source manager (such as Librarian or Panvalet)
—  Execute any pre-processors
— Invoke the compiler

Note:
Encore does not require the program to be compiled or linked for analysis.

Program Analyze features that indicate the type of analysis to be performed.
An initialized AKR to receive Program Analyze output.

Program Analyze options.



3 Getting Started

Analyzing a Program through Encore

The File - Analyze Submit pop-up is used to specify the analyze information and to
submit a program to be analyzed through Encore.

Note:

If the compile JCL resides in a source manager such as Librarian or Panvalet, you cannot
use this method. See the online help for additional information.

To analyze a program

1 Select File » Analyze and press Enter to display the File - Analyze Submit pop-up,
as shown in Figure 17.

Figure 17 » File - Analyze Submit Pop-up

File View Extract Generate Search List Options Help

File - Analyze Submit Program: VIARDEMO
Command ===>

E - Edit JCL S - Submit JCL

Compile and link JCL (PDS or sequentiall:
Data set name 'USER.TEST.CNTL (MEMBER)'

Analyze features (Y/N):
ASG-Encore: Y

AKR data set name 'USER.TEST.AKR’
AKR program name (if overriding PROGRAM-ID)

Analyze options:

Compile? (Y/N) . . . . . . . .. N (Y if needed by features)
Link load module reusable? (Y/N) N (ASG-SmartTest only)

2 Enter this information in the required fields:

a  Specify the PDS member or sequential dataset containing the compile JCL in
the Data set name field.

b  Specify the analyze feature by typing Y beside Encore in the Analyze features
(Y/N) fields.

Note:
If Encore is the only product installed, this field may not be changeable and is
automatically set to Y. Other analyze features are available on the Analyze Submit
pop-up when additional ESW products are installed at your site.
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Optionally, specify analysis report parameters that are used to produce analysis
reports that help you understand and diagnose analysis problems and anomalies.
You can also enter a different analyze parameter to use the Anomaly Repair Facility
to correct certain anomalies that may exist within your code. These are the available
parameters:

J Analysis/anomaly report parameters:

—  VIARERPT - Specifies that the analysis process stops after an analysis
report is generated.

— VIARERPTAN - Specifies that the analysis process continues after an
analysis report is generated and save the information in the AKR.

—  NUMPRM(##) - Determines the number of parameters to allow before a
CALL is listed on the Excessive Parameter List report.

—  RPTCEN - Centers the generated report (the default format for all reports
is left justified).

o Anomaly Repair Facility parameter:

—  VIAANOMF - Instructs the analyzer to run the Anomaly Repair Facility.
This is the batch method for anomaly repair. You can also select the online
method by using the Anomaly Facility - Batch Submit screen accessed
from the File pull-down menu. This parameter can be followed by
additional anomaly report parameters, as shown in this example:

VIAANOMF, PARM (DEBUG1) , ANOMALY (OOPGT, GTF, IPR) ,

COMMENT (YES) ,DSN (' ASG.ANOMALY .REPAIRED.CODE’ ) ,
MEM (MEM1) , HEADER (YES)

See the online help and the ASG-Encore Reference Guide for more
information about these parameters and the Analyze option field.

¢ Specify the AKR dataset name in the AKR data set name field.
3 Submit the JCL to compile and/or analyze by using one of these methods:

a  Typing S in the command input area and pressing Enter.

Or

b  Edit the compile JCL by typing E in the command input area and pressing
Enter. While in the editor, make the appropriate modifications and issue the
TSO command SUBMIT (or SUB). Press PF3 to return to the File - Analyze
Submit pop-up.

4  Verify the analyze results by examining the job output.
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Verifying Analyze Results

After the Analyze batch job has completed, review the job output to verify results. The
output should be checked for these results:

e Acceptable compiler results, if requested.

o Messages indicating the program has been successfully analyzed and stored in the
AKR. Storage in the AKR does not occur if the program does not analyze
successfully.

Figure 18 is an example of an output excerpt indicating a successful analyze.

Figure 18 « Example of an Output Excerpt from a Successful Analyze Job

A3G-CENTER-0S (ESL) REn.n LVLEHH PROGRAM: WIARDEMO DD-MMM-FYY¥Y¥ HH: MM: 35 PAGE 1

LINE ERRCR MESSAGE
{A) A3G02481 PROGRAM 'WIARDEMO' WAS STORED IN AKR 'USER.TEST.AKR'.
(B}
DIAGNOSTICS LINES: O TOTAL - O WARNINGS, O ERROR3I, 0 SEVERE ERROR3, 0 UNRECOVERAELE ERRORSI
SOURCE LINES: 434 TOTAL - 133 DATA DIVISION STATEMENTS, 108 PROCEDURE DIVISICN STATEMENTS
PARAMETER3 PAS3ED: COBOLII, COEZR3, FEATURES=(EN)

COPTIONS IM EFFECT: BUFMAZK=4096K, COBOLII, FEATUREZ=(A3G-ENCORE), FLAG (W), LINECNT=55, NORECUR, NOSEQ,
NOIOURCE, SPACE1

ENTRY POINTS: VIARDEMO
EXTERMAL CALLS:

END OF PROCE33ING: DD-MMM-YYYY HH: MM: 33

where:

A A message (ASG02487T) indicating that program VIARDEMO was
successfully stored in the AKR.

B The area that contains any associated program diagnostics.
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Decomposition

40

Decomposition is the process of separating an applications code into smaller, related
subgroups that are more manageable. These subgroups are fully functional and retain
limited interaction with other decomposed subgroups.

This section explains the preparation process for using Encore. The explanation also
describes the types of Logic Segments that can be extracted and the contents of
Complement Modules.

Before you can begin decomposition, you must perform these preliminary tasks:

'Defining Your Desired Goals" on page 41 .

"Selecting a Program for Decomposition" on page 41 .

"Program Cleanup" on page 41 .

"Choosing a Code Extraction Objective - The Logic Segment" on page 42 .

'Establishing a Project Notebook" on page 44 .

You should be familiar with these terms when using Encore:

See Chapter 2, "Product Overview" on page 5 or the online help for a complete definition

Logic Segment
Complement Module
Data name references
Data name aliases

Subsets

of these terms.



3 Getting Started

Defining Your Desired Goals
You must define your desired goals for re-engineering. These are some common goals:
e  Extracting common code into a standalone, shared module.
o Splitting programs into smaller, easier to maintain modules.
o Reducing or eliminating GOTOs.
) Eliminating obsolete code from programs.
o Building a library of common or reusable code.
Defining an objective promotes a common vision of what is to be accomplished by all

project participants. This common vision guarantees project acceptance at all levels and
helps to propagate subsequent decomposition activity.

Selecting a Program for Decomposition

For your initial decomposition exercise, it is recommended that you select a medium
sized program. The best type of program would be one that is of strategic value to your
company, in need of re-engineering, and contains multiple functions. Ideally, the program
should also contain code common to several other programs for the purpose of eventually
isolating that common code into a standalone or callable module.

There is a learning curve for understanding Encore, so you want to avoid complex
programs that may overwhelm the project team and not show success in a relatively short
period of time. Expertise comes with repetition and each program decomposition serves
as a building block of knowledge for the next one.

Program Cleanup

Before analyzing Encore, you need to resolve existing program abnormalities whenever
possible. These would consist of live exits, out of PERFORM transfers, and dead code or
dead data. Also give 01 Fillers in the Data Division meaningful names so that data names
used for CALLs between complement and segment modules can be more easily
reconciled later on.
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Choosing a Code Extraction Objective - The Logic Segment

In decomposition, it is sometimes difficult to be able to determine which extract objective
to use. One method you can use is to determine the best way to focus on the code you
want to change. You can perform these types of code extracts:

o Perform Range extract

U Transaction extract

) Computation Variable extract
o Report extract

o Statement extract

. CICS server extract

Perform Range Extract

42

A Perform Range extract is all of the code that could be executed by a PERFORM
statement. It includes all of the statements in the paragraph range of the PERFORM, plus
any subordinate code that is PERFORMed or reachable by GOTOs within this paragraph
range.

If the program is already well structured, the logic in question could already be inside one
or more PERFORM ranges. A good candidate for the PERFORM range extract should
possess these characteristics:

o Contains or invokes a large amount of code.
o Performs many times or from many other units.
o Contains all of the 1O statements for a certain file.

o Contains many nested PERFORMs that are not shared by others, so that it is well
isolated from the rest of the program.

. Contains a small number of 01-level structures that are serviced only by this code.

A Perform Range extract can be used to reduce the size of a program, dividing it into
separately called subroutines that can be separately compiled.

See Chapter 4, "Perform Range Extract," on page 57 for more information about Perform
Range extracts.
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Transaction Extract

A Transaction extract contains all of the code that can be reached from a designated
starting point to a designated ending point when selected conditions are true or false as
you have stated they would be. A typical example of its use is to extract the code that is
executed when a certain transaction code variable has a specific value. You would first
select the variable and Encore would then display the conditional statements associated
with that variable. The logic path extracted would depend on whether you specify those
conditional statements to be only true, only false, or true or false.

You can also use a transaction extract to simplify a large program that does not use
PERFORMSs, in which case the code falls through from top to bottom. If you can identify
both a starting point and an ending point for the portion of the program that you are
interested in, you can isolate all of the code that is executed within those boundaries.

See Chapter 6, "Transaction Extract," on page 157 for more information about transaction
extracts.

Computation Variable Extract

A Computation Variable extract locates the minimum set of statements that contribute to
the value of a data variable at a point in the program, while excluding all other code in the
program. For example, Figure 19 shows an extract of the ACTION-CODE variable at
line 80.

Figure 19 » Computation Variable Extract Example

0010 ACCEFT ACTIOH-FARM-A.

0020 ACCEPT ACTICHN-PARM-E.

0030 ACCEFT ACTIOH-FARM-C.

0040 IF ACTION-PARM-A = 7 ADD 1 TOD ACTIOH-PAFM-C.

0050 IF LACTICHN-PARM-L = 5 JUBTRACT 2 FROM ACTION-PARM-E.
0060 COMPUTE ACTIOMN-PARM-A = ACTICHN-PARM-A + 1.

0070 COMPUTE ACTION-CODE = ACTION-CODE —C + 2

0050 DISPLAY ACTION-CODE.

ujui=lu] -

o100

Lines 10, 30, 40, 70 and 80 are extracted because of these reasons:

o The value of ACTION-CODE at line 80 is determined by the computation at line
70, which depends on the variable ACTION-PARM-C.

o The value of ACTION-PARM-C depends on lines 30 and 40.
o The value of ACTION-PARM-C at line 40 depends on the value of
ACTION-PARM-A, which is determined at line 10.

A Computation Variable extract can also be used to create a called module that calculates
the value of a data variable, or determines the actual set of computations used to set a
variable.
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See Chapter 5, "Computation Variable Extract.," on page 133 for more information about
Computation Variable extracts.

Report Extract

A Report extract locates the minimum set of statements that contribute to the content of
an output file once you have identified the 10 statements that produce the file. It is ideally
suited to extract IO statements and associated data to create a standalone program that
creates only that file, or to create a standalone program that omits the creation of the
extracted file.

See Chapter 7, "Report Extract," on page 181 for more information about Report extracts.

Statement Extract

A Statement extract should be used only when no other type of extract objective is
suitable. This would be the case if the code in a program is so convoluted and intertwined
that is makes other extract objectives impossible. The Statement extract allows you to
select an arbitrary set of unrelated statements at your discretion.

CICS Server Extract

A CICS server extract locates all of the necessary statements, files, and data elements
required to create a CICS server extract program. This program is then used to create a
COMMAREA-based server program from a CICS pseudo-conversational program.

See Chapter 8. "CICS Server Extract," on page 213 for more information about CICS
server extracts.

Establishing a Project Notebook

44

At this point, you should establish a project notebook for step-by-step documentation of
the ongoing process. This documentation becomes a flexible, working document for
future Encore decomposition projects within your organization. The project notebook
serves as an excellent source for preparing internal decomposition presentations that are
likely to follow project completion. If properly maintained, a project notebook provides
substantial time savings for future decomposition projects.

These are other sections to include in the project notebook:

o The Troubleshooting Log should contain entries for all technical problems
encountered and the steps taken to resolve them.

e  The Issues Log should chronologically list all functional or procedural issues
resulting from decomposition activity. If properly maintained, these logs

substantially reduce the required completion time of subsequent decomposition
requests.
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Clean-Up Tasks
Once the extract portion of the decomposition project is completed, check to see that the
extracts were successful by verifying these results:
o The resolution of any execution and compilation issues.

o The revision of JCL to reflect the changes for both the affected programs and the
system flow.

o Verification that thorough system integration testing has been performed.

Complement Module Contents

A Complement Module is the original program with the Logic Segment removed. The
purpose of the Complement Module Generation facility is to accurately remove logic
from a program.

Logic is usually removed from a program for one of these reasons:

) The function is no longer necessary.

o The function is processed elsewhere. In this case, the logic may be in a completely
separate program, or may be processed in a CALLed module.

In either case, the code can be removed from the original program.

The accurate definition of a Complement Module depends on the extract objective
selected. The next section describes the complement produced for each extract objective

type.
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Perform Range Extract

Figure 20 shows a complement that contains all of the statements from the original
program, excluding all of the statements of the Perform Range that are not required by
other logic paths. For example, the original program contains this code:

Figure 20 « Complement Module - Perform Range Extract Example

PERFOREM A.
EERFOEM E.
AL
FERFOEM E.
BE.

EERFOEM C.
c.

If A was the Perform Range extracted, the Complement Module would contain all code
except paragraph A, since B and C are also required for a separate execution path.

In addition, the Complement Module replaces a PERFORM of the extracted range with a
CALL statement. A PERFORM VARYING is replaced with a PERFORM of an
Encore-generated SECTION containing the CALL statement.

Report Extract

Figure 21 shows a Complement Module for a report extract objective containing all
statements of the original program, excluding statements of the Logic Segment not
required by other logic paths. For the report extract objective, all identified
WRITE/CALL statements are removed. The resulting program is capable of performing
all functions except the function defined by the Logic Segment. For example, a program
could contain this code:

Figure 21 » Complement Module - Report Extract Example

o010 MOVE VAR-1 TOD B.

oozo MOVE A TO DETAIL1-FILED-A.
o030 MOVE B TD DETAILZ-FIELD-B.
oo4go MCWE B TO DETAIL1-FIELD-E.
ooso WRITE DETAILI1.

o060 WIRTE DETAILZ.

In this example, lines 10, 20, 40 and 50 represent the Logic Segment for DETAIL1. The
complement of this Logic Segment would be lines 10, 30, and 60. Note that line 10 is
common to another path within the program and, therefore, cannot be removed.
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Computation Variable Extract

Example 1

Example 2

The Complement Module for a Computation Variable extract contains all statements of

the original program, excluding statements of the positive Logic Segment not required by
any other logic paths. Because a Computation Variable derivation may be started at any

point in the program, each of these examples and the associated paths are possible. Each
example is based on the type and context of the statement selected as the end point of the
variable.

The selected statement is a logical termination of the selected data variable value.
Typically, these are OUTPUT statements and no further uses of the variable are
dependent on the derived value. The resulting Complement Module excludes all code
(from and including the selected statement) back to the beginning of the program that
contributes to or influences the value of the Computation Variable, but retains any code
needed for other functional paths. For example:

DISPLAY data name

The resulting Complement Module excludes all code from, and including, the DISPLAY
statement to the beginning of the program that contributes to or influences the value of
the data name variable, but retains any code needed for other functional paths.

The selected statement is a modification or assignment of the data variable selected as the
Computation Variable.

An Encore-generated comment indicates that the value of the Computation Variable
needs to be available at this point in the program so that subsequent dependent statements
(if any) that depend on the variable execute properly. For example:

COMPUTE data name = A + B.

DISPLAY data name.

The resulting Complement Module excludes all code from, and including, the
COMPUTE statement to the beginning of the program that contributes to or influences
the value of the data name variable, but retains any code needed for other functional
paths. The COMPUTE statement is retained as a comment.
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Example 3

The selected statement is a use of the data variable selected as the Computation Variable
in an assignment statement. An Encore-generated comment indicates that the use of the
Computation Variable is no longer applicable in the statement, and that the statement
should be altered to no longer reference the Computation Variable. For example:

COMPUTE VAR-1 = A + data name.

The resulting Complement Module excludes all code from, and including, the
COMPUTE statement back to the beginning of the program that contributes to or
influences the value of the data name variable, but retains any code needed for other
functional paths. The COMPUTE statement is retained as a comment.

Example 4

The selected statement is a conditional statement that references the data variable selected
as the Computation Variable. An Encore-generated comment is inserted indicating that
the condition being tested must be altered so that it no longer depends on a value of the
Computation Variable so that the IF statements are correctly invoked. For example:

IF data name EQUAL A THEN...

The resulting Complement Module excludes all code from, and including, the IF
statement back to the beginning of the program that contributes to or influences the value
of the data name variable, but retains any code needed for other functional paths. The IF
statement is retained as a comment.

Transaction Extract

The Complement Module for the Transaction extract is defined by identifying the
conditional paths that definitely are, and those that definitely are not, part of the
transaction complement. The transaction complement should be defined to include the
code required to process all transactions other than the one(s) defined for the transaction
objective.

Statement Extract

The Complement Module for the statement selection is defined as the physical
complement. The complement contains all statements not selected on the Statement
Selection screen.

Server Extract

The Complement Module for the CICS server extract is defined as the business logic
component that can be invoked from a web server or other types of clients. The
complement contains all statements required to define a server-side application.

48



3 Getting Started

The Demonstration Program

VIARDEMO is one of the Encore demonstration programs that is used in various
examples to demonstrate the extraction types. It does the month-end calculations for each
type of checking account carried by the Universal Bank.

Note:

VIARBRWS is the Encore demonstration program used for CICS server extraction and
generation. See Chapter 8, "CICS Server Extract," on page 213 for more information.

VIARDEMO processes these two input files:

o The Checking Account master file, a keyed random access file that contains the
records for all checking account customers.

) The Transaction file, which is a sequential file used to update the Checking
Account master.
VIARDEMO generates these two output files:

J An Action file created from the processed transactions that is used as input to
another program.

o The Exception report file that reports all errors encountered during processing.

Figure 22 shows an example of the type of file output generated from the VIARDEMO
program.

Figure 22 « Example of File Output from the Demonstration Program

000001 IDENTIFICATICH DIVISION.

00000z  PROGRAM-ID. VIARDEHMO.

000003 AUTHOR. ASG DEMONSTRATICH.

oooo04

OO0005 S Fr e A A A A R A A A T T N A R R A A A A NN AN A E AN A AN R AN SR AN A AR TR AR AT G L
oooooe * THIZ PROGEAM DOES THE MONTH END CALCULATIONS FOR EACH TYPE
ooooo? * OF CHECEING ACCOUNT CARRIED EY THE UNIVERSAL BANE. IT
ooooos * HANDLES THE FOLLOWING TYPES OF ACCOUNTS.

ooooos * CHECEING WITH INTEREST

ooooio * CHECEING WITH NO INTEREST

oooo1l o+ MONEY MARKET ACCOUNT (MMA

oooolz o+ SAVINGS ACCOUNT

oooo1s * IT ALSO UFDATES THE ACCOUNT BALANCE, BRANCH BALANCE AND
oooo14 * BANE BALLANCE.

OO00LS S rr e A A A A A A T T N A A R A A A A N AN A A AN A AR AN SR AN A AR TR AR AT G L
oooo1s

000017 ENVIRONMENT DIVIZION.

000015 CONFIGURATION SECTION.

000019 SOURCE-COMPUTER. IEM-370.

000020 OBJECT-COMPUTER. IEM-370.

000021 INFUT-OQUTPUT SECTICON.

*
*
*
*
*
*
*
*

Qo00zz

000023 FILE-CONTROL.

aoo0z4 SELECT ACCT-FILE ASSIGN TO ACCT

aooozEs CORGANIZATION I3 INDEXED

aooozae ACCESS IS RANDOHN

aoooz? RECORD EEY IS ACCT-EEY.

aooozs SELECT EXCEPTION-FILE AZSIGN TO UT-S-EXCEPTS.
aooozs SELECT TRAN-FILE AZSIGN TO UT-S-TRAN.
aoooso SELECT ACTION-FILE AZSIGN TO UT-S-ACTICHNS.

49



ASG-Encore User’s Guide

Figure 23 shows how VIARDEMO is called from another program that passes the control
parameters needed for processing.

Figure 23 « Example of Control Parameter Definitions for Demonstration Program Processing

LINEAGE 3ECTICHN.

01 CONTROL-FALRAMETERS.

05 FREE-3ZERVICE-MIN PIC 39111)V9(4) COMP-3.
05 CD-REVIEW-MIN PIC 39011)Va(4) COMP-3.
01 ERANCH-EALANCE PIC 39(11)vo(4) COMP-3.
01 EBEAWNE-BALANCE PIC 391(11)V3(4) COMP-3.

Figure 24 shows how the PROCEDURE DIVISION is written in a structured format,
with all of the processing initiated by PERFORM statements.

Figure 24 « Example of the PROCEDURE DIVISION for the Demonstration Program

File Edit Confirm Menu Utilities Cowmpilers Test Help

EDIT WIARNxx.DEVL.CNTL (VIARDEMO) - =x.00 Colunns 00001 00072
Command ===2 Scroll ===> C3iR
019300 012754 PROCEDURE DIVISION USING CONTROL-PARAMETERS, BRANCH-BALANCE,
019900 012760 BANE-EALANCE.

0z00oo 012770

0z0lo0 0lz7s80 OPEN O0UTPUT EXCEPTION-FILE.

0z0z00 012790

020300 012500 PERFORM INITIALIZE-PGM.

020400 012900

0z0500 013000 PERFORM ACCT-MAINTENANCE

0zZ0500 013100 THRD ACCT-MAINTENANCE-EXIT

0zZ0700 0l3200 UNTIL TRAN-FILE-ENDS.

0z0800 013300

020900 013400 PERFORM REPORT-FINAL-CNTES.

021000 013500

0zZ1100 013500 PERFORM CLOSE-PGH.

0Z1200 013700

0z1300 013500 GOBACK.

0z1400 013900

021500 014000

021000 014100 ACCT-MAINTENANCE.
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Figure 25 shows how the INITIALIZE-PGM paragraph opens the files and verifies the
parameters passed to VIARDEMO. It also shows how it performs paragraph
GET-NUM-OF-DAYS, which determines the number of days in the current accounting
period.

Figure 25 « Example of the INITIALIZE-PGM Paragraph

File Edit Confirm Menu Utilities Compilers Test Help
EDIT VIARNxx.DEVL.CNTL(VIARDEMO) - xx.00 Columns 00001 00072
Command === Scroll ===> CSR

034600 024200 INITIALIZE-PGH.
034700 024300
034800 024400
034900 024500

PERFORM OPEN-FILEZX.

035000 024600 NOVE +0 TO ACCT-IO-CHT
035100 024700 TERAN-CHNT
035200 024300 ACTION-CHT

035300 024300
035400 025000

WORK-RETURN -CODE .

035500 0Z5100 IF FREE-ZERVICE-HMIN NOT HUMERIC

035600 0Z5200 MOVE +0 TO FREE-SERVICE-MIN.
035700 025300 IF CD-PEVIEW-MIN HOT NUMERIC

035800 025400 HOVE +0 TO CL-REVIEW-MIN.
035900 025500 IF ERANCH-EALANCE HOT NUMERIC

036000 025600 MO¥E +0 TO BRANCH-BEALAMNCE.
036100 0Z5700 IF EAWNE-BALANCE HNOT NUMERIC

036200 0Z5800 MOVE +0 TO BANK-BALAMNCE.
038300 023900

036400 0Z6000 MOVE ZERODES TO WORK-ACTION-EEASON.
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Figure 26 shows how the ACCT-MAINTENANCE paragraph matches the Checking
Account master and the transaction file, and how it applies maintenance to the Checking
Account master by performing paragraph UPDATE-ACCT THRU
UPDATE-ACCT-EXIT. Processing errors encountered are written to the Exception
report.

Figure 26 » Example of the ACCT-MAINTENANCE Paragraph

File Edit Confirm Memu Utilities Compilers Test Help

ELIT VIARN=x.DEVL.CNTL (VIARDEMO) - =x.01 Columns 00001 00072
Command === dcroll ===> C3R
021600 014100 ACCT-MAINTEMNANCE.

021800 014300 READ TRAN-FILE

021900 014400 AT END

022000 014500 MOVE EOF-LITERAL TO TRAN-FILE-FLAG

022100 014600 GO TO ACCT-MAINTENANCE-EXIT.

022300 014800 ADD 41 TO TRAN-CHT.

022500 015000 MOVE TRAN-ACCT-KEY TO ACCT-FEY.

022700 015200 READ ACCT-FILE KEY I3 ACCT-EEY

022800 015300 INVALID KEY

0z2900 015400 MOVE ACTION-MIZSING-ACCT TO WORE-ACTION-REAZON
023000 015500 MOVE SPACES TO ACCT-RECORD

023100 015600 PERFORM INITIATE-ACTION

023200 015700 MOVE +4 TO WORE-RETURN-CODE
023300 015500 G0 TO ACCT-MAINTENANCE-EXIT.

023600 0lalon ADD  +1 TO ACCT-IO-CHT.

023700 016200 PERFORM UPDATE-ACCT THRU UPDATE-ACCT-EXIT.

023900 016400 IF ACCT-MIN-BALANCE I3 LE3S THAN ACCT-BALANCE

024000 016500 PERFORM EXCEPTION-REPORT-1.

024200 016700 ACCT-MAINTENANCE-EXIT.

024300 016800 EXIT.
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Figure 27 shows how the UPDATE-ACCT paragraph calculates the interest payment to
be applied on interest bearing checking accounts. It also shows how it applies the
monthly service charge for each account, if applicable, and outputs a record to the Action
file. The conditional IF ACCT-TYPE OF ACCT-RECORD ='MMA' is used to illustrate
the Transaction extract described in "Transaction Extract" on page 48 .

Figure 27 « Example of the UPDATE-ACCT Paragraph

File Edit Confirm Merm 0Urilities Compilers Test Help

EDLIT VIAPN=x.PROD.CNTL (VIARDEMD) - xx.00 Coluwns 00001 00072
Command ===2 docroll ===> C3R
024600 017100 UPDATE-ACCT.

024700 017200

024500 017300 FERFORM INIT-ACTION-RECOERD.

024900 017400

025000 017500 IF ACCT-TYPE OF ACCT-RECOED = 'INT'

025100 017600 MOVE CHE-INTEREST-RATE TO0 INTERE3T-RATE
025200 017700 ELSE IF ACCT-TYPE 0OF ACCT-RECORD = 'CHE'
025300 017800 MOYE ZERO TO INTEREST-RATE

0z25400 017900 ELSE IF ACCT-TYPE 0F ACCT-RECORD = 'MHM4'
0zZ5500 01s000 MOVE MMA-INTEREST-RATE TO INTEREIT-RATE
025600 01s100 EL3ZE IF ACCT-TYPE OF ACCT-RECOED = '3A4V!
025700 018200 MOYE 5AY-INTEEEST-RATE TO INTEREXT-RATE.
025500 018300

0Z5900 015400 IF ACCT-MULTI-ACCT = 'YES'

0zZa000 018500 ADD CHE-MULTI-ACCT-FATE TO INTERE3T-REATE
026100 018500 MOVE ACTION-MUOLTI-ACCT TO WORE-ACTION-REAGSON
026200 018700 PERFORM INITIATE-ACTION.

026300 018800

026400 015900 IF ACCT-MIN-BALANCE < FREE-SERVICE-MIHN

0zZa6500 013000 HOVE SERVICE-INTEREST-RATE TD INTEREST-FATE
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Figure 28 shows how the code is used to illustrate the Computation Variable extract
described in "Computation Variable Extract" on page 47 .

Figure 28 « Example of the Computational Variable Extract

IF ACCT-MIN-BALANCE < FREE-SERVICE-NIN
MOVE SERVICE-INTEREST-RATE TO INTEREST-RATE
COMPUTE ACCT-SERVICE-CHARGE = ZERVICE-CHLRGE
HOVE ACTICHN-BELOW-MIN TOQ WORE-ACTICH-REASCN
FEREFORM INITIATE-ACTION

EL3E
HOVE ZERQS TO ACCT-SERVICE-CHARGE.

IF ACCT-MIN-EBALAMNCE < O
MOVE ACTICHN-NEG-BALANCE TO WORE-ACTICHN-RELZION
PERFORM INITIATE-ACTION.

COMPUTE WE-INTEREST =
[ACCT-AVG-BALANCE / DAYS-IN-YEALR) *
DATS-IN-PERIOD * (INTEREZT-RATE / 100).
HMOWVE WE-INTERE3T TO ACCT-IMTEREST.
ADD ACCT-INTEREIT TO ACCT-BALANCE.
ADD ACCT-INTEREST TO ACCT-INT-YTD.
SUBTRACT SERVICE-CHARGE FROM ACCT-BALANCE.
SUBTRACT ACCT-INTEREST FROM BRANCH-BALAMNCE.
SUBTRACT ACCT-INTEREST FRCM EANE-BALLNCE.

ADD JIERVICE-CHARGE TO BRAWNCH-BALANCE.
ADD JIERVICE-CHARGE TO EANE-BALANCE.

PERFOEM INITIATE-ACTIOHN.
MOWE TODAY-DATE TO ACCT-LAST-UPDATE.
REWRITE ACCT-RECORD.

UFDATE-ACCT-EXIT.
EXIT.
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Figure 29 shows how the EXCEPTION-REPORT-1 paragraph lists all accounts with a
minimum balance that is less than the current balance. The highlighted code is used to
illustrate the report extract described in "Report Extract" on page 46 .

Figure 29 « Example of the EXCEPTION-REPORT-1 Paragraph

File Edit Confirm Mermm Utilities Cowmpilers Test Help

EDIT VIARMxx.PROD.CNTL (VIARDEMO) - xx.x Columns 00001 00072
Command === Scroll ===> C3R
030000 021870 EXCEPTION-EEPORT-1.

030100 0zZlg50*

030200 0z1lg90* EXCEPTION REPORT 1 LIST ALL ACCOUNTS WITH & MINTIMITM EBALANCE
030300 0z1900* THAT I5 LESS THAN THE CURRENT BALANCE.

030400 0zZzZooo*

030500 0ZZ100 IF EX-RFT-LINE-CNT IS GREATER THaN &0
030600 0ZZZ00 ADD +1 TO EX-EPT-PAGE-CHNT

030700 022300 MOVE EX-RFT-PAGE-CNT TO EXCEF1-REFORT-FAGE-CNT.
030800 022400 WEITE EXCEPT-EUF FROM EXCEFT-HEAD-LINEL.
030900 022401 WRITE EXCEPT-EUF FE.OM EXCEFT-HEAD-LINEZ.
031000 0ZZ402 MOVE 0 TO EX-EPT-LINE-CHT.

031100 022403 ADD +1 TO EX-REPT-LINE-CHT.

031200 022404 MOVE ACCT-BALANCE TO EX-CUR-BAL.

031300 022405 MOV¥E ACCT-MIN-BALANCE TO EX-REPORT-MIN-BAL.
031400 022406 WEITE EXCEPT-EUF FROM EXCEPT-DETAIL-LINEL.
031500 022407 WEITE EXCEPT-EUF FROM EXCEPT-DETAIL-LINEZ.

031600 0224085

Figure 30 shows how the GET-NUM-OF-DAY S paragraph calculates the number of days
in the current accounting period. This code is used to illustrate the paragraph extraction
described in "Perform Range Extract" on page 46 .

Figure 30 « Example of the GEN-NUM-OF-DAYS Paragraph

File Edit Confirm Merm Utilities Compilers Test Help

EDIT VIARNxx.PROD.CHNTL (VIARDEMO) - xx.X Columns 00001 00072
Command === Fcroll === C3iR
033100 022700 GET-NUM-O0F-DAYS.

033200 0zzg00*

033300 022900 ACCEFT TODAY-DATE FROM DATE.

033400 023000

033500 023100 COMFUTE DAYS-IN-PERIOD =

033600 0Z3Z00 MONTH (TODAY-MM) - TODAY-DD.
033700 023300 HMOVE +0 TO DAYS-IN-YEAR.

033800 023400 PERFOEM SUM-TOTAL-DATS

033900 023500 VARYING WORE-CNT FROM 1 EY 1
034000 023600 UNTIL TODAY-DD = WORE-CHNT.

034100 023700%

034200 023800 SUM-TOTAL-DAYS.

034300 023900 COMPUTE DAY3-IN-YEAR = DATS-IN-YEAR + MONTH { WORK-CNT ).
034400 0z4000%
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Perform Range Extract

This chapter contains a practical demonstration of how to use a Perform Range extract to
create a CALLed submodule and a Complement Module, and contains these sections:

Section Page
Introduction 57
The Business Scenario 58
Starting an Encore Session 59
Extracting the Perform Range 63
Creating the Complement Module 75
Listing of CALCDAYS 81
Extracting Multiple Perform Ranges 85
Understanding Perform Extracts and Common Code 108
Finding Common Code in CALLable Submodules and 112
Complements

Replacing 10 Statements with CALLSs to an IO Module 115
Generating the 10 Module 119
Perform Range Extract Compilation Issues 121
Complement Module Program Listing 128

Introduction

In addition to the Perform Range extract demonstration, this chapter also discusses
execution issues and compilation issues.

The Encore demonstration program VIARDEMO is used for the examples in this chapter.
For a partial listing of VIARDEMO, see "The Demonstration Program" on page 49 .
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Your manager at the Universal Bank tells you that some new programs are being written
for a loan calculation and they need to call a routine to determine the number of days in
the interest accrual period. Since this calculation is probably going to be used in future
programs, you are to make this routine a CALLable submodule.

The Interest Calculation Program (ICP) contains the calculations needed. Using Encore,
the subroutine is extracted from the program and a CALLable subroutine is created. You
need to remove the subroutine from the ICP by using Encore's Complement Module
Generation facility. If the calculations in the interest accrual period routine are changed in
the future, maintenance is only done to the submodule.

By doing some preliminary analysis, you determine that the routine you want is located in
the ICP program that contains the GET-NUM-OF-DAYS paragraph, as shown in

Figure 31, and it's structured as a performed subroutine. In this case, the best extract
objective to use is the Perform Range extract.

Figure 31 « Example Program Containing the GET-NUM-OF-DAYS Paragraph

00E358 GET-NUM-OF-DRYS.

000359 x

000360 ACCEPT TODAY-DATE FROM DATE.

000361

000362 COMPUTE DAYS-IN-PERIOD =

000363 MONTH (TODARY-MM) - TODAY-DD.
000364 MOYE +0 TO DAYS-IN-YEAR.

000365 PERFORM SUM-TOTAL-DAYS

000366 VARYING WORK-CNT FROM 1 BY 1
000367 UNTIL TODARY-DD = WORK-CNT.
000368 x

00E369 SUM-TOTAL-DAYS.

000370 COMPUTE DAYS-IN-YEAR = DAYS-IN-YEAR + MONTH ( WORK-CNT ].
000371 x

After performing your initial analysis, you build a checklist that contains these tasks,
which are involved in extracting the Perform Range and generating the CALLed
submodule and the corresponding Complement Module:

J Identify the Perform Range name

o Verify that the Perform Range contains the desired logic
o Extract the desired Perform Range

. Generate the CALLable submodule

) Generate the Complement Module

o Verify the results



4 Perform Range Extract

Starting an Encore Session

To start the Encore session, you need to access the ESW Primary screen and open the
Encore application.

Note:

Logon procedures and AKR information are unique to your programming environment.
If necessary, contact your systems administrator or your Encore coordinator for the
correct dataset names.

To open Encore
1 Logon to the ESW Primary screen.

2 Select Re-engineer P Program and press Enter to display the Encore Primary screen.

Or

Type EN on the command line and press Enter to display the Encore Primary
screen.

3 Select File » Open and press Enter to display the File - Open Program pop-up, as
shown in Figure 32.

Figure 32 * File - Open Program Pop-up

File View Extract Generate Search List Options Help
File - Open Program

Type AKR information and program name. Then press Enter.

Application Knowledge Repository (AKR):

Data Set Name . . . 'USER.TEST.AKR'

Program Name . . . VIARDEMO (blank for selection list)
Volume Serial . . . (if not cataloged]
Password . . . . . [if passuord protected)

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
¥isit the ASG Support Web Site at www.asg.com
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4  Type the AKR dataset name in the Data Set Name field and VIARDEMO in the
Program Name field and press Enter.

Note:

A program must be analyzed and placed in the AKR before you can use Encore. For more
information about analyzing a program and placing it in the AKR, see "Getting Started"

on page 23 .

The program is now available to Encore and your next step is to identify the Perform
Range name. This is done by using a Structure View, which is a graphical representation
of logical program units.

To use Structure View

1 Select View P Structure and press Enter to display the View - Structure View
Request pop-up, as show in Figure 33.

Figure 33 » View - Structure View Request Pop-up

File Wiew Extract Generate Search List Optisns  Help

VYiew - Structure Vieu Reguast

Type request apticns., Then press Enter. For 3 name selection list
for a range lother than 1 or 21, type a pattern le.g. ABC*) in the
mame field.

Levels 2 of 4 of depth

Range
1 Procedure diwvision
All entry points
Perform range name
Entry point rame

Hested program name

AW

lama

Options
Repetition

2 Toview the entire program, type 3 on the Levels option of the View - Structure View

Request pop-up and press Enter to display the Structure View screen (see Figure 34
on page 61). It is not necessary to type anything in the Range field (the default is
Procedure Division).

See the online help for more detailed information about the options in the structure
view request pop-up.



4 Perform Range Extract

Figure 34 shows that box 007 has the paragraph name GET-NUM-OF-DAYS,
which is the Perform Range you are looking for. You can verify this by examining
the code in the Perform Range from the Structure View screen.

Select View » Zoom In and press Enter.

Place your cursor in box 007 GET-NUM-OF-DAYS and press Enter to zoom in on
the selected data.

Figure 34 » Structure View Screen

Etructure Yiew Program: WIARDEHD
Cammand ===% _ scrall ===% (SR
RSGLEE82T 3 0OF 3 LEVELS DISPLAYED IN THE WIEM.
More: * b
+---- 081+
¥IARDEMO
tm———-—— +
|____ _____________________________________________________________________
+---- 0D2+ +---- 003+
IMITIALI ACCT -HAT
ZE-PGH MTEHRMCE
THRW A=
o mm - + e +
|- | e By
=== 0BG+ +---- QA7+ +---- [08+ +---- 009+
OFEH-FIL GET - HUM- THITIATE UFDATE-A
ES OF -LAYS -ACT ION CCT THRU
LUPDATE#
dmmmm e F O . 4+ dmmmm - O +

Note:

If your PF keys are set to the Encore defaults, you can perform the Zoom In
function by placing your cursor in the graphics box and pressing PF4. See the
online help for more information about PF keys.
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5  The Zoom In request displays the source lines contained in the
GET-NUM-OF-DAYS paragraph, as shown in Figure 35. Press PF3 to return to the
Structure View screen.

Figure 35« View - Source Pop-up

Yiew - Source SCREEM FOSITIONED
Command === soroll === L5R
0003558 GET-WUM-OF -DAYS. PERF RMG
e R 1 LIME NOT DISFLAYED
[lo] ipc: ] ACCEPT TODAY-DATE FROM DATE. PERF RNG
e R 1 LINE NDT DISPLAYED
nenz6e COMPUTE DAYE-IN-PERIOD = PERF RN
000363 HONTH (TODAY-MM] - TODAY-DD.
Da0sEd HOVE +@8 TO DAYS-IN-YERR. FERF RMG
Do0EEE PERFORM EUH-TOTAL-DAYS PERF RNG
DoDz66 VARYING MORK-CNT FROM L BY L PEAF RHNG
nenze? UNTIL TODAY-DD = WORK-CHT. RETURH
- - - - - - - - - - - - - - - 1LINE NOT DISPLAYED
DOO%GE  SUH-TOTAL-DAYSE. PERF RMG
ooos?o COMRUTE DA¥S-IN-YEAR = DAYS-IN-YEAR + MONTH [ WORE-CNT | . RFERF
- - - - - - - - - - - - - - - E4 LINES NDT DISPLAYED
suwrxsnwewsaweesexeeexeexs BEOTTOM OF DATH 2asess et awst Kawst Kawst s

The previous Structure View redisplays and the boxes containing the code for the
Perform Range extract are highlighted, as shown in Figure 36.

Figure 36 » Structure View Screen

Structure Yiew Program: YWIARDEHO
Comtand === Scroll ===» CSR
More: - {0
+---- DA?+ #---- 008+ +---- OGE9+ +-
GET -HUM- INITIATE UPDATE -A E
OF=DAYS =ACTION CCT THRU H
UPDATE= -
+o—m - + F-—--——— -+ +—-————- -} +-
| [ RS [T U,
+---- D12+ +---- 013% +---- Qld+ +---- 015+ +---- Q16+ +---- Q1T+
SUR-TOTA INIT-ACT IHITIATE INITIATE INITIRTE IHITIATE
L-DRYS I0OH-RECH -ACTION -RCTION -AGTION -ACTION
RD 18] 18] (a) 3]
Fmmm + +--------+ +REFEATED+ +REFEARTED+ +REPEATED+ +FEFERATED+

seexexresexeesexeesexrexexeese BOTTIM OF DATH o0 s 5w s X s XEw s K mse Ky

6  Press PF3 to return to the Encore Primary screen.
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4 Perform Range Extract

Extracting the Perform Range

To extract the Perform Range GET-NUMBER-OF-DAYS

1 Select Extract » Perform Range and press Enter to display the Extract - Name Logic
Segment pop-up, as show in Figure 37.

The Name field contains an Encore created default name for the Perform Range you
want to extract. You can assign your own name to the Logic Segment or you can use
the default name. For this example, use the default Logic Segment name
PERFORM-RANGE-0001.

Figure 37 « Extract - Name Logic Segment Pop-up

File View Extract Generate Search List Options Help

Extract - Name Logic Segment ram: VIARDEMO
Command ===
Type name of logic segment. Then press Enter.
KKK KRR KK
Name . . . PERFORM-RANGE-0001 HEK KKK KKK
KKK K KK K KK KK DK K OR KR OR KK KK KKK KR K K KKK KKK b+ 33 KKK KK
KKK K KK K KK KK DK K OR KR OR KK KK KKK KR K K KKK KKK b+ 33 KKK KRR
b+ 33 b+ 33 KKK KK b+ 33 XK
b+ 33 b+ 33 KKK KK b+ 33 XK
b+ 33 0K DK KKK KK K R K K R DK KR DK KR KRR KR K KK KKK KR K KK KRR KKK K
b+ 33 KK KKK KK K KK KK DK KK DK KR KRR KK KK KKK KR K K KKK KKK

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
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Press Enter again to display the Extract - Perform Name List pop-up, which contains
a list of all Perform Ranges in the program, as show in Figure 38.

Figure 38 » Extract - Perform Name List Pop-up

Extract - Ferform Mame Li 12 PERFORH RANGE NAHES

Command ===3 Scroll === LER

Select PEAFORM Range namels| for extract., Thern press Enter. Fress

Enter when complete. Use S0RT command to order column by walue.

5 - Select Wo- ¥iew Source I - Unselect
Bize Times FERF Direct Subord
FEAFOAM Ranga Namea Lines ] FERF by FPEAFs PERFs

S - mmmmm mm - == mmmm —m- ---- b

_ ACCT-HAINTEMAKWCE THRU ACCT-MAL 27 12,86 1 1 3

_ CLASE-FILES T &.83 1 1 a o
CLOSE-FGH E 2.38 1 1 1 1
EXCEPT ION-REPDRT-1 16 7.B2 1 1 o] [c]

_ BET-NUM-OF-DAYS i@ 4,76 1 1 1 1

_ IWIT-ACTILOHW-RECORD 9 4.29 1 1 4] ¢}

_ IMITIALIZE-FGH 21 10.84 1 1 2 3
IMITIATE-ACTION 1z E.14 5 2 o} o]
OFEN-FILES 5 z.zd 1 1 o] [c]

_ HREPORT -FIMAL-CHNTRS 5 2.28 1 1 1} o]

PFd=Yieu PF5=Filter FPFF17=Sort

Use the Filter feature to narrow the list of selectable statements and simplify the
statement selection.

Type Filter on the command line and press Enter (or press PF5) to display the
Extract - Perform Range Filter pop-up (see Figure 39 on page 65).

Note:

You can type EXPORT on the command line to write selected Perform Range name
data from the Extract - Perform Name List pop-up to a specified, or default, dataset
name. See the ASG-Encore Reference Guide for a detailed description of the
EXPORT command and associated operands.




4 Perform Range Extract

Type GET-NUM-OF-DAYS in the PERFORM Name field, as show in Figure 39, to
filter the list of selectable perform ranges to include only this Perform Range. For
this example, use the default values for the Use Context field.

Figure 39 « Extract - Perform Range Filter Pop-up

Extract - Perform Hame List
T rart - Perfarn Rangs Filter
E | Type information for filtering PERFORH Range Mame 1ist
FERFORM Mame  GET -HUM-0OF-DAYS

Data Name

- Use Context Options
1 1. FReferences S Aliasing
2. Uses

— 3. Modifications

_ | kine Range .
CAOEOL Subset
Text Pattern

_ REFORT-FINAL-CHNTRS 5 .38 1 1 1} L1}

PF4=V¥iew PF5=Filter PFF17=3ort
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5  Press Enter to redisplay the Extract - Perform Name List pop-up, as show in

Figure 40. The only selection is GET-NUM-OF-DAYS.

Type S to the left of GET-NUM-OF-DAYS and press Enter. Press Enter again to
return to the Encore Primary screen, which displays with a message indicating that

the criteria for the extract were successfully selected.

Figure 40 » Extract - Perform Name List Pop-up (filtered)

Extract - Ferfarm Mame List
Command === _ Scroll ===} CSH

Select PERFORM Range mame(s] for emtract. Then press Enter. Press
Ernter when complete. Use S0RT command to order column by walue.

3 - Select ¥ - ¥iew EBource U - Unselect
Size Times PERF Direct Subord
FERFORM Range MWame Lines % FERF by PERFs PERFs
o fommmm —oo e C T
s BET-MNUM-DOF -DAYS 18 4.76 1 1 1 1

EEEAREEXREEE XA e e Xy QOTTOH OF DATE #0050 0 0 0k 00 0 R 0k 00 0 308 3 k3

PF4=View FFE=Filter FPFl¥=5ort

See the online help for more detailed information about Extract features.
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4 Perform Range Extract

Viewing the Logic Segment

After extracting the Logic Segment, review the output to verify that you have selected the
correct code.

To view the Logic Segment created by the extract

1 Select View » Logic Segment and press Enter to display the View - Select Logic
Segments pop-up, as show in Figure 41.

The View - Select Logic Segment pop-up lists all Logic Segments created for the
program. The last active Logic Segment is highlighted and selected for viewing. For

this example, view the PERFORM-RANGE-0001 Logic Segment.

Figure 41 » View - Select Logic Segments Pop-up

¥iew - S=lect Logic Segmant 1 LOGIC SEGHENTS
Command ===» _ Scrall ===»* [ZA
3 - Gelect
Frogram Logic Segmant Mams Descriptian
S VIFRDENO  PERFORM-RANGE-00DL perforn Range

xxspwrsxewrrxewrrxewrrxwwrrxwws BOTTOH OF DATA *# s ssws s ds e e EF XN RXEW

Note:

To select another segment on the View - Select Logic Segments pop-up, (if
applicable), blank out the default S and select the Logic Segment you want to view
and press Enter.
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2 Press Enter to display the Source View screen, as show in Figure 42, which contains
the Logic Segment. The Logic Segment contains all of the code in the selected
Perform Range and all of the data items that are referenced by that code.

Figure 42 » Source View Screen - View Logic Segment

SEource YiewWw Frogram: YIARDEMO
Command === _ Serell ===} [EH

- - - - - - - - - = - - - - - - 21D LINES NOT DISPLAYED

Q00258  GET-NUH-OF-DAYS. LOGICSEG

- - - - - - - - = = = = = = = = = 1 LINE NOT DISPLAYED
BOD3E0 ACCERT TODAY-DATE FROM DATE. LOGICSEG

- - - - - - - - - - - - - - - - - 1LINE NOT DISPLAYED
AOD2RE2 COHFUTE DAYS-IM-PERIDD = LOGICSES
QD263 HMONTH (TODRY-MM] - TODAY-DD. LOGICSEG
BODZEAR4 HMUYE +@ TO DAYS-IN-YEAA. LOGICSEG
BOD3ES PERFORM SUM-TOTAL-DAYS LOGICSEG
BOO366 YARYING WORK-CNT FROM 1 BY 1 LOGICSEG
AAD2ET UNTIL TDDAY-DD = WORKR-CNT . LOGICSES

- - - - - - - - - - - - - - - - - L LINE NOT DISPLARYED
LODZES  SUM-TOTAL-DAYS. LOGICSEG

Qaoozre COMPUTE DAYS-IN-YEAR = DAYS-IM-YEAR + MOWTH T WORK-CHT 1. LOGICSEG
- - - - - - - - - - - - - - - - §4 LINES NOT DISPLAYED

rxmmEsamEsranEsvanrs e BOTTOM OF DATH #aus 3 aus M XA MEX XA MEF XA MER
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4 Perform Range Extract

Saving the Logic Segment
After viewing the Logic Segment, save it in the AKR for future processing and access.
To save a Logic Segment in the AKR

1 Select File » Save Segment and press Enter to display the File - Save Logic Segments
pop-up, as show in Figure 43.

Figure 43 » File - Save Logic Segments Pop-Up

File - Bave Laogic Segments 1 LOGIC SEGHMENTS
Command === _ Scroll === [CSR

Select segment to be Zawed or marked for EBatch computatien and press Enter.
Hhan selections are complets, press FF3/15 (ENDY.

5 - Have B - Batch computation
Pragramn Lagic Segment Mame Description
s WIARDEMD FERFDFH- PANGE-DADL Farform Range

R RN KN KN KN K Ky HOTTOH OF DATA SxfrdEarrd frnd el feneg aen

2 Type S to the left of the Logic Segment to be saved (PERFORM-RANGE-0001 in
this example) and press Enter to display the File - Save Segment pop-up (see
Figure 44 on page 70).

Note:

To generate the Logic Segment using a batch job, type B and press Enter to select
the desired Logic Segment. See the online help for more information about batch
generation.
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3 Perform these actions on the File-Save Segment pop-up (see Figure 44):
a  Type the name to save the segment as in the Name field.
b  Optionally enter a short description in the Description field.

¢  Optionally enter a long description of the Long Description field.

Figure 44 « File - Save Segment Pop-Up

File - Sawve Sedgment
Command === Soroll === C3R

Type segment definition information. Then press Enter.

Chjective . . . . @ Perform Range

Author . . . . . . @ USERID

Created . . . . . & DD-MMM-¥YYYV HH:MMN:33
Name . . . PERFORM-RANGE-OOO01

Dezscription PERFORM-RANGE-EXTRALCT

Long Description:
TE3T SEGMENT FOR INSTALLATICH.

4  Press Enter to return to the File-Save Logic Segments pop-up.

5  Press PF3 once to return to the Source View Screen and once again to return to the
Encore Primary screen.
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4 Perform Range Extract

Creating the CALLable Module

After the Logic Segment has been extracted, viewed, and saved, you need to create the
CALLable submodule.

To create a CALLable submodule from the Logic Segment

1 Select Generate » COBOL module and press Enter to display the Generate - Select
Logic Segment pop-up, as show in Figure 45.

Figure 45 » Generate - Select Logic Segment Pop-up

Generate = Select Logic Seament 1 LOGIC SEGMEMNTS
Command ===r _ Seroll ===) C§R
3 - Helect
Program Legic Segment MName Description
S VIERDEMD  GET-NUM-OF-DAYS CALCULATE NUMEER OF Davs

FEEEAERENAE NN AN AN AR NER N BOTTOM OF DATA R EmX EanOt net Eenet et

Note:

CALLable modules can also be generated using a batch job. See the online help for
more information about batch generation.

The Generate - Select Logic Segment pop-up lists all of the Logic Segments that
you have extracted during your current session, including any other Logic
Segments that have been saved in the AKR. The last referenced Logic Segment is
highlighted and preselected. Since the Logic Segment that you have extracted was
saved as GET-NUM-OF-DAYS, this is the name that is highlighted.
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Press Enter to display the Generate - COBOL Module pop-up, as show in Figure 46.

Figure 46 * Generate - COBOL Module Pop-up

File View Extract Generate Search List Options Help

Generate - COBOL Module Program: VIRRDEMO
C
Type Program ID and select generation options.
2R OK KR DK R R OK R OK KRR
Objective . . : Perform Range KKK KKK KK KKK
Program ID . . CALCDAYS _
Options KKK KKK K
CALLs to I0 Module(s) KK KKK K K
KKK
------------------------------------------------------- KKK
HORK KK 2R DK R K 0K R K K R K K R DK K R DK K R DK KR KRR 2R DK KR DK R R DK R R DK R OK K R OK K
HORK KK 2R DK R K DK R K K R K K R DK K R DK K R DK KR KR 2R DK KR DK R R DK KR DK R OK KRR

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Visit the ASG Support Web Site at www.asg.com

A default name is assigned in the Program ID field, but can be changed as required.
In this case, change the name to CALCDAYS and press Enter to display the
Generate - Specify Perform Range ENTRY Names pop-up.

Note:

To set format and content options for the COBOL module being generated, select
Options » Generate. See the online help for more information about Generate
options.

Press Enter to display the Generate - Multi-module PERFORM Ranges pop-up (see
Figure 47 on page 73).




4 Perform Range Extract

To select the Perform Range to be generated from the Generate - Multi-module
PERFORM Ranges pop-up (see Figure 47), type S in the Program ID area for the
GET-NUM-0F-DAYS Perform Range and press Enter to display the Edit Screen

(see Figure 48).

Figure 47 « Generate - Multi-Module PERFORM Ranges Pop-up

Generate - Hulti-medule PERFORM Ranges
Command === Scrall ===» CER

Salect the module to gernerate, then press Enter.

FRAEHFRLENERLR NI NAE LML ARNERANNE TOP OF DATA HEREE0E000 0EME DRMER DRWER AT
s CALCDAYS GET -MUM-0F-DAYS

soeses R ew R wtwae stwae s Xk BOTTOM OF DATH s sm s $0wse S0 mee £ ek Kexe

When the Edit screen displays, type CREATE on the command line and type C 9999
on the first line of code. Press Enter to save the module in your source library and
display the Edit/View - Create pop-up (see Figure 49 on page 74).

Figure 48 » Edit Screen Display of CALCDAYS

A3G-Encore EDIT - USERID.ENCEXEXX.COEOL COLTMNS 00001 00072
Command ===> CRELTE Seroll ===»> CSR
FTEEFTT AR F AT T AN T AL TANTEANTAANNANLS TDp of Data FFFEEEEEEEEEEEEEEEEEEEEENNNLLS
C 9999 o o o o o o o o o o o o o o o o o o ol o o o o o o o o o
aooooz * A3G, INC. *
aoooos *
aoooo4 * GEMERATED BY ASG-ENCORE RELEASE 6.0(000) *
aoooos * *
aoooos * PROGRAM: CALCDAYS *
aoooo? * *
aoooos * DATE: DD-MMM-YYYY HH:MM:33 *
aoooos * REQUESTOR: UIERID *
aoooio * *
ooooill * AKR INFORMATICH *
oooo1z * D3 NAME: USERID.TEST. LER *
oooo013 * HMEMEEER: VIALARDEMO ALTAZ: (NCNE) *
ooooi4 * *
oooo1ls * SEGHMENT NAME: PERFORM-RANGE-COOO1 *
oooola * *
aooo17? * OBJECTIVE TYPE: PERFCREM RANGE *
aoool E i) *
00001 e A3G1605I ENTER THE CREATE COMMAND TO 3AVE THE COBOL PROGRLM. e *
aoooz I u *
Qoooz1 o o o o o o o o o o o o o o o o o o ol o o o o o o o o o
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7  Type the name you want to save the program under in your source library, as shown
in Figure 49, verify or clear any data in the Data Set Name and Volume Serial fields,
and press Enter to create the member and return to the Edit screen. Press PF3 until
you return to the Encore Primary screen.

Figure 49 » Edit/View - Create Pop-up

Edit/View - Create
Contmand ===

"Current” Data 3Jet: USERID.ENCEXEEX.COBCL

To IZPF Library:

FProject . . . ASG
Group . . . . CEBDEXEX
Type . . . . CHNTL
Menber . . . CALCDAYS

To Other Partitioned Data Zet Menber:
Data Set HName
Volume Serial . . . [If not cataloged)
Data Jet Password . . [ If password protected)

Enter "/" to select option
Specify pack option for "CREATE"™ Data Set

Fress ENTER key to create. Enter END comnand to cancel create.

Note:
CREATE may only be issued against an empty member. If CALCDAYS already
exists in your library, you would need to use the REPLACE command. See the
online help and the ASG-Encore Reference Guide for more information about these
commands.
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Creating the Complement Module

4 Perform Range Extract

After you have created the CALLable submodule, you can create the Complement
Module. The Complement Module is the original program with the extracted Logic
Segment removed. PERFORMs to the extracted Perform Range are replaced with

Encore-generated CALLs.

To create the Complement Module

1 Select Extract » Complement and press Enter to display the Extract - Name Logic

Segment pop-up, as show in Figure 50.

Figure 50 « Extract - Name Logic Segment Pop-up

Extract - Name Logic Segment

File View Extract Generate Search List Options

Command ===
Type name of logic segment. Then press Enter.
KKK KRR KK
Name . . . COMPLEMENT-0002 HEK KKK KKK
KKK K KK K KK KK DK K OR KR OR KK KK KKK KR K K KKK KKK KKK KK
KKK K KK K KK KK DK K OR KR OR KK KK KKK KR K K KKK KKK KKK KRR
b+ 33 b+ 33 KKK KK XK
b+ 33 b+ 33 KKK KK b+ 33 XK
b+ 33 0K DK KKK KK K R K K R DK KR DK KR KRR KR K KK KKK KR K KK KRR KKK K
b+ 33 KK KKK KK K KK KK DK KK DK KR KRR KK KK KKK KR K K KKK KKK

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
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ram: YIARDEMO

2 Accept the Encore-generated Logic Segment name (COMPLEMENT-0002 in this
example) and press Enter to display the Extract - Complement pop-up (see Figure 51

on page 76).
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To specify the Logic Segment from which to generate a Complement segment, select
GET-NUM-OF-DAYS and press Enter, as show in Figure 51.

Figure 51 « Extract - Complement Pop-up

Extract - Complement 1 LOGIG SEGHENTS
Command ===% Boroll === [ER
Select segments for complement esxtract and press ENTER., Hhen selections
ate complete, press Emter,

8§ - Select U - Unselect
Frogram Logic Segment MName Description
5 WIARDEMO  GET-NUM-0F-DAYS CALCULATE HUMEER OF DAYS

*rurmrsnemrrpmrsarmrsnemrr wamy BOTTOH OF DATA #®xf afsus ErmxF KEmEF X MEF KEW

Press Enter to return to the Encore Primary screen.

Select Generate » COBOL module and press Enter to display the Generate - Select
Logic Segment pop-up, as show in Figure 52. Select the Logic Segment that is used
to create a Complement Module (COMPLEMENT-0002 in this example) and press
Enter to display the Generate - COBOL Module pop-up (see Figure 53 on page 77).

Figure 52 * Generate - Select Logic Segment Pop-up

Generate - Select Logic Segment 3 LOGIC SEGMENTS
Command ===> _ Scroll ===> CSR
S - Select
Program Logic Segment Name Description
_ VIARDEMO COMPLEMENT-0002 Complement Perform Range
S VIARDEMO  TRANSACTION-0001 Transaction
VIARDEMO  TRANSACTION-0002 Transaction

KKK KK KK K KK KKK XK KOKOKOIOKOIOIOIOICICIOIOICK. BOTTOM OF DATA 35 505K 400K 50K KK K K K K K K K K KKK K OK 0K




4 Perform Range Extract

Accept the default name (VIARDEMYV in this example, as shown in Figure 53), and
press Enter to display the Generate - Specify Perform Range CALL Names pop-up

(see Figure 54).

Figure 53 « Generate - COBOL Module Pop-up

File View Extract Generate Search List Options Help

Generate - COBOL Module Program: VIRRDEMO
C
Type Program ID and select generation options.
2R OK KR DK R R OK R OK KRR
Objective . . : Complement KKK KKK KK KKK
Program ID . . VIARDEMV
Options KKK KKK K
CALLs to IO Module (s) KKK KKK KK
KKK
------------------------------------------------------- KKK

ASG4312I DEFAULT PROGRAM ID VALUE ASSIGNED. VERIFY, AND CHANGE IF
NECESSARY .
Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
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Type CALCDAYS (if not automatically displayed, see Figure 54) as the ENTRY
Name for the GET-NUM-OF-DAYS Perform Range and press Enter to accept the
name.

Figure 54 » Generate - Specify Perform Range CALL Names Pop-up

Generate - Zpecify Perform Aange CALL MNames
Command ===» _ Seroll ===> CiR

The complement module includes CALLs to extracted FERFORH Rangels). Type
the PROGRAM-ID or ENTRY Names of the programs to be CHLLed. HWhen complete
press Enter,

Program ID  ENTRY Mame PERFORH Range Hame

FREFEEREREERE ERRLRKARLR KRR LRME TOP OF DATA HEREFKFMERKIRER RBRERKRRER KRR
CALCOAYS GET - HUM-0OF -DAYS

rerdxrexerrexe vk xewxa xewxa ¥ BOTTOM OF DATAH ZEresim el XasEd ¥in e XEREL XEXT
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8  Press Enter to display the Edit screen with the generated module. Type CREATE on
the Command Line and then type C 9999 on the first line of code, as show in
Figure 55. Press Enter to display the Edit/View - Create pop-up (see Figure 56 on

page 79).

Figure 55 » Edit Screen - Complement Module
A45G-Encore EDIT - T3ERID.ENCX:XIZ.COEOL COLUMHS 00001 00072
Command ===> CREATE Gocroll ===> C3R
FTHEEHAFT FHA A AT FATATTEANIANATSISAARNSNSN TD]J 0f Data TFFFFTaANTTETTATAFFTAATSSTAARSNS
C 9999 ok ok ol o b ok b o ook ok oo o o o o o o o o ol o o o o o o o e e o o o o
oooooz * 450G, INC. *
0oooos * *
ooooo4 * GENERATED BY A5G-ENCOEE RELEASE 6.0¢000) *
ooooos * *
0aoaos * PROGRAM: VIARDEMY CONPLEMENT *
aaoaov * *
000003 * DATE: DD-MMM-YYYV HH:MM: 53 *
ooooog * REQUESTOR: TSER *
oooolo * *
ooooll * AFR INFORMATION *
gooolz * D5 WAME: USERID.TE 5T. AKR *
ooools * MEMEER: VIARDEMO ALTIAS: (NONE) *
ooool4 * *
ooools * S3EGMENT NAME: COMP LEMENT-0003 *
oooolea * *
ooool? * OBJECTIVE TYFE: COMPLEMENT (COMPUTATION VARIABLE) *
00001 Ess3335333335533553355335533355335533553335533535335533353335333380 *
00001 e A3Gla05I ENTER THE CEEATE COMMAND TO 3AVE THE COBEOL PROGEAM. g ###®##w®®
00002 Ds533353335355353553355335533355335533553335533555353553535533353335H1
oooozl *

78



4 Perform Range Extract

When the Edit/View - Create screen displays, type the name you want to save the
program under (VIARDEMYV in this example, as show in Figure 56), verify or clear
any data in the Data Set Name and Volume Serial fields, and press Enter.

Figure 56 » Edit /View - Create Screen - Complement Module

Edit/View - Create
Command ===2

"Current” Data Set: USERID.ENCXCCIS.COEOL

To ISPF Library:

Project . . . ARG
Group . . . . CEGOXRICH
Type . . . . CNTL
Member . . . VIARDEMY

To Other Partitioned Data 3et HMember:
Data et Name .
Voluwe Serial . . . [If not cataloged)
Data Set Password . . [If password protected)

Enter "/" to select option
Specify pack option for "CREATE™ Data Set

Press ENTER key to create. Enter END command to cancel create,

Note:

CREATE may be issued only against an empty member. If VIARDEMYV already
exists in your library, use the REPLACE command. See the online help and the
ASG-Encore Reference Guide for more information about these commands.
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Encore has now created program VIARDEMYV, which contains all of the logic of
the original program, except for the extracted Logic Segment.

If you examine the Complement Module, part of which is shown in Figure 57,
notice that the statement PERFORM GET-NUM-OF-DAYS has been replaced with
a CALL to CALCDAYS.

Figure 57 « VIARDEMYV Complement Module

L3G-Encore EDIT - U3ERID.EMCEXXEXE.COBOL COLTMNS 0001 00072
Comnand === Jocroll ===» C3R
ooo37?? * A3G-ENCORE-CALL
ooo037s CALL 'CALCDAYS' TIING

ooo37g DAYS-IN-PERIOD

000380 DAYS-IN-YEAR

000351 TODAY-DATE.

000352

000353

000354 INIT-ACTICN-EECCORD.

ooo03ss MOVE ACCT-CONTROL-CODE TO ACT-CONTROL-CODE.

oo03sa MOVE ACCT-EEY TO ACT-ACCT-EEY.

000387 MCVE ACCT-NUM OF ACCT-RECORD TO

000355 ACCT-NUM OF ACTICHN-RECORD.

alulnjcisi=] HMOVE ACCT-TYFPE OF ACCT-RECORD TO

alulnjci=ln] ACCT-TYPE OF ACTICN-RECCRED.

ooo03sl MOVE ACCT-3TATUS-CODE TO ACT-STATUS-CODE.

ooo3s:z MOVE ACCT-BALANCE TO ACT-CUR-BALANCE.

000393

000354

000395 CLOSE-PGH.

oo03sa

alulnici=in] PERFORM CLOSE-FILESZ.

nlulnjci=ic]

10 Press PF3 until you are returned to the Encore Primary screen.
11 Select File » Close and press Enter to display the Close Program pop-up.
12  Select Close, discard segments. All unsaved logic segments are discarded when you

exit Encore by selecting the Exit option. For this example, you do not need to save
any generated data.

Note:
The Exit pop-up displays if you attempt to exit Encore using PF3. From this
pop-up, options are available to save logic segments, discard logic segments, or
cancel the exit and return to Encore.
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Listing of CALCDAYS

Figure 58 shows the first section of the Encore-generated module CALCDAYS. Samples
of the CALL Encore generated from the module VIARDEMO to CALCDAYS, listing
the data elements it is passing as parameters, are contained in this section.

Figure 58 * Member Containing Sample CALCDAYS Generated CALL

45G-Encore EDIT - ASG.VIACEN:I.CNTL (CALCDAYS) COLUMNS 00001 00072
Command === Soroll ===> CSR
FEEEEE AT A E T T AN AT A A AT T AN TNNLSN S TDp of Data FFrirtarrriaraiasadrsanesssasssy
oooool ok o o o o o o o o o o o o o o o o o o o o o
aooooz * L3G, INC. *
a0oons * *
aoooo4 * GENERATED BY A5G-ENCORE RELEASE 6.0{000) *
a0ooas * *
a0ooag * PROGRAM: CALCDAYS *
aoooa? * *
aooons * DATE: DD-MMM-T¥YY HH:MM: 53 -
aooong * REQUE3TOR: USERID -
a0ooLo * *
a0ooll * LER INFORMATION *
oooolz * '3 NAME: USERID.TEST. AKER. *
a0ooLs * MEMEER: VIARDEMO ALTAS: (NONE) *
aoool4 * *
a0ooLs * SEGMENT MHAME: PERFORM-RANGE-001 *
a0oole * *
ooooL? * OBJECTIVE TYFE: PERFOEM RANGE *
oooozo * LIG-ENCORE NOTES:

a0oozl * GET-NUM-0F-DATS

DUDDlg e e o e o e i e e i e i e e il e al ai e ai  ai a i  aie  e

Figure 59 shows the sample CALL containing input and output code.

Figure 59 « Sample CALL Showing Inputs and Outputs

A3G-Encore EDIT - A3G.VIACENIX.CNTL (CALCDAYS) COLTMMS 00001 0007z
Commmand === Zeroll === C3R
goooza * RSG-ENCORE MNOTE:

oooo0z3 * THE FOLLOWING ARE SAMPLE CALLSZ SHOWING INPUTS AND OUTPUTS:
0000z 4 *

0000z s * CALL 'CALCDAYTS' UIING

0000z & *® DAY3-IN-FPERIOD <<OUTPUT>>

goooz? *® DAYS-IN-YEAR <<OUTPUT>>

goooozs * TODAY-DATE <<OUTPUT>>

goooozs *

000030 * AZG-ENCORE MNOTES:

oooo31 *

oooo3z * 1. "GOBACK™ WAI INSERTED TO TERMINATE THE FPROGRAM NORMALLY WHEN
000033 *® IT3 INTENDED FUNCTICN I3 COMPLETED. PLEASE EXAMINE EACH
000034 * INSERTICN TO DETERMINE IF THISZ ACTICN IS APPROPRIATE.

000035 *

0000368 *

oooo3 7 IDENTIFICATION DIVISION.

000035 PROGEAM-ID. CALCDAYS.

oooo3s AUTHOR. A3G DEMONITRATICH.

oooo4a

oooo041 e e e ol o e e e e e o e e e e e e i i i i e e e e i o e i i e
oooo4z * THIZ PROGRAM DOES THE MCWTH END CALCULATIONZ FOR EACH TYPE *
000043 * OF CHECKING ACCOUNT CARRIED BEY THE UNIVERSAL BANK. IT *
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When Encore generates a CALLable module, it creates notes that you need to examine to
verify that the module performs the way you expect it to, as show in Figure 60.

Figure 60 « Encore Workbench Notes

AZ3G-Encore EDIT - AZG.VIACEMNEXE,CNTL(CALCDATI) COLUMNSE 00001 00072
Command === 3croll ===» C3R
aoooso * ASG-ENCORE NOTES:

Qooo3l *

aooo3z * 1. "GOBACK®™ WAS INSERTED TO TERMINATE THE PROGRAM NCORMALLY WHEN
000033 * ITS INTENDED FUNCTION IS COMPLETED. PLEASE EXAMINE ELCH
Qooos4 * INSERTICN TC DETERMINE IF THIZ ACTICHN I3 APPROPRIATE.

Qooo3s *

aooo3s e *

Qooosw IDEMTIFICATION DIVIZICON.

Qooo3s PROGRAM-TID. CALCDAYS.

aoooss AUTHOR. A3G DEMOMSTRATICN.

aoooio

DDDDql i e i i e e e e e i e e i e e i e e i e e e e i e i i i e e e
aooo4z * THIZ PROGRAM DCES THE MONTH END CALCULATICNS FCOR EACH TYPE *
Qooo43 * OF CHECKING ACCOUNT CARRIED BY THE UNIVERIAL BANE. IT *
aooo44 * HANDLES THE FOLLOWING TYPES OF ACCOUNTS. *
aooo4s * CHECKING WITH INTERE3T *
aooo4s + CHECEING WITH NO INTEREST *
aooog7? * MONEY MARKET ACCOUNT (MMA) *
Qooo4s * SAVINGS ACCOUNT *
aooo49 * IT ALZO UPDATES THE ACCOUNT BALAWNCE, BRANCH BALANCE AMND *
aoooso * BANK EALANCE. *
aooosl ol o o o o o o ol o ol ol o ol ol o o o o o o ol o

Figure 61 shows that Encore generated all of the necessary divisions when it created the
CALLable submodule. In the DATA DIVISION, Encore has included all data items
referenced by the Perform Range GET-NUM-OF-DAYS.

Figure 61 » Divisions Generated

ENVIRCHNHMENT DIVISICH.
CCHNFIGURATICON SECTICH.
SCOURCE-CCMPUTER. IEM-370.
OBJECT-CCOMPUTER. IEM-370.

DATAL DIVISICH.
WORKING-3TORAGE SECTICH.

77 WORK-CNT FIC 9(4).
01 HMONTH-TABELE-INIT.

82



4 Perform Range Extract

Figure 62 shows that any data elements contained in the Working-Storage section of the

original program that had Value clauses that were placed in the LINKAGE SECTION of
the CALLable module had the value clauses removed and shown as comments. COBOL
does not allow Value clauses in the LINKAGE SECTION.

Figure 62 » Value Clauses Removed and Shown as Comments

LIHNKAGE SECTIOM.
# PAEG-ENCORE MOTES:
L3
* 1. YALWE CLAUSES OMITTED FRDM LIMKAGE ARE SHOWM AS COMHENTS.
* 2. USED, MODIFIED MWD REFEREMCED [USESMODY SYMBOLS ARE
" HOTED,
* 3. ANNOTATED COPYEQQE SYHBOLS ARE REPRODUCED AS COMMENTS.
E 3
F7T DAYS-IN-FERIOD FIC 58|8]¥ald4] COMP-3.
* oo MAD
?7 DAYS-IN-YEAR PIC 39(81W3 (4] COMP-2,
" ... REF
0L TODAY-DATE.
a5  TODAY -¥Y FIC 3(0Z].
a5 TARAY -MH FIC 9(02].
* T =1
a5 TODAY-DD FIC afn2l,
* I =l
PROCEDURE DIVISION USING
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Figure 63 shows that any statements generated by Encore are preceded by a comment. In
the case of the module CALCDAYS, Encore indicated that it inserted a GOBACK to
terminate the program normally when its intended function is completed. You need to
verify that this is what you want. If not, you need to change it to continue processing.

Figure 63 * GOBACK Comment

PERFORH GET-NUM-DF-DAYS.
GOEACK.

* AZG=ENCORE= GOBRACK

GET-NUM-DF-DAYS .
*
ACCEFT TODARY-DATE FRAOM DATE.

COMPUTE DAYS=-IN=FERIOD =
MONTH [TODAY-HM1 - TODAY-DOD.
MOYE +0 TO DRAYE-IM-YEAR.
PERFDORH SUM-TOTAL-DRYS
YARYING WORK-CNT FROM 1 BY 1
UNTIL TODAY-DD = WORK-CHNT.
x
SUM-TOTAL-DAYS.
COMPUTE DAYS-IMN-YEAR = DAYS-IM-YEAR + HOWTH [ WORK-CMT | .

© ASG-EMCORE HOTE: »=xxxx EWD OF GEWERATED HODULE =xexxe
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4 Perform Range Extract

Extracting Multiple Perform Ranges

By default, when you create a Logic Segment containing multiple Perform Ranges, the
CALLable module has multiple entry points. You can assign unique names to the entry
points. These entry point names are included in the CALLable module and the CALLing
module has CALLs generated for each Perform Range using the entry point names that
you assigned.

As an additional option, you can generate more than one module from a multiple Perform
Range extract. What this means is that rather than generating one module with an entry
point for each Perform Range extracted, you have the ability to create a separate module
for one or more of the Perform Ranges selected.

Creating the CALLed Module with Multiple Entry Points

Assume that you created a Logic Segment containing three Perform Ranges that are used
to create a CALLable module and the complement or CALLing program. The CALLable
module contains 3 entry points that are named PROGENT1, PROGENT?2, and
PROGENTS3.

To create the Logic Segment
1 Start an Encore session and, if necessary, open program VIARDEMO.

2 Select Extract P Perform range and press Enter to display the Extract - Name Logic
Segment pop-up (see Figure 64 on page 86).
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3 Accept the default name shown in Figure 64 and press Enter to display the
Extract - Perform Name List pop-up (see Figure 65).

Figure 64 » Extract - Name Logic Segment

File View Extract Generate Search List Options Help

Extract - Name Logic Segment ram: VIARDEMO
Command ===
Type name of logic segment. Then press Enter.
KKK K KK K K K
Name . . . PERFORM-RANGE-0001 EEESEELE S
K 200K K KKK KKK K KK K K K K OK K K KKK K KKK KK K K KK K K K KKK OK KKK K K K K
K 200K K KKK KKK K KK K K K K OK K K KKK K KKK KK K K KK K K K KKK OK KKK K OK K K
KKK OK KKK OK KKK K K K KKK OK KKK
KKK OK KKK OK KKK K K K KKK OK KKK
KKK OK K 200K KKK KK K KKK KK K K KK OK K K K K 20K K KKK KK K K KK K K K K
KKK OK K 28K KKK KKK K KK K KK K K K K K K K KKK K KKK KK K K KK K K K

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Visit the ASG Support Web Site at www.asg.com

4  Seclect the first three Perform Ranges and press Enter twice to return to the Encore
Primary screen.

Figure 65 ¢ Extract - Perform Name List Pop-up

Extract - Ferfaorm Name Li 12 FERFODRH RRMEE NRHES
Command === Soraell === C3IA
Select PERFORM Range name(s] for extract. Then press Enter. Press
Enter when complete. Use 30RT command to order calumn by walue.
B - Select V - Wiew Bource U - Unselect
Size Times FERF Direct Subord
PERFOARM Range MWame Lires % PERF by PERFs PERFs
Ikl (=== === e il ---- »
= ACCT-HAINTEMANCE THRU ACCT -HAI 27 12. 28 1 1 3 4
= CLOBE-FILEE T %33 1 1 o} el
s CLOEE-FGH 5 2.z28 1 1 1 1
_ EXCEPTIOW-REPORT -1 18 7.82 1 1 4] 4]
GET=NUM=0F=DAYS i 4.78 1 1 1 1
_ IMIT-ACTLON-RECORD 9 4,29 1 i ul a
IMNITIALIZE-PGH 21 14,600 1 1 2 3
INITIATE-ACTION 1z & 14 5 2 o} o]
OFEN-FILES 5 2,28 1 1 o} o]
_ REPORT-FIMAL-CNTRS 5 2,30 1 1 4] 4]
FFd=¥iew PFF3=Filter PFl17=Sort
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4 Perform Range Extract

Select Generate » COBOL module and press Enter to display the Generate - Select
Logic Segment pop-up, as show in Figure 66. Press Enter to select the Logic
Segment you just created and to display the Generate - COBOL Module Pop-up (see
Figure 67 on page 88).

Figure 66 * Generate - Select Logic Segment Pop-up

Generate - Select Logic Segment 2 LOGIC SEGHMEMTS
Command ===} _ Scrmll === [C5R
% - Helect
Pt~ gy am Logic Segment MName Lescription
VIARDEMD  GET-NUM-OF-DRAYS CALCULATE NUHBER OF DAYS
5 VIARDEMD  PERFOAM-AANGE-@ODL Per farm Rarge

ik et re xRt KeReexenx QOTTOH OF DATE #tsstKe®Et X2 w et KXEEE0E0RE KX
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Type the first Program Entry name (PROGENT]1 in this example, as shown in
Figure 67) in the Program ID field and press Enter to display the Generate - Specify
Perform Range ENTRY Names pop-up (see Figure 68 on page 89).

Note:

For multiple entry points, there is no specific order to the use of entry point names.
Any entry point name can be used for the Program ID.

Figure 67 * Generate - COBOL Module Pop-up

File View Extract Generate Search List Options Help

Generate - COBOL Module Program: VIARDEMO

C
Type Program ID and select generation options.
AR KKK K KKK KK K
Objective . . : Perform Range KKK KK XK K K K KK XK
Program ID . . PROGENT1 _
Options KKK KKK
_ CALLs to I0 Modulel(s) KKK KKK

KKK

B e ' KKK

ASG4312I DEFAULT PROGRAM ID VALUE ASSIGNED. VERIFY, AND CHANGE IF
NECESSARY.

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
¥isit the ASG Support Web Site at www.asg.com

Figure 68 on page 89 shows the Generate - Specify Perform Range ENTRY Names
pop-up, which is used to provide the ENTRY statement names for the CALLable
module (PROGENT]1, the name you specified on the Generate - COBOL Module
pop-up. Encore assigns the Program ID name to one of the extracted Perform
Ranges.

In this case, ACCT-MAINTENANCE THRU ACCT-MAINTENANCE-EXIT was
assigned as the program name. You need to add the other two ENTRY names.



4 Perform Range Extract

Type PROGENT2 as the ENTRY name for CLOSE-PGM.
Type PROGENT3 as the ENTRY name for CLOSE-FILES.

Press Enter twice to display the Generate - Multi-module PERFORM Ranges pop-up
(see Figure 69 on page 90).

Note:

The name of the Selected Perform Range displays to the right of the entry point
name column. Any Perform Ranges performed by the selected Perform Range are
indented directly beneath. The list of Perform Range names can be condensed by
using the Collapse line command. To remove the subordinate Perform Ranges from
the list, enter '-' in the line command field next to the desired Perform Range. To
expand the list to include the subordinate Perform Ranges, enter a plus sign (+) in
the line command field next to the collapsed entry.

The Move and Into actions can only be used to reverse a split that creates separate
modules from entries for multiple Perform Range extracts. You cannot reverse a
nested Perform Range split.

Figure 68 * Generate - Specify Perform Range ENTRY Names Pop-up

Generate - Specify Perform Range ENTAY Hames
Command ===¥ _ Scroll === L3R

Specify the Programll and ENTRY names of the modules to be generated.
E - Eplit H - Mowve I - Into + - Expand - - Collape=

Program ENTRY PERFORH Range Mame

EEXEHEREFXFENF N M AR xF ke kEexdwx [OF OF DATH ¥ Frxf Xy ¥ AN EF KR RRE NERE
PROGENT1 WACCT-MAINTEMAMNCE THREU ACCT-HAIMTEMANCE-EXIT
FERFORH IMITIATE-ACTION
FERFORH UFDATE-ACCT THRU UPDATE-ACLT-EXIT
PERFORM IWIT-ACT IOM-RECORD
PERFORH EXCEFTIOH-REFORT-1
PROGENT2 «[CLOSE-PGM
¥ FERFDRH CLOSE-FILES
FROGEMTZ *CLOZE-FILES

s rerexeexeekxexewxexewrexd BOTTOM OF DATH Texexesyd y¥exe X Ee XEERENENT
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10 Press Enter twice when you have finished typing the ENTRY statement names to

11

display the Generate - Multi-module PERFORM Ranges pop-up, as show in
Figure 69.

Figure 69 * Generate - Multi-module PERFORM Ranges Pop-up

Generate - Multi-module PERFORH Ranges
Command ===3 _ Scroll ===» C3R

Eelect the module ta germerate., then press Enter.

EEAFMEFUFMEF XAMEFLRRRAANMERRFMEFS TOF OF DOATA #urwx s admFF A MEFRFRNER XA MEN KFH
5 PROGENTI1 ACCT-HAINTEMANCE THRU ACCT-HAINTEMAWNCE-ERIT

FROGENTZ CLOSE-PGH

PROGENTZ CLOSE-FILES

EAXAKEL LR XA XAM KL X ¥ ¥ xwxxxx BOTTOM OF DATH *tsXiXi®XiXIMELEXEELXAKEL KK

This pop-up is used to select the CALLable module to be generated. The contents of
this pop-up depend on how you complete the Generate - Specify Perform Range
ENTRY Names pop-up (see Figure 68 on page 89). In this example, three Perform
Ranges were extracted to generate one module with three ENTRY names. For that
reason, only one program name is displayed in this pop-up.

Type S in the selection field next to the Program ID PROGENTT and press Enter to
display the generated module in the Edit screen (see Figure 70 on page 91).
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Figure 70 shows the multiple ENTRY statements generated by Encore.

Figure 70 + CALLable Module With Multiple ENTRY Statements

A3G-Encore EDIT - USERID.ENCEXEXX.COEOL COLTMNS 00001 00072
Command === Seroll ===»> CSR
ooo31s

aooszzo PERFORM ACCT-MAINTENANCE THRU ACCT-MAINTEMNAMNCE-EXIT.

ooo3al GOBACE.

o0o03zz2

000323 * AIG-ENCORE- GOBACE
000324 ENTRY 'PROGENTZ' UIING

000325 WORK-RETURN-CODE.

ao0o3za * AIG-ENCORE- ENTRY
aoo3a?

0o0a3zs PERFORM CLOSE-PGH.

ooo3zs GOBACE.

ooos33o

000331 * AIG-ENCORE- GOBACE
000332 ENTRY 'PROGENTS'.

000333 * AIG-ENCORE- ENTRY
000334

000335 FPERFORM CLOSE-FILES.

000336 GOBACE.

ooa337

000338 * AIG-ENCORE- GOBACE
oo0o33s

ooos340

12 Press PF3 until you return to the Encore Primary screen.
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Creating Separate Modules from a Multiple Perform Range Extract

92

For this example,

. ACCT-MAINTENANCE THRU ACCT-MAINTENANCE-EXIT

assume that these Perform Ranges are extracted from VIARDEMO:

. CLOSE-PGM
. CLOSE FILES

Perform Range ACCT-MAINTENANCE THRU ACCT-MAINTENANCE-EXIT

performs the Perform Ranges shown in Figure 71.

Figure 71 » Perform Range ACCT-MAINTENANCE

TRCCT-HA
RER

ADD
MOy
RER

31 0]¥]
PER

RCCT-HA

INTENANCE.
0 TERAN-FILE
AT END
MOYE EOF-LITERAL TO TRAM-FILE-FLAG
GO TD ACCT=-MALNTEMANCE-EXIT.
+1 TO TRAN-CNT.
E TRAN-ACLCT=KEY TO ACCT=-EEY.
D ACCT-FILE  KEY [§ ACCT-KEY
INYALID KEY
MOYE ACTIDW-MISSING-ACCT TO WORK-ACTION-REASOH

HMOYE SPACES TO ACCT-RECORD
PERFDAM IWITIATE-ACTION
MOYE +4 TO HWORK-RETURN-CODE

GO TO ACCT-MAIMTEMANCE-EXIT.
+1 TO ACCT-IO-CHT.
FORH UPDATE-ACCT THREU UFDATE-ACCT-EXIT.

IF ACCT-MIN-BALANCE IS LESE THAN ACCT-BALANCE

PERFORM EXCEPTIONM-REPORT-1.

INTENANCE-EXIT.

EXIT.




4 Perform Range Extract

Perform Range CLOSE-PGM performs the Perform Range shown in Figure 72. Perform
Range CLOSE-FILES does not perform any other Perform Ranges, but is performed by
CLOSE-PGM.

Figure 72  Structure of Perform Range CLOSE-PGM

CLOZE-PGH.

FERFCREM CLOSE-FILES.

HOVE WORK-RETUEN-CODE ToO RETURN-CODE.

CLOSE-FILES.
CLOJE EXCEFTICHN-FILE.
CLOSE TRAN-FILE

ACCT-FILE
ACTICH-FILE.

The default result of an extract of multiple Perform Ranges is a CALLable module with
an ENTRY name for each Perform Range extracted. You have determined that
UPDATE-ACCT THRU UPDATE-ACCT-EXIT, performed by
ACCT-MAINTENANCE THRU ACCT-MAINTENANCE-EXIT, should be a separate
module. The result you want would be these two modules:

) One module containing three ENTRY names, PROGENT1 for
ACCT-MAINTENANCE THRU ACCT-MAINTENANCE-EXIT, PROGENT?2 for
CLOSE-PGM, and PROGENT?3 for CLOSE-FILES.

. One module containing the Perform Range UPDATE-ACCT THRU
UPDATE-ACCT-EXIT along with any other Perform Ranges executed by it.

This example shows the steps involved in creating multiple modules from a multiple
Perform Range extract:

1 Start an Encore session and open VIARDEMO if necessary.

2 Select Extract » Perform range and press Enter to display the Extract - Name Logic
Segment pop-up.

3 Press Enter to accept the default Logic Segment name on the Extract - Name Logic
Segment pop-up.

4  Select the first 3 Perform Ranges from the Extract - Perform Name List pop-up and
press Enter twice.
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10

Select Generate » COBOL module.
Press Enter to select the Logic Segment just extracted.

On the Generate - COBOL Module pop-up, type PROGENT1 in the Program ID field
and press Enter to display the Generate - Specify Perform Range ENTRY Names
pop-up, as show in Figure 73.

Figure 73 » Generate - Specify Perform Range ENTRY Names Pop-up

Generate - Specify Perform Range ENTRY Hames
Command === Seroll ===% CER

Specify the ProgramID and ENTAY names of the modules to be generated.

S - Split H - Mawve I - Inte + - Expard - - Cellapse
Pragram EHTREY PERFORM Pange Mate
EEXEXZEXENERX X XAMK e XA K meexxewx TOP QF DATH FEEEX LEMXAXANEE XXM XN EE XXX S
_ PROGENT1 *ACCT-MATNTENANCE THRU ACCT-HAINTENANCE-EXIT
- FERFORH INITIATE-AGTION
] FERFORHKH URDATE-ACCT THRU UPDATE-ACCT-EXIT

PERFORM IMIT-ACT IOM-RECORD
FERFORH EXCEFTION-AEPORT-1
PROGENT2  =CLOSE-PGM
* FERFORK CLOSE-FILES
_ PROGEMTZ =CLOSE-FILES
FEARAFEARNERLRAAMA A NAR A0k 0k BOTTOM OF DATA SHOraMae s m i SRNEr 6N ER L0

Figure 73 shows that PROGENT1, the ENTRY name for ACCT-MAINTENANCE
THRU ACCT-MAINTENANCE EXIT, is the default Program ID. PROGENT?2 is
assigned to Perform Range CLOSE-PGM, and PROGENT3 is assigned to Perform
Range CLOSE-FILES. Also, Perform Range UPDATE-ACCT THRU
UPDATE-ACCT-EXIT, which is performed by ACCT-MAINTENANCE THRU
ACCT-MAINTENANCE-EXIT, is generated as a separate module.

Type PROGENT?2 as the ENTRY name for CLOSE-PGM.

Type PROGENT3 as the ENTRY name for CLOSE-FILES.

To generate UPDATE-ACCT THRU UPDATE-ACCT-EXIT as a separate module,
type S in the line command column next to PERFORM UPDATE-ACCT THRU

UPDATE-ACCT-EXIT and press Enter to display the updated Generate - Specify
Perform Range ENTRY Names pop-up (see Figure 74 on page 95).
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4 Perform Range Extract

Figure 74 shows that the Perform Range UPDATE-ACCT THRU
UPDATE-ACCT-EXIT has been split out as a separate program by Encore. The
Perform statement within ACCT-MAINTENANCE THRU
ACCT-MAINTENANCE-EXIT has been converted to a CALL.

Figure 74 « Generate - Specify Perform Range ENTRY Names Pop-up

Generate - Specify Perform Range EMNTRY Hames
Catimand ===% _ Scroll ===% CER

Specify the ProgramID and ENTRAY names of the modules to be generated.
S - Split H - Mave I - Imtas + - Expard - - Lallapse

Program EMTRY PERFORM Range Mawe

FAEXAXKEEXXXERX KKt Xawr ez ws: TOP JF DATA SAXXE XA XKEX KR XNRE XA XS XK ENT LR K
_ PROGENHT1 *ACCT-MATHTENAKNCE THRU ACCT-HATNTENANCE-EXIT
FERFORH IMWITIATE-AGTION
+ CALL "UPDATE-ACCT THRU URPDATE-ACCT -EXIT"
FERFORH EXHCEFTION-REPDRT-1
PROGENTZ *LCLOSE-FPGM
# PERFORH CLOSE-FILES
PROGEMTZ =*CLOSE-FILES
URDATE-ACCT THRU UFDATE-ACCT-EXIT
FERFORM INIT-ACTION-RECDRD

REXEHERAERBHER KAREE SRR K e R X% BOTTOM OF DATA XXk X4¥ed KEERE KNSR EREENE K

Type UPDTACCT as a Program ID for the Perform Range UPDATE-ACCT THRU
UPDATE-ACCT-EXIT, as shown in Figure 75, and press Enter twice to display the
Generate - Multi-module PERFORM Ranges pop-up (see Figure 76 on page 96).

Figure 75 » Generate - Specify Perform Range ENTRY Names Pop-up - Assign Program ID

Gehetate - Specify Perform Range EMTRY Mames
Command === Scroll ===: CSR

Specify the ProgramIl and EMTRYT names of the modules to be generated.
S - Split M - Mowe I - Inta + - Expand - - Collapse

Frogram ENTRY FERFORM Range Hame

TOF OF DATA
— PROGEMT1 #ACCT-MATHTENAMCE THRU ACCT-MAINTENAMCE-ESIT
- PERFORM IMITIATE-ACTION
+ CALL "UPDATE-ACCT THRU UFDATE-ACCT-EXIT
FERFORM EXCEPTIONM-REPORT-1
PROGEMTZ  #CLOSE-PGH
# PERFORM CLOSE-FILES

FROGEMTZ #CLOSE-FILES

UPDTACCT UPDATE-ACCT THRLU UPDATE-ACCT-ERIT
FERFORM IMIT-mCTION-RECORD

EOTTOM OF DATA
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96

12

13

14

15

To generate a module and display it in Edit, type S on the selection field next to the
desired Program ID name (PROGENTT1 in this example, as show in Figure 76) and
press Enter to generate the module and display it on the Edit screen.

This pop-up is used to select each module to be generated. Only one module can be
selected at a time.

Figure 76 » Generate - Multi-module PERFORM Ranges - Select Module to Generate

Generate - Multi-module PERFORAM Aanges
Command === Screll ===» [CEA

Select the module ta generate, then press Erter.

EREFMEFRAREFRAREARAREARARENXARKENE TOP OF DATH #F ¥ srr ¥rd¥f XA EN KRR RARER KR
5 PROGENT1 ACCT-HAINTENANCE THRU ACCT-HAINTENANCE-ERIT
FAOGENT 2 CLOSE-PGH
PROGENTZ  CLOSE-FILES
UFDTACLCT UFDATE=ACCT THRU UPDATE-ACCT-EXIT

¥R EEMEREREF REmER b nenrwewr BOTTOH OF DETA Asmxr irmxs xew el RRnEs KENER XEN

Save the generated module by typing CREATE on the command line and then C
9999 on the first line of code. Press Enter to save the module in your source library
and display the Edit/View - Create pop-up.

On the Edit/View - Create pop-up, type the name you want to save the program under
in your source library, verify or clear any data in the Data Set Name and Volume
Serial fields, and press Enter to create the member and return to the Edit screen.

Press PF3 to return to the Generate - Multi-module PERFORM Ranges pop-up. You
can repeat this procedure to generate the remaining modules. When finished, press
PF3 until you return to the Encore Primary screen.



4 Perform Range Extract

Reviewing the Generated Modules
The results of this exercise have produced two modules; PROGENT1 and UPDTACCT.

Figure 77 shows that PROGENT]1 is the Program ID and is made up of the Perform
Ranges ACCT-MAINTENANCE THRU ACCT-MAINTENANCE-EXIT,
CLOSE-PGM, and CLOSE-FILES.

Figure 77 « PROGENT1

ALG-Encore EDIT - USERID.ENCXIOCC{. COBOL Memher PROGENT1 created
Command === Fcroll === C3iR

ok o o ok o o ok o ol o e o i e ol o o ol TDp Df Dﬁt—ﬁ ook ok o ol ok o o ol o o o o e o o o o o o ok
aooonl e i i i i e e i i i e i e e o o o
oooooz * A5G, INC. *
ooooa3 * *
ooooo4 * GENERATED EY ASG-ENCORE RELEASE 6&.0(000) *
ooooos * *
ooooos * PROGRAM: PROGENT1 *
ooooa? * *
ooooas * DATE: DD-MMM-FYVY HH:MM: 53 *
ooooog * REQUESTOR: TSERID *
oooolo * *
ooooll * AFR INFORMATION *
oooolz * D5 NAME: TSERID.TEAT. AKR *
ooool3 * MEMEEE : VIARDEMO ALTAS: (NOME) *
ooool4 * *
ooooLs * ZEGMENT NAME: PERFORM-RANGE-0001 *
oooole * *
ooool7? * QBJECTIVE TYPE: PERFORM RANGE *
ooools * PERFORM NAME (3 : *
oooole * ACCT-MAINTENANCE THEU ACCT-IMAINTENANCE -EXIT *
oooozo * CLOSE-PGH *
o000zl * CLOSE-FILES *

Figure 78 shows that PROGENT?2 is the ENTRY name for CLOSE-PGM Perform
Range.

Figure 78 « PROGENT2

* ASG-EHNCORE- GOBACK
ENTRY 'PROGENTZ' USING
HORK -AETURN-CODE.
* A3G-ENCORE- ENTRY

FERFORM CLOSE-PGEM.
GOBEACE .
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Figure 79 shows that PROGENTS3 is the ENTRY name for CLOSE-FILES.

Figure 79 « PROGENT3

* ASG-EMCORE- GOBACK
EMTRY ‘PROGENT3'.
# ASG-ENCORE- EMNTRY

FERFORM CLOSE=-FILES.
GOERACE.,

* ASG-ENCORE- GOBRCK

Figure 80 shows that the Perform for UPDATE-ACCT THRU UPDATE-ACCT-EXIT
has been changed to a CALL to program UPDTACCT.

Figure 80 « Call to UPDTACCT

] AEG-EMCORE- CALL
CALL 'UPDTACCT' USIHG

TRAK-RECORD
INTEREST-RRATE
DAYS-IM-FERIOD
OAYS-IM-YEAR
WORK -ACTIOH-RERASON
ACTION-CHT
TODAY-DATE
CONTROL-FRARPAMETERS
BRANCH-BALAMCE
BANE -BALAKNCE.

IF ACCT-MIN-BALANCE I3 LESE THAN ACCT-BALANCE
PERFAORH EXCEPTION-REPAORT-1.

ACCT-MAINTEHRNCE-EXIT.
EXIT.
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Detecting and Eliminating Multiple Perform Range Common Code

This section discusses the techniques you can use to eliminate replication of common
code within multiple Perform Range extracts.

Common code can occur within a multiple Perform Range extract when the Perform
Range selected to be converted to a CALLable module contains a performed subroutine
that is executed by additional Perform Ranges in the extract. Encore identifies this
condition and gives you the option of eliminating replication of common code.

For this discussion, assume that the two Perform Ranges in VIARDEMO,
ACCT-MAINTENANCE THRU ACCT-MAINTENANCE-EXIT and UPDATE-ACCT
THRU UPDATE-ACCT-EXIT are to be selected for extract. Additionally, Perform
Range UPDATE-ACCT THRU UPDATE-ACCT-EXIT is to be generated as a
CALLable module.

ACCT-MAINTENANCE THRU ACCT-MAINTENANCE-EXIT and UPDATE-ACCT
THRU UPDATE-ACCT-EXIT both perform subroutine INITIATE-ACTION. When
both Perform Ranges are generated as CALLable modules, the code in
INITIATE-ACTION is present in both modules. Encore detects this condition and allows
you to circumvent it.

To select the Perform Ranges

These steps select Perform Ranges ACCT-MAINTENANCE THRU
ACCT-MAINTENANCE-EXIT and UPDATE-ACCT THRU UPDATE-ACCT-EXIT:

1 Select Extract » Perform range.

2 Accept the default Logic Segment name on the Extract - Name Logic Segment
pop-up by pressing Enter.

3 On the Extract - Perform Name List pop-up, select the Perform Ranges
ACCT-MAINTENANCE THRU ACCT-MAINTENANCE-EXIT and
UPDATE-ACCT THRU UPDATE-ACCT-EXIT (you may have to page down to
see the last Perform Range). Press Enter to confirm the selection and press Enter
again to return to the Encore Primary screen.
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To generate the COBOL module

The object of this extract is to generate two CALLable modules. Currently, module

VIARDEMYV contains two ENTRY points; VIARDEMYV as the Program ID, and another

ENTRY point that represents Perform Range UPDATE-ACCT THRU

UPDATE-ACCT-EXIT. These steps provide the option to convert a Perform Range to a

CALLable module.

1 Select Generate » COBOL module.

2 Select the Logic segment just extracted or except the highlighted selection.

3 Press Enter to accept the default Program ID on the Generate - COBOL Module
pop-up. The Generate - Specify Perform Range ENTRY Names pop-up displays and
is used to provide the ENTRY statement names for the CALLable module, as shown

in Figure 81.

Figure 81 » Generate - Specify Perform Range ENTRY Names Pop-up

Generate - 3pecify Ferform Range ENTRY Names

Command ===: Zcroll === LER
Epecify the PragramID and ENTRAY names of the modules ta be generated.
5 - Split H - Mowe I - Inte + - Expand - - Collapse

Pragram EHTRY PERFORH Fange Hame

FRXEME XX EWNEEX RN XM X XM e X TOP OF DATA M $mtee 0o o s 5o 50k w0 300w 30w
_ YIARDEMY *ACCT -HATNTENANCE THRU ACCT-MATHTENAKCE-ERIT

FERFORM THITIATE-ACTION

# PERFORM UPDATE-ACGT THRU UPDATE-ACCT-EXIT

PERFORHM IMIT-ACTION-RECORD

FERFORM EXCEFTIOM-REFPORT-1
5 UPDATEADR = UPDATE-ACCT THRU UPDATE-ACCT-EXIT

FERFORM THITIATE=-ACTION

FERFORM IHIT-ACTION-RECORD

FENEMEEEREE MR KN ER R eny: BOTTOH OF DATE S8k 0 WE i S W R 2w

4  To convert UPDATE-ACCT THRU UPDATE-ACCT-EXIT to a CALLable
module, initiate the split option by typing S to the left of Perform Range
UPDATE-ACCT THRU UPDATE-ACCT-EXIT and press Enter.
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4 Perform Range Extract

Figure 82 shows that the ENTRY field for UPDATE-ACCT THRU
UPDATE-ACCT-EXIT now becomes the Program ID field, indicating that the
Perform Range is generated as a CALLable module. Note that the words DUP (002)
appear to the right of the Perform statements PERFORM INITIATE-ACTION.
Encore has detected that the code in this Perform Range is duplicated in both
modules. The number within the parentheses indicate the number of times the
Perform Range is executed in this Logic Segment.

Figure 82 « Using the Split Option to Generate a Callable Module

Generate - Specify FPerform Aange EMTRY MNames
Command === Screll === [ER

Specify the ProgremID and ENTRY names of the modules to be generated.
E - Split H - Mowe I - Inte + - Expand - - Collapse

Program EHTRY FERFORH Range Mame

EEXRFREFEFREFXFREFRRREF X RER 3R X [P OF DATH # ¥ ¥xF xsxer EeEEF XFRER KERER XE ¥
WIARDEMY #ACCT-HAINTEMAMCE THRU ACCT-MAINTEMANCE-EXIT
FERFORH INITIATE-ACTION OUF le0z)
+* CALL "UFDATEOA™
. FERFOEM EXCEFTION-REFORT=-1
_ UPDATEQA *UPDATE -ACCT THRU UPRATE-ACCT-ERIT
=) FERFORM INITIATE-ACTION OUP le02)
_ FERFORH INIT-ACTIDN-RECORD
wxakmak Hewrtnwek e amxeinwx QOTTOH OF DATHA #amae £ e samae S ek Ka it an

To change executed Perform statement code to a CALLable module

1

Type S to the left of the Perform statement PERFORM INITIATE-ACTION and
press Enter.

Note:

You can eliminate duplicate code that can occur when converting Perform Ranges
to modules by using the Split option to convert the duplicated code into a
CALLable submodule. By doing this, the Perform statements in the two modules
are changed to CALLs.
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A Program ID field is now displayed next to Perform statement
INITIATE-ACTION. Note that the PERFORMSs have been changed to CALLs, as
shown in Figure 83.

Figure 83 « Using the Split Option

Generate - 3pecify Perform Range ENTRY Mames
Command ===% Scroll ===% [CS5R

Specify the ProgramID and ENTAY names of the modules to ke generated.
5 - 5plit K - Mawe I - Inte + - Expand - - Collapse

Program EHNTRY PERFORH Range MName
ERXENEEXER X E XN TR X ERx e Xk xemx X TOP OF DRTH %5008 30k 50800k 0k 5008 8 3 00 508 00k 3008 00 3 0k 5080
_ VIRRDEMY *ACCT-HRINTENRHNCE THRU ACCT -MAINTEWAHCE-ERIT

CALL "INITIATE-ACTION™

++ CALL "UPDATEDAR"
FERFORM EXCERTION-REFORT-1
UFDTARCCT «|IPDATE-ACCT THRU UFDATE-ACCT-ERIT

CALL "INITIATE-RCTION™
— FERFORHM INIT-RCTION-RECORD
_ INITRCT_ INITIATE-ACTION
ERERMEERRRER CEMER LR 0eMerwens BOTTOH OF DATA £3 W semes suues suner ey o

Change the Program ID for UPDATE-ACCT THRU UPDATE-ACCT-EXIT and
enter a Program ID for INITIATE-ACTION.

Replace UPDATEOA with UPDTACCT in the PROGRAM field next to
UPDATE-ACCT THRU UPDATE-ACCT-EXIT.

Type INITACT in the PROGRAM field next to INITTATE-ACTION.



4 Perform Range Extract

Press Enter twice to display the Generate - Multi-module PERFORM Ranges
pop-up, as show in Figure 84.

This pop-up is used to select which COBOL module is generated. Only one module
can be selected at a time. Select a module and press Enter to generate the module
and display the source using your default editor. When you have processed the
generated module (saving it, for example), press PF3 to redisplay the

Generate - Multi-module PERFORM Ranges pop-up. You can select another
Program ID or you can press PF3 to return to the Encore Primary screen.

Figure 84 » Selecting a Module for Generating a COBOL Module

Generate - Multi-madule PERFORM Ranges
Command ===} _ Goroll === C%R

Select the module to generate, then press Enter.

Frogram ID  ENTRY Mame FERFORH Fange Hame

ERAFAFEAFAFRAF LA A rxwxsxinx [OP OF DATH ¥ Frxsa s s Fma R AN EFAFRNE R A EXE

Y IARDEMY ACCT-MAINTEMANCE THRU ACCT-HAIMTEMAMCE-EXIT
UFDTACCT UFDATE-ACCT THALU UPDATE-ACCT-EXIT
_ INITACT INITIATE-ACTION

¥EFAFTEXAXTCRL kX xuwkx xxwx ¥y BOTTOM OF DATH ToCxd s ¥ Xa¥X I XXX LENLXLKT
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Creating Complement Modules from Multiple Perform Range Extracts

104

When creating the Complement Module from a multiple Perform Range extract, Encore
replaces the PERFORM statements for each Perform Range with a CALL to the ENTRY
name that you assigned to each Perform Range. Once you have created the CALLable
submodule, you then need to create the CALLing program (complement).

To create a Complement Module from a Multiple Perform Range extract

1 Select Extract » Complement to display the Extract - Name Logic Segment pop-up,
as show in Figure §85.

Figure 85 » Extract - Name Logic Segment Pop-up

File View Extract Generate Search List Options Help

Extract - Name Logic Segment ram: VIARDEMO
Command ===
Type name of logic segment. Then press Enter.
KKK K KK K KK K
Name . . . COMPLEMENT-0001 KKK KKK KKK
KKK KK KK KK KK K KK K K KK K K KKK KK KKK KK K OK KK K K K KK K OK KK K K K
KR KKK K KR KK K OK R K KK K KR K K KKK K R KR KK KK KK XK KKK X R OK KKK KR
KKK X R KKK R KKK K O K KK XX
R XKOK K KKK XK XK R XK KK XK XK KK X
KK KKK K KKK K R KR KK K K KK K K K K R K OK KK K R OK K KK R K KK K KR KK KK K
O KKK KKK K KKK KK R KK KK KR KK K OK R R KK KK KK OK KR KK XK

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
¥isit the ASG Support Web Site at www.asg.com

2 Accept the default Logic Segment name and press Enter to display the

Extract - Complement pop-up (see Figure 86 on page 105).




4 Perform Range Extract

Select the multiple Perform Range Logic Segment previously generated, as show in
Figure 86. Press Enter, then PF3 twice to return to the Encore Primary screen.

Figure 86 » Extract - Complement Pop-up

Extract - Complement 4 LOGIC 3SEGMEMTS
Command ===x _ Scroll ===>» CSR

Select segments for complement extract and press EMTEA.  lLhen selections
are complete, press Enter.

5 - Select U - Unselect

Program Legic Begment Name Lescription

WIARDEHD BET-HUM-DF -DAYS CALCULATE NUMBER OF DAYS
_— YIARDEHD PERFORM-RANGE-GE0&1 Ferform Range
_ WIARDEHD PERFORM=RANGE=-BG082 Ferform Aange
5 YIARDEHD PERFORM-RANGE-B003 Ferform Range

FEEFAFREFAFREF R uxFrxswr e s xy BOTTOM OF DATA MEF XS REFEFEEFXFXFREFXT RN K F

From the Encore Primary screen, select Generate » COBOL Module and press Enter
to display the Generate - Select Logic Segment pop-up (see Figure 87 on page 106).
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5  Select the Complement Logic Segment, as show in Figure 87, that was created in
step 3 on page 105 and press Enter to display the Generate - COBOL Module pop-up

(see Figure 88).

Figure 87 * Generate - Select Logic Segment Pop-up

Gernerate - Select Logic Segment 5 LOGIC 3EGMENTS
Cammand === _ Scroll === CiR
5 - Helect
Program Legic Seament MWama Description
5 YIARDEHWD COMPLEMENT-0004 Complemnent Perform Range
WIARDEHD GET-MUM-DF -DAYS CALCULATE NUMEBER OF DAYS
WIARDEHD PERFOAM-RANGE-E0G1 Ferform RAange
WIARDEHD  RERFORM-RANGE-G0G2 Perform Range
_ WIARDEHD  PERFORM-RANGE-80Q3 Perfarm Ramge

FRXFXFREFXTFRN AR RRF XA Ko mxrxd BOTTOM OF DATH F®¥f ¥ ey ¥XerF XARTREFXFRREKF

6  Type the name of the CALLing program in the Program ID field and press Enter to
display the Generate - Specify Perform Range CALL Names pop-up (see Figure 89

on page 107).

Figure 88 * Generate - COBOL Module Pop-up

File View Extract Generate Search List Options Help

Generate - COBOL Module Program: YIARDEMO

Type Program ID and select generation options.
KKK KK KK K K KK K K

Objective . . : Complement KK KK K KKK KK KKK
Program ID . . YIARDEMY
Options KKK KKK
CALLs to I0 Modulel(s) KKK KK KKK
XX
——————————————————————————————————————————————————————— AKX

ASG4312I DEFAULT PROGRAM ID VALUE ASSIGNED. VERIFY, AND CHANGE IF
NECESSARY .

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Visit the ASG Support Web Site at www.asg.com
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4 Perform Range Extract

Encore remembers the ENTRY statement names you assigned when extracting the
multiple Perform Ranges and lists them on the Generate - Specify Perform Range
CALL Names pop-up, as show in Figure 89. Verify that the names are correct and
press Enter to display the Edit screen (see Figure 90).

Figure 89  Generate - Specify Perform Range CALL Names Pop-up

Generate - Specify Perform Range CALL Names
Command ===> Scroll ===> CSR

The complement module includes CALLs to extracted PERFORM Rangels). Type
the PROGRAM-ID or ENTRY Names of the programs to be CALLed. When complete
press Enter.

Program ID ENTRY Name PERFORM Range Name

33K K 5K K K K K 5K K 5K 3K K 5K K K K OK KKK KKK KKK KKK TOP OF DATEA K KK 5K K K K 5K 5K K K 5K K 5K 3 K K K XK 5K K K K K K K X K

PROGENT1 ACCT-MAINTENANCE THRU ACCT-MAINTENANCE-EXIT
PROGENT2 CLOSE-PGM
PROGENT3 CLOSE-FILES

33K K 5K K K K K 5K K 5K KK KKK ROK KK KKK KKK kKX BOTTOM OF DATA 5K 5k K K K 5K 5K K K 5K K 5K 5 K 5K 5K XK 5K K K 5K XK K & X K

The Edit screen shows an example of one of the CALLSs to the multiple program
ENTRYSs generated by Encore at the appropriate place (line 241).

Figure 90 » Encore-Generated CALLs to Multiple Program ENTRYs

L3G-Encore EDIIT - USERID.EMNCEXXXX.COBOL COLUMNE 00001 00072
Command ===> Seroll ===> C3R
a00z34 PERFORM ASGGEN-PROGENTI1

O00Z35 L AL3G-ENCORE- FERFORH
O00Z36 UHNTIL TRAN-FILE-ENDS.

000z37

O00Z38 FERFORM REFORT-FINAL-CHTRS.

ooozas

000z 40 * AZG-ENCORE- CALL
oooz41 CALL 'PROGENTZ' UIING

oooz4z WORKE-RETURN-CODE .

00z 43

000Z 44

000z 45 GOELCE.

000z 46

000z 47

000z 48

000z 49 GET-NUM-OF-DAYS .

ooozso *

ooozs1 ACCEPT TODAY-DATE FROM DATE.

ooz sz

0O00Z 53 CONFUTE DAYS-IN-PERIOD =

000z 54 MNONTH (TODAY-MM) - TODAY-DD.

O00Z55 NOVE +0 To DAYI-IN-YEAFR.

After you have reviewed the output, press PF3 until you return to the Encore Primary
screen.
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9  Optional. After entering the edit session, type CREATE on the command line and
then C 9999 on the first line of code. Press Enter to display the Edit/View - Create
pop-up and save the compliment module (if desired).

Understanding Perform Extracts and Common Code

108

When you extract a Perform Range Logic Segment, you need to be aware of common
code within the Perform Range. Common code occurs when a Perform subroutine is
performed by two or more subroutines in a program. An example of common code is
shown in Figure 91.

Note:

This section shows examples that are not contained in VIARDEMO. The programs and
associated figures used in this section are provided as specific examples of how to review
Perform extracts and common code.

e  Box 003, AML-MORT-TYPE, performs Box 008, CALCULATE-RATE.
J Box 009, VERIFY-ACCT also performs CALCULATE-RATE.

Figure 91 » Structure View of Common Code

File View Extract Generate Search List Options Help
Structure View Program: MOROOOZ (0
Command ===> Jeroll ===> CZR
More: - + =
o ooz + o 003+
I IZNEIT)I(‘;’REI } I‘?“‘?;’E“‘g_%m I Paragraph AML MORT-TYPE
A 8 i CALCULATE-RATE
| | [RU &ML | PETOW
E + e +
e | bommeenea S

L 006 + 4 - -- - - 007+ 4+ ----- 008+ 4+ ----- 0og +

| OPENFIL | |GET-NUM- | |CALCULAT| |VERIFY-4 |

| ES | [OF-DAYS | |E-RATE | |[CCTTHRU |4 Poragraph VERIFY-ACCT

| I | | | WVERIFY *| performs CALCULATE-RATE

E o +oh o oAb +

| bemmennen oo e boeeeee

o 012+ o 013+ +----- 014+ +----- 015+ +----- 016+
| SUB-TOTA | |&PPLY-TR | |CALCULAT | |CALCULAT| |CALCULAT |
|L-DAYS | JalE | |E-RATE | |E-RATE | [E-RATE |
| | | |1 @11 @ [N
oo + o + +REPEATED + +REFPEATED+ + REPEATED +




4 Perform Range Extract

If you were to extract paragraph VERIFY-ACCT and create a CALLable submodule, it
would contain paragraphs VERIFY-ACCT, APPLY-TRANS, and CALCULATE-RATE.
Normally, a Complement Module would not contain code present in the extracted Logic
Segment(s). However, in this case the Complement Module would also contain paragraph
CALCULATE-RATE because it is also performed outside of the extracted Logic
Segment, i.e, from AML-MORT-TYPE. This means that the logic in
CALCULATE-RATE would exist in both the CALLable submodule and the
Complement Module.

To prevent the replication of common code

1 Since paragraph CALCULATE-RATE is common to several Perform Ranges, you
would extract it first and generate a CALLable submodule.

2 After generating the submodule, generate the Complement Module.
Notice that the common code in paragraph CALCULATE-RATE (as shown in

Figure 91 on page 108) has been replaced by a CALL to module CALCRATE in
Figure 92, the CALLable submodule you just created.

Figure 92 » Structure View of Complement Module MOR0009C

File Taenr Eract Cratierte Search List Ciptiones Help
Stoachurs S Progrmm: KMORI009C
Command === Saoll==== CZR
Iore: - + =
+ooe- 002+ e 00z +
| IMITLALI | |AML-KMORT |
| IE-P I | |-TYPE TH |
| | |RTITABD-* |
[ + - S+
Feoaeas 006+ +------ 07+ 4------ g+ +----- ong +
| OPEH-FIL | |GET-HUM- | [CALCRATE| [VERIFV-& |
| ES | OF-DAYS | | | [CCT THRIT |
| I 1 | | VERIFY *|
F L T
LT 012+ +------ 013+ teoaeos 014+ +----- OLlS+ +----- 0l +
| SUE-TOTA | |APPLY-TE | |CALCEATE | |CALCRATE| |CALCEATE |
|L-DAWE | |ATTE 11 |
| | | 11 B B 8l
L Lk L T T O P L

Note:

The Complement Module (MORO0009C) created in step 2 must be Analyzed and
placed in the AKR before the extraction in step 3 on page 110 is done.
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3  Extract the Perform Range VERIFY-ACCT from the Complement Module
MORO009C created in step 2 on page 109 and generate a CALLable submodule. The
generated submodule (after VERACCNT was analyzed) is shown Figure 93.

Figure 93 » Structure View of Submodule VERACCNT

File View Extract enerate Hearch List Options Help
Structure View Program: VERACCHNT
Command ===> Boroll ===> C3R
More: +
o - a0l +
| VERACCNT |
| |
| |
R +
|
[ SR oz +
| VERIFY-& |
| CCT THRU |
| VERIFY * |
[ I —— +
Foommeneas e e booemeee |
o - 003 4+ 4 - oo - - o0+ 4+ --- .- 005+ 4+ ----- 006+ 4+ ----- o007 +
| APPLY.TR | |'CALCRAT | |*CALCRAT | |‘CALCRAT | |“CALCRAT |
| ANE | 1E” | |E” | |E | |E |
| |1 |ASG1582I 2 OF 2 LEVEL3 DISFLAYED IN THE VIEW| |
R s P — F F - F - +

Note that the common code in paragraph CALCULATE-RATE in the original
module has been replaced by a CALL to module CALCRATE, created in step 1 on

page 109.
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4 Perform Range Extract

Generate another Complement Module from Complement Module MOR0009C,

created in step 2 on page 109, name it MOR00091, and analyze it. See "The Analyze
Facility" on page 36 for more information about using Encore to analyze a program.

Figure 94 » Structure View of Complement Module MOR00091

File View Extract Generate Hearch List Options Help
Structure View Program: MORI0091
Command ===> Heroll ===> C3R
More: +
boosmmnr e [c e [oomenne
+oo 00z + +oo 003+ [ 004+ + - - - 005+
| INITIALI | | AML-MORT | | REPORT-F | |CLOSE-PG |
| ZEPGM | |-TYPETH | |INAL-CNT | |M |
| | | BT AML-* | | S [ |
o + [ + o I +
bosmemnes | [onomemmnes [2ommmmmenes | |
[ SR 006 + 4+ - - - - 007+ +----- 008+ 4+ ----- 009+ +----- 010+ [ SR 011+
| OPEN-FIL | |GET-NUM- | |*CALCRAT | |‘VERACCH | |EXCEFTIO | | CLOJE-FI |
| E3 | |OF-DAYS |E* | |T* | H-REPORT | | LES |
| [ I I e | | |
o I L [ F + S, +
I
[ o1z +
| SUM-TOTA |
| LDAYS |
| |
Foeiain +

The CALLable submodule created in step 3 on page 110 (see Figure 93 on page

110) and Complement Module MORO00091 created in step step 4 above (see
Figure 94) both have CALLs to submodule CALCRATE, created by step 1 on

page 109, thereby eliminating the duplication of code in the Complement Module

and the submodule VERACCNT.
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Finding Common Code in CALLable Submodules and
Complements

Encore provides you with an easier way to isolate common code. Assume that you have
created a Perform Range Logic Segment with the default name GET-NUM-OF-DAYS
and the complement Logic Segment with the default name COMPLEMENT-0004.

To determine if common code exists

1 Select Extract » Common Code to display the Extract - Name Logic Segment
pop-up, as show in Figure 95.

Figure 95 » Extract - Name Logic Segment Pop-up

File View Extract Generate Search List Options Help

Extract - Name Logic Segment ram: VIARDEMO
Command ===
Type name of logic segment. Then press Enter.
KK R K KK KK K K
Name . . . COMMON-CODE-0001_ R KKK KKK
R KK KK KK KK KK R KK K K KK KK K KKK K R KR KK KK KK XK XK KK K K KK KK R
KKK KK KR K KK KK KK K KR K KKK KR KK KK K OK KK XK KKK X KKK K KK
KKK X X KKK O KKK X RO XK XXX
KKK K KKK KK K KK K K K KKK AKX
KK KKK K KK KK R KR KK K K KK K K R K R DK OK KK K AR KK KK R K KK K KR KK KK R
R KKK KKK KK KK KK KKK KK KR KK KK R R KK KK KKK KR KK XK

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Visit the ASG Support Web Site at www.asg.com

2 Use the default Logic Segment name and press Enter to display the
Extract - Common Code pop-up (see Figure 96 on page 113).
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4 Perform Range Extract

Select the Logic Segments to be checked for common code. In this example, Logic
Segments COMPLEMENT-0004 and GET-NUM-OF-DAYS are selected, as show
in Figure 96. Press Enter twice to return to the Encore Primary screen.

Figure 96 » Extract -

Common Code Pop-up

Command ===%

press Enter.
3 - Select

Frogram

WIARDEMD
WIARDEMD
WIARDEMD

won

Select segments for common cede extract.

U - Unselect
Logic Segment Name
COMPLEHMENT-DB04

GET-NUH-0F -DAYS
PERFORH- RANGE-ROD2

ERLEMEELENEELENER LM Lxuxk 0w QOTTOH OF

Eztract - Common Code

Scrall ===% CSR

Hhen selections are complete,

Descriptian

Complement Perfeorm FAange
CALCULATE MUHBER OF DAYS

Ferfarm Range

DIETEA LW LN LENEE LENEE LENEE LN

3 LOGIGC SEGHENTS

Select View P Logic Segment to display the View - Select Logic Segment pop-up,
as show in Figure 97.

Figure 97 » View - Select Logic Segments Pop-up

Command ===
5 - Select
Program

5 WIARDEMD
WIARDEMD

YIARDEMD
WIARDEMD

Logie Segment hame

COMHON-CODE-@0W1
COMPLEMENT-0B04
GET-NUH-0F -DAYS
FERFORH- RANGE-DOD2

Yiew - Select Leogic Segment

Scroll ===3 [CZR

Deseriptian

Comman Code
Complement Perfeorm FAange
CALCULATE MWUHBER OF DAYS

Ferform Range

ERAENER RN OENE RO 0wk 0ewx QOTTOH OF DIRTEA S06M 30 206N 300 306N 300 06N X0 L EW X LW

4 LOGIC SEGHENTS
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114

Select the Logic Segment that was created from the Common Code extract and press
Enter to display the View - Common Code PERFORM Ranges pop-up, as show in

Figure 98.

Figure 98 * View - Common Code PERFORM Range Pop-up

Yiew - Commen Code FERFORH Ranges
Command ===3 Scrall === [C5R

FEAFORM Rarnge Mame
YIARDEMO
IMITIALIZE-FGM
OFEM-FILES
GET-HUM-DF -DAYE
SUM-TOTAL -DAYS
ACCT-HAIWTEMAKNCE THRU ACCT-HAIMTENAMCE-EXIT
INITIATE-RCTION
UFDATE-ACCT THRU UFDATE-ACCT-EXIT
INIT-ACTION-RECORD
EXCEPTIAN-REPCAT-1
RERORT =FINAL=CHTRS
CLOSE-FPGM
CLOSE-FILEE
INMITIALIZE-FGM
OFEW-FILES

If common code exists between a Perform Range Logic Segment and the
Complement this pop-up is displayed, showing all Perform Ranges in the program.
Perform Ranges containing code that would appear in both the CALLable
submodule and the CALLing program are highlighted. Indented Perform Range
names are subordinate to the preceding non-indented Perform Range names.

You can display the common code within the highlighted Perform Range(s) in a
Source View, Tree View, or Structure View from this pop-up by entering the
commands SV, TV, or STV, respectively, on the command line.

Once common code is identified, it can be eliminated by following the procedures
described in "Detecting and Eliminating Multiple Perform Range Common Code"

on page 99 .

Note:

If no common code exists, a No Statements message displays when you
attempt to view the Common Code Logic Segment.




4 Perform Range Extract

Replacing 10 Statements with CALLs to an 10 Module

Encore provides an automated solution to the COBOL constraint against file references
across program boundaries. It involves replacing IO statements contained in the Perform
Range with Encore-generated CALLSs to an IO module. Encore can also generate the 10
Module.

Note:

The CALLs to 10 Module(s) option from the Generate - COBOL Module pop-up is
available from any extract method except for Common Code.

To replace 10 statements with CALLs to 10 modules

1 Select Generate » COBOL Module to display the Generate - Select Logic Segment
pop-up, as show in Figure 99.

Figure 99 » Generate - Select Logic Segment Pop-up

Generate - Select Logic Segment 3 LOGIG SEGHENWTS
Command ===% _ Beroll === LCSR
% - Helect
Ptogram Logic Segment Mame Description
5 WIARDEMD COMPLEHENT-D204 Complement Ferform Range
WIARDEMD GET-NUH-0F-DAYS CALCULATE MUHEER OF DAYE
_ WIARDEMD  PERFORM-RRAMGE-Q002 Perform Range

¥ wewrdwrnxprrnxsxrwxe xR rswx GOTTOH OF DATA ¥+#3F ¥ssad ¥ewdf Eesf XEREE XEw

2 Type S next to the Logic Segment name you want to generate and press Enter to
display the Generate - COBOL Module pop-up (see Figure 100 on page 116).
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3  Type the Program ID and enable the CALLSs to IO Module(s) option by typing a
forward slash (/) next to the option, as shown in Figure 100.

Figure 100 « Generate-COBOL Module Pop-up

File View Extract Generate Search List Options Help

Generate - COBOL Module Program: VIARDEMO

Type Program ID and select generation options.
KK KK K KKK K K K K K

Objective . . : Computation Variable KKK KKK KKK KKK

Program ID . . VIARDEMY

Options HOK KKK KK

/ CALLs to IO Module(s) KK K K KK K
KKK

_______________________________________________________ XX

ASG4312I DEFAULT PROGRAM ID VALUE ASSIGNED. VERIFY, AND CHANGE IF
NECESSARY.

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Visit the ASG Support Web Site at www.asg.com

4  Press Enter to display the Select FD Names pop-up, as shown in Figure 101.

Figure 101 « Select FD Names Pop-up

Select FD Names 4 FD NAMES
Command ===> Scroll ===> CSR

Select the FD names(s) for which CALLs to an I/0 module should be generated

Then press Enter. 'x' indicates I0 Modules have been previously generated.
I0 Parm Block Prefix . . ASG
FD Name ENTRY Name
_  ACCT-FILE ACCTOFIL
_  ACTION-FILE ACTIONGF
_ EXCEPTION-FILE EXCEPTIO
TRAN-FILE TRANGFIL

3K KK KK OK 3K KK KK K KOKOKCKOK KK KRR K KX BOTTOM OF DATA K 50K K K K K K K K K 5K K K K K K K K KK KKK KK
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Verify the Encore-generated prefix to the IO Parm block that is created in the
LINKAGE section, to select one or more FD names, and to verify the ENTRY names
that are used in the generated CALL to the selected files. You can use the
Encore-generated prefix and ENTRY name, or assign your own by typing over the
respective fields.

Note:

An asterisk (*) next to the FD name signifies that an IO module has been previously
generated for that file.

Press Enter to display the Generate - Specify Perform Range CALL Names pop-up,
as show in Figure 102.

Figure 102 « Generate - Specify Perform Range CALL Names Pop-up

Generate - Specify Perform Range CALL Names
Command ===> Scroll ===> CSR

The complement module includes CALLs to extracted PERFORM Rangel(s). Type
the PROGRAM-ID or ENTRY Names of the programs to be CALLed. When complete
press Enter.

Program ID ENTRY Name PERFORM Range Name

32K K KK K OK K K KKK KK KKK KRR KX TOP OF DATEA K %K 50K K % K 3K K K K K K K K KK X K KK K K KKK X

PROGENT1 ACCT-MAINTENANCE THRU ACCT-MAINTENANCE-EXIT
PROGENT2 CLOSE-PGM
PROGENT3 CLOSE-FILES

KKK K K K K K KK K KKK KK KKK IOCRK K. BOTTOM OF DATR 50K 5 K K 3 X 3K K K K K K K K K K X 3K K K % X K K X X

The Complement Module includes CALLSs to extracted PERFORM Range(s). If not
automatically displayed, you need to specify the ENTRY name of the program to be
CALLed.

In the ENTRY Name field for the Perform Range, enter a name for the program to
be CALLed, if needed.
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8  Press Enter to accept the name and press Enter again to generate the module.

When Encore generates the module, it substitutes CALLSs to the IO module(s)
selected in the Select FD Names pop-up.

The CALLs to the selected 10 module are shown in Figure 103.

Figure 103 « Encore-Generated CALLs to IO Module

A3G-Encore EDIT - USERID.ENCEXEXX.COEOL COLTUMNS 0001 00072
Command ===> Seroll ===»> CSR
00a3 68 CALL “ACCTOFILY U3IING VIA-IOELOCEK, ACCT-RECORD

oo0os3es * AZG-ENCOREEND IS0 3THT
aoosvo COPEN INPUT TRAN-FILE

ooo37l QOUTPUT ACTICN-FILE.

a0o37v7e

Q00373

000374

oo0a3v?s VIAGEN-PROGENT1 SECTICHN.

aoa3ve

aoosT?? CALL ‘*PROGENT1* UIING

ao0as3vs TRAN-FILE-FLAG

aoosve INTEREST-RATE

aoo3sn DAT3-IN-FERIOD

0o0o3s1 DAT3-IN-YELR

00352 WORK-ACTICHN-EEASCH

000353 ACCT-IO-COUNT

000354 TELAN-CHT

000385 EX-RPT-LINE-CHNT

000386 EX-RPT-PALGE-CNT

aoa3s? ACTION-CHNT

000388 WORK-RETURN-CODE

ao0o3ss TCDAY-DATE

9 Press PF3 until you return to the Encore Primary screen.

At some point, it becomes necessary to generate the IO module that is CALLed by
the CALLable submodule generated in the previous steps. There is no required
sequence for creating the IO module or the CALLing module. The only requirement
is that the IO module Program-ID be the same as the CALL Name assigned on the
Select FD Names pop-up.

118



4 Perform Range Extract

Generating the 10 Module

The 10 module supports physical sequential, VSAM sequential, VSAM relative, and
VSAM indexed files. All variations of 10 statements for these files are supported,
including declaratives. RD, SD, and CD files are not supported. It is not necessary to
perform an extract prior to generating an IO module, however, an analyzed program must
be opened.

To generate an 10 module

1 Select Generate » File IO module to display the Generate - FD Name List pop-up, as
show in Figure 104.

This pop-up is used to select the file to be used in the IO module. All FD names
defined in the program are listed in the column labeled FD Name. An asterisk to the
left of the FD name indicates that an IO module has been previously generated for
this FD. Information about each file is listed on the pop-up, such as access method,
organization, number of READs to the file, and number of WRITEs to the file.

Figure 104 « Generate FD Name List Pop-up

Generate = FD Mame List 4 FD NAMES
Command ===3 Screll ===} CSR

Select the nam= of the FO far the I0 module generation.  Then press Enter.
'*' indicates names have been previously generated.

FIr Hame Access Organization READs WRITEs
ACCT-FILE I/70 IMDEXED 1 1
ACTIDN-FILE OUTPUT  SEQUENTIAL 1] 1
= ENCEPTIOH-FILE QUTPUT  SEQUENTIAL ] 4
TRAN-FILE ITHFUT  SEQUENWTIAL 1 [}

EREEMEE KA MEAAERRRETERAMER KARER K BOTTOM QF DATH SEsXss xsm ¥ EFaEf EAMNF KEMEFXF

2  Type S next to the FD name to be selected. Only one FD can be selected per IO
module. Press Enter to display the Generate - IO Module pop-up (see Figure 105 on
page 120).
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3 Press Enter to display the Generate - IO Module pop-up, as show in Figure 105, and
generate the IO module.

4  Verify that the Program ID matches the ENTRY name assigned to the CALL to this
module.

Figure 105 « Generate - 10 Module Pop-up

File View Extract Generate Search List Options Help
Generate - I0 Module m: VIARDEMO

Type Program ID and I0 Module Options. Then press Enter.
KK OK KK KK

Selected FD Name . . . : EXCEPTION-FILE KKK KKK
Program ID . . . . . . . EXCEPTIO
I0 Parm Block Prefix . . ASG
R K K
Options KKK
/ Display EDIT Options XK X
Output to Existing Library xX

ASG40291 DEFAULT PROGRAM ID VALUE ASSIGNED. YERIFY AND CHANGE IF
NECESSARY .

Visit the ASG Support Web Site at www.asg.com

Once the 10 module has been created, as show in Figure 106, you have the option
of saving it using the CREATE command (for an example, see step 9 on page 108).

5  Press PF3 until you return to the Encore Primary screen.

Figure 106 « Generated 10 Module Screen

LSG-ESW - COBOL EDIT - USERID.ENCXXXXX.COBOL COLUMNS 00001 00072
Command ===> Seroll ===»> CSR
FTEEFTT AR F AT T AN T AL TANTEANTAANNANLS TDp of Data FFFEEEEEEEEEEEEEEEEEEEEENNNLLS
Qoooo1 o o o o o o o o o o o o o o o o o o ol o o o o o o o o o
Qooooz * *
Qoooo0s * A5G, INC.

Qooo04 * *
ooooos * GENERATED BY ASG-ENCCRE RELEASE 6.0(000) *
oooooe * *
Qoooow? * *
Qoooos * DATE: DD-MMM-YYYY HH:MM:33 *
Qoooos * REQUESTOR: USERID *
ooooio * *
oooo1l * FD: EXCEPTICHN-FILE *
ooooiz * *
Qooo13 * AKR INFORMATION *
oooo14 * DS MNAME: USERID.TEST. AKR *
oooo1ls * HEMEER: VIARDEMO ALTIALS: (NONE) *
oooole * *
Qooo17 o o o o o o o o o o o o o o o o o o ol o o o o o o o o o
oooois *

oooois * #%* NOTEZ, COMMENTS, HMEISAGES *+%
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4 Perform Range Extract

Perform Range Extract Compilation Issues

When Encore generates CALLable modules from a Perform Range extract, certain
conditions may occur that cause compile errors or cause the program not to run at all. As
shown in this section, Encore inserts comment messages in the generated modules when
these conditions occur.

Condition 1

Encore-generated CALLs from the Complement Module to the extracted module.

The Complement Module produced for None.
a Perform Range objective contains
Encore-generated CALLs to the

extracted module.

Condition 2

Encore generated a CALL that replaced a PERFORM VARYING construct.

Cause Action

A PERFORM with the VARYING or If the replaced PERFORM used the
TIMES option cannot be replaced by a ~ VARYING option, verify or alter

CALL statement. In this case, Encore SECTION name or the extracted module.
generates a SECTION to contain the

generated CALL, and PERFORMs that

SECTION using the original VARYING

or TIMES option.
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Example - Condition 2

If the generated submodule was originally PERFORMed by the Complement Module
using the VARYING or TIMES option, Encore cannot replace the PERFORM with a
CALL. Instead, Encore creates a SECTION to contain the generated CALL and
PERFORMSs that SECTION using the original VARYING or TIMES option. Figure 107
shows the PERFORM VARYING option to an extracted subroutine in the original
program.

Figure 107 « PERFORM VARYING Example 1

000371

00037z GET-HNIM-0F-DATS.

000373 *

000375 ACCEPT TODAY-DATE FROIN DATE.

000376

000377 COMPUTE DAYS-IN-PERIOD =

000378 MONTH (TODAY-DD) - TODAY-DD.
000379 MOVE +0 TO DAYS-IN-YELR.

000380 PERFOBRM SUM-TOTAL-DAYS

000381 VARYTHG YOFE-CHT FROM 1 BY 1

000382 UHTIL TODAY-DD} = WORK-CHT.

Figure 108 shows the message created by Encore in the Complement Module.

Figure 108 « PERFORM VARYING Example 2

000023 * 2. A FROGERAM SECTIOH HAS BEEH GEHERATED FOR CALLING EACH
000029 * EXTRACTED PFERFORM BAHGE THAT HAS PERFOBPMED USIHG THE
000030 * *VARYTHG' OPTIOH. EXAMINE EACH SECTION TO DETERMIHE
000031 * IF THE VARIED DATA ITEM IS HAHDLED APPROFPRIATELY .
o003z
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4 Perform Range Extract

Figure 109 shows the PERFORM - VARYING to the SECTION generated by Encore.

Figure 109 « PERFORM VARYING Example 3

oon3ave GET-NUM-0F-DAYS.

o003 *

oo0374a ACCEPT TODAY-DATE FROM DATE.

oo037s

oo03ve COMFUTE DAYS-IN-FPERIOD =

o007y HONTH (TODAY-DD) - TODAY DD.
oo037s HOVE +0 TO DAYS-IN-YEAR.

ooo37s * ASG-ENCORE - FERFORH
000350 PERFORM ASGGEN-VIARRDEMY

oon3sl VARYTHG WORK-CHT FROM 1 BY 1
000352 UHTIL TODAY-DD = WORK-CHT.
000383 *

oo03s4 ASGGEN—VIARDEMY SECTIOH.

000385

000380 CALL *VARDEMY’ USIHG&

000387 DAY S-TH-YERR

000353 WORE-CHT .

000359

000390 AS GGEN—VIARDEMV-EXIT.

000391 EXIT.

oo03ez

o033

oonzed * #x*x% END OF ASG-ENCORE GENERATED MODULE, *++#%*
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Condition 3

An unnamed 01 level data item, moved from WORKING-STORAGE to LINKAGE,
must be assigned a valid COBOL data item name.

e Anunnamed 01 level was moved  Agsign a valid COBOL data item name to

to the LINKAGE SECTION. each LINKAGE SECTION data item with
When Encore generated the the name ' FILLER'.
LINKAGE SECTION for a

subprogram, it did not rename data
items that were moved from the
WORKING-STORAGE
SECTION.

o COBOL syntax allows a
nonreferenced 01 level data item to
go unnamed in
WORKING-STORAGE, butnot in
LINKAGE.

o Encore assigns the name
' FILLER' to the data item and
issues this message. The
subprogram cannot successfully
compile until the data item is given
a valid name.

. A similar situation occurs when
two 01 levels are defined with the
same name and are not referenced
at the 01 level. In this case, the
compiler detects a duplicate name.
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4 Perform Range Extract

An unnamed 01 level data item is contained in the USING list of an Encore-generated
CALL from the Complement Module to the extracted module.

e Anunnamed 01 level was moved  Agsign a valid COBOL data item name to

to the LINKAGE SECTION.
When Encore generated the
LINKAGE SECTION for a
subprogram, it did not rename data
items that were moved from the
WORKING-STORAGE
SECTION.

o COBOL syntax allows a
nonreferenced 01 level data item to
go unnamed in
WORKING-STORAGE, butnot in
LINKAGE.

o Encore assigns the name
' FILLER' to the data item and
issues this message. The
subprogram cannot successfully
compile until the data item is given
a valid name.

. A similar situation occurs when
two 01 levels are defined with the
same name and are not referenced
at the 01 level. In this case, the
compiler detects a duplicate name.

each generated CALL USING entry with
the name ' FILLER'.

Condition 5

Encore-generated statements that cause normal exits from the program.

Encore generates program exit
statements (STOP RUN, GOBACK,
EXEC CICS RETURN) to ensure that
the program exits properly. A normal
program exit is generated when the
intended function of the program is
complete.

Review the conditions surrounding each
generated exit statement to determine if
the default exit statement should be
augmented or replaced.
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Condition 6

Encore has determined that a COPY statement cannot be used. Portions of the copybook
are reproduced inline.

* Ugd?r certain conditions, the Determine why the COPY member was
original COPY statement cannot  notusable. No action is required, however,
be used in a generated module. the COPY member contents may be

) modified in order to use it in this context.
. When data elements in the COPY

statement contain definitions split

between WORKING STORAGE A copybook contains both FD and data
and LINKAGE sections item definitions. One or more of the data

item definitions must be used in the
. When COPY statements contain LINKAGE SECTION.
dead code.

. ‘When the contents of a COPY
statement used in the LINKAGE
SECTION contain the VALUE
clause.

Example:

o In addition to this message, Encore
generates comments indicating
why the COPY statement could
not be used as originally coded.

Condition 7

A generated subprogram references a file, but not all of the references to that file are
contained within the subprogram. COBOL does not support file references across
program boundaries.

If the Perform Range code contains some Consider regenerating the module with the
references to a file, but does not contain CALLs to IO Module option on the

all references to it, this message is Generate - COBOL Module pop-up (see
generated. Figure 88 on page 106).
Example:

One Perform Range opens FILE-X, a
second Perform Range reads FILE-X, and
a third Perform Range closes FILE-X. If
the Logic Segment fails to select all three
Perform Ranges, this message is
generated.
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4 Perform Range Extract

Condition 8

Encore has generated ENTRY statements to provide alternate entries into a subprogram.

Cause Action

When multiple Perform Ranges are None, information only message.
selected for the Perform Range objective,
each Perform Range is assumed to be a
separate ENTRY of the generated
module. This message is produced to
document the generation of multiple
ENTRY statements. Each ENTRY was
assigned a name from the

Generate - Specify Perform Range Entry
Names pop-up (see Figure 89 on page
107).

Condition 9

Encore has generated the following variables to pass INDEX values between
subprograms. Verify that appropriate names have been generated.

Cause Action

The Perform Range requires table index Review the generated SET and 77 level
variables as input parameters. Index statements.

Names are not true COBOL variables,

and their values cannot be communicated

through linkage. To accomplish

execution equivalency, Encore adds

additional code to both the Complement

Module and the submodule.
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Complement Module Program Listing

This section shows a Complement Module that was generated from a program that
contained an indexed table. These examples include the Complement Module and the
submodule that remain after the perform extract.

Example 1 - Complement

Figure 110 shows the Encore generated note that describes the variables that have been
generated for the Complement Module.

Figure 110 « Compliment Module Note

AIG-ENCORE NOTE: THE FOLLOWING VARIAELES HAVE BEEN
* GENERATED TO PASZ *INDEX’ VALUEZ BETWEEN SUEBPROGRAMI
* VERIFY THAT APPROPRIATE NAMES HAVE BEEEN GENERATED.

Figure 111 shows that Encore created a 77 level variable with a USAGE IS INDEXED
clause. This figure also shows that Encore has set the generated index variable to the local
table index value.

Figure 111 « Complement Module 77 Level Variable & Generated Index Variable

7T AZGRN3-TAELE-INDEX USAGE IS INDEZX.

PROCEDURE DIVISICH.
ACCEPT INFUT-FROCESS-CODE.
HOVE ZEROI TO DATA-TAEBLE.
HOVE 0O TO NUM-ROWI.
SJET TAELE-INDEX TO 1.
FPERFORM LOAD-TAELE THRU LOAD-TAELE-EXIT.
ZET TAELE-INDEX TO 1.
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Figure 112 shows that Encore CALLs the submodule and passes the table along with the
index variable.

Figure 112 « Complement Module Submodule CALL

CALL “INDEEDEV® TUIING
DATAL-TAELE
ABGRNS-TABELE-INDEX
INFUT-PROCESS-CODE
VALID-ITEM-31

Figure 113 shows that on the return from the CALL, Encore generated a SET statement to
set the value of the table index to the value of the index variable that was passed to the
submodule.

Figure 113 » Encore Generated SET Statement

* ASG-ENCORE-3ET
SET TABELE-INDEX TO ASGRNS-TABELE-INDEX.

PERFORM DIZPLAY-TALELE THRU DISPLAY-TAELE-EXIT.
SITOP RUN

LOAD-TAELE.
ACCEPT INPUT-WAR.
IF INFUT-WALR = 0O, GO T2 LOAD-TAELE-EXIT.
HOVE INPUT-WAR TO TAELE-ENTRY (TABELE-INDEX).
ADD 1 TO NUM-ROWS.
IF NUM-ROWS = 20, GOT O LOAD-TAELE-EXIT.
3ET TABLE-INDEX UP BY 1,
GO TO LOAD-TAELE.
LOAD-TAELE-EXIT.
EXIT.

LIZPLLY-TALELE.
IF VALID-ITEM-3W = ‘¥~
DIZPLLY *PROCE3S CODE IS WALIDS
LDIZPLLY TAELE-ENTRY (TAELE-INDEX)
ELSE
DIZPLLY *PROCE3S CODE INVALIDY.
DIZPLAY-TAELE-EXIT.

* #®*** END OF ASG-ENCORE GEMERATED MODULE. *#%%%
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Example 2 - Submodule
Figure 114 shows the submodule CALLed by the previously listed Complement Module.

Figure 114 « Called Submodule

e i e i i i e e e e e i o e
* GENERATED BY ASG-ENCORE, FRON ASG, INC. *
* *
* PROGRAM: INDEXDEV *
+* *
% DATE: DD-MMM-VY¥Y  HH:MM:SS *
% REQUESTOR: USERID *
* *
* AR INFORMATION *
* DS WAME: USER. TEST. LKR *
* MEMEER: INDEXDEM ALIAS:  {HCHE] *
+* *
% SEGMENT MLME: (UNLSSTGHED ] *
+* *
* OBJECTIVE TYPE: PERFORM RINGE *
* SELECTED NAME: SEARCH-TAELE THRU SEARCH-TAELE-EXIT *
Lo o o o o bl o o ol ol ol ol o i ol o o o il ol o ol o e i ol o o o ol o ol o o o e ok o
* THE FOLLOWING IS A SAMPLE CALL SHOWING INPUTS IND CUTFUTS: *
+* *
% CALL ‘INDEXDEY USING *
* DATL-TABLE << INPUTs> *
* LSGENS-TAELE-INDEX << INPUTs> *
* INPUT-PROCESS-CODE << INPUTs> *
% VAL ID- ITEM-ST << TNPUT>> *
+* *
% LSG-FMCORE NOTES: *
* *
* 1. ‘GOBACK’ WAS INSERTED TO TERMINATE THE *
* PROGRAM MOEMALLY WHEN ITS INTENDED FINCTICH IS CCMPLETED. *
% PLEASE EXALMINE EiCH INSERTICH TO DETERMINE IF THIS ACTICH *
% IS AFPROPRILTE. *
+* *
%+ z. THE LINEAGE SECTICN CONTATNS CNE OR MORE TAELE INDEX *
* MAMES. INDEX MAMES ARE NOT TRUE COBOL VARIABLES, AND *
* THEIF. VALUES ARE NOT COMMUNICATED THROUGH LINKAGE. *
* EXANINE HOW THIS PROGRAM INTERACTS WITH INDEX VALUES. *
e i e i i i e e e e e i o e
IDENTIFICATION DIVISICH.

PROGRAM-ID. TIMDEXDEV.

ENWIRONMENT DIVISION.
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4 Perform Range Extract

Figure 115 shows how the variable passed from the Complement Module that contains

the initial value of the table index is defined in the LINKAGE SECTION.

Figure 115 » Passed LINKAGE SECTION

DATAL DIVISION

LINEAGE JIECTION.

* ASG-ENCORE NOTES:
*
* 1. VALUE CLASES OMITTED FROM LIMNEAGE ARE SHOWN AS COMMENTS.
* 2. USED, MODIFIED AND REFERENCED (USE/MOD) SYMBOLS ARE NOTED.
* 3. ANNOTATED COPYEOOK SYMEOLS ARE REPRODUCED AS COMMENTS.
+
01 DATA TABLE.
05 TABLE-ROWS OCCURS 20 TIMES INDEXED BY TAELE-INDEX.
USE
10 TAELE-ENTRY PIC 999.
* USE
77 INPUT-PROCESS-CODE  PIC 999.
* USE
77  WALID-ITEM-3W PIC X.
* USE

Figure 116 and Figure 117 show how the table index is set to the value passed by the
Complement Module

Figure 116  Table Index Value - 1

* L3G NOTE: THE FOLLOWING WARIABLES HAVE EEEN

* GENERATED TO PA3S “INDEXY WALUES BETWEEN SUBPROGRALMI.
* VERIFY THAT APPROPRIATE NAMES HAWE BEEN GEMNERATED.
7 ASGRNS-TAELE-INDEX USAGE IS INDEX.

PROCEDURE DIVISION USING
DATL-TAELE
ASGRNA-TABELE-INDEX
INFUT-FPROCESZS-CODE
VALID-ITEM-3ZW..

Figure 117 « Table Index Value - 2

* AZG-EMNCORE - 3ET

3ET TABELE-INDEX ToO ASGRMNS-TABELE-INDEX.
PERFORM SEARCH-TAELE THRU SEARCH-TAEBLE-EXIT.
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Figure 118 shows how the index variable is set to the value of the table index, calculated
in paragraph SEARCH-TABLE.

Figure 118 » Index Variable - SEARCH-TABLE

* AIG-ENCORE- 3ET

SET ASGENS-TABELE-INDEX TO TABLE-INDEX.
* AIG-ENCORE - GCEACE
GOBACK.

SEARCH-TAELE.
SEARCH ALL TAELE-ROW3
LT END
MOVE ‘MNf TO VWALID-ITEM-3T
WHEM TABLE-ENTRY (TALELE-IMDEX) = INPUT-PROCESS-CODE
MOVE *YF TO VALID-ITEM-3W.
SEARCH-TABELE-EXEIT.
EXIT.

* *%%%% END OF ASG-ENCORE GENERATED MODULE. FEREEE
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Computation Variable Extract

This chapter contains a practical demonstration of how to perform a Computation
Variable extract to compute the value of a variable, and contains these sections:

Section Page
Introduction 133
The Business Scenario 134
Starting an Encore Session 134
Extracting the Computation Variable 135
Viewing the Logic Segment 140
Saving the Logic Segment 143
Creating Pseudo Source Modules to Change Logic Segment Results 145
Controlling Extract Boundaries 152
Computation Variable Extract Compilation Issues 155

Introduction

This chapter contains a scenario that demonstrates the technique of using a Computation
Variable extract to determine how the value in a variable gets computed.

The Encore demonstration program VIARDEMO is used for the examples in this chapter.
For a partial listing of VIARDEMO, see "The Demonstration Program" on page 49 .
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The Business Scenario

You are a senior programmer at the MIS department at Universal Bank. Accounting asks
you how the Interest Calculation Program (ICP) calculates interest for the different types
of customer accounts. The ICP program has not been looked at in years and you don't
remember the algorithm for calculating the interest.

By doing some preliminary analysis, you determine that the interest calculation variable
is WK-INTEREST. Using Encore, you can identify and select the variable used to
compute the interest and isolate all of the statements that contribute to or influence the
value in that variable. The extract method used to do this is the Computation Variable
extract.

Starting an Encore Session

134

To start the Encore session, you need to access the ESW Primary screen and open the
Encore application.

Note:

Logon procedures and AKR information are unique to your programming environment.
If necessary, contact your systems administrator or your Encore coordinator for the
correct dataset names.

To open Encore
1 Logon to the ESW Primary screen.

2 Select Re-engineer P Program and press Enter to display the Encore Primary screen.

Or

Type EN on the command line and press Enter to display the Encore Primary
screen.

3 Select File » Open and press Enter to display the File - Open Program pop-up.

4  Type the AKR dataset name in the Data Set Name field and VIARDEMO in the
Program Name field and press Enter.

See "Starting an Encore Session" on page 59 for more information.
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Extracting the Computation Variable

To extract a Computation Variable and isolate all associated statements

1 Select Extract » Variable and press Enter to display the Extract - Name Logic
Segment pop-up, as shown in Figure 119.

The Name field contains an Encore generated default name, which can be replaced
if desired. For this example, use the default name
COMPUTATION-VARIABLE-0001.

Figure 119 « Extract - Name Logic Segment Pop-up

File View Extract Generate Search List Options Help

Extract - Name Logic Segment ram: VIARDEMO
Command ===
Type name of logic segment. Then press Enter.
KKK K KK K K
Name . . . COMPUTATION-VARIABLE-0001 XK KKK K KKK
KKK KKK KK K K R KK K K K K XOK KKK KKK KK KKK K KK XK KKK XK KKK K KK
KKK KKK KKK KKK K K K KK K K K K KKK KKK KKK K K K KK K K KKK XK KK KK K KK
KKK X KK KK KKK K KK KK KKK
KKK K KKK KK KKK KKK KK KK L %9
KK KK KK KKK KKK KK KK K KK K KK K K K IR IOK KK KK KK K K K K
K KK XK KK KKK KK KK K OK K K KK K KKK K K K K KKK KK KK KK K KK K K K K

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
¥isit the ASG Support Web Site at www.asg.com
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Press Enter to display the Extract - Data Name List pop-up, as shown in Figure 120.

This pop-up displays the name of all variables in the program. The list can be
scrolled up and down. By default, the data names are displayed in alphabetic
sequence with the name of the group level in which the variable is defined. To sort
the variables in a different order, press PF17.

You can also display the variable name profile instead of the Qualification by
typing 2 in the Data Name Information field.

Figure 120 « Extract - Data Name List Pop-up

Extract - Data Mame List 53 DATA NAMES
Command ===» Scroll ===» C5R

Select Data Hame. Then press Enter to display referencing statements. Use
SO0RT command to order column by walue. Press Enter when complete.

Data Name Information

11, fuatificatiaon

2. Profile

£ - Select ¥ o- Wiaw Saurce U - Unselect

LY Datz Mame Qualification
_ 05 ACCT-AYG-BALAKNCE A1 ACCT-RECORD

0% ACCT-BALANCE 01 ACCT-RECORD

05 ACCT-CONTROL-CADE @1 ACCT-RECORD
_ 05 ACCT-INT-YTD @1 ACCT-RECORD
_ 05 ACCT-INTEREST 01 ACCT-RECORD

77 ACCT-IO-CNT

05 ACCT-KEY 01 ACCT-RECORD

05 ACCT-LAST-UFDATE @1 ACCT-RECORD

PFd=View PFS=Fiilter PFLl7=Sert

Use the Filter option to simplify the variable selection process.

Type Filter on the command line of the Extract - Data Name List pop-up and
press Enter (or press PF5) to display the Extract - Computation Variable Filter
pop-up (see Figure 121 on page 137).
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To shorten the list of selectable variables to those that begin with W, type W* on the
Data Name line, as shown in Figure 121, and press Enter to redisplay the
Extract - Data Name List pop-up.

Figure 121 » Extract - Computation Variable Filter Pop-up

Extract - Computation Yarizsble Filter

Tupe information for filtering Data Yariable Mame lict

Data Mame . . L&

Use Cantext Dptians
1. Heferences _ HAliasing Lewal Humber . . __
2., ls=es

3. Hedifications

COFYEODK Mame
Lirme Harge . .
Lakel Hame .
COBOL Subset

Options
Limit 1o within an existing Segment

PF4=View PFE=Filter FPFl7=Sort

Note:

Use the Limit to within an existing Segment option on the Extract - Computation
Variable Filter pop-up to limit or bound the current extract definition. See
"Extracting Code from an Existing Logic Segment" on page 153 for an example of

how, and when, this option is used.
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After filtering, the Extract - Data Name List pop-up displays all data names
beginning with W, as shown in Figure 122,

Figure 122 « Extract - Data Name List Pop-up After Filtering

Extract - Data Name List 4 DATA MAMEE
Command ===» Scroll === C5R

Select Data Hawe. Then press Enter to display referencing statements. Use
S0RT cammand to arder column by walue. PFress Enter when complete.
Datz Hame Information
1 1. Quatificarion
2. Profile
£ - Select V¥ o- Wieuw Source U - Unselect

LW Data Mame Qualification

5 77 WK-INTEREET
77 WORK-ACTIOM-REASOM
77 WARAK-CHT

_ 77 WORK-RETURN-CODE

sersxEwrsxswxsxawas s xxwxixx BOTTOM OF DATH Sxx® aswad xwaE HEwEE XN REE XEHT

5  Type S on the selection line showing WK-INTEREST and press Enter to display the
Extract - Source Ordered View pop-up (see Figure 123 on page 139).

Note:

If the fully qualified data name is typed in the Data Name field on the

Extract - Computation Variable Filter screen, Figure 122 does not display. The
Encore Primary screen redisplays with the information message ASG42891
VARIABLE (S) "WK-INTEREST" SELECTED. SELECT VIEW OR
GENERATE.
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5 Computation Variable Extract
Type S on lines 303 and 307, as shown in Figure 123, and press Enter. Press Enter
again to redisplay the Extract - Data Name List pop-up (see Figure 124).

This pop-up shows the statements associated with WK-INTEREST.

Figure 123 « Extract - Source Ordered View Pop-up

Extract - Source Drdered View
Command ===¥ _ Scroll ===: C&R

Select statements for Computation Varlakle Extract, press Enter.  Hhen
complete press Enter.
Referenced Data Mama: WK-IWNTEREST

filiasing: YEZ

5 - Select Voo View Source U - Unselect
s 0BA303 COMPUTE WE-INTEREST =
npa3Edq [ACCT-AYE-BALAMCE ¢ DAYS-IN-TEAR] *
[i]¢]ekelal DAYS-IN-PERIOD = VIWTEREST-RATE / 1007,
= 000307 MOYE LIK-INTEREST TO ACGCT-IHTEREST.

EFRFMRFRAMRARTRAAXT RN d Kk x BOTTOM OF DATA sxsmss xsmrs xsMrf XA X RFMERXT

The Extract - Data Name List pop-up redisplays with the WK-INTEREST data name
highlighted.

Figure 124 « Extract Data Name List Pop-up - Variable Name Selected

Extract - Data Hame List
Command === Scroll ===: CSR

Select Data Mame. Then press Enter to display referencing statements., Use
SORT command to order column by walue. Press Enter when complete.
Data Mame Information

1 1. Qualification
2. FPFrofile
S - Select Wo- Wiew Source U - Unselect
LY Data Mame Qualification

TT WK-INTEREST

7T WORK-ACTION-REASON
TT WORK-CHT

TT WORK-RETURM-CODE

EOTTOM OF DATA

ASG4044T COMPUTATION WARIABLE STATEMEMTS SUCCESSFULLY SELECTED. |

Press Enter. The Encore Primary screen displays the message ASG40441
COMPUTATION VARIABLE STATEMENTS SUCCESSFULLY SELECTED,
indicating that the variable was selected.
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Viewing the Logic Segment

140

Viewing the selected Logic Segment allows you to determine how the value of
WK-INTEREST is derived.

To view the Logic Segment

1 Select View P Logic Segment and press Enter to display the View - Select Logic
Segment pop-up, as shown in Figure 125.

This pop-up displays all of the Logic Segments extracted during the current session,
as well as the logic segments that are saved in the AKR. The most recently
extracted Logic Segment is highlighted and preselected for convenience.

Figure 125 « View - Select Logic Segment Pop-up

Yiew - Select Loglc Segment 2 LOGIC SEGMENTS
Comrmand ===3 _ Scroll ===» CER
Z - Gelect
Program Logic Segment Mame Descriptien
5  WIARDEMD COMPUTATION-YARIABLE-OGEL Computation Yariable
WIARDEMD GET-HUH-OF-DAYE CALCULATE MUMBER OF DAYS

st sk K e eesewexewee s QUTTOM OF DATH soesdmsoeme 0wk Kt ws Samiens
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Type 'FIND COMPUTE WK-INTEREST ='on the command line and press Enter
to view the results. Figure 126 shows the Logic Segment extracted for variable
WK-INTEREST. From this segment we can see the algorithm for computing the
account interest, including the component that calculates the interest rate
(INTEREST-RATE / 100).

Figure 126 » Search View - Logic Segment for WK-INTEREST Extraction

Source Vieu Program: VIARDEHD
Command ===X> _ Seroll ===% CER
Qanzas COHFUTE Wk-INTEREST = PATTERN
Qanz0g [ACCT -AYG-BALAKCE / DAYS-IN-YEAR] =

000305 DA¥S-IM-FERIOD = [IWNTEREST-RATE / 1081,

- - - - - - - - - - - - - - - - - 1LINE HDT DIBPLAYED
lalictiig HOVE HK-INTEREST TD ACCT-INTEREST.

e T R R S 16 LINES HOT DIZPLAYED
0o0z224  UPDATE-ACCT-EXIT.

= = " = = = = = = = = = = = = = 33 LINES HOT DISPLAYED
000358  GET-HUH-OF -DAYS.

- - - - - - - - - - - 1LINE NDT DISPLAYED

DO6D ACCERT TODAY-DATE FROM DRTE.
- - - - - - - - - - - - - - - - - 1LINE NOT DISPLAYED
ponzG2 COHPUTE DAYE-IN-PERIOD =
000363 HOMTH [(TODAY-HM] - TODAY-DD.
ulalizai ) HOVE +@ TO DRYS5-IN-YEAR.
DOEES FERFORM EUH-TOTAL-DAYE
DODZ6E YARYING WORK-CHT FROM 1 BY 1

0N3A7 UNTIL TODAY-DD = UORK-CHT, RETURK
- - - - - = - - - - - - - - - - - 1LINE HOT DISPLAVED

To use Logic Segments to discover interest rate values

1

2

Select Search P Data to display the Search - Data Name pop-up.
Type INTEREST-RATE in the Data Name field.
Select All from the Direction option.

Select Mods from the Reference option and press Enter to find the statements that
modify the interest rate. Leave the default values for all other fields.
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The results of the search are displayed in the Source View, as shown in Figure 127.
All statements that modify the interest rate are highlighted. You now know that the
interest rate is controlled by the setting of ACCT-TYPE of ACCT-RECORD.

Figure 127 » Search View - Statements that Modify Interest Rate

File W“iew Ewtract Generate Search List Options Help

Source Yiew Praogram: Y IARDEMD
Command === Scroll ===: CER
QOO27E MOVE CHE-IMTEREST-RATE TO IMTEREST-RATE DATA MOD
GEO2TS ELSE IF ACCT-TYPE OF ACCT-RECORD = "CHE®
QEOZE0 MOVE ZERO TO IMTEREST-RATE DATA MO
ponzal ELSE IF ACCT-TYPE OF ACCT-RECORD = 'MMA’
Qoozez MOVE MMA-IHTEREST-RATE TO IMTEREST-RATE DAETA MO
e alajet=ic] ELSE IF ACCT-TYPE OF ACCT-RECORD = 'Sy’
QEoozed MOVE SAW-IMTEREST-RATE TO INTEREST-RATE. DATA MO
--- - - - - - - - - - - - - - - - - - 1 LIME HOT DISPLAYED
GDOZEE IF ACCT-MULTI-ACCT = 'YVES'
GEO2ET ADD CHE-MULTI-ACCT-RATE TO IMTEREST-RATE DAETA MO
e R B T 2 LIMES MOT DISPLATED
aonz91 IF ACCT-MIM-BALAMCE < FREE-SERWICE-MIN
[ ala)e= el MOYE SERVICE-IMTEREST-RATE TO IMTEREST-RATE DATA MO
T T T I S R B T 2 LIMES MOT DISPLATED
QEOZ9E ELSE
- - - - - MOT DISPLAYED
GIDZE2 C ASGE443I & DATA MOCDS FOUMD FOR IMTEREST-RATE.
QEozE4
QEA3ES DTS- IN-FERIOD # [ IHTEREST-RATE - 1000,
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5 Computation Variable Extract

Saving the Logic Segment

It is not necessary to actually save the Logic Segment for the Computation Variable to
demonstrate this scenario. However, since this computation is essentially a company
business rule, you should save the Logic Segment in the AKR for future reference.

To save the segment
1 Select File » Save segment and press Enter to display the File - Save Logic Segments
pop-up, as shown in Figure 128. This pop-up lists all Logic Segments created during

an Encore session.

Figure 128 « File - Save Logic Segment Pop-up

File - 3ave Logic Segments 1 LOGIC SEGHENTS
Command ===% _ Scroll ===% L[5SR

Select segment to ke Sawed or marked for Eatch computation and press Enter.
Whan celections are complete, press FF3/16[ENDY.

5 - Bawe B - Batch computation
Program Legic Segment Mame Description
=  WIARDEMD COMPUTATION-YARIABLE-OAOL Computation Yariable

EREEMEREENER RN e Nt e HOTTOH OF DRTA el el el Seed Senek o6

2 Type S next to the Logic Segment COMPUTATION-VARIABLE-0001 and press
Enter to display the File - Save Segment pop-up (see Figure 129 on page 144).

Note:

To generate the Logic Segment using a batch job, use the B line command to select
the desired Logic Segment. See the online help for more information about batch
generation.
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3  Onthe File - Save Segment pop-up, type the segment name, a short description, and
if desired, a long description, as shown in Figure 129.

Figure 129 » File - Save Segment Pop-up

File - S3ave Segment
Command === 3croll ===» CSR

Type segment definition information. Then press Enter.

Chijective . - . . ! Cowmputation Wariable
bythor . . . . . . : U3IERID

Created . . . . . : 03-0CT-2000 09:06:11
Mame . . . INTEREST-CALCULATICN

Description INTEREST-CALCULATICN LOGIC SEGMENT

Long Description:
THIZ LOGIC 3EGMENT CONTAINS THE 3TATEMENTS THAT CALCULATE HOW THE INTEREZT
15 CALCULATED.

4  Press Enter to return to the File - Save Logic Segments pop-up where a message
displays in the short message field indicating the segment was successfully added to
the AKR.

5  Press F3 until you return to the Encore Primary screen.

Note:

You can save the Logic Segment under the default name. However, it is
recommended that you save them under meaningful names.
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5 Computation Variable Extract

Creating Pseudo Source Modules to Change Logic Segment

Results

If the program being analyzed contains a CALL to a program that has not been analyzed,
you should consider creating pseudo source to obtain better results in an extracted
program.

Pseudo Source Modules

These conditions may require creating pseudo source for programs that have not been
analyzed:

Encore assumes all parameters are both used and modified. If this is not the case,
then pseudo source should be written.

If the CALLed program is not COBOL.

You choose not to analyze the CALLed program.

The purpose of the pseudo source module is to identify the inputs and outputs of the
CALLed routine. The pseudo source module must be saved in the AKR.

Each CALL statement parameter is input only, output only, or both input and
output.

— Input-only parameters are used but not modified by the CALLed module.
—  Output-only parameters are modified but not used by the CALLed module.

— Input and output parameters are both used and modified by the CALLed
module.

Figure 130 shows an example of a program being re-engineered that contains this
code.

Figure 130 * Creating Pseudo Source Modules - Program Re-engineering Code Example

HOVE O TO PAYHMENT.

MOVE LOAN-AMOUNT TO PARM-1.

CALL “INTEREST’ USING PARM-1, FAYMENT.
DISFLAY PAYMENT

145



ASG-Encore User’s Guide

146

If a Computation Variable extract request is made for the variable PAYMENT at
the DISPLAY statement, you should assume that the preceding CALL statement
and the MOVE LOAN-AMOUNT statement are both required. This assumption
can be made because it appears that the CALL to the INTEREST module is
modifying the PAYMENT parameter. If this assumption is true, the CALL is
required; however, if this assumption is false, the CALL statement is unnecessary
(although the MOVE 0 TO PAYMENT statement would be required).

The report and Computation Variable extract objectives assume that all parameters
are both input and output, which may not always be an accurate assumption. In
some cases, the extract contains more than the minimum set of code because of this
assumption. To obtain completely accurate results, the actual type of each
parameter must be made known to the extract objective process. This can be
accomplished in either of the ways described in these conditions.

o Analyze the CALLed program and save it in the AKR containing the
CALLing program. In some cases, this may not be feasible, e.g., the program
source is not accessible, the program may be so large that sufficient resources
are unavailable, or the program is non-COBOL.

o Write a pseudo source module, identifying the type of each parameter.
Analyze this pseudo source module instead of the actual CALLed program.

See "The Analyze Facility" on page 36 for more information about using Encore to
analyze a program.

Defining precise parameter types in a pseudo source module results in more
accurate extract results for the report and Computation Variable extracts, because
unnecessary code cannot be extracted.

These are the rules for writing pseudo source modules:

. For input parameters, use a MOVE data-item TO ws-data-item
statement; where ws-data-itemis a WORKING-STORAGE data item
that is the same data type as data-item.

. For output parameters, use a MOVE SPACES TO data-item
statement. A MOVE ZEROES statement may be used if appropriate.

o For output parameters that are only possibly modified (as opposed to
definitely modified) by the CALLed routine, code the MOVE SPACES TO
data-item statement in an IF statement that tests a
WORKING-STORAGE data item.

o Code all inputs before outputs. If a data item is both an input and an output,
code it first as an input and then as an output.

. The LINKAGE SECTION declarations should match the declarations in the
calling program.
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Figure 131 and Figure 132 are examples of a program that CALLs a non-COBOL
subroutine that calculates an interest amount, and the pseudo source module that
may be written for that subroutine.

Figure 131 « Program Being Re-engineered

IDENTIFICATION DIVISION.
PROGRAM-ID. WIARDEMO.

DATL DIVIZION.
WORKING-3TORAGE 3ECTION.

T MORE-LOAN FIC 9593,
T WORE-RATE PIC 9599,
7 WORK-AMOTNT PIC 9599,

MOWVE 10000 TO WORK-LOAN.

MOVE 9.5 TO WORE-RATE.

MOVE 10 TO WORK-AMOUNT.

CALL ‘“3UBRTH' UIING WORE-LOAN.
WORK-RATE, WORE-AMOUNT.

DISPLALY WORK-LOAN WORKE-AMOUNT.

Figure 132 « Pseudo Source Module

IDENTIFICATICON DIVIZSION.
PROGREAM-IL. SUEBRTHN.

DATA DIVISICHN.
WORKING-3TCORAGE 3ECTICH.

7 W3-LOAN-AHMT FIC 9933,
T WE-INTEREST-RATE PIC 9993,
LINEAGE SECTICH.

T LOAN-AMOUNT PIC 9933,
77 INTEREST-RATE PIC 9939,
7 INTEREST-AMT PIC 9939,

PROCEDURE DIVISION USING LOAN-AMT.
INTEREST-RATE, INTERE3T-AMT.
*

*INFPUTS
w

HOVE LOMAN-AMT TO W3-LOAN-AMT.

MOVE INTEREIT-RATE TO W3-INTEREST-RATE.
*

*OUTPUTS

*
MCVE ZEROES TO INTEREST-AMT.
GOBACK.

In Figure 132, the pseudo source subroutine SUBRTN contains these three
parameters:

. LOAN-AMT
J INTEREST-RATE
. INTEREST-AMT
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Scenario 1

Scenario 2

148

The first MOVE statement of the pseudo source module specifies a use of
LOAN-AMT, indicating that LOAN-AMT is an input parameter.

The second MOVE statement indicates that INTEREST-RATE is also an input
parameter.

The third MOVE statement specifies a modification to INTEREST-AMT,
indicating that it is an output parameter.

Given that the report and Computation Variable extract objectives assume that all
parameters are both input and output, these scenarios explain the example (see the
code of the program being re-engineered in Figure 131 on page 147 and Figure 132

on page 147):

A Computation Variable extract is performed for the variable WORK-AMOUNT at
the DISPLAY statement.

o Without a pseudo source module, the MOVE 10 TO WORK-AMOUNT
statement would be extracted because it is assumed that WORK-AMOUNT is
both input and output.

e  With a pseudo source module, the MOVE statement would not be extracted.

A Computation Variable extract is performed for the variable WORK-LOAN at the
DISPLAY statement.

o Without a pseudo source module, the CALL statement would be extracted.

e  With a pseudo source module, the CALL statement would not be extracted.
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Including Non-selected Code in the Logic Segment

Under certain conditions, Encore produces a result that does not include all required code.
In Figure 133, assuming that only the READ statement was determined to be part of the
result, Encore would not have extracted line 250 (ADD +1 TO TRAN-CNT).

Figure 133 » Logic Segment Non-selected Code Example

ooo24z

B00242 ACCT -MATHTENANCE.

B0oZd44

eliajel) READ TRAW-FILE

Bio2ag AT EMD

ooo247 MOVE EOF-LITERAL TD TRAW-FILE-FLAG
Qo248 GO TO ACLT-HAINTENAMCE-EXIT .
Q0oz43

ANA2EA aoD +1 TO TRAMW-CNT.

ooo2sL

BOE262 MOYE TRAM-ACLCT-KEY TU ACCT-KEY.
[eli]edone]

a00254 READ ACCT-FILE EEY IS5 ACCT-KEY

For Computational Variable extracts, Encore allows for the inclusion of omitted lines of
code from the resulting Logic Segment.

1 Select View » Logic Segment and press Enter to display the View - Select Logic
Segment pop-up, as shown in Figure 134.

Figure 134 « View - Select Logic Segment Pop-up

Yiew - Select Logic Segment 2 LOGIC SEGHENTS
Command ===% Sorall ===% L[5SR
% - Select
Program Logic Segment Mame Description
WIARDEMD GET-NUH-0OF-DAYS CALCULATE MUHEEE OF DAYS
S WIARDEMD INTEREST-CALCULATION IMTEREST -CALCULATION LOGIC 5EG

doob S0k doemckok 0wt sk waot ekt ok QOTTOH OF DIETE  #oe ook sk s 008 80k 500 0030k 3000 000k 3000

2 Type S next to the Logic Segment you saved in the last exercise and press Enter to
display the Source View screen (see Figure 135 on page 150).
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3  Type LOCATE 243 onthe command line and press Enter to position line 243 at the
top of the screen, as shown in Figure 135.
Figure 135 « Expanded Source View Screen - Zoom In Command
Source Yiew Program: YIARDEMO
Command ===> Scroll ===> CSR
000243 _ACCT-MAINTENANCE. LOGICSEG
-~ - - - - - - - - - - - - - - - - 1 LINE NOT DISPLAYED
000245 READ TRAN-FILE LOGICSEG
000246 AT END LOGICSEG
000247 MOVE EOF-LITERAL TO TRAN-FILE-FLAG LOGICSEG
000248 GO TO ACCT-MAINTENANCE-EXIT. LOGICSEG
- - - - - - - - - - - - - - - - 3LINES NOT DISPLAYED
000252 MOVE TRAN-ACCT-KEY TO ACCT-KEY. LOGICSEG
- - - - - - - - - - - - - - - - - 1LINE NOT DISPLAYED
000254 RERD ACCT-FILE KEY IS ACCT-KEY LOGICSEG
000255 INVALID KEY LOGICSEG
- - - - - - - - - - - - - - - - 3LINES NOT DISPLAYED
000259 MOVE +4 TO WORK-RETURN-CODE LOGICSEG
000260 GO TO ACCT-MAINTENANCE-EXIT. LOGICSEG
- - - - - - - - - - - - - - - - 3LINES NOT DISPLAYED
000264 PERFORM UPDATE-ACCT THRU UPDATE-ACCT-EXIT. LOGICSEG
- - - - - - - - - - - - - - - - 4 LINES NOT DISPLAYED
000269 ACCT-MAINTENANCE-EXIT. LOGICSEG
- - - - - - - - - - - - - - - - 3LINES NOT DISPLAYED
4  Place the cursor immediately below line 248 and press PF4 (Zoom in) to expand the

view to include non-selected lines, as shown in Figure 136.

Notice that the expanded lines (249 - 251) are not part of the Logic Segment. They
are not highlighted and they have not been tagged with LOGICSEG.

Figure 136 « Expanded Source View Screen - Zoom In Results

Source Wiew 2 DETRIL LIHES

4 LIMEE

Command ===> Scroll ===» C5R
Gd0zAa% ACCT-MAINTENAMCE. LOGICSEG
- - - - - = = - - - - - - - = - - 1 LINE NOT DISPLAYED
QO0245 READ TRAM-FILE LOGICSEG
BO0246 AT ENO LOGICSEG
aap247 MOVE EOF-LITERAL TO TRAN-FILE-FLAG LOGICBER
Qd0zZ4E GO TO ACCT-MAINTENAMCE-EXIT. LAOGICSEG
ao0zdg
o258 AlD  +1 TO THAN=CHT,
AO0ZE51
Ba0252 HOVE TRAM-ACCT-KEY TO ACCT-KEY. LOGICSER
- - - - - = = - - - - - - - = - - 1 LINE NOT DISPLAYED
QO0254 READ ACCT-FILE  KEY IS RACCT-KEY LOGICSEG
00255 IHWALID KEY LOGICSEG
R - R T T B TR S 4 LIMES WOT DISPLAYED
aadnDze= MOYE +d TO WAORK-RETURN-CODE LOGICSEG
BODZER GO TO ACCT-MAINTEMANCE-EXIT. LOGICSEG
T T 3 LINES HOT DISPLAYED
Q00264 PERFORM UPDATE-ACCT THRU UPDATE-ACCT-EXIT. LOGICSEG

NOT DISPLAYED

150




5 Computation Variable Extract

5  Type I on line 250 and press Enter, as shown in Figure 137.

Figure 137 » Including Source Line in Logic Segment

Source Wieu 3 DETRIL LIMES
Command ===% Scroll ===% C5R
Q00245 RCCT-MAINTEMANMCE. LOGICSEG
- - - - - - - - - - - = = - - - - 1 LIHE HOT CISPLAYED
Gi0zas READ TRAMW-FILE LOGICSEG
Ea0zZa6 AT EHD LOGICEEGR
Qooz247 MOYE EQF-LITERAL TO TAAM-FILE-FLAG LOGICSEG
go024s GO TO ACCT-MAINTEHANMGE-EXIT. LOGICSEG
[an2a8
QIDZED ADD  +1 TO TRAMN-CHT.
BO0z61
Qo02e2 HOYE TRAW=-ACCT=KEY TO ACCT=KEY. LOGICSEG
- - - - - - - - - - - - - - = = - L LIHE NOT DISPLAYED
Ei0254 READ ACCT-FILE KEY IS ACCT-KEY LOGICSEG
Gl0zEs INVALID KEY LOGICSEG
- - - - = - - - - = - = - - - - 3 LINES HOT DISPLAYED
Qo0z59 MOYE =4 TO WORE-RETURK-CODE LOGICSEG
GO02E0 GO TO ACCT-MAIMTEWEMCE-EXIT. LOGICSES
- - - - = - - - - = - = - - - - d LINEE NOT DISPLAYED
[elulwied i PERFOAM UPDATE-ACCT THAU UPDATE-ACCT-EXIT. LOGICSEG
- - - - = - - - - = - = - - - - 4 LINES HOT DISPLAYED

Figure 138 shows that the Source code at line 250 is highlighted and has been
included in the Logic Segment.

Figure 138 * Source Line Included in Logic Segment

Bource Vieu Fragram: WIARDEHD
Cammand ===7% Scroll ===% C3R
Q00245 RCCT-MAINTEMAMCE. LOGICSEG
- - - - - - - - - - - = - - - - - 1LINE HOT CISPLRYED
Gi0zas READ TRAMW-FILE LOGICSEG
Ea0zZa6 AT EHD LOGICSEG
Qooz247 MOYE EQF-LITERAL TO TAAWN-FILE-FLAG LOGICSEG
go024s GO TO ACCT-MAINTEHANMGE-EXRIT. LOGICSEG
[an2a8
oapzsop HDD +1 TO TRAN-CHT.
BO0z61
Qo02e2 HOVE TRAW=-ACCT=-KEY TO ACCT=KEY. LOGICSEG
- - - - - - - - - - - - - - = = - L LINE HOT DISPLAYED
Ei0254 READ ACCT-FILE KEY IS ACCT-KEY LOGICSEG
Gl0zEs INVALID KEY LOGICSEG
- - - - = - - - - = - = - - - - 3 LINES HOT DISPLRYED
Qo0z59 MOYE +4 TO WORE-RETURK-CODE LOGICSEG
GO02E0 GO TO ACCT-MAIMTEWRMLCE-EXIT. LOGICSEG
- - - - = - - - - = - = - - - - 3 LINEE NOT DIEPLAYED
[elulwied i PERFOAM UPDATE-ACCT THAW UPDATE-ACCT-EXIT. LOGICSEG
- - - - = - - - - = - = - - - - 4 LINES HOT DISPLAYED

Because the Logic Segment has been changed, you must save the file before
returning to the Encore Primary screen.

6  SelectFile P Save Segment and press Enter to display the File - Save Logic Segments
pop-up.
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7  Type S next to the Logic Segment to be saved and press Enter to display the
File - Save Segment pop-up. Type the appropriate descriptive information and press
Enter to return to the File - Save Logic Segments pop-up. Press PF3 until you return
to the Encore Primary screen.

Note:

In addition to including the identified statement, Encore ensures that all of the code
necessary to execute the statement is also included in the generated module.

Controlling Extract Boundaries

152

There are instances when each extract objective gives you more code than you want, e.g.,
a program processes multiple transactions. In these instances, you need to be able to
specify the extract boundaries to better control the amount of extractable code.

In this example, you want to extract all of the compute statements for a variable
associated with a particular transaction type and generate a CALLable module. First, you
need to assess which type of extract you should use by considering these options:

J A Perform Range extracts the desired statements mentioned in the example,
however, it also extracts all statements that can be executed by the Perform
statement, including other Perform Ranges and GO TOs.

o A Transaction extract with altered START and END points cannot sufficiently
narrow the scope of the extract unless the statements are adjacent.

) A Report extract isolates the output statements required, however, it also extracts all
contributing or influencing statements from the selected statements to the beginning
of the program, giving you extra code that is not required. Also, the Report extract
does not generate CALLable modules.

J A Computation Variable extract isolates the compute statements for the variable
mentioned in the example. It also extracts all contributing or influencing statements
from the compute statement selected, to the beginning of the program, again
selecting extra statements that are not required. As with the Report extract, it does
not generate CALLable modules.

The Computation Variable extract objective has an option that allows you to extract code
from an existing Perform Range or Transaction Logic Segment. Normally, within the
Report and Computation Variable extract objectives, code is extracted from the selected
statements to the beginning of the program. When you perform a Report or Computation
Variable extract from a Logic Segment, the extract boundaries extend from the selected
statements to the beginning of the Logic Segment.



5 Computation Variable Extract

Extracting Code from an Existing Logic Segment

To extract code from an existing Logic Segment

1

Follow the same procedure you perform for a conventional Computation Variable
extract (see "Extracting the Computation Variable" on page 135), with this
exception:

When you select the Filter option on the Extract - Data Name List screen (see
Figure 120 on page 136) and the Extract - Computation Variable Filter pop-up
displays, as shown in Figure 139, select the Limit to within an existing Segment
option by typing a forward slash (/) next to the option. Selecting this option
indicates that the extract is performed against an existing Logic Segment. In
addition to typing data in the various fields as you would for a conventional extract,
use this option to indicate that the extract is to be done within a Logic Segment.

Figure 139 « Selecting the Limit to within an Existing Segment Option

Extract - Computatiam Yariable Filter
S | Type informatien for filtering Data YWariable Mame list.

Data Mame

U=e Camtext - Options
1. Heferences 4 Aliasing Level Numbar .
2, lses

3. Heoaifications

CORYBADK Mame
Line Aange . .
Lakel MName . .
COBOL Subset

Options
A Limit ta within an existing Segment
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Press Enter to display the Select Extract-within Logic Segment pop-up, as shown in
Figure 140.

Select the Logic Segment for code extraction. Only Perform Range or Transaction
Logic Segments are displayed in the list of Logic Segments. Only one Logic

Segment can be selected.

Figure 140 « Select Extract-Within Logic Segment Pop-up

Seplect Ewtract-within Logic Seagment 1 LOGIC SEGHENTS
Command ===» _ Scroll ===>» [ER

Select the Loglc segment which limits or bounds the current Extract
definition. Then press Enter.

5 - Helect
Program Logic Segment Mame Description
WIARDEMD GET-NUH-0OF-DAYS CALCULATE MUHEBER OF DAYES

FREEEERLERERERER e e QOTTOH OF DATA SESS Sl Sl Sl STy 1

Press Enter until you return to the Extract - Data Name List pop-up.

From this point, the extract procedures are the same as for a conventional
Computation Variable extract (see "Extracting the Computation Variable" on page
135). Only those statements that lie within the selected Logic Segment are eligible
for extract.

Note:

If the Logic Segment contains 10 statements, you may want to consider selecting
the CALLS to IO Module(s) option when you generate the program to avoid the
COBOL constraint of referencing files across program boundaries.
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Computation Variable Extract Compilation Issues

When Encore generates CALLable modules from a Computation Variable extract, certain
conditions may occur that cause compile errors or cause the program not to run. As
shown in this section, comment messages are inserted in the generated modules when
these conditions occur:

Condition 1

Encore has generated statements that cause normal exits from the program.

Cause Action

Encore generates program exit Review the conditions surrounding each
statements (GOBACK, EXEC CICS generated exit statement to determine if the
RETURN) to ensure that the program  default exit statement should be augmented
exits properly. or replaced.

Condition 2

Encore has determined that a COPY statement cannot be used. Portions of the copybook
are reproduced inline.

Cause Action

Under certain conditions, the original ~ Determine why the COPY member was not
COPY statement cannot be used ina  usable. No action is required, however, the
generated module, such as when COPY member contents may be modified to
COPY statements contain dead code.  use it in this context.

In addition to this, Encore generates Example:
comments indicating why the COPY
statement could not be used as
originally coded.

A copy book is used in many programs.
Some statements are not referenced in this
program and, therefore, would be
considered dead code.
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Condition 3

Encore has tailored OPEN or CLOSE statements.

Cause Action

Encore ensures that all necessary None.
file-related statements are extracted,

including OPEN statements and

CLOSE statements. When an OPEN or
CLOSE statement includes references

to files that are not required by the

Logic Segment, Encore generates a

partial statement to reference only the

desired files.

Condition 4
STOP RUN in empty Exception clauses (i.e., ON SIZE, ON OVERFLOW)

Cause Action

COBOL does not permit a NEXT Revise to include a more meaningful error
SENTENCE to appear in an exception handling routine.

clause. Encore inserts a STOP RUN in

an exception clause that is part of a

Computation Variable extract.
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Transaction Extract

This chapter contains a practical demonstration of how to perform a Transaction extract
to create a replacement standalone program, and contains these sections:

Section Page
Introduction 157
The Business Scenario 158
Starting an Encore Session 159
Extracting the Objective 160
Creating the Replacement Module 165
Changing the Start/End Points 169
Transaction Extract Compilation Issues 178

Introduction

This chapter contains a scenario that demonstrates the technique of using a Transaction
extract to create a replacement standalone program called INTCALC, which does not
contain processing logic for money market accounts.

The Encore demonstration program VIARDEMO is used for the examples in this chapter.
For a partial listing of VIARDEMO, see "The Demonstration Program" on page 49 .

157



ASG-Encore User’s Guide

The Business Scenario

You have been assigned the task of removing all processing logic for money market
accounts in the Interest Calculation Program (ICP).

After performing your initial analysis, you build a checklist that contains these tasks,
which are involved in extracting the code you require:

) Identify the variable that contains the identifying code for money market accounts.
o Extract all of the logic for money market account processing.

o Generate a replacement module without the money market account processing
logic.

You determine that the money market accounts are identified on the input file by the
MMA code in the data field ACCT-TYPE of ACCT-RECORD. The conditional that
drives the transaction processing is in paragraph UPDATE-ACCT in the VIARDEMO
demonstration program, as shown in Figure 141. Since the logic you need to extract is
driven by the MMA transaction code, you determine that the best extraction method
would be a Transaction extract.

Figure 141 « Money Market Accounting Example

000273 UPDATE-ACCT.

Q00274

000275 PERFORM INIT-ACTION-RECORD.

000276

ooo277 IF ACCT-TYPE OF ACCT-RECORD = 'INT'

000278 MOVE CHE-IHNTEREST-RATE TO0 INTEREST-RATE
000279 ELSE IF ACCT-TYPE OF ACCT-RECORD = 'CHK'
000280 MOVE ZERO TO INTEREST-RATE

000281 ELSE IF ACCT-TYPE OF ACCT-RECORD = 'MMA'
000282 MOVE MMA-IHTEREST-RATE TO IHTEREST-RATE
000283 ELSE IF ACCT-TYPE OF ACCT-RECORD = 'SAW!'
000284 MOVE SAV-IHTEREST-RATE TO IHTEREST-RATE.
000285

000286 IF ACCT-MULTI-ACCT = 'YES'

000287 ADD CHE-MULTI-ACCT-RATE TO INTEREST-RATE
000283 MOVE ACTIOH-MULTI-ACCT TO WORK-ACTIOH-REASOH
000289 PERFORM THITIATE-ACTIOH.

Qaoozs0

Note:
The choice of a particular extract method does not necessarily mean it is the best or only
method. Preliminary analysis helps narrow the available choices. The final choice is up to
you.
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Starting an Encore Session

To start the Encore session

Note:
Logon procedures and AKR information are unique to your programming environment.
If necessary, contact your systems administrator or your Encore coordinator for the
correct dataset names.

1 Logon to the ESW Primary screen.
2 Select Re-engineer P Program and press Enter to display the Encore Primary screen.
Or

Type EN on the command line and press Enter to display the Encore Primary
screen.

3  Select File » Open from the Encore Primary screen action bar and press Enter to
display the File - Open Program pop-up.

4  Type the AKR dataset name in the Data Set Name field and VIARDEMO in the
Program Name field and press Enter.

See "Starting an Encore Session" on page 59 for more information.
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Extracting the Objective

160

To perform a Transaction Extract using the ACCT-TYPE variable

1 Select Extract P Transaction and press Enter to display the Extract - Name Logic
Segment pop-up, as shown in Figure 142.

The Logic Segment Name field contains a default name, generated by Encore for
the Logic Segment that you extract. You can assign your own name to the Logic
Segment or you can use the default name. For this example, use the default name
TRANSACTION-0001.

Figure 142 « Extract - Name Logic Segment Pop-up

File View Extract Generate Search List Options Help

Extract - Name Logic Segment ram: VIARDEMO
Command ===
Type name of logic segment. Then press Enter.
KR KKK OK KK K
Name . . . TRANSACTION-0001_ KK AKX KKK K
R KKK KK KK K KR KK KK KK KK K KKK KR KR KK KK KK X K XK KKK K KKK KR
2K R KKK K K OR KK K OK K K KK X KR X KKK K K OR KR KK K K KK X K KKK X R KKK K KK
KKK XK R K KK KKK K K KKK K KKK
O KOK K OO KK OK KKK K K KKK L+ 3
KKK K KKK KR KR KK K KK KK R KR K OK K OK X AR KKK K KKK KR KK XK R
K KK X KRR ICI KKK KK KKK IOK K OK K KNI K IR K KK KK XK

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Visit the ASG Support Web Site at www.asg.com
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2 Press Enter to display the Extract - Transactions Paths List screen, which lists all
transaction paths in the program, as shown in Figure 144.

Figure 143 « Extract - Transaction Paths List Screen

Extract - Transaction Paths List
Comrmand ===3 Seroll ===» CER

Identify conditionals which are definitely TRUE for the transactian, those
which are definitely FALSE, and leave blank the conditlonals which may be
either TRUE or FAL3E. Then press Enter.

T - TRLE F - FALEGE blanmk - TRUESFALSE ¥ - View Spurce

_ loo2es IF ACCT-MIN-EALANCE I5 LESS THAW ACCT-BALANCE
ngoeT? IF ACCT-TYFE OF ACCT-RECORD = "INWT’

_ dooava ELSE IF AGCT-TYFE OF ACCT-RECORD = "CHK'
opgzal ELSE IF ACCT-T¥FE OF ACCT-RECORD = 'HMA'
ooazEd ELSE IF ACCT-T¥FE OF ACCT-RECORD = 'SAV’

_ NOQ2&6 IF ACCT-HULTI-ACCT = "WES'

_ noozal IF ACCT-MIN-EALAHCE « FREE-SERWICE=MIN

_ Doozgd IF AGCT-HIN-EBALANCE < @
opg3a2 IF EX-RFT-LIME-CNT IS5 GRERTER THAM &0
ooa3E? IF FREE-EERVICE-MIN KOT NUMERIC
1003E4 IF CD-REWIEW-MIN HOT MNUMERIC

PFS=Filter PF&=5tart/End Point

The first step in the process is to filter the transaction lists to select those paths
referencing ACCT-TYPE.
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Type Filter on the command line and press Enter (or press PF5) to display the
Extract - Data Name List Filter pop-up, as shown in Figure 144.

This pop-up displays all the data names associated with the transaction paths that are
listed for the program. You can select a data name from the list, or you can use the
Filter option to reduce the list or select a specific data name. For this exercise, use
the filter option to select the data name ACCT-TYPE.

Figure 144 » Extract - Data Name List Filter Pop-up

Extract - Data MName List Filter 17 DATHA WAHES
Command ===% _ scroll ===> L[3A
Select Data Hamals) for filtering Transaction Fath List, The SORT
command may be used to order Data Names.

Data Mame Information

Qualification

5 - Selact Wo- View Source U - lUrselect

Ly Data MName OQualification

05 ACCT-EALAMCE 01 ACCT-AECDRD
_ 05 ACCT-EEY 01 ACCT-RECORD
_ 05 ACCT=-MIN-BALANCE 01 ACCT-RECORD

0% ACCT-HMULTI-RAGCT 01 ACCT-RECORD

01 ACCT-RECORD

10 ACCT-TYPE 05 ACCT-KEY, 01 ACCT-RECORD
01 EANK-BALANCE

11 ERANCH-BALANCE

PFS=Filter PF17=Saort

Type Filter again on the command line and press Enter (or press PF5) on the
Extract - Data Name List Filter pop-up to display the Extract - Transaction Variable
pop-up (see Figure 145 on page 163).

See the online help for more detailed information about Transaction extract
features.
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Type ACCT-TYPE in the Data Name field to select all transaction paths using this
variable name, as shown in Figure 145.

You can also enter a pattern for the variable name containing wildards (? for one
character; * for zero or more characters) to reduce the list of available selections.

Figure 145 « Extract - Transaction Variable Pop-up

c B e e
Extract - Transaction Variable
S
c Type information for filtering Data Yariable Name list.
Data Name . . ACCT-TYPE
Aliasing Level Number .

COPYBOOK Name
Line Range .
- Label Name .
COBOL Subset COND

_ 05 ACCT-MULTI-ACCT 01 ACCT-RECORD

~ 01 ACCT-RECORD
~ 10 ACCT-TYPE 05 ACCT-KEY, 01 ACCT-RECORD

_ 01 BANK-BALANCE
_ 01 BRANCH-BALANCE

PF5=Filter PF17=Sort
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6  Press Enter to redisplay the Extract - Transaction Paths List screen, as shown in
Figure 146.

This screen redisplays with all paths referencing the variable ACCT-TYPE
highlighted and the message ASG4027I DATA NAME “ACCT-TYPE”
SELECTED in the long message area. You can indicate which conditionals (IF
statements) can be true (T) for the replacement module, which conditionals can be
false (F), and which conditionals can be true or false (blank). For this extract, you
want to remove the logic associated with the MMA transaction code, so the
statement associated with that transaction must be false.

Figure 146 « Extract - Transaction Paths List Screen with Variable Name Selected

Extract - Transaction Faths List
Command ===} Scroll ===: CSR

Identify conditionals which are definitely TRUE for the transaction, those
which are definitely FALSE, and leawe blank the conditionals which may be
either TRUE or FALSE. Then press Enter.

T - TRUE F - FALSE blanl: - TRUE<FALSE Vo= Wiew Source
— BEGZTT IF ACCT-TYPE OF ACCT-RECORD = "IMT®
— BREZTY ELZE IF ACCT-TYPE OF ACCT-RECORD = 'CHE'
F ooozal ELSE IF ACCT-TYPE OF ACCT-RECORD = ‘'HMA*
- DEzEz ELZE IF ACCT-TTYPE OF ACCT-RECORD = "Spd’

EOTTOM OF DATA

ASG4E2TI DATAMAME "ACCT-TYPE" SELECTED. |

7 Type F on line 281, which disables the True path for this conditional in the
replacement module. The remaining IFs for ACCT-TYPE are left blank, since they
can be either true or false. Press Enter.

8 Press Enter twice to return to the Encore Primary screen.
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Creating the Replacement Module

To create the replacement module

1 Select Generate » COBOL module and press Enter to display the Generate - Select
Logic Segment screen, as shown in Figure 147.

This screen lists all of the Logic Segments you have extracted during your current
session, as well as all Logic Segments that have been saved in the AKR. The last
Logic Segment extracted (in this case TRANSACTION-0001) is highlighted and
tagged for selection. TRANSACTION-0001 is the Logic Segment you use to
generate the COBOL program.

Figure 147 « Generate - Select Logic Segment Screen

Generate - Select Logic Segment 2 LOGIC SEGMENTS
Comrmand === _ Bcroll ===» CER
S - Select
Program Logic Segment Hame Descriptien
WIARDEMD GET-HNUH-OF-DAYE CALCULATE MUMHER OF DAYS
S WIARDEMO TRAKWSACTION-BO0L Transactien

e xwswxwwwxwnERrsnEexenEswwwEex BOTTOM OF DATA ®xssss aewsd xrwed xswaE HERNERT

Note:

The Generate - Select Logic Segment pop-up is scrollable, but you must first blank
out the S select code.
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2 Press Enter to display the Generate - COBOL Module pop-up, as shown in
Figure 148.

3 A default name is assigned in the Program ID field on this pop-up, but can be
changed as required. For this example, you need to change the name in the Program
ID field to INTCALC and then press Enter to display the Edit screen, (see Figure 149

on page 167).

Figure 148 « Generate - COBOL Module Pop-up

File View Extract Generate Search List Options Help

Generate - COBOL Module Program: YIARDEMO
C
Type Program ID and select generation options.
KKK KK KK K K KK K K
Objective . . : Transaction KKK KKK KKK KK K
Program ID . . INTCALC_
Options 3K OK KKK KK
CALLs to I0 Module(s) KKK KK KKK
XX
——————————————————————————————————————————————————————— KK X

ASG4312I DEFAULT PROGRAM ID VALUE ASSIGNED. VERIFY, AND CHANGE IF
NECESSARY .

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
¥isit the ASG Support Web Site at www.asg.com
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Type CREATE on the command line and type C 9999 on the first line of code, as
shown in, Figure 149. Press Enter to display the Edit/View - Create screen (see

Figure 150).

Figure 149 » Edit Screen

A%G-Encore EDIT - USERID, ENCXICC, COBOL COLUMNS 00001 00072
Command ===> CREATE docroll ===> C3R

FEFFFH FFEFF A A AT FA ST I T AT AT IS ST A TSNS TDIJ of Data FFFFFFdadd T FEFTHETHRTTENTFTENNTF
C 9999 A R A A RN AT A AN AT E T TR R AN A FF ST AAA AT ASESAANNTHASESSF AN ST
aooanz * A5G, INC. *
ooooos * *
ooooong * GENERATED BY A3G-ENCORE FELEASE &.0(000) *
aooans * *
aooane * PROGRAM: INTCALC *
aooan? * *
aooans * DATE: DD-MMM-YVYY HH:MM: 35S *
aooang + REQUE3TOR: USERID *
oooalo * *
oooall + AFR INFORMATION *
aoonlz * 'S HaME: USERID.TEST. AKR *
aoonls * MEMEER: VIARDEMO ALTAS: (NONE) *
ooool4 * *
oooals +* SEGMENT NAME: TRANSACTION-000L *
oooale * *
aooaL? * OBJECTIVE TYPE: TRANSACTION *
00001 EssssssSssSsSs5s555555335533533355555555535555595555555555333533333333330 w
00001 e A43SG160SI ENTER THE CREATE COMMAND TO SAVE THE COBEOL PROGRAM. e *
00002 [sssss55588555558 55555 3505553585 55555 5555555555 5855555355558 8853s *
ooonzl * START: *

Type the name you want to save the program under (INTCALC in this example),
verify or clear any data in the Data Set Name and Volume Serial fields, and press
Enter to save the member and return to the Edit screen.

Figure 150 « Edit/View - Create Screen

Edit/View - Create
Command ===

"Current” Data Set: USERID.ENCOO0Z7.COEOL

To ISPF Library:

Project . . . USERID
Group . . . . TEIT
Tspe . . . . CHTL
Member . . . INTCALC

To Other Partitioned Data Set HMember:

Data et HName .

Volume Serial . . . [If not cataloged)
Data Set Password . . [If password protected)

Enter "/ to select option
Specify pack option for "CREATE"™ Data 3et

Press ENITER key to create. Enter END command to cancel create.
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Note:
CREATE may be issued only against an empty member. If INTCALC already
exists in your library, use the REPLACE command. See the online help and the
ASG-Encore Reference Guide for more information about these commands.

Figure 151 shows the Encore-generated notes added to the INTCALC standalone
program indicating that STOP-RUN was inserted into the code.

Figure 151 « Encore Blocked False Path - INTCALC - 1

45G-Encore EDIT - T3ERID. ENCXEEE. COBOL COLUMNS 00001 00072
Command ===3 Scroll ===> CSR
000031 * L5G-ENCORE NOTES:
00003z *
000033 % 1. "ATOP RUN™ WAS INSERTED TO ABNORMALLY TERMINATE THE PROGEAM
000034 * FOR CONDITIONS WHICH SHOULD NOT OCCUR. PLEASE EXAMINE EACH
000035 * INSERTION TO DETEEMINE IF THIS ACTION I3 APPROFRIATE.
000036 *

*

000037

Figure 152 show the generated code blocking the false path in the INTCALC
standalone program. This is the result of marking the conditional for

ACCT-TYPE = MMA false. Encore generates a NO PATH and a STOP RUN if the
conditional is ever true, but you may want to change these entries to something
more meaningful.

Figure 152 « Encore Blocked False Path - INTCALC -2

L5G-Encore EDIT - USERID.ENCXZCCI. COBOL COLUMNS 00001 00072
Command === Joroll ===x C3R
ooozs0

oo00z§l PERFOFM INIT-ACTION-RECORD.

000zZ§2

000253 IF ACCT-TYPE OF ACCT-RECORD = 'INT'

ao0zE4 MOVE CHK-INTEREST-RATE TO INTERE3T-RATE

Q00za5s EL3E IF ACCT-TYPE OF ACCT-RECORD = 'CHE'

000286 MOVE ZERO TO INTEREST-RATE

ooozg? ELSE IF ACCT-TYPE OF ACCT-RECORD = 'MML'

000288

ooozgg 5TOP RUN

ooozan * LSG-ENCORE- 5TOP RUN
oooz9l * ASG-ENCORE- NO PATH
ooo0z9z EL3E IF ACCT-TYPE OF ACCT-RECORD = '34V'

o00z9s MOVE SAV-INTEREST-RATE TO INTEREST-FATE.

ooo0zad

Note:

Rather than having Encore display an error message, you can direct Encore to issue
a CALL to your shop standard error abend program (if you have one) by specifying
the name of your abend program on the Options - Product Parameters pop-up (see
Figure 7 on page 27).
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To close Encore
1 Press PF3 until you are returned to the Encore Primary screen.
2 Select File P Close and press Enter to display the Close Program pop-up.

3 Select Close, discard segments. All unsaved Logic Segments are discarded when you
exit Encore by selecting the Exit option. For this exercise, you do not need to save
any generated data.

Note:

The Exit pop-up displays if you attempt to exit Encore using PF3. From this
pop-up, options are available to save logic segments, discard logic segments, or
cancel the exit and return to Encore.

Changing the Start/End Points

The default START statement is the PROCEDURE DIVISION statement. The default
END statements are all program exits. If the default START and END statements are not
valid for the extract to be performed, they can be changed.

After initiating Encore and opening program VIARDEMO (see "Starting an Encore
Session" on page 159), use these steps to change the default START and END points.

To change START and END point defaults

1 Select Extract » Transaction and then press Enter to display the Extract - Name
Logic Segment pop-up.
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Press Enter again to display the Extract - Transactions Path List pop-up, as shown in
Figure 153.

Figure 153 « Extract - Transaction Paths List Pop-up

Extract - Transaction Paths List
Comrmand ===3 Seroll ===» CER

Identify conditionals which are definitely TRUE for the transactian, those
which are definitely FALSE, and leave blank the conditlonals which may be
either TRUE or FAL3E. Then press Enter.

T - TRLE F - FALEGE blanmk - TRUESFALSE ¥ - View Spurce

_ loo2es IF ACCT-MIN-EALANCE I5 LESS THAW ACCT-BALANCE
ngoeT? IF ACCT-TYFE OF ACCT-RECORD = "INWT’

_ dooava ELSE IF AGCT-TYFE OF ACCT-RECORD = "CHK'
opgzal ELSE IF ACCT-T¥FE OF ACCT-RECORD = 'HMA'
ooazEd ELSE IF ACCT-T¥FE OF ACCT-RECORD = 'SAV’

_ NOQ2&6 IF ACCT-HULTI-ACCT = "WES'

_ noozal IF ACCT-MIN-EALAHCE « FREE-SERWICE=MIN

_ Doozgd IF AGCT-HIN-EBALANCE < @
opg3a2 IF EX-RFT-LIME-CNT IS5 GRERTER THAM &0
ooa3E? IF FREE-EERVICE-MIN KOT NUMERIC
1003E4 IF CD-REWIEW-MIN HOT MNUMERIC

PFS=Filter PF&=5tart/End Point

Press PF6 to display the Extract - START/END Statements pop-up, as shown in
Figure 154.

Figure 154 « Extract - START/END Statements Pop-up - Deselect START and END Points

Extract - START/END Statements
Command ===> _ Scroll ===> CSR

Select start and end statement(s] for transaction. MWhen complete press
Enter.

1 - List START/ENDI(s) 2 - List All statements
S - Select START E - Select END(s) U - Unselect V - View Source
u 000225 PROCEDURE DIVISION USING CONTROL-PARAMETERS, BRANCH-BALANCE START
u 000226 BANK-BALANCE . START
u 000240 GOBACK. END

KKK KK KKK KK KK KK KKK X CKOCKR KR KK BOTTOM OF DATA 0K 5% %K 5K 5 X K K K K K K K K K X K KK KK KK X X

Type U on lines 225, 226, and 240 and press Enter to de-select the current START
and END points.
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Figure 155 shows the Extract - START/END Statements pop-up redisplayed with
the message NO STARTING STATEMENT in the upper right corner of the screen.

Figure 155 « Extract - START/END Statements Pop-up - Information Message Display

Extract - START/END Stateme NO STARTING STATEMENT
Command ===> Scroll ===> CSR

Select start and end statement(s) for transaction. When complete press
Enter.

1 - List START/END (s) 2 - List All statements
S - Select START E - Select END(s) U - Unselect ¥ - View Source
_ 000225 PROCEDURE DIVYISION USING CONTROL-PARAMETERS, BRANCH-BALANCE ENTRY
_ Doo226 BANK-BALANCE . ENTRY
_ DoD240 GOBACK. EXIT

3K 3K K 3K K K KK KKK KKK KKK KR KKK KKK KRR KK BOTTOM OF DATA KKK KKK K K K KK K K K K K K K K K KK KK KKK

Type 2 on the command line, as shown in Figure 156, and press Enter to expand the
display to include all the Procedure Division statements (see Figure 157 on page
172).

Figure 156 « Extract - START/END Statements Pop-up - List All Statements

Extract - START/END Ztatemsnts
Command ===% 2 Scroll ===% CER

Select start and end statementls) for transactien. When complete prass

Enter,
1 - List STERT/ENDI|s) 2 - List All statements
5 - Select START E - Select ENDIs) U - Unselect
O0mpA225 PROCEDURE DIWISIDM UEIMG CDMTROL-PRRAMETERS, ERAHCH-BALANCE ENTRY
0oazze6 BRMK -BRLANCE. ENTRY
_ noazdn GOBACEK . EXIT

FAEAHAKARICXAXECX AKXk xxwxx x BOTTOM OF DATA A rxs st KX XICXAXELXAMELKANE
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Figure 157 shows that the Extract - START/END Statements pop-up now displays
the expanded information. You are now ready to select a START statement.

Figure 157 « Extract - START/END Statements Pop-up - Expanded View

Extract - START/END Statemants

Cotrmang === _ Scroll ===3 C5R
Select start and end statemant|s] for tramsactian. Uhen complete press
Enter.
1 - List START/END (=] 2 - List ALl statements
5 - Select START E - Select ENDIs) U - Unselect

00a2z5 PROCEDURE DIWISION USING COMTROL-PARAMETERS. BRAWCH-EALANCE ENTRY

_ DE@226 BANEK - BRLAMLE EHTRY
_ ooz
0pag22a QPEN QUTPUT EXCEPTIDM-FILE.
0pa2z8
0pdzzo PERFDRH INITIALIZE-PGH.
_ @231
_ o232 PERFORH ACCT =MATHTEMANCE
P 1]c < b k| THRU ACCT-HAINTEMANCE-EXIT
0BA234 UNTIL TRAW-FILE-ENDE.
0Bd23s
OPd2zE PERFORH AEFORT-FINAL-CNTRS.

To select a new START statement

1 Scroll to line 273 on the redisplayed Extract - START/END Statements pop-up, as
shown in Figure 158.

Figure 158 « Extract - START/END Pop-up - Scrolling to Line 273

Extract - 3TART/END Statements
Command ===> Seroll ===»> CSR

SGelect start and end statement(s) for transaction. When complete press
Enter.

1 - List START/END (=) Z - List All statements

3 - Select START E - Select END(s) U - Unselect V - View Source

|

|

|

|

|

|

|

|

|

|

| 000273 UPDATE-ACCT.
| oo0z74
|
|
|
|
|
|
|
|
|
|
'

~ o0o0z7s PERFORM INIT-ACTICN-RECORD.

_ oo0zvs

~ o0o0z77 IF ACCT-TYPE OF ACCT-RECORD = ' INT'

_ ooozvs MOVE CHE-INTEREST-RATE TO INTEREST-RATE
~ ooozrs ELSE IF ACCT-TYPE OF ACCT-RECORD = 'CHE

_ ooozso MOVE ZERO TOQ INTEREST-RATE

_ ooozsti ELSE IF ACCT-TYPE OF ACCT-RECORD = 'MMA

_ ooozsz MOVE MMA-INTEREST-RATE TO INTEREST-RATE
_ 000283 ELSE IF ACCT-TYPE OF ACCT-RECORD = 'S4V

_ ooozs4 MOVE SAV-INTEREST-RATE TO INTEREST-RATE.
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2 Type S next to the new START line UPDATE-ACCT, as shown in Figure 159, and
press Enter.

Figure 159 « Extract - START/END Pop-up - Selecting START Statement

Extract - STRART/END Statemsnts

Command === _ Seroll ===» CER
Select start and end statement|s] for transactian. Uhen complete press
Enter,
1 - List START/EMWD (=) 2 - List A1l statements

E - Splect ETART E - Select ENDI=s) U - Unselect
S 0ea273  URDATE-ACCT.
_ nBazvdq
_ neezvs PERFORH IWIT-ACTION-RECORD.

OpA27E

opaz27Ty IF ACCT-T¥PE OF ACCT-RECDRD = "INT'

Opa27e MOYE CHK-IMTEREST-RATE TO INTEREST-AATE
_ neazrg ELSE IF RCCT-TYPE OF ACCT-RECORD = "CHK'
_ na@zzn MOYE ZERD TO IMTEREST-RATE
_ DRozel ELZE IF RCCT-TYFE OF ACCT-RECORD = "HMA'

opa2el MIYE MMA-IWNTEREST-RATE TO IWTEREST-RATE

opEz2Es ELSE IF RCCT-T¥FE OF ACCT-RECDRD = '"SAw'

0paz2eEd MOYE SAY-INTEREST-RATE TO INTEREST-AATE.

Figure 160 shows that the new START line (line 273) now has the START tag on
the far right of the screen. (A START point includes an entire COBOL statement. In
this case, the statement is on line 273.) You are now ready to select an END
statement.

Figure 160 « Extract - START/END Statement Pop-up - Results of Start Change

Extract - START/END Statement WO EMD STATEHENT (%)
Cotrand === _ Scroll ===» CER
Select start and end statement(s) for transaction. When complete press
Enter.
1 - List START/EMD|=] 2 - List All statements

5 - Select START E - Select EHDIs) U - Unselect

0Aa27s  UPDATE-ALCCT . STRRT

0Eaz2Ta

NEE2TE PERFORH IMIT-ACTIOM-RECORD.
_ DRa2vEe
_ neezv? IF ACCT-TYPE OF ACCT-RECORD = "INWT'

OBA2TE MAYE CHE-INTEREST-RATE TO IWTEREST-RATE

oEazTa ELSE IF ACCT-TYPE OF ACCT-AECORD = 'CHK'
_ neaz2en MOYE ZERO TO INTEREST-RATE
_ nge2gl ELSE IF ACCT-TYFE OF ACCT-RECORD = "HMA'
_ Qeozs2 MOYE HMMA-INTEREST-RATE TO IHTEREST-RATE

OEE2=3 ELSE IF ACCT-TYFE OF ACCT-RECORD = 'SAW’

Ooa2Eq MOYE EAY-INTEREST-RATE TQ INTEREST-AATE.
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To select a new END statement

1 Scroll to line 325, type E next to the new END line, as shown in Figure 161, and
press Enter.

Figure 161 « Extract - START/END Statement Pop-up - Select END Statement

Extract - 3TARTSEND Sratements
Comtnang ===3 Seroll ===» CER
Select start and end statement|s] for transactian. Uhen complete press
Enter,
1 - List START/EMWD (=) 2 - List A1l statements

E - Splect ETART E - Select ENDI=s) U - Unselect
_ neazz1
_ neag22 REWRITE RCCT=RECORD,
_ neesz23

0pA32d  URDATE-ACCT -EXIT.
E OBA325 EXIT. FERF-END
_ Opd3zE
_ 0ea22?  EXCEPTIOM-REFORT-1
_ DBEs2s =
_ DRag2y = EACEPTION REPORT 1 LIST ALL ACCOUNTS HITH A MIMIMUH EBALANCE

0BA330 = THAT IS LESS THAM THE CURREHNT BALAMNCE.

opa3z1

0pa3z2 IF EX-APT-LINE-CHNT IS GRAEATER THAM &0

Figure 162 shows that the display is now highlighted with the END tag on the far
right of the screen. The highlighting indicates all statements that are reachable from
the set START point.

Figure 162 » Extract - START/END Statement Pop-up - Highlighted Display

Extract - START/END Statements
Command === _ Serpll === CER
Zelect start and end statement(s) for transaction. When complete press
Enter.
1 - List START/EMD|=] 2 - List All statements

5 - Select START E - Select EHDIE) U - Unselect

0EA321

0Ea3z2 REWRITE ACCT-RECORD.

nEE2z3
_ nge22d  UUPDATE-RCCT-EXIT.
_ DEe32s EXIT. END

OEE32E

0B3a327 EXCEPTIOWN-AEFDRT -1
_ DEBF2A =
_ 0@@%29 =  EXCEPTION REPOAT 1 LIST ALL ACCOUNTS WITH A MINIMUK BALAMCE
_ 0Ee3F30 = THAT IS LESS THAM THE CURREHT EBALAMLE,

OEE3E1 *

0oa3z2 IF EX-APT-LINE-CHT IS GREATER THAN &0
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Press Enter to return to the Extract - Transaction Paths List pop-up and press Enter
again to return to the Encore Primary screen. You are now ready to generate a
CALLable submodule.

To generate a CALLable submodule

1

Select Generate » COBOL module and press Enter to display the Generate - Select
Logic Segment pop-up.

Press Enter to display the Generate - COBOL Module pop-up, type in the required
information, and press Enter.

Encore generates a CALLable submodule that executes the code you selected by
setting the new START and END points (see Figure 163).

Figure 163 « Generate - Encore-Generated Callable SubModule

45G-Encore EDIT - USERID.ENCXXIZII, COBOL COLUMNS 00001 00072
Command === doroll ===> CiR
00o0z05 PROCEDURE DIVISION U3ING

o0oo0zos TRAN-RE CORD

aoozov PGM-3IGNATURE

000zos INTEREST-RATE

ooozog DAYS-IN-PERIOD

ooozlo DATS-IN-VEAR

ooozll WORK-ACTION-REASON

goozlz ACTION-CNT

000213 TODAY-DATE

0o0zl4 CONTROL -PARAMETERS

oooz1ls BRANCH-BALANCE

0oo0zZle BEANK-EALANCE .

oooz17

0o0o0z1ls

ooozle

0oo0zZzo UPDATE -&CCT.

0oo0zZzl

000ZZ2 PERFOFM INIT-ACTION-EECORD.

000223

oo0zz4 IF ACCT-TYPE OF ACCT-RECORD = 'INT'

000zZ25 HMOVE CHE-INTEREAT-RATE TO INTEREZT-EATE
ooozas ELSE IF ACCT-TYPE OF ACCT-RECORD = 'CHE'

After saving the module, press PF3 until you return to the Encore Primary screen.
Select File P Close and press Enter to display the Close Program pop-up.
Select Close, discard segments. All unsaved Logic Segments are discarded when you

exit Encore by selecting the Exit option. For this tutorial, you do not need to save any
generated data.

Note:
The Exit pop-up displays if you exit Encore using the PF3 key. From this pop-up,
options are available to save logic segments, discard logic segments, or cancel the
exit and return to Encore.
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START/END Usage Notes

When you select Option 2, List ALL statements on the Extract - START/END
Statement pop-up (see step 5 on page 171 and Figure 156 on page 171), all
PROCEDURE DIVISION statements in the program are displayed on the screen.
Selection of START and END statements may be based on the cursor location.

Figure 164 « Start/End Usage Notes Example

goo3sg =

AOQ3ER ACCERT TODAY-DATE FROH DATE.

oaD3EL

[elufee i COHFUTE DAYS-IN-PERIUD =

QNR363 MONTH ITODAY-MH] - TODAY-DD.

ano364 MOYE +0 TO DAYS-IN-YERR.

Julnfuike [:1-) PERFORM SUM-TOTAL-DAYE

QOD3EE VARYING HWORK-CHT FROH 1 BY 1

GOG36T UHTIL TODAY-DD = WORK-CHT. RETLRH
QOE36E =

QU03Ee  SUM-TOTAL-DAYS.

Qap3ze COHFUTE DAYS-IM-YEAR = DAYS-IM-YEAR + MONTH | HWDRK-CHT ). FETURN
oap3arL =

[eLi]mic e

o373 IHITIALIZE-PGH.

oapa74

Qanaie FERFORM OPEM-FILES.

on3reE

Qoe3?T MOYE +0 T0 RCCT-IO-CNT

The rules for cursor location are explained in these steps, using the code in
Figure 164 as an example. In the rules for selecting a statement, the E line
command (to select an END statement) is used as an example.

o If the E line command is used on a line containing a single COBOL statement,
e.g., line 364, that statement is selected as an END statement, highlighted, and
tagged.

J If the E line command is used on a line containing a COBOL statement that
spans more than one line, e.g., lines 362 and 363, the entire statement is
selected. The E line command could be entered on either line 362 or line 363.
The statement is highlighted and tagged.

J If the E line command is used on a line containing more than one full or
partial COBOL statement (not shown in this example), use this procedure:

—  Type E on the selection line and move the cursor to the desired statement
and press Enter. The statement is selected as an END statement,
highlighted, and tagged.
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When selecting a START statement, type S next to an executable COBOL statement. If
the selected statement is an unexecutable COBOL statement, these general rules apply:

Comment lines and compiler directives occurring at the end of an executable code
block are considered part of the paragraph or section that follows. The starting point
begins at the paragraph or section name that follows.

A line followed by one or more executable statements prior to the succeeding
section, or a line that is part of the last section, is considered part of the preceding
section. The starting point is the end of the statement, before the comment or
directive.

Blank lines that occur at the end of an executable code block, and that are not
preceded by a comment or compiler directive, are considered part of the preceding
paragraph or section. The starting point is at the end of the last executable statement
in the preceding paragraph.

A blank line that follows all executable statements of the preceding paragraph, and
that is preceded by a comment or compiler directive, is considered part of the
following paragraph. The starting point is the paragraph or section name in the
following paragraph.

A blank line that is followed by one or more executable statements, or that is part of
the last paragraph or section of the program, is considered part of the preceding
paragraph. The starting point is the end of the preceding paragraph.

The statements that compose the current transaction are highlighted. The highlighting
changes if the START or END statements are redefined, or if conditional paths are
blocked or unblocked on the Extract - Transaction Paths List screen.

Note:

A Transaction Logic Segment consists of those statements that can be reached from the
START point and that reach an END point without passing beyond an END point or
program exit, or without passing through a blocked conditional path.
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Transaction Extract Compilation Issues

Condition 1

178

When Encore generates modules from a Transaction extract, certain conditions may
occur that cause compile errors or cause the program not to run. As shown in this section,
Encore inserts comment messages in the generated modules when these conditions occur.

An unnamed 01 level data item, moved from WORKING-STORAGE to LINKAGE,
must be assigned a valid COBOL data item name (sub-program request).

An unnamed 01 level was moved
to the LINKAGE SECTION.
When Encore generated the
LINKAGE SECTION for a
subprogram, it did not rename data
items that were moved from the
WORKING-STORAGE
SECTION.

COBOL syntax allows an
unreferenced 01 level data item to
go unnamed in
WORKING-STORAGE, butnot in
LINKAGE.

Encore assigns the name

' FILLER' to the data item and
issues this message. The
subprogram cannot successfully
compile until the data item is given
a valid name.

A similar situation occurs when
two 01 levels are defined with the
same name and are not referenced
at the 01 level. In this case, the
compiler detects a duplicate name.

Assign a valid COBOL data item name to
each LINKAGE SECTION data item with
the name ' FILLER'.
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Condition 2

Encore has generated statements to cause normal and abnormal exits from the program.

Cause Action

Condition 3

Encore generates program exit
statements (STOP RUN, GOBACK,
EXEC CICS RETURN, EXEC CICS
ABEND) to ensure that the program exits
properly. A normal program exit is
generated when the intended function of
the program is complete. For a
transaction objective, an abnormal
program exit is generated for conditional
clauses that have been blocked using
TRUE/FALSE.

Review the conditions surrounding each
generated exit statement to determine if
the default exit statement should be
augmented or replaced. For a transaction
objective, ensure that the proper program
paths were selected.

Encore has determined that a COPY statement cannot be used. Portions of the copybook

are reproduced inline.

Cause

Action

Under certain conditions, the original
COPY statement cannot be used in a
generated module:

. When data elements in the COPY
statement contain definitions split
between the
WORKING-STORAGE and
LINKAGE sections.

. When COPY statements contain
dead code.

. When the contents of a COPY
statement used in the LINKAGE
SECTION contain the VALUE
clause.

In addition to this message, Encore
generates comments indicating why the
COPY statement could not be used as
originally coded.

Determine why the COPY member was
notusable. No action is required, however,
the COPY member contents may be
modified in order to use it in this context.

Example:

A copybook contains both FD and data
item definitions. One or more of the data
item definitions must be used in the
LINKAGE SECTION.
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Condition 4

Condition 5

180

Encore has generated a LABEL target used to transfer control to a transaction START
statement.

For a transaction objective Logic Review and verify.
Segment, the start point of the transaction

was not the first statement of the program

module. Encore generated a label, with a

GO TO statement to branch to that label,

to create a path to the transaction code.

Encore has generated a DISPLAY statement prior to each abnormal program exit.

Encore has generated DISPLAY Review the conditions surrounding each
statements just prior to a generated generated DISPLAY statement to
abnormal program exit. determine if it should be augmented or

replaced. Ensure that a DISPLAY is an
appropriate action for the condition that
occurred.

Note:
A DISPLAY statement is not generated for a CICS program, or when a subroutine is
specified in the COBOL Module Exit field on the Options - Product Parameters pop-up
(see Figure 7 on page 27).




Report Extract

This chapter provides a practical demonstration of how to perform a Report extract to
create sample programs that perform month-end calculations and produce exception
reports, and contains these sections:

Section Page
Introduction 181
The Business Scenario 182
Starting an Encore Session 183
Extracting the Report 184
Creating the COBOL Module 188
Understanding the Results of the Extract 191
Creating the Complement Module 194
Complement Module - Understanding Generated Notes 198
Using Pseudo Source Modules to Change Logic Segments 199
Controlling Extract Boundaries 207
Report Extract Compilation Issues 210
Introduction

This chapter demonstrates how to use Encore to create these programs:

o A program that performs all of the month-end calculations for the different types of
checking accounts without producing the exception report.

o A standalone program that produces an exception report.
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The Encore demonstration program VIARDEMO is used for the examples in this chapter.
For a partial listing of VIARDEMO, see "The Demonstration Program" on page 49 .

The Business Scenario

182

The Universal Bank has a program that does the month-end calculations for each type of
checking account that is run at the close of business at month-end. The process cycle
requires the maximum time allowed to run in the available process window. The program
produces an exception report that is produced after month-end (see Figure 165).
Management has requested that the report be run standalone, thereby extending the
process window. Extracting the report from the existing program would be time
consuming and carries the risk of corrupting the current program.

Figure 165 » Report Extract Business Scenario Example

EXCEPTION-REFORT-1.

EXCEPTION REFPCORT 1 LIST ALL ACCOUNTS WITH A MINIMUM BALANCE
THAT I3 LESS THAN THE CURRENT EBALANCE.

4 4 o+ @

IF EX-RPT-LINE-CHNT IS5 GREATER THAN &0
ADD +1 TO EX-RPT-PAGE-CNT
MCWE EX-RPT-FAGE-CNT TO EXCEP1-REFPORT-FPALGE-CHNT.
WRITE EXCEPT-EBEUF FROM EXCEPT-HEAD-LIMNEL.
WEITE EXCEPT-EUF FROM EXCEPT-HEAD-LIMNEZ.
NCWE O TO EX-FPT-LINE-CHNT.

ADD +1 T EEX-RPT-LINE-CHNT.

MCWE ACCT-BALAWNCE TO EX-CUR-EBAL.

MCWE ACCT-MIN-BALANCE TC EX-REPORT-MIN-EAL.
WRITE EXCEPT-EUF FROM EXCEPT-DETAIL-LINEL.
WEITE EXCEPT-EUF FROM EXCEPT-DETAIL-LINEZ.

Encore can be used to automate the decomposition process of removing the report from
the month-end calculation program without changing the rest of the program's functions.
In addition, Encore does not change the original program so there is no danger of
inadvertently changing the calculation functionality.

The object of this decomposition exercise is to remove a file and all the data statements
and logic statements that contribute to the output file in the program. The Report extract
locates the minimum set of statements that contribute to the content of an output file,
when the 10 statements that produce the file are identified. For this reason, the logical
extract choice is the Report extract.
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Starting an Encore Session

To start the Encore session

Note:
Logon procedures and AKR information are unique to your programming environment.
If necessary, contact your systems administrator or your Encore coordinator for the
correct dataset names.

1 Logon to the ESW Primary screen.

2 Select Re-engineer P Program and press Enter to display the Encore Primary screen.
Or

Type EN on the command line and press Enter to display the Encore Primary
screen.

3 Select File » Open and press Enter to display the File - Open Program pop-up.

4  Type the AKR dataset name in the Data Set Name field and VIARDEMO in the
Program Name field and press Enter.

See "Starting an Encore Session" on page 59 for more information.
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Extracting the Report

To select the Report extract EXCEPTION-FILE from VIARDEMO

1 Select Extract P Report and press Enter to display the Extract - Name Logic Segment
pop-up, as shown in Figure 166.

The name field on this pop-up contains an Encore-generated default name. You can
assign your own name to the Logic Segment, or you can use the default name. For
this example, use the default name REPORT-0001.

Figure 166 « Extract - Name Logic Segment Pop-up

File View Extract Generate Search List Options Help

Extract - Name Logic Segment ram: VIARDEMO
Command ===
Type name of logic segment. Then press Enter.
KKK K KK K K
Name . . . REPORT-0001_ XK KKK K KKK
KKK KKK KK K K R KK K K K K XOK KKK KKK KK KKK K KK XK KKK XK KKK K KK
KKK KKK KKK KKK K K K KK K K K K KKK KKK KKK K K K KK K K KKK XK KK KK K KK
KKK X KK KK KKK K KK KK KKK
KKK K KKK KK KKK KKK KK KK L %9
KKK KK KKK KKK KK KK K K K R K KK KK K KK XK KKK KKK K KK K K R KK XK K
K KK XK KK KKK KK KK K OK K K KK K KKK K K K K KKK KK KK KK K KK K K K K

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
¥isit the ASG Support Web Site at www.asg.com

2  Press Enter to display the Extract - Report Name List pop-up (see Figure 167 on page

185).
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Type S next to the FD name EXCEPTION-FILE and press Enter to display the
Extract - Source Ordered View pop-up (see Figure 168 on page 186).

Figure 167 contains a list of all report names in the program.

Figure 167 « Extract - Report Name List Pop-up

Extract - Repart Mams List 4 REPORT NAHES
Command ===» Screll === C3A

Select Wame of Repeort Definitien for extract. Then press Enter. Use SORT

command to arder column by wvalue.  Fress Enter uhen complete.
5 - Zelect ¥ - VWiew Source I - Unselect
QOFEN Nutr
Name Type Organization Options HELCS
__________________________________________________________ ____}
ACCT-FILE FD LHOEXED 1:0 1
_ ACTION-FILE FD SEQUENTIAL QUTRUT 1
5 EXCERFTION-FILE FD SEQUENTIAL QUTFUT 1
EYS0UT COMAME BEfUENTIAL auTrUT ul

FEAEMEEARNEECRNER AN AN 00k QOTTOH OF DRTE SEMEeaeuer £ b N mee e £n

FFa=Yiew FFE=Filter PFI17=3art

Note:
You can reduce the list of selectable names by pressing PF5, which displays the
Extract - Report Name Filter pop-up. This pop-up is used to specify filtering
criteria. See the online help for more information about the Extract - Report Name
Filter pop-up.
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4  Type S next to line numbers 335, 336, 341, and 342 and press Enter, as shown in
Figure 168. This pop-up displays all of the 10 statements associated with
EXCEPTION-FILE. You need to extract all statements that contribute to the output
data.

Figure 168 « Extract - Source Ordered View Pop-up - Statement Selected

Extract - Source Ordered View
Command ===} _ Scroll ===: CER

Select statements for Report Extract, press Enter. When complete press
Enter.

Report Wame: EXCEPTION-FILE

5 - Gelact VWo- Yiad Seurce U - Unselect
= DBA33S5 WRITE EXCEFT-BUF FROM EXCEPT-HEAD-LIKWEL.
= DDA33E WRITE EXCEPT-BUF FROM EXCEPT-HEARD-LINEZ.
s ODBE341 WAITE EXCEPT-BUF FRADM EXCEPT-DPETAIL-LIMNEL
s [0E342 WRITE EXCEPT-BUF FAOM EMCEPT-DETAIL-LINEZ.
rrxawrxawre e xrerexrerexxxx BOTTOM OF DATA *XIXICXi¥ICXidXdXadyd ¥R Xy

5  Press Enter again to return to the Extract - Report Name List pop-up (see Figure 169
on page 187).
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The message in the long message area shown in Figure 169 indicates that the
Report Statements for the EXCEPTION-FILE report was successfully selected.

Press Enter to return to the Encore Primary screen.

Figure 169 « Extract - Report Name List Pop-up

Extract - Report Name List
Command ===> Scroll ===> CSR

Select Name of Report Definition for extract. Then press Enter. Use SORT
command to order column by value. Press Enter when complete.

S - Select ¥ - View Source U - Unselect
OPEN Num
Name Type Organization Options RECS
__________________________________________________________ ———y
_ ACCT-FILE FD INDEXED I/0 1
_ ACTION-FILE FD SEQUENTIAL OUTPUT 1
_ EXCEPTION-FILE FD SEQUENTIAL OUTPUT 1
_ SYsouT DDNAME SEQUENTIAL OUTPUT 0

3K K K KK K K K KK K KK OKCKOKOKCKK KR OKCKKOKCK K KR BOTTOM OF DATHA K %K K K K K K K K K 5K K K K K K K K K K KKK KK

ASG40431 REPORT STATEMENTS SUCCESSFULLY SELECTED.

See the online help for more detailed information about Extract features.
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Creating the COBOL Module

Now you need to create a standalone module to produce the Exception report. This is

done by using the Logic Segment created in "Extracting the Report" on page 184. The
module contains all of the statements required to produce the Exception Report along

with the necessary file and working storage elements.

1 Select Generate » COBOL module and press Enter to display the Generate - Select
Logic Segment pop-up, as shown in Figure 170.

Figure 170 « Generate - Select Logic Segment Pop-up

Ganerate - 3elect Logic Segment d LOGIC 3EGHENTS
Command ===} _ 3orell ===} CzA
F - Select
Frogram Logic Segment MName Descriptian
_  WIARDEMO GET=NUM=0F=DAYS CALCULATE WUMEER 0OF DAYZ
_  ¥YIARDEMO IHTEREST-CALCULATION LHMTEREST-CALCULATION LOGIC SEG
&  WIARDEMD REFORT-20@1 Repart

FERERER SRR EERERER SRR ERERRE R £nE BOTTOH OF DATHA ##RE3 303 SRRE $3MEF BRREE S48

2  Type S next to the Logic Segment name REPORT-0001 and press Enter to display
the Generate - COBOL Module pop-up (see Figure 171 on page 189).
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3  Type REPTPRGM in the Program ID field and press Enter to display the Edit screen
(see Figure 172).

Figure 171 « Generate COBOL Module Pop-up

File View Extract Generate Search List Options Help

Generate - COBOL Module Program: YIARDEMO

Type Program ID and select generation options.
KKK KK KK K K KK K K

Objective . . : Report KKK 3K K K K KK KK K
Program ID . . REPTPRGM _
Options HOKK KK KK
CALLs to I0 Module(s) KKK KK KKK
KKK
——————————————————————————————————————————————————————— KKK

ASG4312I DEFAULT PROGRAM ID VALUE ASSIGNED. VERIFY, AND CHANGE IF
NECESSARY .

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
¥isit the ASG Support Web Site at www.asg.com

4  Type CREATE on the command line and type C 9999 on the first line of code. Press
Enter to display the Edit/View - Create pop-up (see Figure 173 on page 190) to save
the module in your source library.

Figure 172 « Edit Screen

A$G-Encore EDIT - USERID.ENCXOGOK. COBOL COLUMNS 00001 00072
Command === CREATE Scroll ===> C3R

FEERES TR T A TET T AR TAATANTANEALNAANENS TDp of Data FFEEEEEEEEEEEEEEEEELEEEENENLLY
C 9999 ok o o o ok o o o o o o o o o i o o o o o ok o o o o o o o o o
oooooz * A3G, INC. *
ooooos * *
goooo4 * GENERATED EY ASG-ENCOEE RELEASE &.0(000) *
ooooos * *
ooooos * PROGRAM: REPTFRGH *
ooooo? * *
ooooos + DATE: DD-MMM-Y¥YY HH:MM: 55 *
goooog * REQUE 5TOR: TSERID *
oooolo * *
ooooll + AKR INFORMATION *
oooolz * D3 NAME: TUSERID.TE5T. AKE *
oo0o1s * MEMEER.: VIARDEMO ALIA&S: (NONE) *
oooo14 * *
ooools + SEGMENT NAME: REPORT-000L *
oonole * *
oooo17 * OBJECTIVE TYPE: REPORT *
00001 Ess5s535353535535353555535353555535353553535355355353535535353533sN *
00001 e A5G1605I ENTER THE CEEATE COMMAND TO SAVE THE COBOL PROGERAM. e *
00002 Dss5s535353535535353555535353555535353553535355355353535555353533s *
oooozl * SELECTED LINE(S): *
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190

Type the name you want to save the program under in your source library
(REPTPRGM in this example, as shown in Figure 173), verify or clear any data in the
Data Set Name and Volume Serial fields, and press Enter. You are returned to the
Edit screen where message Member REPTPRGM created is displayed in the
upper right corner of the screen confirming that the member has been successfully
saved (see Figure 174 on page 191).

Figure 173 « Edit/View - Create Pop-up

Edit/View - Create
Command ===

"Current” Data Set: UIERID.ENCIOCI{.COEOL

To ISPF Library:

Project . . . A5G
Group . . . . CEGOXRDIY
Type . . . . CNTL
Member . . . BEPTPRGH

To Other Partitioned Data Set HMember:

Data Set Name . .

Voluwe Serial . . . [If not cataloged)
Data Set Password . . [If password protected)

Enter "/" to select option
Specify pack option for "CREATE™ Data Set

Fress ENTER key to create. Enter END command to cancel create.
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Understanding the Results of the Extract

Note:

To better understand the results of the extract, see "The Demonstration Program" on page
49 for an overview of the Encore demonstration program VIARDEMO.

As aresult of the Report extract, a standalone program was created that contains all of the
necessary statements, files, and data elements to produce the Exception report.

Figure 174 shows the comments generated by Encore at the beginning of the module. The
comments indicate the extract objective type, the name of the file extracted, and the line
numbers in the original program that were extracted.

Figure 174 « Report Module - Screen 1

A3G-Encore EDIT - U3ERID,.ENCXCI{.COBOL Mewmher REPTPRGM created
Command === Gcroll ===> C3iR

e o S i e i o i e i i i i i e i e TDp Df Dﬁta e e i e i i e i i e i i e i i o o
DDDDD_‘L e i i i e i e i e i i e i e i i e e i e e e e i e i e e i e e e i e o i e e o
oooooz * A5G, INC. *
aooaas3 * *
aooong * GENERATED BY A3G-ENCORE RELEASE £.0(000) *
aooans * *
aooang * PROGRAM: REPTPRGM *
aoona? * *
oooaos * DATE: DD-MMM-VV¥YY HH:MM: 33 *
oooa0g + REQUE 3TOR: T2ERID *
aooalo * *
oooall * AKR INFORMATION *
aoonlz * 'S NAME: USERID.TEST. AKR *
0o0al3 * MEMEER.: WIARDEMO ALIA%: (NONE) *
ooool4d * *
aooals * SEGMENT NAME: REPORT-0001 "
aooale * "
aooaL? * OBJECTIVE TYPE: REPORT *
aooals * REPORT NAME(S): *
oooale * EXCEPTION-FILE *
aoonzo * "
aoonzl * SELECTED LINE(S): "
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Figure 175 shows how Encore flags any code changes it has made with comments
imbedded within the program.

Figure 175« Report Module - Screen 2

ASG-Encore EDIT - USERID.ENCXZ:CZ.COBOL COLUMNS 00001 00072
Conmand === Scroll ===> CSR
oooLrz * ASG-ENCORE NOTES:

oooL?s *

aoo174 * 1. WALUE CLAUSES OMITTED FROM LINKAGE ARE ZHOWN 4% COMMENTS.
aoo17s * Z. USED, MODIFIED AND REFERENCED (USE/MOD) 5SYMEOLS ARE
aoo17e * NOTED.

aoo17?? * 3. ANNOTATED COPYEOOK SYMEOLS ARE REPRODUCED ASZ COMMENTS.
aool7e *

oool7e 0l CONTROL-PARAMETERS.

aoolso 05 FREE-SERVICE-MIN PIC S9(11)¥3(4) COMP-3.
ooolsl * ..REF
aoolaz 05 CD-REVIEW-MIN PIC 39{11)V¥3{4) COMP-3.
aoolas 01 BRANCH-BALANCE PIC 39{11)V¥3{4) COMP-3.
ooolad 0l EBANK-BALANCE PIC 29(11)¥a(4) COMP-3.
0001&5

000186 PROCEDURE DIVISION USING CONTROL-PARAMETERS, BRANCH-EALANCE,
aoola? EANE-BALANCE.

aoolas

ooolae OFEN OUTPUT EXCEPTION-FILE.

oooleo

aoo19l PERFORM INITIALIZE-FGM.

aoole:z

aoo193 PERFORM ACCT-MAINTENANCE

Encore has included only those statements and files that contribute to the creation of the
Exception Report. Notice in Figure 176 that ACTION-FILE was not extracted from
VIARDEMO, since it does not contribute to the creation of the Exception Report file.

Figure 176 « Report Module - Screen 3

A5G-Encore EDIT - USERID, ENCX:CCK. COBOL COLUMNS 00001 00072
Conmand === Jcroll ===> C&R
ooon4s3 ENVIRONMENT DIVISION.

ooon4g4 CONFIGUEATION SECTION.

0o004s S0URCE-COMPUTER. IEM-370.

aoon4ge OBJECT-COMPUTER. IEM-370.

aoon4g? INPUT-0UTPOIT SECTION.

aoonds

aoon4gs FILE-CONTROL.

ooooso SELECT ACCT-FILE ASSIGHN TO ACCT

aooasl ORGANIZATION IS INDEXED

aooasz ACCESS IS5 RANDOM

aooass3 EECORD EEY IS ACCT-EEY.

ooons4 SELECT EXCEPTION-FILE ASSIGN TO UT-53-EXCEPTS.
0oonss SELECT TRAN-FILE ASSIGHN TO UT-3-THAN.
000056

aooas? DaTA DIVISION.

aoonss

aoons9 FILE SECTION.

aooasn FI ACCT-FILE

aoonsl LABEL RECORDS ARE STANDARD.

ooooez 0l ACCT-RECORL.

000063 05 ACCT-CONTROL-CODE PIC 9(A).
ooons4 05 ACCT-EEY.
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Figure 177 shows that the OPEN and CLOSE statements in VIARDEMO reference
TRAN-FILE, ACCT-FILE, EXCEPTION-FILE, and ACTION-FILE. Since
ACTION-FILE was not extracted, Encore modified the OPEN and CLOSE statements in
REPTPRGM that referenced ACTION-FILE. The original OPEN and CLOSE statements
remain in the program, but they are commented out.

After reviewing the extract results, press PF3 until you return to the Encore Primary
screen.

Figure 177 « Report Module - Screen 4

43%G-Encore EDIT - USERID.ENC:ICI. COEOL COLUMNS 00001 00072
Command ===2 dcroll ===> C3R
a0o03z9 OPEN-FILES.

a0o0330

000331 * OPEN INPUT TRAN-FILE

a0oz3z * I-0 ACCT-FILE

a0o0333 * QUTPUT ACTION-FILE.

a00334 * ASG-ENCORE- PARTSTMT
a00335 OPEN INPUT TRAN-FILE

a00336 I-0 ACCT-FILE.

a0o0z37

a0oz3e

a0o033g CLOSE-FILES.

000340

a00341 CLOSE EXCEPTION-FILE.

o0o034z

o00343 * CLOSE TRAN-FILE

a00z44 * ACCT-FILE

a00345 * ACTION-FILE.

000346 * ASG-ENCORE- PARTSTMT
a0o0347 CLOSE TRAN-FILE

o0o034s ACCT-FILE.

a0oz49

Q00350 * LIG-ENCORE NOTE: ***%% END OF GENERATED MODULE ###+##
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Creating the Complement Module

After generating the standalone program, you can create the Complement Module to the
standalone. The Complement Module is the original program with the statements defined
by the extracted logic Segment removed. The program does the month-end processing

but does not generate the Exception Report. The Complement Module Generation facility

is used to create the complement of the original program.

To create the Complement Module

1 Select Extract » Complement and press Enter to display the Extract - Name Logic

Segment pop-up, as shown in Figure 178.

Figure 178 « Extract - Name Logic Segment Pop-up

Extract - Name Logic Segment

Command ===
Type name of logic segment. Then press Enter.
Name . . . COMPLEMENT-0002
KR K KKK KKK KK R K KK KK KKK KR KK KK K OK KK XK
KKK KK KR KK KK KK KK K KR K K KKK KR KR KK KK KK X K KKK X
KKK XK K KKK KKK XK 0 OK KK
R K KK KKK KK AOK KK KK KK KKK
KKK K KKK KR KR KK K KK KK R KR K OK K OK X AR KKK K KKK KR KK XK R
KO KK X R KK K K KK KK K K R K K K K KR KK X K K KR KK KK R K K K K KR KK X K

File View Extract Generate Search List Options

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Visit the ASG Support Web Site at www.asg.com

2 Accept the default name and press Enter to display the Extract - Complement pop-up

(see Figure 179 on page 195).
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Type S next to Logic Segment name REPORT-0001, as shown in Figure 179, and
press Enter.

This pop-up is used to select the Logic segments to be excluded from the original
program. Since you have extracted the logic for creating the exception report as a
standalone program, the Complement Module would not create the Exception
report. For this reason, you need to exclude Logic Segment REPORT-001.

Figure 179 « Extract - Complement Pop-up

Extract - Complement 3 LOGIC SEGMENTS
Comraand ===% _ Ecroll === CER

Select segments for complement extract and press ENTER.  When selections
are camplete, press Emter,

5 - Select U - Unselect

Frogram Logic Segment Name Oescription
_ MIARDEMO GET-NUH-OF - DAYS CALCULATE WUMBER OF DAYS
_ VIARDEMO INTEREST-CALCULAT ION ITNTEREST-CALCULATION LOGIC SEG
& WIARDEMO REFORT-AO0L Raport

FREEEMARAEMERLERARNERLRN ey BOTTOM OF DATA EEEATEAENERLENEEATHNLR AL MARNE

Press Enter again to return to the Encore Primary screen.
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5  Select Generate » COBOL Module and press Enter to display the Generate - Select
Logic Segment pop-up, as shown in Figure 180.

Figure 180 * Generate - Select Logic Segment Pop-up

Generate - Select Logic Segment 4 LOGIC SEGHMEMTS

Command ===3 — Sermll ===3: [C5R

% - Helect

Pr cgir am Logic Segment MName Description
5 WIARDEMD  COMPLEMENT-DE0Z2 Complement Repart

WIARDEND  GET-NUM-DOF-DAYS CALCULATE WUHEBER OF DAYS
_ WIARDEMO INTEREST-CALCULATION INTEREST -CALCULATION LOGIC SEG
_ WIARDEMO  REFORT-GO001 Report

FRNFMER LR REmER AR ek awwx BOTTOH OF DATA Hewxs ufmrrasmsf KEMEFNFNERNEN

6  Type S next to COMPLEMENT-0002 and press Enter to select it and display the
Generate - COBOL Module pop-up, as shown in Figure 181.

Figure 181 ¢ Generate - COBOL Module Pop-up

File View Extract Generate Search List Options Hel

Generate - COBOL Module Program: VIARDEMO

Type Program ID and select generation options.
AR K K KK R K KK KK K K

Objective . . : Complement R K KK K KK KK XK

Program ID . . CALCPGM_

Options KKK KKK

_ CALLs to I0 Modulel(s) KK KK K KK
KKK

------------------------------------------------------- KKK

ASG4312I DEFAULT PROGRAM ID VALUE ASSIGNED. YERIFY, AND CHANGE IF
NECESSARY .

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Visit the ASG Support Web Site at www.asg.com
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Type CALCPGM in the Program ID name field and press Enter to display the Edit
screen, as shown in, as shown in Figure 182.

Type CREATE on the command line and type C 9999 on the first line of code. Press
Enter to display the Edit/View - Create pop-up to save the member (see Figure 183).

Figure 182 « Edit Screen

A%G-Encore EDIT - U3ERID.ENCXICI.COBOL COLUMNS 00001 00072
Command ===> CREATE Gcroll ===> C3R

e e i S i i i e i e i e e i TDp Df Dﬁta e i e i i e i e i e i i e i e o
C gggg e i i i e i e i e e i i e o e i i i e e i e e e i e i i e e i i e i i e i i o
aooonz * ASG, INC. *
000003 * *
oooo04g * GENERATED BY A3G-ENCORE RELEASE &.0(000) *
aooons * *
aooong * PROGRAM: CALCPGM COMPLEMENT *
aoooa? * *
0o000s * DATE: DD-MMM-YY¥YY HH:MM: 33 *
oooo0g + REQUE 3TOR: UEERID *
aooolo * *
ooooll * AKR INFORMATION *
aoonlz * I'S NAME: USERID.TEST. AKR *
ooools * MEMEEER.: WIARLEMO ALIA%: (NONE) *
oooold * *
aooals * SEGMENT NAME: COMPLEMENT-0002 *
aooale * *
aoool? * OBJECTIVE TYPE: COMPLEMENT (REPORT) *
00001 Esss553335553335533335333335555555555555555555555535353535535535355333335N *
00001 e A4%5G1603I ENTER THE CEEALTE COMMAND TO 3AVE THE COBOL PROGEAM. e #wa®awsx
0000: Dss55533353553 58555 356855553555553585555355533535858553358858333388as

aoonzl

Type the name you want to save the program under (CALCPGM in this example),
verify or clear any data in the Data Set Name and Volume Serial fields, and press
Enter.

Figure 183 « Edit/View - Create Pop-Up - Save the Complement Module

Edit/View - Create
Command ===

"Current” Data Set: UIERID.ENCXCCI. COEOL

To ISPF Library:

Project . . . &SG
Group . . . . CEGOXRRDY
Type . . . . CHNTL
Member . . . CALCPGHM

To Other Partitioned Data Set Member:

Data Jet Name .

Voluwme Serial . . . [If not cataloged)
Data Set Password . . [If password protected)

Enter "/" to select option
Specify pack option for "CREATE™ Data 3Set

Press ENTER key to create. Enter END command to cancel create.
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Program CALCPGM is created. This program contains all of the logic of the
original program, except for the extracted Logic Segment, and is stored in your
COBOL source library.

Complement Module - Understanding Generated Notes

198

When Encore creates the Complement Module, remarks are generated in the module
concerning any statements modified by Encore.

Note 1, as shown in Figure 184, is generated whenever a Complement Module is created
in anything other than a Perform Range extract. A Complement Module may include a
CALL to a submodule. Since the CALL is not automatically generated, as in a Perform
Range extract, you must place any required CALLSs to submodules wherever appropriate.
In this case, no CALLable submodule was created, so no action is required for this

message.

Figure 184 « Complement Module Descriptive Notes

ASG-Encore EDIT - USERID.ENCXXIOO.COBOL COLUMNS 00001 00072
Command === Gocroll ===> C3R
aoo0zo * ABIG-ENCORE NOTES:

aoonzl *

aoonzz * 1. THIS MODULE IS THE FUNCTIONAL COMPLEMENT OF THE MODULE
aoonz3 * DEFINED BEY THE LOGIC SEGMENT SELECTION CEITERIA. YOU MUST
ooonz4 * DETEFMINE THE APPROPRIATE POINT(3) TO PLACE A CALL TO THE
0oo0zs * LOGIC SEGMENT MODULE.

0o000ze *

aoonz? *

aoonze IDENTIFICATION DIVISION.

aoonzg PROGRAM-ID. CALCPGM.

000030 AUTHOR. VIASOFT DEMONATRATION.

00003l

DDDDSZ e i i i i e i e i e i e i i e e e e e i e i e i i i e e i i e i e e o
aoon33 * THIS PROGRAM DOES THE MONTH END CALCULATIONS FOR EACH TYPE *
ooon34 * OF CHECEING ACCOUNT CARRIED BY THE UNIVERSAL EBaNK. IT *
000035 * HANDLES THE FOLLOWING TYPES OF ACCOUNTS. *
000036 * CHECEING WITH INTEREST *
aoon3? * CHECEING WITH NO INTEREST "
aoon3s * MONEY MARKET ALCCOUNT |MMA) "
aoon3g * SAVINGS ACCOUNT =
oooo4o * IT ALS0 UPDATES THE LCCOUNT BALANCE, BRANCH BALANCE AND *
ooon4l * BEANK BALLANCE. *
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Using Pseudo Source Modules to Change Logic Segments

Pseudo Source Modules

If the program being analyzed contains a CALL to a non-COBOL program, or to a
program that has not been analyzed, you should consider creating pseudo source to obtain
better results in an extracted program under these conditions:

e  I[fall parameters are not used and/or modified, pseudo source should be written.
o If the CALLed program is not COBOL.

J You choose not to analyze the CALLed program.

The purpose of the pseudo source module is to identify the inputs and outputs of the
CALLed routine. The pseudo source module must be saved in the AKR.

Each CALL statement parameter is input-only, output-only, or both input and output.
e  Input-only parameters are used but not modified by the CALLed module.
o Output-only parameters are modified but not used by the CALLed module.

e  Input and output parameters are both used and modified by the CALLed module.

For example, Figure 185 shows a program being re-engineered that uses this code:

Figure 185 ¢ Using Pseudo Source Modules - Program Re-engineering Code Example

MOWE 0 TO PAYHMENT.

MCWE LOAN-AMOUNT TO PARM-1.

CALL *INTEREST* U3ING FLRM-1, PAYMENT.
DISPLAY PATMENT

If a Report extract request is made for the variable PAYMENT at the DISPLAY
statement, it may be assumed that the preceding CALL statement and the MOVE
LOAN-AMOUNT statement are both required. This assumption can be made because it
appears that the CALL to the INTEREST' module is modifying the PAYMENT
parameter. If this assumption is true, the CALL is required; however, if this assumption is
false, the CALL statement is unnecessary (although the MOVE 0 TO PAYMENT
statement would be required).
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The report and Computation Variable extract objectives assume that all parameters are
both input and output, which may not always be an accurate assumption. In some cases,
the extract contains more than the minimum set of code because of this assumption. To
obtain completely accurate results, the actual type of each parameter must be made
known to the extract objective process. This can be accomplished in either of the these
two ways:

Analyze the CALLed program and save it in the AKR containing the CALLing
program. In some cases, this may not be feasible, e.g., the program source is not
accessible, the program may be so large that sufficient resources are unavailable, or
the program is non-COBOL.

Write a pseudo source module, identifying the type of each parameter. Analyze this
pseudo source module instead of the actual CALLed program.

See "The Analyze Facility" on page 36 for more information about using Encore to
analyze a program.

Precisely defining the parameter types in a pseudo source module results in more accurate
extract results for the report and Computation Variable extracts, because unnecessary
code is not extracted.

These are the rules for writing pseudo source modules:

For input parameters, use a MOVE data-item TO ws-data-item statement.
where:

ws-data-itemrepresents a WORKING-STORAGE data item that is the same
data type as data-item.

For output parameters, use a MOVE SPACES TO data-itemstatement. A
MOVE ZEROES statement may be used if appropriate.

For output parameters that are only possibly modified (as opposed to definitely
modified) by the called routine, code the MOVE SPACES TO data-item
statement in an IF statement that tests a WORKING-STORAGE data item.

Code all inputs before outputs. If a data item is both an input and an output, code it
first as an input and then as an output.

The LINKAGE SECTION declarations should match the declarations in the
CALLing program.
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Figure 186 and Figure 187 on page 202 are examples of a program that CALLs a
non-COBOL subroutine that calculates an interest amount, and the pseudo source module
that may be written for that subroutine.

Figure 186 « Program Being Re-engineered

IDENTIFICATICN DIVIZICH.
PROGRAM-ID. WVIARDEMO.

DATAL DIVISION.
WORKING-3TORLGE SECTICH.

T WORK-LOAN PIC 9539,
7 WORK-RATE PIC 9295,
7 WORK—-AMOUNT PIC 9559,

MOVE 10000 To WORE-LOAN.

MOVE 9.5 TO WORE-RATE.

MOVE 10 TO WORE-LMOUNT.

CALLL “3UBRTH’ UIING WORK-LOAN.
WORK-RATE, WORK-LMOUNT.

DISPLAY WORK-LOAN WORK-AMOUNT.
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Scenario 1

202

In Figure 187, the pseudo source subroutine SUBRTN contains these parameters:
LOAN-AMT, INTEREST-RATE, and INTEREST-AMT. The first MOVE statement of
the pseudo source module specifies a use of LOAN-AMT, indicating that LOAN-AMT is
an input parameter. The second MOVE statement indicates that INTEREST-RATE is
also an input parameter. The third MOVE statement specifies a modification to
INTEREST-AMT, indicating that it is an output parameter.

Figure 187 « Pseudo Source Module

IDEMTIFICATION DIVISICH.
PROGRAM-ID. SUEBRTH.

DATAL DIVISICH.
WORKING-3TORAGE SECTICH.

7 Wa-LOA-AMT FIC 9999,
K W3-INTEREST-RATE PIC 9999,
LINKAGE SECTICH.

K LOAN-AMOUNT PIC 9999,
7 INTEREST-RATE FIC 9999,
K INTEREST-ANT PIC 9999,

FROCEDURE DIVIATION USING LOAN-AMT.
INTEREST-RATE, INTEREST-AMNT.
*

FINPUTS
*

MCWVE LOAN-AMT TO W3-LOAN-AMT.

MNCWE INTEREST-RATE TO W3-INTEREST-RATE.
*

*QUTPUTS

*
HOVE ZERCES TO INTEREST-AMT.
GOBLCK.

Because both the report and Computation Variable extract objectives assume that all
parameters are both input and output, these scenarios explain the example (see the code
of the program in Figure 186 on page 201 and Figure 187).

A Computation Variable extract is performed for the variable WORK-AMOUNT at the
DISPLAY statement.

o Without a pseudo source module, the MOVE 10 TO WORK-AMOUNT statement
would be extracted because it is assumed that WORK-AMOUNT is both input and
output.

o With a pseudo source module, the MOVE statement would not be extracted.
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A Computation Variable extract is performed for the variable WORK-LOAN at the
DISPLAY statement.

. Without a pseudo source module, the CALL statement would be extracted.

e  With a pseudo source module, the CALL statement would not be extracted.

Including Non-selected Code in the Logic Segment

Under certain conditions, Encore produces a result that does not include all required code.

Figure 188 « Logic Segment - Non-selected Code Example

ooo2az
QoQ243
aogzd4
a0oe4s
ooo2ae
ooo24av
QoR248&
anozda
alifaleista]
ooo2sL
Qo252
Qog252
Q00254

ACCT -HAINTENANCE.
READ TRAM-FILE
AT EMD
MOVE EOF-LITERAL TO TRAW-FILE-FLAG
GO TO ACCT-HAIMTEMAMWCE -EXIT.
ROD +1 TO TRAN-CHNT.
MOYE TAAN-RCCT-KEY TO ACCT-KEY .

READ ACCT-FILE EEY IS ACCT-KEY

In Figure 188, assuming that only the READ statement was determined to be part of the
result, Encore would not have extracted line 250 relating to TRAN-CNT.

For Reports extracts, Encore allows for the inclusion of omitted lines of code from the
resulting Logic Segment.
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To include lines in a Logic Segment

1 Select View P Logic segment and press Enter to display the View - Select Logic
Segment pop-up, as shown in Figure 189.

Figure 189 « View - Select Logic Segments Pop-up

VYiew = Select Logic Segment E LOGIC SEGMENTE
Commaned ===3 _ Scroll === CER
5 - Helect
Program Lagie Seqment Mame Description
_  VYIARDEMD INTEREST-CALCULAT ION INTEREST-CALCULATION LOGIC 3SEG
5 WIARDEMD REFORT-0O01 Feport
YIARDEMD TARNEACTION-2a01 Transaction

srxxwresenreseesexeesexsexeneex OOTTOM OF DATHA #*stxsesasstsaxststnnt xnet s

2 Type S to the left of Logic Segment REPORT-0001 and press Enter to display the
Source View screen, as shown in Figure 190.

Figure 190 « Source View Screen - Non-Expanded

Saurce View Frogram: WIARDEHD
Command ===% _ Scrall ===» C3R
Q00243 ACCT-MAINTEHANCE. LOGICSER
- - - - - - - - - - - - = = = - = 1LINE NOT DISFLRYED
Q10245 READ TRAMN-FILE LOGICEEE
QO029G AT EMD LOGICEEE
Qo247 MOWE EOF-LITERAL TO TRAW-FILE-FLAG LOGICEER
aon24ds GO TO ACCT-HAINTEMAMCE-EXIT. LOGIGSER
R R T T 3 LIMES MDT DISFLAYED
Q0252 MOYE TRAMN-RCCT-KEY TO RCCT-KEY . LOGICSEE
- - - - - - - - - - - - = - = - - 1LINE HOT DISPLRYED
Qo254 READ ACCT=FILE KEY IS ACCT=KEY LOGICSER
Qo025 INVYALID KEY LOGICSEG
R R T T 3 LIMEE MOT DISFLRAYED
Qo02549 MOYE +4 TO WORK-AETURN-CDDE LOGICEEER
QOD26Ea GO TO ACCT-HRINTEMANCE-EXIT. LOGICEER
- - - - - - - - - - - = = - = - 3 LIHES MOT DISPLARYED
Q00264 FERFORM UPDATE-ACCT THRU UPDATE-ACCT-EXIT. LOGICSER
- - - - - - - - - - - - = - = - - 1LINE NOT DISFLRYED
QOn26G IF ACCT-MIN-BALAMCE IS LEE3 THAN ACCT-BALAMCE LOGICEER
QOD26T PERFORM EXCEPTLOW-REPORT-1. LOGICSER
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3 Position line 243 to the top of the screen.

4  Place the cursor immediately below line 248 and press PF4 (Zoom In) to expand the
view to include non-selected lines, as shown in Figure 191. Notice that the expanded
lines (249 - 251) are not part of the Logic Segment. They are not highlighted, nor are
they tagged with LOGICSEG.

Figure 191 ¢ .Source View Screen - Expanded

Source View 13 DETRIL LIHES
Command === Scroll ===% CER
L0029%  ACET-MAINTEWAMNCE. LOGICZEG
pON2d4
BON245 READ TRAW-FILE LOBICSEG
AO02dE BT EHWD LOGICSER
[a024a7 MAOYE EQF-LITERAL T4 TRAN-FILE-FLAG LOGICEER
Ba0zdE GO TO ACCT-MAINTENRAMCE-EXIT. LOGICSEG
panz4s
BON25a AabD  +1 TO TRAN=CHT.
pON251
AODZ252 HOVE TRAW-ACCT-KEY TO ACCT-KEY. LOGICEER
[a0Z53
RODz54 READ ACCT-FILE KEY IS ACCT-KEY LOGICSEG
RON2EE THWALID KEY LOGICSEG
BON25E MOYE ACTION-HISSING-ACCT TO WORK-ACT INM-REASON
QO0ZST MOYE SPACES TO ACLT-RECORD
[a0258 FERFORM IMITIATE-ACTION
Ela] =] MOYE #4 TO WAORK-RETURN-CODE LOGICSEG
QONZER GO TO ACCT-MAINTEWRMCE-EXIT. LOGICSEG
BON2E1

5  Type I online 250, as shown in Figure 192, and press Enter to refresh the Source
View screen (see Figure 193 on page 2006).

Figure 192 « Source View Screen - Including Source Line in Logic Segment

Source Wieu % DETAIL LIKWES
Command === Scroll ===% C3SR
@0024%  ACCT=-MAIMTEMWANCE. LOGICSEG
Qooz244
Qo045 READ TRAM-FILE LOGICSEER
QODZ4E AT EHND LOGICEEG
aooz4y HMOYE EQOF-LITERAL TO THAM-FILE-FLAG LOGICSEG
Qo248 G0 TO ACCT-MAINTEMANCE-EXIT. LOGICSEG
a0024a
100250 HDD  +1 TO TRAM-CNT.
QODZs1
aooze2 HOYE TRAW-ACCT-KEY TO ACCT-REY. LOGICSEG
- - - - - - - - - - - - - - - - - 1LINE HOT DISPLAYED
Q0054 READ ACCT-FILE KEY IS ACCT-KEY LOGICSEER
QO0Z6S INVALLID KEY LOGICSEG
T T T T R R R T 3 LIMES NOT DISPLAYED
QO00z259 HMOYE +4 TOQ WORK-RETURN-CODE LOGICSEG
A002ER GA T ACCT-MAIMTEMAMCE-EXIT. LOGICSEG
e T R T 3 LINES MOT DISPLAYED
QODZ6 PERFOAM UFDATE-ACCT THAW UPDATE-ACCT-EXIT. LOGICSER
- - - - - - - - - - - - - - - - - 1LINE HOT DISPLAYED
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The Source code at line 250 is highlighted and has been included in the Logic
Segment, as shown in Figure 193.

Figure 193 « Source View Screen - Source Line Included in Logic Segment

Source View Fragram: YIARDEHD
Carmand === Scrall ===% CER
LoD249z  ACCT-MAINTEMANCE. LOGICSER
Qoo244
a00z24% READ TRAM-FILE LOGICSER
AO0Zd6 AT END LOGICSEG
o024y MOWE EOF-LITERPAL TO TRAW-FILE-FLAG LOGICSEER
Lan2gE GO TD ACCT-HAINTEMAMCE-EXIT . LOGICSEER
@o0243
ao0nzsa ADD +1 TO TRAN=CHT.
Qoo0251
o025 MAOYE TRAN-ACCT-KEY TO ACCT-REY . LOGICEEER
L0253
LOD254 READ ACCT-FILE KEY IS ACCT-KEY LUOGICEEER
Q00255 INVALID KEY LOGICESER
Q00256 MOWE ACTION-MISSIMG-ACCT TO WORK-ACTION-RERSON
QoR25T MOYE SPRACES TO ACCT-RECORD
non25g FERFDRH IMITIATE-RCTION
Lanz2&a MOYE +4 TO HORK-AETURN-CODE LOGICSEER
[ul] el o] GO TO ACCT-HAINTEMANCE-EXIT. LOGICESER
Qo0261

Because the Logic Segment has been changed, you must save the file before
returning to the Encore Primary screen.

Select File » Save Segment and press Enter to display the File - Save Logic Segments
pop-up.

Type S next to the Logic Segment to be saved and press Enter to display the

File - Save Segment pop-up. Type the appropriate descriptive information and press
Enter to return to the File - Save Logic Segments pop-up. Press PF3 until you return
to the Encore Primary screen.

Note:

In addition to the identified statement, Encore ensures that all the code necessary to
execute the statement is also included in the generated module.
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Controlling Extract Boundaries

There are instances when each extract objective gives you more code than you want. For
example, when the output statements for a particular file are imbedded within a Perform
Range. You want to extract only those output statements imbedded in the Perform Range
and generate a CALLable module.

A Perform Range extracts the desired statements. However, it also extracts all statements
that can be executed by the Perform statement, including other Perform Ranges and GO
TOs. A Transaction extract with altered START and END points does not sufficiently
narrow the scope of the extract unless the statements are adjacent.

A Report extract isolates the output statements mentioned in the first example. It also
extracts all contributing or influencing statements from the selected statements to the
beginning of the program, giving you more code than you want. Also, the Report extract
does not generate CALLable modules.

The Report extract objectives allow you to extract code from an existing Perform Range
or Transaction Logic Segment. Normally, within the Report extract objective, code is
extracted from the selected statements to the beginning of the program. When you
perform a Report extract from a Logic Segment, the extract boundaries are now from the
selected statements to the beginning of the Logic Segment.

Extracting Code from a Logic Segment

When extracting code from an existing Logic Segment, follow the same procedure as you
do when you perform a conventional Report extract (see "Extracting the Report" on page
184) with the exception noted in step 3 below and step 4 on page 208.

To extract code from a Logic Segment

1 Select Extract » Report and press Enter to display the Extract - Name Logic Segment
pop-up.

2 Accept the default name and press Enter to display the Extract - Report Name List
pop-up.

3  Type Filter on the command line and press Enter or press PF5 to display the
Extract - Report Filter pop-up (see Figure 194 on page 208). When the
Extract - Report Filter pop-up displays, enter an asterisk (*) in the Report Name
field, which allows you to perform the extract against an existing Logic Segment.
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4  Select the Limit to within an existing segment option by typing a forward slash (/)
next to the option, as shown in Figure 194. In addition to typing data in the various
fields as you would for a conventional extract, the option Limit to within an existing
Segment is used to indicate that the extract is to be done within a Logic Segment.

Figure 194 « Extract - Report Filter Pop-up

Extract - Report Filter
= Type information far filtering Report WName list.

Repart HName x
Data Mame
CORYBODK Hame
Lime HAange

Optiong
s Limit to withinm an existing Segment

rxawEeXewsaneeseReeewre ety QOTTOM OF DATH txtXst st st KM et St u0t XM EkEE

PFd=Vied PFS=Filter PFL7=Sort
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7 Report Extract

Press Enter to display the Select Extract-within-Logic Segment pop-up, as shown in
Figure 195.

This pop-up is used to select the Logic Segment for code extraction. Only Perform
Range or Transaction Logic Segments are displayed in the list of Logic Segments.
Only one Logic Segment can be selected.

Figure 195 ¢ Select Extract - within Logic Segment Pop-up

Select Extract-within Logic Segment 1 LOGIC SEGMENTS
Command ===> Scroll ===> CSR

Select the Logic segment which limits or bounds the current Extract
definition. Then press Enter.

S - Select
Program Logic Segment Name Description
_ VIARDEMO PERFORM-RANGE-0001 Perform Range

KK K K K K 3K K K KK K KKK 30K IOROKOIOKOKCKOKOKCRKOK R BOTTOM OF  DATA k% 50K K 3K K 3K K K 3K K K % K K K K K K K 3K K K K K X K

After selecting the Logic Segment, press Enter to highlight the selection. Press Enter
until you to return to the Extract - Report Name List pop-up.

From this point on, the extract procedures are the same as for a conventional Report
extract (see "Extracting the Report" on page 184). Only those statements that lie
within the selected Logic Segment are eligible for extraction.

Note:

Because the Logic Segment contains 1O statements, you may want to consider
selecting the CALLs to IO Module(s) option when you generate the program to
avoid the COBOL constraint of referencing files across program boundaries.
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Report Extract Compilation Issues

Condition 1

Condition 2

210

When Encore generates standalone replacement and Complement Modules from a Report
Range extract, certain conditions may occur that could cause compile errors or the
program not to run at all. As shown in this section, Encore inserts comment messages in
the generated modules when these conditions occur.

Encore has generated statements that cause normal exits from the program.

Encore generates program exit Review the conditions surrounding each
statements (GOBACK, EXEC CICS generated exit statement to determine if
RETURN) to ensure that the program the default exit statement should be
exits properly. augmented or replaced.

Encore has determined that a COPY statement cannot be used. Portions of the copybook
are reproduced inline.

Under certain conditions, the original Determine why the COPY member was
COPY statement cannot be used in a notusable. No action is required, however,
generated module, such as when COPY the COPY member contents may be
statements contains dead code. modified to use it in this context.

In addition to this, Encore generates Example:

comments indicating why the COPY . . .
statement could not be used as originally %ﬁgg};?(i)sogol;gze&g gﬁggﬁiﬂ&gﬁm&
coded. ’

contains statements that are not referenced
by this particular program. Those
statements are considered dead code.




Condition 3

Condition 4

Condition 5

7 Report Extract

Encore has generated a DISPLAY statement prior to each abnormal program exit.

Encore has generated DISPLAY Review the conditions surrounding each
statements just prior to a generated generated DISPLAY statement to
abnormal program exit. determine if it should be augmented or

replaced. Ensure that a DISPLAY is an
appropriate action for the condition that
occurred.

Note:

A DISPLAY is not generated for a CICS program, or when a subroutine is specified on
the COBOL Module Exit field on the Options - Product Parameters pop-up (see Figure 7

on page 27).

Encore has tailored OPEN or CLOSE statements.

Cause Action

For Computation Variable and report None.
objectives, Encore ensures that all

necessary file-related statements are

extracted, including OPENs and

CLOSEs. When an OPEN or CLOSE

statement includes references to files that

are not required by the Logic Segment,

Encore tailors the statement to reference

only the desired files.

STOP RUN in empty Exception clauses (i.e., ON SIZE, ON OVERFLOW).

Cause Action

COBOL does not permit a NEXT Revise to include a more meaningful error
SENTENCE to appear in an exception  handling routine.

clause. Encore inserts a STOP RUN in an

exception clause that is part of a Report

Variable extract.
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CICS Server Extract

This chapter contains a practical demonstration of how to perform a CICS server extract
to create a COMMAREA-based server program from a 3270 CICS
pseudo-conversational program, and contains these sections:

Section Page
Introduction 213
The Business Scenario 214
Conversion Process 215
Starting an Encore Session 216
Extracting the CICS Server Program 217
Generating the CICS Server Module 223

Understanding the Results of the CICS Server Module Generation 234

CICS Server Extract Compilation Issues 242
Extracting the Self Directed Server Program 245
Using IBM Solutions 254

Introduction

In addition to demonstrating the technique of using a CICS server extract to create a
COMMAREA-based server program from a 3270 CICS pseudo-conversational program,
this chapter also discusses the various ways to use a server program to accomplish the
goal discussed in The Business Scenario, including execution and compilation issues.

Note:
The Encore demonstration program VIARBRWS is used for the examples in this chapter.
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The Business Scenario

214

You have a CICS application that tracks the 401(K) contributions made by your
employees. The application allows new contributions to be made, past contributions to be
updated to correct data entry errors, and all past contributions to be viewed. Application
users have requested that the view function be made available through a web browser.
You have tried web access to CICS through 3270 Bridge, but you know that this is a
short-term solution because Bridge depends on the screen layout, which may change
from time to time. You would also like the solution to be adaptable to new ways of
interfacing to the external world, e.g., through a Java servlet that performs additional
processing before generating an HTML page.

The implementation of web access for existing CICS applications should be viewed as a
re-engineering process. For applications where presentation logic and business logic are
intermixed, migration to another presentation medium using the existing presentation
logic may be inefficient or impossible depending on your current environment. Encore
allows you to separate presentation logic and business logic in both conversational and
pseudo-conversational CICS programs, resulting in a CICS server program containing
business logic. Once the CICS server program is isolated from the presentation logic, it
becomes a business logic component that can be invoked from a web server, as well as
from other client types, (e.g., Java servlets, MQSeries, and CICS clients on other
platforms).

This chapter demonstrates how this business scenario can be handled by Encore through
its server extract and generation facilities.

Note:
This process also includes steps that are performed outside of Encore.
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Conversion Process

Figure 196 shows the process of converting the browse function in the application to
support web access.

To convert the application browse function

1 Analyze the browse program for Encore. See "The Analyze Facility" on page 36 for
more information about using Encore to analyze a program.

2 Extract the logic responsible for record retrieval. The resulting program is known as
the Next-Page server module. For this demonstration, extract the logic responsible
for retrieving records in the backward direction, with the assumption that employees
would want to view the most recent records first.

3 Generate the server program containing the extracted logic.

Figure 196 = CICS Server Extract/Generation Business Scenario Example

Original Application

‘ Function WMenu ‘ MMMMMM

T Ty

EXEC CICS SEND

EXEC CICS RECEIVE

/ % > SER . Browse
s iAFED CLIENT @ | 0| | e
Ao EREERARERRDLLIEENT 1 e

ENCORE CICS SEmEXTRACT-

Mainframe

wsgrRvER . NN | |
TR - clzmmg/rk SERVER
\ ﬁ Encore Generated \Q
¥ et e e
EXEC CICS LINK
EXEC CICS SEND
Browse 01 Expanded Parm List Browse EXEC CICS RECEIVE
05 Original Parms > 3
Server 05 Screen Data Client
EXEC CICS RETURN

IBEM Provided
Solution Weh
Server
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Starting an Encore Session

216

To start the Encore session

Note:
Logon procedures and AKR information are unique to your programming environment.
If necessary, contact your systems administrator or your Encore coordinator for the
correct dataset names.

1 Logon to the ESW Primary screen.

2 Select Re-engineer P Program and press Enter to display the Encore Primary screen.
Or

Type EN on the command line and press Enter to display the Encore Primary
screen.

3 Select File » Open and press Enter to display the File - Open Program pop-up.

4  Type the AKR dataset name in the Data Set Name field and VIARBRWS in the
Program Name field and press Enter.

See "Starting an Encore Session" on page 59 for more information.
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Extracting the CICS Server Program

To select a Server extract

Select Extract P Server and press Enter to display the Extract - Name Logic Segment

pop-up, as shown in Figure 197.

The name field on this pop-up contains a default name generated by Encore. You
can assign your own name to the Logic Segment or you can use the default name.

For this example, use the CLIENT-SERVER-0001 default name.

Figure 197 « Extract - Name Logic Segment Pop-up

File View Extract Generate Search List Options Help

Extract - Name Logic Segment ram: VIARDEMO
Command ===
Type name of logic segment. Then press Enter.
KK KKK XK
Name . . . CLIENT-SERVER-0001_ KKK KKK K
KKK KKK KKK K K K K K K K K K KK X KKK KK KKK KK K K KK XK K KX KX KKK XK K X
KK KKK KKK K K K K K KK K K KK K KKK KK KK KK K K K KK K KK KKK XK K KK KK KK K
KKK KK K KKK KKK KK KKK X XKEKXR
KKK XK KKK KX KK KK K KKK K KK
KX KX KKK KKK KK KKK K KK K K R KK KK K K K K KR KKK KKK K K OK K K K KK X
KKK XK K KKK K KKK KKK K K K K K KK K K K K K K KKK KKK K KKK K K K K

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Visit the ASG Support Web Site at www.asg.com

Press Enter to display the Extract - Server pop-up (see Figure 198 on page 218),

which contains a list of available server types.
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3  Type 1 to select CICS, as shown in Figure 198, and press Enter to display the
Extract - CICS server Endpoints pop-up (see Figure 199 on page 219).

Figure 198 « Extract -Server Pop-up

File View Extract Generate Search List Options Help

Extract - Serwver Program: YIARBRWS

Select the type of server to generate.
KK KK K KKK K K K K K K K K K KK K K K K

Tgpe KR KKK K KR K KK K R K KK K KR KR K
1 1. CICs LR
2. Self Directed XK KKK
K KK K OK KK K K K
KKK X R OK KKK KR
————————————————————————————————————————————— O K KK XX
R XKOK K KKK XK XK R XK KK XK XK KK X
KK KKK K KKK K R KR KK K K KK K K K K R K OK KK K R OK K KK R K KK K KR KK KK K
O KKK KKK K KKK KK R KK KK KR KK K OK R R KK KK KK OK KR KK XK

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
¥isit the ASG Support Web Site at www.asg.com

Note:
If you select the Self Directed server name you can reduce the list of selectable
names by pressing PF5. The Filter - Self Directed Server pop-up displays, which
allows you to specify filtering criteria. See "Extracting the Self Directed Server
Program" on page 245 and the online help for more information about the

Filter - Self Directed Server pop-up.
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To ensure that you are selecting the code you want to extract, type V next to the CICS
EXEC you want to view, as shown in Figure 199. Press Enter to display the View
Source pop-up (see Figure 200 on page 220).

This pop-up contains all of the statements associated with the CICS member. You
need to extract all statements that contribute to the output screen.

Figure 199 « Extract - CICS Server Endpoints Pop-up - View Option

Extract - CICE Server Endpeints

Cotmand === Eecroll === CER
Select the statement for each CIC% Serwver Endpoint and press Enter to wiew
the corresponding Startpoeints, This screen will be redisplaged to allow
additional Endpoints to be selected. Press Enter when all selections are
complete .

5 - Belect VW - Wiew Source U - Unselect

opdAdsl EXEC CICS SEND MAFL'BROWEE') WAPSET ['VIARERW')

OEGdE2 ERRSE END-EXEC.
v DB@GLE EXEC CICS SEND MAPI('ERDWSE'] HAPSET (' VIARBRW']

IBAG1E ERASE END=EXEC.
_ beagsl EWEC CICS SEWD MAPT BROWSE') HAFPSET (' VIARERW') END-EXEC.

OBEAET 2 EXEC CICS SEND MARL EBROWEE') WAPEET ['VIARERL')

OBRAGET3 EARSE END-EXEC.
_ 0BoE34 EMEC CICS SEWD MAPT BROWSE') HAPSET [ VIARBRW'I

0BA6S5 ERARSE END-EXEC.
_ OPATas EXEC CICS SEWD MAPL'MENU') MAPSETL'VIARHKWU') ERASE EMD-EXEC.
FREEEMARAEMERLERARNERLRN ey BOTTOM OF DATA EEEATEAENERLENEEATHNLR AL MARNE

219



ASG-Encore User’s Guide

220

Verify that the CICS EXEC server code selected represents the type of code you
want to extract, as shown in Figure 200. After verifying the code, press PF3 to return
to the Extract - CICS server Endpoints pop-up (see Figure 201). If necessary, repeat
this process until you find the code you want to extract.

Figure 200 « View - Source Pop-up - CICS Extract

Tiaw - Source Fruo 2 LIMES FOUND
Command ===% _ Joroll === CER
ogosoa WOWE HUMB TO HUMBERLO.
ogogs1n HOYE HAME TO HRMELD.
[alclif=y B HOWE AMAUNT TO AMOUMTLO.
Oo0E12 «
OO0E1E & OISPLAY HAP
ogngld =
0goslh EXEC CICS SEMD MAF [ BROHSE') MAPFSETI WIARERW™] LINE RHG
DA0G16 ERASE EMD-EXEL. LINE RHG
DADELT x
OOOELE « FETURM WITH A COMM. RAREA.
Do0E1G *
ogosz20n EXEC CICS RETURM TRAMSIDCEIBTRMID] COMHARER [COHMAREA]
0ans21 LEMGTH (131 EMD=EXEC. FGH EXIT
oo0822 =
DADEZE « AFTER THE "RECEIWE" COMHAMD EXECUTES, THE FRDGRAH TESTE THE
Oo0EZ24 « OFERRTORS FESPONSE. adWLY "CLEARR™, "PFL", "FF2™, "F" OR "B"
Do0BE35 * KEYS ARE TAKEN AS YALID IMPUT.

Type S next to the line you want to select and press Enter to display the
Extract - CICS Server Startpoints pop-up (see Figure 202 on page 221).

Figure 201 « Extract - CICS Server Endpoints Pop-up - Select Option

Extract - CICS Server Endpoints

Command === Seroll ===% CER
Eelect the statement for each CICE Server Endpoint and press Enter to wiew
the correspending 3tartpoints, This screen Will be redisplayed to alleod
additional Endpeints te be selected., Press Enter when all selectlions are
complete .

5 - Select W - Yiew Source I - Unselect

oAadsl EXEC CICE SEND HAP [T EROWSE'] MAPSET L'VIAREBRL' |

oa0daz? ERASE EMD-EXELC.
= N@06LE EXEC CICS SEMD HAP ['BROWSE'] MAPSET ['VIAREAW')

DaN61E ERASE END-EXEC.
_ beges2 EXEC CICS SEND HAP [T EROKSE 1 MAPSET [ WIAREBRL 1 EWD-EXEC.

Oao0E?? EXEC CICES EEND HAP['EROMWSE'] MARSET | VIARERL'|

oa06ET3 ERASE EMD-EXELC.
_ hans3d EXEC CICS SEND HAP['BROWSE'1 MAPSET [ WIAREAW']

NANESs ERASE END-EXEC.
_ 0A07as EXEC CICE SEND WAP [T HENU'] HAPSET L' WIARMHU') ERASE EHND-EXEC.
FEARAFRAFAFRLELIMNAXAF ML N0k 0k BOTTOM OF DATA XX LEMARLXMLXLRNER ARMER LRAE
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Type S in the indicated command area or press Enter to accept the selection (all
highlighted text is preselected, see Figure 202). Press Enter to return the
Extract - CICS Server Endpoints pop-up, (see Figure 203).

Figure 202 « Extract - CICS Server Startpoints Pop-up

Extract - CICE Server Startpoints
Cammamd ===% _ Scroll ===% CER

Select statements for CICS Serwver Startpoints and press Ernter.  Press Enter
when celections are complete fo return to the Endpoints SCrean.

Endpaint
5 - Select YV - Yiew Source I - Unselact
0AdeE24a EXEL LICS RECEIVE HMAPL'BROUSE'] HAPSET (' VIARERW')
0oaE30 RESP (RESFONSE] END-EXEC.

FEXAXEEXEXNEEX X KAMKE X xxwxt Xt BOTTOM OF DATH ZEXE XAMEEXERXE XN ERXER R R XN E

The message displayed in the long message area confirms that the CICS statements
for the EXEC CICS SEND code were successfully selected. Press Enter to display
the Extract - CICS Server Paths pop-up (see Figure 204 on page 222).

Figure 203 « Extract - CICS Server Endpoints Pop-up - Selection Confirmation Message

Extract - CICS Serwer Endpoints

Command === Scroll ===} CSR
Select the statement for each CICS Server Endpoint and press Enter to wiew
the corresponding Startpoints. This screen will be redisplayed to allow
additional Endpolnts to be selected. FPress Enter when all selections are
complete.

S - Select Wo- Wiew Source U - Unselect
— BaGa4s1 EXEC CICS SEHD MAF('BROWSE') MAPSET('WIARERW' 1

ooa4ez ERASE EML-EXEC.
— BEGELS EXEC CICS SEMD MAF( EROWSE') MAPSET( ' WIARERW )

OOAELE ERASE END-EXEC.
— BEGESZ EXEC CICS SEMD MAP('EBROWSE') MAPSETE'WIARERW') EHMD-EXEC.
— BEGEETZ EXEC CICS SEMD MAFL BROWSE') MAPSET( WIAREBRW )

OOAETE ERASE EML-EXEC.
— BE0E34 EXEC CICS SEHD MAF('BROWSE') MAPSET('WIARERW' )

OOaEas ERASE EML-EXEC.
— BEETIS EXEC CICS SEMD MAFC ' MEMU') MAPSETC( WIARMMU' ] ERASE EMD-EXEC.

ASGHIEZT CICS STATEMENMTS SUCCESSFULLY SELECTED.
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The default T (TRUE) or F (FALSE) selections have been made based on the
selection criteria, as shown in Figure 204. An X indicates that the code does not
apply to this extract. You can change the settings, if desired. Press Enter to return to
the Encore Primary screen (see Figure 205).

Figure 204 « Extract - CICS Server Paths Pop-up

Extract - CICS Server Patns
Command ===% _ Beroll === CER

ITdentify conditionals which are definitely TRUE for the Serwer, those which
are definitely FALSE, and leawe blank the conditionals Which may be either
TRUE or FALSE. Press Enter uhen all selections are complets.

T - THUE F - FALSE blank - TRUE/SFALSE V - ¥iew Source
T 000285 IF EIBCALEN HOT = @ THEN
¥ 0DAZT? IF EIECALEN = O THEM GO TO NEXT-LIKE.
0Dasa6 IF EIRCALEWM = O THEN GO TO TEST-STATS.
F ORaGz4 IF EIBAID = DFHCLEAR THEH
F 0ga640 IF EIBAID = DFHFFL OR DIRI = "F° THEW GO TO PRAGE-FORWARD,
T 000641 IF EIBAID = DFHFFZ OR DIRI = "B° THEMW GO TO PRGE-EACKUARD.
EEHEMEE LRk K ¥ BEDTTOM OF DATA MEemEd S3Mer 0eRE S femanns

The Encore Primary screen displays with a message indicating that the criteria for
the statement extract were successfully selected.

Figure 205« Encore Primary screen - CICS Statement Selection Confirmation Message

File M“iew Extract Generate Search List Options Help

ASG-Encote Frogram: WIARBRWS
Command ===k _
shesteshh etk hkehoh Hektkoh
sk ko skoksokop kot
skt kot skt hohek okt
etk shespekeske: sepokctok dekokiok sk
Heskkbeh
skt

Copyright Allen Systems Group, Inc., an unpublished worl.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
VYizit the ASG Support Web Site at www. asg.com

| ASG41E2T CICS STATEMEMTS SUCCESSFULLY SELECTED. |

See the online help for more detailed information about CICS extract features.
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Generating the CICS Server Module

Now you are ready to create a standalone CICS server module that contains all of the
statements required to produce the CICS server.

To generate the CICS server module

1 Select Generate » Server and press Enter to display the Generate - Select Logic
Segment pop-up, as shown in Figure 206.

Figure 206 * Generate - Select Logic Segment Pop-up

Generate - Select Laogic 3egment 1 LOGIC SEGHMENTS
Command ===} _ Scroll === CSR
3 - Select
Fr ogram Logic Segment MName Description
S VIARBRWS CLIENT-SERVER-DOOL Client Server

sexewnenewsexrexexzexeneenewxey HOTTOM OF DATHA 0w somimsoe o0m i a0 se e o008 wom e 508w %0 30

2  Type S next to the Logic Segment name you want, or accept the default selection,
and press Enter to display the first Generate - HOST Copy Member pop-ups (see
Figure 207 on page 224).

Note:

The number of Generate - HOST Copy Member pop-ups displayed during this
procedure depends on the ENDING and STARTING statements selected on the
corresponding Extract - CICS Server Endpoints (see Figure 201 on page 220) and
Extract - CICS Server Startpoints pop-ups (see Figure 202 on page 221). A
minimum of two Generate - HOST Copy Member pop-ups always display for a
generated server.
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Type the new name you want to assign to the DFHCOMMAREA copy member in
the Copy Member field (CPYCOMAR in this example, see Figure 207). Assign the
starting level number and level number increment you want or accept the defaults
(the default record level is 5). Press Enter to display the second Generate - HOST
Copy Member pop-up (see Figure 208 on page 225).

Figure 207 « Generate - HOST Copy Member Pop-up Number 1

Generate - Select Logic Seghent
L mmm - mm e oe— - ————-——-—--——---_ 11 ===} LC5R

Gernerate - HIET Copy Hewmber 1 4aF 2

Enter new COPY member infoermation, Press Enter when

complate.

5 Existing Copyback Information

x Copy Hembar . . . . . . . LS EREED E8 YT
Data Mame . . . . . . . . : DFHCOHMAREA

Hed Copybcok Information

Copy Metmber . . . . . . GFYCOHAR _
Starting Lewel Humber 5
Lavel MNumber Increment 5
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Accept the new copy member defaults, as shown in Figure 208, or change the name
and level numbers, and press Enter to display the Generate - HOST Server Module
pop-up (see Figure 209).

Figure 208 « Generate - HOST Copy Member Pop-up - Number 2

Generate - Select Logic Segment
L L -mmmmmmm st mmmm oo -—-——-—--—-—--- 11 ===} CiR

Generate - HOST Copy Member 2 0F 2

Enter new COPY member information. Press Enter when

complete,

S Existing Cepyboek Infarmation

¥ Capy Member . . . . . . . @ VIARERHLC EMERARNER LA T
Data MWame . . . . . . . . : EROWEED

Hed Copubook Informatlon
Copy Member . . . . . . VIARBRC3S
Ftarting Level Mumber =}
Level Mumber Increment ]

Type 1 to select Generate Options and press Enter to display the Options - Generate
pop-up (see Figure 210 on page 226).

Figure 209 « Generate - HOST Server Module Pop-up

Generate = 3clect Logic Segment
e e A

Generate - HOST Ceopy Hember |

E Gernerate - HOST Serwer Module

Tyme Program ID and select generation options, Rttt

E Objective . . @ Client Server R AR K
Frogram ID . . . SEAY¥ER
Functions

1 1. Generate options.. .
2. Genmerate COPY members...
1. Generate serwver module
9. Exit
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6  Indicate the options you want for the COBOL Module generation, as shown in
Figure 210, and press Enter. Press PF3 to return to the Generate - HOST Server
Member pop-up (see Figure 211 on page 227).

Figure 210 « Options - Generate Pop-up

Options - Generate

* Select the desired COBOL Module Generate Options.
Display EDIT Options _ Output to Existing Library
COBOL Source
Full DATA DIYISION _  Retain Source Line Numbers
_  Retain COPY statements _  Retain PERFORMed Paragraphs

In-l1ine Communication Area

The COBOL Generation Options pop-up allows you to select these generation
options:

Display EDIT Options Displays the ASG-SmartEdit Edit Options screen.

Output to Existing Allows Encore to insert the generated output directly
Library into the existing library.

Full DATA DIVISION Specifies whether the full DATA DIVISION should
be carried over into the generated module.

Retain COPY Specifies whether to retain or expand the copy

statements statements. Expand is the default. This option is only
used if the items in the COPY member are being
modified by the product. If no modification takes
place, COPY statements are always retained,
regardless of the setting on this option.

In-line Communication Specifies that you want to include the expanded
Area COPY Statements in-stream.
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Option Description

Retain Source Line Specifies that you want to preserve the original code
Numbers columns in the generated module.

Retain PERFORMed  Specifies that existing PERFORM Statements of

Paragraphs extracted Perform Ranges are replaced with a
PERFORM to an ESW-generated CALL section. If
this option is not selected, existing PERFORM
statements are replaced with CALL statements
(unless the statement is a PERFORM VARYING).

7  Type 2 to select Generate COPY Members, as shown in Figure 211, and press Enter
to display the Generate - COPY Members pop-up (see Figure 212 on page 228).

Figure 211  Generate - HOST Server Module Pop-up

E Generate - HOST Server Module
- ‘ Tupe Program ID and select generstion options,. | --—---------
f bDbjective . . : Client Server EWER AR A
Program ID . . . SEAYER
Functions

2_ 1. Generate options...
2. Generate COPY members.. .
d. Genarate server modula
4. E=it
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8 Type S next to the COPY member you want to select, as shown in Figure 212, and
press Enter to display the Edit screen (see Figure 213).

Figure 212 * Generate - COPY Members Pop-up

Generate = COPY Hembers
Command ===> Screll ===) CER

Select the COFY Members to be generated and press Enter. Press FF3/151END)
when all selectiens are complete,

5 - 3elect

COPY Hember Contents Cenerated
S CPYCOMAR DFHCOMHAREA HO

YVIARBRCS BROMSED HO

rxxxmrrrrnrrRTnrsxFrxekxcxcxxdx BOTTOM OF DATH S mssr asmrr sk s XA REF XA RENRT

9 Type CREATE on the command line and type C 9999 on the first line of code. Press
Enter to display the Edit/View - Create pop-up to save the module in your source
library (see Figure 214 on page 229).

Figure 213 « Edit Screen - CREATE Command

A5G-Encore EDIT - USERID.ENCICCCL COBOL COLUMNS 00001 00072
Command ===> CREATE jcroll ===> C3R
oo o o o o o o e e TDIJ of Datg #FF i a FF i T a A F T A A AT TTAANNTANNNS
C 9333 05 EESPONSE PIC 359(G) COMP.

oooooz 05 43G-DFHCOMH.

oooaos * ASG-ENCORE - DFHCOMMARER
ooooog *

oooaos 10  STATS PIC Xil).

oooaog 10 RIDE PIC 2ia).

ooooo? 10 RIDF PIC 2ia).

oooaog 05 &43G-DFHEIBEVARS.

aaoaog 10 A3G-EIBAID PIC Xl

FEEEFFE KEEEEEEERFXXLFFFFFAFFF5FF%%% Bottom of Data FHFrsstss dadd FFFFF Soosu oo %

5553555555 5555 5555555555 5553555555555555555555355555555555383553
2 A5G1e08I ENTER THE CREATE COMMAND TO SAVE THE COBEOL PROGRAM. =
55535355535 55355553535555 5553555535 53555555555353555555555352383383
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10 Type the name you want to save the member as in your source library, as shown in
Figure 214, verify or clear any data in the Data Set Name and Volume Serial fields,
and press Enter to return to the Edit screen (see Figure 215).

Figure 214 « Edit/View - Create Pop-up - CP’YCOMAR Member

Edit/Wiew - Create
Command ===3

"Current” Data Set: USERID.ENCO0033.COBOL

To ISPF Library:

Project . . . ASG
Group . . . . CEGQDXGCC
Type . . . . CHNTL
Member . . . CPFYCOMAR

To Other Partitioned Data 5Set Mewmbher:
Data 3et Name .
Volume Serial . . . [If not cataloged)
Data et Password . . [If password protected)

Enter /" to select option
Specify pack option for "CREATE™ Data 3et

Press ENTER key to create. Enter END command to cancel create.

11 The Edit screen redisplays with a message confirming that the member has been
created. Press PF3 to return to the Generate - Copy Members pop-up (see Figure 216

on page 230).

Figure 215« Edit Screen - CPYCOMAR Member Created

45G-Encore EDIT - USERID.ENCXXIZII, COBOL Mewber CPYCOMAR created
Command === doroll ==== C3R
FEERET AT ETHATET AN LAALASTAANAN AN S S TDD Df Dﬁtﬁ oo o o o o b o o o o o o o o ok o o o
oooool 05 EESPONSE PIC 52(8) COMP.

googoz 05 ASG-DFHCOMM.

000003 * ASG-ENCORE - DFHCOMMAREL
ooooo4 *

ooooos 10  STATS TPIC Xil).

oooooe 10 ERIDE PIC 9(&)

ooooo? 10 RIDF PIC 9(&)

ooooog 05 ASG-DFHEIBVARS.

ooooog 10 A3G-EIBAID PIC Xil)

FEEHEE KEEEEERERAEARAFRASASFFFAFHAS FBobbom of DAba Fass S sh s ha s a v aa S AR NFHNHRTH
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230

12 A message displays in the long message area indicating that the COBOL module has
been successfully generated, as shown in Figure 216. The status also changes from
NO to YES under the Generated column. Select the next Copy member and repeat
step 8 on page 228 through step 11 on page 229 to edit and save the member. Once
saved, press Enter and then PF3 to return to the Generate - COPY Member pop-up

13

(see Figure 217 on page 230).

Figure 216 « Generate - COPY Members Pop-up - Select COPY Member

Generate - COPT Members
Command ===

Select the COPYT Members to be generated and press Enter.
when all selections are complete,

5 - Select
COPYT Member Contents

CPTCOMAR  DFHCOMMARER
YIARBRCE — BROWSED

EOTTOM OF DATA

Scroll ===> CSR
Press PF2<1S(EMD)

Generat ed

ASG43231 COBOL MODULE SUCCESSFULLY GEMERATED. |

After the member has been saved, a message displays in the long message area
indicating that the COBOL module has been successfully generated, as shown in
Figure 217. The status also changes from NO to YES under the Generated column.
Press PF3 to return to the Generate - HOST Server Module pop-up (see Figure 218).

Figure 217 « Generate - COPY Members Pop-up - Confirmation Message

Gerierate - COPY Members
Command ===

Select the COPYT Members to be generated and press Enter.
when all selections are complete,

S - Select
COPYT Member Contents

CPYCOMAR  DFHCOMMAREA
WIARBRCS  BROWSED

EOTTOM OF DATA

Scroll ===} CSR
Press PF3<1SCEHD]

Generat ed

ASG43231 COBOL MODULE SUCCESSFULLY GEMERATED.
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14 Type 3 to select Generate server module and press Enter to display the Edit screen
(see Figure 219 on page 232).

Figure 218 * Generate - HOST Server Module Pop-up

E Generate - HOST Copy Member |

= o o -

- E Generate - HOST Server Module it
¥ Tupe Fragram ID and select generatian options. LEMEXNE

Dbjective . . : Cliant Server
Program ID . . . SERVER

Functions
d_ 1. Generate options...
2, Generate COPY members...
- 2, fGenerate server module
4, Exit
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15 Type CREATE on the command line and type C 9999 on the first line of code, as
shown in Figure 219. Press Enter to display the Edit/View - Create pop-up to save
the module in your source library (see Figure 220).

Figure 219 « Edit Screen - CREATE Command

A3G-Encore EDIT - USERID, ENCXCC, COBOL COLUMNS 00001 00072
Command ===> CREATE dcroll ===> C3R
e o S i i i i i e e i e i e i TDp Df Dﬁtﬁ e e o e o e e e e e el e
C gggg e i e i e i i e i e i i e i e i e i e e e e i e e e i e e i e e e e
aooanz * A3G, INC. *
ooooons: * *
oooong * GENERATED BY A3G-ENCORE BELEAZE &.0(000) *
aooans * *
aooane * PROGRAM: SERVER *
aooan? * *
ooooos * DATE: LO-MMM-YYYY HH:MM: 33 *
ooooog + REQUE 3TOR: USERID *
aooalo * *
aooall + AFR INFORMATION *
aoonlz * 'S NAME: USERID. PART. AKR *
ooooLs * MEMEER.: VIARERWS ALIAS: (NONE) *
oooolrd * *
aooals +* SEGMENT NAME: CLIENT-3ERYER-0001 *
ao0ale * *
aooal? * OBJECTIVE TYPE: CLIENT SERVWER *
00001 Esss5s553335553355533335333533555555555555555555555555555555333333330

00001 e A3G160SI ENTER THE CREATE COMMAND TO SAVE THE COEOL PROGEAM. e

00002 Desssssss5o553 55855 38055533858 555353 5555388553 385553335883338883s

oooozl

16  Type the name you want to save the member as in your source library, verify or clear
any data in the Data Set Name and Volume Serial fields, and press Enter to return to
the Edit screen (see Figure 221 on page 233).

Figure 220 « Edit/View - Create Pop-up - SERVER Member

Edit/¥iew - Create
Command ===3

"Current” Data 3et: USERID.ENCICCOK. COBOL

To ISPF Library:

Project . . . A3ZG
Group . . . . CEGOXZCI
Type . . . . CHNTL
Menber . . . 3ERVER

To Other Partitioned Data 3et Mewher:

Data Set HName .

Volume Serial . . . [If not cataloged)
Data %et Pasgsword . . [If pazsword protected)

Enter /" to select option
Specify pack option for "CREATE™ Data Set

Press ENTER key to create. Enter END command to cancel create.
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The Edit screen redisplays with a message confirming that the member has been
created, as shown in Figure 221. Press PF3 to return to the Generate - HOST Server
Module pop-up (see Figure 222).

Figure 221 » Edit Screen - Member SERVER Created

A8G-Encore EDIT - U3SERID.ENCXEIICK. COEOL Member ZERVER created
Command === Scroll ===> C3iR
o o B i i e i e i e e e e i e TDp Df Data i i e i i e i e i e i e o o
DDDDD]_ e e i i e i e i e e e e e e i e e i e e e i e i i e i i e i i i e i i o i e i
oooooz * A5G, INC. *
aoo0a3 * *
aooon4g * GENERATED BY ASG-ENCORE FELEAZE &.0{000) *
aooons = *
aooo0g * PROGRAM: SERVER *
aoooa? * *
0o000s * DATE: DD-MMM-YY¥YY HH:MM: 53 *
ooooasg * REQUE3TOR: TSERID *
aooolo " "
ooooll * LKR INFORMATION "
aooolz = 'S NAME: USERID.PART.AKR *
ooooLs * MEMEEER.: VIARERWS ALIAS: (NONE) *
ooool4d * *
ao00ls * SEGMENT NiAME: CLIENT-SERVER-0001 *
ao00le * *
aoooLl? * OBJECTIVE TY¥PE: CLIENT SERVER *
aoools IDENTIFICATION DIVISION.

aooo1e PROGEAN-ID. SERVER.

oooozo ENVIRONMENT DIVIZION.

0oo0z1

Type 4 and press Enter to exit the Generate - HOST Server Module pop-up and
return to the Encore Primary screen. The CICS server module has now been
generated.

Figure 222 « Generate - HOST Server Module Pop-up

E Generate - HOST Server Module
Type Program ID and select generation options. = | -----------

x Objective . . : Client Server KKK K KK K K K
Program ID . . . SERVER

Functions

4_ 1. Generate options..
Generate COPY members...

Generate server module

Exit

B WK
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Understanding the Results of the CICS Server Module

Generation

234

As a result of the CICS server extract, Encore created a standalone program that contains
all of the necessary statements, files, and data elements to produce the CICS server.
Figure 223 shows the comments generated by Encore at the beginning of the module. The
comments indicate the extract objective type and the name of the file extracted
(SERVER).

Figure 223 « CICS Server Module - Screen 1

oooool
nooonz
Qooons
Qooona
oooons
nooooe
oooon?
Qooons
Qooons
ooooLo
ooooll
nooolz
QoooLs
Qooola
0ooaLs
oooole
ooooL?
ooooLs
ooooLe
Qooozo
Qooozl

43G-Encore EDIT - USERID.ENCXCI.COEOL
Command ===

COLUMNS 00001 00072
Scroll ===> CiR

FEEREE FEXRFTHERXAERRAERRLRHRRRGRXXGLTS Top of Data FEFFrFaar e adaaadaa e FATRTLTHES

R R R R A T R A A T AT T AR AT N AT T RN AR AR T RN ST TR R ATRLS

*
+
+
*
*
*
+
+
*
+
*
*
*
+
+
*

GENERATED EY ASG-ENCORE

PROGRAM:

LATE:
REQUE 3TOR.:

AFE. INFORMATION
L5 NAME:
MEMEEE.:

SEGMENT NAME:

OBJECTIVE TYPE:

3G, INC.
FELEASE 6.0(000)

SERVER

DD-MMM-TYVY HH:MM: 33

VIASHG

USERID. PART. AKR

VIARERWS ALIAS: (NONE)

CLIENT-SERVER- 0001

CLIENT SEEVER

IDENTIFICATION DIVISION.
PROGRAM-ID.
ENVIFEONMENT DIVIZION.

JERVER.

P I T I N N I )
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Encore flags any code changes it has made with comments imbedded within the program,
as shown in Figure 224. Data definitions that are not needed by the server program are
removed.

For example:

e  The original DFHCOMMAREA is now renamed to CPYCOMAR and defined to be
a record under the new DFHCOMMAREA (parameter list).

o Data needed to be communicated between the client and the server programs are
now defined as another record (VIARBRCS) under the new parameter list.

Figure 224 « CICS Server Module - Screen 2

L3G-Encore EDIT - USERID.ENCEXEXK.CCOBOL COLUMNS 00001 00072
Conmand ===> Seoroll ===> CSER
oooozz2 DATAL DIVISICON.

ooooz3

ooooz4 WORKING-STORLGE SECTICH.

aooozs 01 COMMAREL.

o000z a 02 STATS PIC Xil).

ooooz7 * EUILDS FPREV EBACK PAGE
000028 0z RIDE FIC 9(6).

oooozs * BUILDS MEXT FUD PAGE
oooo3a 0z  RIDF PIC 9(&).

oooo31 COPY DFHAID.

oooo3z * FILEL RECORD DESCRIPT'N
aooo3s3 01 FILEAL.

aooo34 COPY DFHICFIL.

ooo03s

oooo3a LINKAGE SECTICHN.

oooo3T

ooo03g 01 DFHCOMMAREL.

oooo3g COPY CPYCOMAR.

oooo40 COPY VIARERCS.
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Only those statements and files that contribute to the creation of the CICS server program
are included, as shown in Figure 225.

o The AID key value (e.g., function keys) is passed in by the client using
DFHCOMMAREA.

o Copy it to EIBAID to allow the server code to function as before.

Figure 225 « CICS Server Module - Screen 3

ASG-Encore EDIT - USERID. ENCXZXCIH. COBOL COLUMNS 00001 00072
Conmand ===2 Scroll ===> C&R
ooon44 *

aoon4s * AN EXIT IS SET UP TO TRAP ANY UNEXPECTED EFROERS3. ALL OTHER
0o004e * ERRORS ARE DETECTED EXPLICITLY IN THE PROGEAM EY USING THE
aoon4g? * "RESP™ OPTION ON THE CICS COMMAND.

aoondgs *

aoon4gs MOVE ASG-EIBAID TO EIEATD.

aooaso * A3G-ENCORE- MOVE
oooasl * ALIG-ENCORE HNOTE:

aoonsz * THIS HANDLE STATEMENT Wi3 CHANGED.

ao0o00ss * EXEC CICS HANDLE CONDITION ERROR (ERRORS) END-EXEC.

ooons4 EXEC CICS HANDLE CONDITION ERROR (ERRORS) END-EXEC.

aoo0ass

ooonss *

aooas? * THE LENGTH OF THE "COMMAREA™ I3 TESTED. IF NOT ZERO THEN
aooass * THE NEXT OFERATOR COMMAND MUST BEE RECEIVED FROM THE TERMINAL.
aoons9 *

aoo0ae0 * IF IT HAS & LENGTH THE "COMMAREA™ ERETRUNED IS MOVED TO
ooonel * WORKING STORAGE IN THE FROGEAM.

ooonez *

000063 IF EIECALEN NOT = 0 THEN

000064 MOVE ASG-DFHCOMM TO COMMAREA

000065 * 43G-ENCORE- MOVE
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Code referring to the original DFHCOMMAREA is changed to use the new record
ASG-DFHCOMM, which is passed in by the client program. Original code not associated
with the page-backward logic has been removed, as shown in Figure 226. In this case, the
code removed deals with the initialization of the original DFHCOMMAREA, which
should be performed now by the client.

Figure 226 « CICS Server Module - Screen 4

A3G-Encore EDIT - USERID.ENCEXEXX.COEOL COLTMNS 00001 00072
Command ===> Seroll ===»> CSR
oooov7l * MCVE DFHCOMMAREAL TO COMMARER

aooove * AIG-ENCORE- MOVE REMOVED
aooa7s GO T2 PROMPT.

oooo74 *

aooovs * THIZ COMMAND MAPS IN THE ACCOUNT WUMEER FEROM THE OPERATOR
aooove * INSTRUCTICN MENU. NOTE THE EXPLICIT TESTING OF THE RESPCNSE
aooaT?? * TC THE COMMAND.

aooovs *

aooovs *

aoooso * THE EACEWARD EBEROW3E IS SIMILAR TO THE FORWARD BROWSE.
oooos1 * NOTE THAT AN EXTRA CALL TO THE "READ-PREV"™ ROUTINE I3 NOT
aooosz * REQUIRED WHEN BROWSING BACKE FROM THE HIGH END OF THE FILE.
00053 *

oooos4 PAGE-BACKWARD.

Qo0o0ss *

oooosa * LOW END OF FILE

aooos? * RESET MAP 'C!

aoooss *

aoooss MCWVE LOW-WALUES TO BROWSED.

aooosa *

oooos1 * RIDF ---» MNEXT FPAGE

aooosz *
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238

Error checking code has been modified since the original way of showing errors would
not work in the server. You need to review, and possibly replace, all code generated from
the CICS server module extraction/generation process. Figure 227 shows an example of
code that should be reviewed and/or replaced by other code that sets an error indicator in
the parameter list so the client can display the error properly.

Figure 227 « CICS Server Module - Screen 5a

A3G-Encore EDIT - USERID.ENCEXEXX.COEOL COLTMNS 00001 00072
Command ===> Seroll ===»> CSR
aooo093 IF EIBECALEN = 0 THEN GO TO TEST-3TATS.

aooos4 *

aoooss * 3TART BROWSE WHERE WE LEFT COFF LAST TIME.

aooosa *

aooos? EXEC CIC3 STARTER FILE('FILEA'}) RIDFLD(RIDE IN COMMAREA)
aoooss RESF (RESPCN3E) END-EXEC.

aoooss *

aooioo * CHECE RESPCNIES

oooio01 *

aoo10z2 IF RESPON3IE = DFHRESP (NOTFND) THEN

aoo103 NEXT SENTENCE.

ooo104 * AIG-ENCORE- MNEXT 3ENTENCE
ooo105s IF RESPCN3IE NOT = DFHRESP (NORMAL) THEN

oool106 NEXT SENTENCE.

aoo1o7 * AIG-ENCORE- MNEXT 3ENTENCE
aoo10s *

aooios TEST-3TATS.

oooiio *

ooo111 IF STATS IN COMMAREAL = 'H' THEN GO TO PREV-LINE.

oooi1iz *

000113 * REALD AND DISCARD THE RECORD POINTED TO EY RIDE CHNLY

ooo114 * IF THE HI END OF THE FILE HAZ NOT BEEEN REACHED
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Figure 228 shows where the data generated by the page-backward logic is displayed by
the original code. Encore has replaced the SEND MAP statement with statements that
update the parameter list and return to the caller, which is expected to display the data in

the parameter list.

Figure 228 « CICS Server Module - Screen 6

A3G-Encore EDIT - USERID.ENCEXEXX.COEOL COLTMNS 00001 00072
Command ===> Seroll ===»> CSR
O00zas * EXEC CIC3 SEND MAP('BROW3E') MAP3IET('VIALRERW'

O0ozza * ERL3E END-EXEC.

aoozaw? MCWVE EIBAID TO ASG-EIBAID.

aoozas * AIG-ENCORE- MOVE
aoozas MCWVE COMMAREA TO ASG-DFHCOMM

oooz3o * AIG-ENCORE- MOVE
oooz31 EXEC CIC3 RETUEN END-EXEC.

oooz3z * AIG-ENCORE- GEMNERATED CICS RETURN 3THMT
000233 * ASG-ENCORE NOTE:

000z34 * THI3 CIC3 RETURN 3ITATEMENT WAS REMOVED.

O00z35 * EXEC CIC3 RETURN TRANSID (EIBTRENID) COMMAREL (COMMAREA)

O00z36 * LENGTH(13) END-EXEC.

aooz37 GOBACE.

000z3s * AIG-ENCORE- GEMERATED GOBACK 3THMT
oooz3g *

aooz40 * AFTER. THE "RECEIVE"™ COMMAND EXECUTES, THE PROGELM TESTS THE
oooz41 * COPERATCORS RESPCNSE. CONLY "CLEAR®™, "PF1™, "PFZ", "R
oooz4z * KEY3 ARE TAKEN A3 VALID INPUT.

00o0z43 * ALL OTHER RESPCNSIES ARE IGNCORED.

000z 44 *

00oz45 PROMPT.

oooz46 * ASG-ENCORE NOTE:
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Figure 229 shows that the original RECEIVE MAP statement has been removed. Data
that were originally set by the RECEIVE MAP statement are expected to be passed in
using the parameter list when this CICS server module is invoked by the client.

o The CLEAR key processing should have been handled by the client.

J The page-forward logic should have been extracted to a separate CICS server
module. The client code should have dispatched the processing of the page-forward
command to that logic. Checking for the page-forward command is therefore
unnecessary. Encore replaces it with a statement that does not process it.

o The READ-NEXT paragraph has been removed because it is not needed by the
page-backward logic.

Figure 229 « CICS Server Module - Screen 7

A3G-Encore EDIT - USERID.ENCEXEXX.COEOL COLTMNS 00001 00072
Command ===> Seroll ===»> CSR
aooz47 * RESF (RESPCN3E) END-EXEC.

aooz4s * MCWVE DFHRESP (NORMAL) TO RESPONSE.

aooz4s AIG-ENCORE- MOVE RESP
aoozso *

ooozs1 CHECE CLEAR EEY.

000z 52 *

000z 53 IF EIBLIDI = DFHCLEAR THEN.

000z54 * CCNTINUE. AIG-ENCORE - CCNTINUE
O00z55 *

O00zs56 * CHECE PF EEYS.

Qoozs7? *

000z 58 * IF EIBALID = DFHFF1 OFR DIRI = *F* THEN

ooozss CCNTINUE.

aoozen * AIG-ENCORE - CCNTINUE
ooozel * IF EIBALIDI = DFHPFZ OR DIRI = *E THEN GO TO PAGE-BACEWARD.
000z 62 *

000z 63 * CHECE RESPCONIES.

000z 64 *

O00zZe5s *

O00zZe6 * THI3 ROUTINE EXECUTES A “EEADPREV® COMMAND TO EEAD THE NEXT
ooz e? RECORD INTO THE FILE AREL, WITH RESPECT TC THE KEY IN “RIDE™.
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Figure 230 shows that the original code to display the main menu has been replaced by a
RETURN statement to transfer control back to the client.

Figure 230 « CICS Server Module - Screen 8

ARSG-Encore EDIT - USERID.ENCXCOCCL COBOL COLUMNS 00001 00072
Command === Scroll ===> C3R
o0oze4 * THIS ROUTINE EXECUTES A4 "FEADFEEW™ COMMAND TO READ THE NEXT
000265 * RECORD INTO THE FILE AREA, WITH FESPECT TO THE EEY IN "RIDE".
000266 *

00oze7? READ-PREV.

000Z68 EXEC CICS FEADPREY INTO(FILEL) FILE('FILE4')

000zZ69 RIDFLD (RIDE IN COMMAREA) EESP(FESPONSE) END-EXEC.

00oz70 *

O00z71 * IN 50ME ERROR SITUATIONS &4 DUMP IS TAKEN AND THE ME3354GE
000z72 * “TRANSACTION TERMINATED™ IS MOVED TO "ME3SAGES™ FOR DISPLAY
000273 * ON THE OPERATOR INSTRUCTION SCREEN.

00o0z74 *

000Z75 *

000z7a * DISPLAY GENERAL MENU THEN EXIT.

000277 *

000278 MENT.

ooozTe *

ooozso * RESET MAP '4'

ooozsel *

ooozaez MOVE EIBAID TO ASG-EIBAID.

00o0ze3 * 45G-ENCORE- MOVE
oooze4 EXEC CICS FETURN END-EXEC.

000Z85 * ASG-ENCOEE- GENERATED CICS RETURN STMT
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CICS Server Extract Compilation Issues

A module-generated from a CICS server extract may contain compile errors or code that
must be reviewed for correctness or optimal performance. When these conditions occur,
Encore inserts comment messages in the generated modules, as discussed in these CICS
server extract conditions.

Condition 1

Encore has generated compile errors on label names used in CICS HANDLE
CONDITION statements, but not defined in the CICS server module.

Encore removed error handling code Review your error handling logic to see if
from the server program that is not part of the CICS HANDLE CONDITION
the server logic. statements in the server program are still

viable. You may want to replace the
original error handling logic with code that
sets certain error indicators and returns
them as output parameters. Additionally,
you may also want to replace the error
detection method. Current programming
practices recommend using the DFHRESP
option instead of HANDLE CONDITION
statements to detect error conditions. See
your CICS application programming
guides for details about how this should be
done.

242



8 CICS Server Extract

Condition 2

Encore has generated incorrect NEXT SENTENCE statements that appear to lead to
paths for which the preconditions have apparently failed.

The preconditions that apparently failed Review all the conditional statements that
should never happen in the first place. contain NEXT SENTENCE statements
Encore does not automatically eliminate generated by Encore. If these conditional
these conditional statements, giving the  statements perform checks before the
false impression that the code generated proper start of the server logic, make sure
is incorrect. they have been replaced by equivalent
checks on the client side before the server
is invoked. Once this is done, these
conditional statements can be commented
out or eliminated from the server program.
For example, the original logic that causes
the server to be invoked may perform a
check to see if the EIBAID key is the PF1
function key. This logic may be
implemented in the client as a check or to
determine whether a PAGE DOWN button
was clicked. The server in this case would
not be invoked unless the condition is true
on the client side. The corresponding
check on the server side is therefore
redundant and should be eliminated. They
are retained in the server code generated
by Encore only as a reminder that they
should be reimplanted in the client code.
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Condition 3

Encore has generated some incorrect branches. They should have led to other paths but
are replaced by Encore with simple NEXT SENTENCE statements that nullify the branch
statements.

The branches that are nullified would Review all the conditional statements that
have lead to paths that are not in the contain NEXT SENTENCE statements
server. generated by Encore. If these conditional

statements test for conditions that would
have caused a different SEND MAP
statement to be executed, replace these
statements with code to set a certain
indicator in the output parameter list. The
client side logic should be implemented to
check this indicator to decide what other
actions to take after the server returns.

Condition 4

Encore has generated compile errors on COPY statements.

The COPY members have not been Go through the "Generating the CICS
generated or were generated but saved ~ Server Module" on page 223 steps until
under incorrect names. you reach the Generate - COPY Members

pop-up (see Figure 212 on page 228).
Verify that all COPY members have been
generated. If the COPY members are not
found, even though Encore shows them as
having been generated, check your copy
libraries to see if the COPY members have
been generated under the correct names.
Encore places you in an edit session in the
generate process so you can save the result
in any dataset you choose, but Encore has
no way of verifying if you have named the
resulting file to match the COPY
statement.
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Extracting the Self Directed Server Program

If you do not want to extract a CICS server, you can use the Extract - Server menu option
(see Figure 232 on page 246) to select a Self Directed server and generate the type of
server you require.

To select the Self Directed Server Extract

1 Select Extract » Server and press Enter to display the Extract - Name Logic Segment
pop-up, as shown in Figure 231.

The name field on this pop-up contains a default name generated by Encore. You
can assign your own name to the Logic Segment or you can use the default name.

For this example, use the default name CLIENT-SERVER-0001.

Figure 231 « Extract - Name Logic Segment Pop-up

File View Extract Generate Search List Options Help

Extract - Name Logic Segment ram: VIARDEMO
Command ===
Type name of logic segment. Then press Enter.
KKK KK KK K K
Name . . . CLIENT-SERVER-0001_ R KKK KKK K
KKK KK KKK KK K K KK K K K K K K KKK KK K KKK K K K K K K K K KKK K K KK K K K
AR K K KK R KK K K KR KK K K KK KK KR KKK K R K K K KK R K KK XK KK K KKK KK R K
KK KK KKK K KKK X K KKK X T+ 3
KKK X KR KKK KR X KK X R XKOK K XX
KKK K KR KKK KR KK K KK R K K K KK K K K K K K KR KK K K KR K K K K R K OK K X
K KKK KKK KR KR KK R K KK K K R K KK OK KK KKK K K KK KK R K KK OK K

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Visit the ASG Support Web Site at www.asg.com

2  Press Enter to display the Extract - Server pop-up (see Figure 232 on page 246).
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3  Figure 232 contains a list of available server types. Type 2 to select Self Directed
and press Enter to display the Extract - Self Directed Server Endpoints pop-up (see

Figure 233).

Figure 232 « Extract - Server Selection Pop-up

File View Extract Generate Search List Options Help

Extract - Server Program: YIARBRWS

c
Select the type of server to generate.
R KK K K KK K K K KR K OK K K KR XK K X X
Tgpe SR OKOK KK KKK K R KR KK K K KK K K K K
2_ 1. CICs KA KKK
2. Self Directed KKK K
K OK KK KKK KK K
XK KK K KKK KK R K
e T ' KKK KX X KK
KKK X X KKK O KKK X RO XK XXX
KKK K KKK KK KK K K KK KK K K KKK K K KK K KKK OK K K KK K K K K K K K K X
XK KK K 2K KK KK R KR DK OK K K KR K K K K R KKK X 2K R KK K K KR K K K K R KK K

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Visit the ASG Support Web Site at www.asg.com

4  You can reduce the list of selectable names by pressing PF5, or by typing Filter and
pressing Enter to display the Extract - Filter - Self Directed Server Filter pop-up (see
Figure 234 on page 247).

Figure 233 « Extract - Self Directed Server Endpoints Pop-up

Extract - Self Directed Serwver Endpoints
Command === Scroll ===r CSR

Select the statement for each Server Endpoint and press Enter to select the
appropriate Data Item(s). Press Enter when all selections are complete.

5 - Select Vo= View Source U - Unselect

OoEs4  PROCEDURE DIWISIOM.

QREZEs *

OOEZEE + Al EXIT IS SET UF TO TRAF @AY UNEXFECTED ERRORS. ALL OTHER
OOEZET + ERRORS ARE DETECTED EXPLICITLY IW THE PROGRAM BT USIMG THE
QooZes =+ "RESP" OPTIOM OM THE CICS COMMAMC.

QORZE9 *

olelayess o) EXEC CICS HAMDLE COMDITIOM ERRORCERRORS) EMD-EXEC.

ooEzEsl o+

QREZeE * THE LEMGTH OF THE "COMMARER" IS TESTED. IF MOT ZERO THEM
OOEZESS =+ THE HE=T OFERATOR COMMAMC MUST BE RECEIVED FROM THE TERMIMAL.
OaEEe4 *

QaEIZas IF IT HAS m LEWGTH THE "COMMAREAR" RETRUMED IS MOVED TO
FFS=Filter

246



8 CICS Server Extract

This pop-up allows you to specify filtering criteria. Type the data name you want to
search for (COMMAREA in this example) and enter the other options you want to
use in the filter process, as shown in Figure 234. Press Enter to display the

Extract - CICS Server Endpoints pop-up (see Figure 235 on page 248).

Figure 234 « Extract - Filter - Self Directed Server Filter Pop-up

Extract - Self Directed Server Endpoints

[
Extract - Self Directed Server Filter

=1
a | Enter the desired Filtering parameters and press Enter.

Lata Mame . . QOMMAREA
- Uze Context Options

2z 1. References < Aliasing

2. Uses

3. Modifications

Copy Bool: Mame — ________
Line Range .

Label Mame

COEOL Subsst

oaa2e4 +

FF3=Filter

DENZ9S * IF IT HAS A LEMGTH THE "COMMAREAR" RETRUMED IS MOVED TO
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Figure 235 contains all of the filtered statements associated with the CICS member.
You need to extract all statements that contribute to the output data. To ensure that
you are selecting the code you want to extract, type V next to the statement you want
to view and press Enter to display the View Source pop-up (see Figure 236 on page

249).

Figure 235« Extract - Self Directed Server Endpoints Pop-up

Command ===

5 - Select

Y OED34E
DEOES44
= DEDZSE
C OEDITE
DEESTS
_ 0EE391
_ OoD4zz
_ OEE4S0
DEE491
_ OEES10
DEES1 1
_ OEOSZE

PFS=Filter

Extract - Self Directed Serwver Endpoints
Scroll ===r CSR

Select the statement for each Server Endpoint and press Enter to select the
appropriate Data Itemis). Press Enter when all selections are complete.

Vo- Miew Source U - Unselect

EXEC CICS STRRTER FILE('FILEA') RIDFLDCRIDF IN COMMAREA]
RESF(RESFOMSE) EMD-EXEC.

IF RIDF IM COMMARER MOT EQUAL "9939933° THEM

EXEC CICS STRRTER FILE('FILEA') RIDFLDCRIDF IN COMMARER)
RESF(RESFONSE) EMD-EXEC.

IF RIDF IM COMMAREA = 'G@EOCEE° THEM GO TO MEXT-LIME.

MOVE RIDF IM COMMAREA TO RIDE IM COMMAREA.

EXEC CICS RETURM TRANSIDCEIETRMID) COMMAREACCOMMARERA)
LEMGTH(13) EMD-EXEC.

EXEC CICS STARTER FILE( FILEA') RIDFLDCRIDE IN COMMAREA]
RESF(RESPOMSE) EMD-EXEC.

IF STATS IM COMMAREA = 'H' THEW GO TO FREV-LINE.




Verify that the selected statement code represents the type of code you want to
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extract, as shown in Figure 236. After verifying the code, press PF3 to return to the

Extract - Self Directed Server Endpoints pop-up (see Figure 237). If necessary,

repeat this process until you find the code you want to extract.

Figure 236 « View - Source Pop-up

0gozar =
0gozaE =
Danz3a

0e0zam «
0a0zdl «
0gnz4 =
ggnzag
Dan3dad
Da0zAs
Da0z4E
oanz4av?
DaN24e
nanz4aa
ulelifci]
DaOssL1
Da0z52
DE0z63

LI ]

Command ===% _

Tiaw - Source Fruo 2 LIMES FOUND
Joroll === CER

ACCOUNT WUHEBER OMITTED

HOVE 'GooAoA’ To RIDF IM COMHARREA.

THE "STAATER™ COMMAND ESTABLISHES THE BROMSE STARTING FOINT.

EXEC CICS STAATBR FILE('FILEA') RICFLDIRIDF IMN COMMAREA] LINE R

IF

RESF [RESPOMSE] END-EXEC. LINE RHG

THE "MOTFND™ CONDITION DCCURS AT THE START EROWSE THE

HESSAGE "EMD OF FILE - PLEASE RESTAAT " IS MOVED TD "MESSAGEE"
FOR DISPLAY OH THE OPERATOR INSTRUCTION SCREEM.

IF

RESPONWSE = DFHRESP [(NOTFHD! THEM

HOVE 'EWD OF FILE - PLEASE RESTART' TO MESSAGES
B0 TO MENU.

AESFONSE NOT = DFHRESF(MORMAL)] THEN GO TO ERRORS.

Type S next to the Endpoint server statement line you want to select, and press Enter
to display the Extract - Self Directed Server Data Names pop-up (see Figure 238 on

page 250).

Figure 237 « Extract - Self Directed Server Endpoints Pop-up

Command ===3

5 - Select

s (100243
190344
1]alaf o3
ooa37e
noozTa
19231
Qo422
opddsn
ood4s1
neo&EL0
1goh11
Qo322

PFFE=Filter

Extract - Self Rirected Ferver Endpoints
Beroll ===» CER

Select the statement for each Serwer Endpeint and press Enter to select the
appropriate Data Item(s), Press Enter when all selections are complete,

W - Vieu Spurece U - Unselect

EXEC CICY STRATER FILED FILER') RIDFLDIAIDF IM COHMAREA]
RESF (RE3POMSE] EHD-EXEC.

IF RIDF IN COMMRRER WOT EQUAL '999599° THEN

EXEC CICS STRRTER FILEL'FILER') RIDFLDLRIDF IN COHMARER]
RESF [RESPOMSE] EWD-EXEC.

IF RIDF IN COMMAREA = "GOO00E' THEW 0 TO MEXT-LIHE.

MOVE RIDF IN COMHARER TO RIDE IN COMHAREA.

EXEC CICS RETURM TRAMSIDIEIBTRMID) COMMARER (COHHMAREA]
LEMETH [13] END-EXEC.

EXEC CICS STRATER FILE('FILEAR') RICFLDIAIDE IM COHMAREA]
RESF (RESPOMSE] EHD=-EXEC.

IF STATS IM COMMAREA = "H° THEM GO TQ PREY-LINE.

249



ASG-Encore User’s Guide

250

9

10

Type S to the left of the data name(s) you want, as shown in Figure 238.

Figure 238 « Extract - Self Directed Server Data Names Pop-up

Extract - Felf Directed Sarver Data Hames
Cammand === _ Scroll === CER

Select the Data Mames for this Server Endpoint and press Enter. FPress
Enter when all celectlonhs are complete,

§ - Select ¥ - Wiew Source U - Unselect
LY Data Hame Qualificatian
= 02 RIDF 01 COMMAREA

= 7 RESFONIE
EEEARERXANEREE KaR Kt Kam ek Kzt EOTTOM OF DATHA ZEXA XAMEEXARKEXAMEE KRNI E X LR E

The selected data names are highlighted, as shown in Figure 239. Press Enter to
display the Extract - Self Directed Server Startpoints pop-up (see Figure 240 on page

251).

Figure 239 « Extract - Self Directed Server Data Names Pop-up - Selected Data Names

Extract - Self Directed Server Data Hames
Catmand === _ Scraoll === CER

Select the Data Mames for this Server Endpoint and press Enter. Press
Enter wnen all selections are complets,

5 - Select ¥ - YView Source U - Unzelact
LY Data Name Qualification
o2 RIDF b1 COMMAREA

77 RESRONIE

EEEAKBEEAKEELE KAREA KARKR XKk 2% BOTTOM OF DATA ZXEX EAXKAKAMEE KRR KRR KR KRXE
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11 Page down until you find the startpoint and type S next to the Startpoint server
statement line you want to select, as shown in Figure 240. Press Enter to display the
Extract - Self Directed Server Endpoints pop-up (see Figure 241).

Figure 240 « Extract - Self Directed Server Startpoints Pop-up

Extract - Self Directed Server Startpoints
Command ===% Eeroll ===» CER

Select the statement for each Server Startpoint and press Enter. Press
Enter when all celections are complete,

E - Splerct ¥ - Wieu Spurece U - Umselect
ngeELy =
_ 0Bas20 IF KEYL HOT = ZERQ THEN
aeAs21 IF KE¥I I5 WUHERIC THEW
00Aa3z2 =
opazza = YALID INFUT
0gaE2d =
5 DOEE25 HOYE KEYI TO RIDF IN COHMAREA
_ Opds2E HOVE KEY¥I To RIDE IN COHMAREA
ooazz? ELSE
Igazze =
IgEE29 = HOT HUMERILC
DERE30 =
PFE=Filter

12  Verify that the message in the long message area indicates that the statements for the
EXEC CICS SEND code were successfully selected. Press Enter to display the
Extract - Self Directed Server Paths pop-up (see Figure 242 on page 252).

Figure 241 « Extract - Self Directed Server Endpoints Pop-up

Extract - Self Directed Serwer Endpoints

Command === Scroll ===} CSR

Select the statement for each Server Endpoint and press Enter to select the

appropr-iate Data Item(=). Press Enter when all selections are complete.
S - Select Wo- Miew Source U - Unselect

— BEEE43 EXEC CICS STARTER FILE('FILEA') RIDFLDCRIDF IM COMMAREA)
[alalEleL ) RESP(RESFOMSE) EMD-EXEC.

— BEGOZESE IF RIDF IM COMMAREA HOT EQUAL '9393393° THEH

— BEEETE EXEC CICS STARTER FILE('FILEA') RIDFLDCRIDF IM COMMAREAD
GREITI RESPLRESFOMSE) EMD-EXEC.

— Baaz31 IF RIDF IM COMMAREA = 'GCEE@000° THEM GO TO MEXT-LIME.

— BEE4Z2 MOVME RIDF IM COMMAREA TO RIDE IM COMMAREA.

— Boo490 EXEC CICS RETURM TRAMSIDCEIETRMID) COMMAREACCOMMAREA)
ooad4a1 LEMGTH(13) EMD-EXEC.

— Baas1a EXEC CICS STARTER FILE('FILEA') RIDFLDCRIDE IH COMMAREA]D
ooasil RESPIRESPOMSE) EMD-EXELC.

- BEESZE IF STATE IM COMMAREA = "H' THEMW GO TO PREY-LIME.

ASG4I12T EMDPOINT AMD STARTPOINT STATEMENTS SUCCESSFULLY SELECTED.

251



ASG-Encore User’s Guide

252
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The default T (TRUE) or F (FALSE) selections have been made based on the
selection criteria, as shown in Figure 242. When you are done reviewing or changing
the information on this pop-up press Enter to display the Extract - Self Directed

Server Outputs pop-up (see Figure 243 on page 253).

Figure 242 « Extract - Self Directed Server Paths Pop-up

Extract - 5Sel1f Directed Serwver Faths
Catmand === _ Scroll ===3» C5R

Identify conditianals which are definitely TAUE for the Serwer. those which
are definitely FALZE. and leave blank the conditionals which may ke either
TRUE & FALSE. Press Enter when all selections are complete,

T - TRUE F - FALEE blamk - TRUESFALSE YW - View Seource
F O0@0z38 IF EIBCALEN NOT = D THEN
F oenztl IF RESPOMSE = DFHRESPIMAPFRIL) THEM
F oansld IF RESFOMSE MOT = DFHRESP [MORMAL1 THEHW GO TO ERROAS.
T 0RO3Z0 IF REYL MWOT = ZERQ THEN
oaaz21 IF KEYI I2 MNUMERIC THEM
oaazs0 IF RESFOMSE = DFHRESP (NOTFND) THEN
nenz&3 IF RESPOMSE MOT = DFHRESP (MORMAL] THEW GO TQ ERAGAS,
_ 0gn3zg IF RIDF IWN COMMAREA HOT EOQUAL "992393° THEN
_ 0B0s?y IF EIBCALEN = 0 THEM GO T0O HEKXT-LINE.
_ OBeo383 IF RESPOMSE = LFHRESP(MOTFNDI THEN
oaaz3E IF REEFOMSE NDT = DFHREGF |[NORMAL] THEMW GO TD ERROAE.
oaaz3l IF RIDF IN COHMARER = 'DOO0SOB" THEW GO TD WEXT-LINE.
nendan IF RESPOMSE = DFHRESP[EWDFILE] THEM GO T TOOHIGH.

Note:
An X

next to a generated conditional indicates that the code does not apply to this

extract.
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Select the Output statement you want to include in the server and press Enter to save
the selection, as shown in Figure 243. Press Enter again to return to the Encore
Primary screen (see Figure 244).

Figure 243 « Extract - Self Directed Server Outputs Pop-up

Extract - Self Directed Server Outputs

Command === _ Scroll ===» CER
Eelect the Output statements to be included in the Serwver and press Enter.
Fress Enter when all selections are complete,

§ - Select ¥ - Wiew Source I - Unselect

0002498 = HORKING STORAGE IM THE FROGRAM.

gopozdy? *
_ hgn23g IF EIBCALEN MOT = 0O THEM

nenzag HOWYE DFHCOMMAREA TO COMMAREA

nagsa0 GO TO PROMFT.

ooosd1

ooozd2 x THI5 COMHAND MAFS IMW THE ACCOUNT WUHBER FROM THE OFERATOR

opnzgs * INSTRUCTION MEMU. NOTE THE EXPLICIT TESTIMG OF THE RESFONSE

ngnzgd = TO THE COMHAND,

nonsps =
= 080306 EXEC CICS RECEIVE MRPL'MENU') HRPSET('WIARHMU')

goo=a? RESPRESFONSE] EMD-EXEC.

PFE=Filter

The Encore Primary screen displays with a message indicating that criteria for the
Statement extract were successfully selected.

Figure 244 « Encore Primary screen - Confirmation Message

File W“iew Ewtract Generate Search List Options Help

A5G- Encaore Praogram: YW IARBRWS
Command ===
kg Hkkk B T B B
stk skl ok stk
ok bk ES BB T g bbbk kb
shsporbtg stttk shobrbabk ok shekerks
eshestekok
ko

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of BSG, Inc. Use restricted to authorized licensees.
Vizit the ASG Support Web Site at www. asg.com

| ASG41111 SELF-DIRECTED SERVER STATEMEMTS SUCCESSFULLY SELECTED. |

See the online help for more information about Encore Extract features.
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Using IBM Solutions

After you have extracted and generated the server-side components from a CICS
application, you can use a variety of existing IBM solutions to migrate to a client/server
or web-based architecture. These server components may be deployed in a web-based
application in a variety of ways. This section presents three alternatives for implementing
a web-based application using the server-side components generated using Encore. As all
three alternatives rely on IBM products to provide the communication infrastructure, the
last part of this section describes the resources available from IBM to help implement
these alternative solutions.

Approach #1: Web-to-CICS Using 3270 Bridge

254

Figure 245 shows the structure of an application that uses CICS Web Support and 3270
Bridge to translate between BMS screens and HTML pages, which provides quick access
to existing 3270-based applications from the web. The boxes on the right side of the
figure represent software products or components available from IBM.

Figure 245« Web-to-CICS Using 3270 Bridge Example

CICS Transaction Server IBM Products
EXEC CICS
i . END CICS Web Bridge ‘
U orginal || Genorated [——————| (DFHWBLT)
| Application | Browse EXEC CICS
| Client RECEIVE I 3270 Data
CICS Weh 3270 Interface
(DFHWBTTA)
EXEC CICS EXEC CICS I HTTP Data in EBCDIC
(3 LNk RETURN
CICS Business Logic Interface
Data (Weh Attach & Alias)
File Encore
Y\ Generated
Browse HTTP Data in ASCII
Server
CICS Web Support

‘ (Sockets Listener Task)

HTTP Request/Resy
HTTP Response| Web
‘ 05/39 eNetwork ‘ Browser
C ications Server |
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Although web access using 3270 Bridge can be done without separating the business
logic and the user interface, making the separation allows the logic in each component to
be more readily identified and understood. It also allows the presentation logic to be
isolated and tested before being migrated to other presentation technologies, such as
HTML. Extracting the server components using Encore and deploying them under this
approach provides a migration path to solutions based on other approaches in the future.

These are some advantages:
o Rapid implementation.
o Low risk because this solution requires minimal changes to an existing application.

. Only a single copy of presentation logic is required.

These are some disadvantages:
o Clumsy looking and inflexible user interface.
) Server resources consumed by the user interface limit scalability.

o Solutions are unlikely to be long-lived or strategic.
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Approach #2: Web-to-CICS Using Web-Aware CICS Programs

Figure 246 shows the structure of an application that uses user-written CICS programs to
generate the HTML pages to be displayed in web browsers and to process requests. These
programs use EXEC CICS WEB commands or the communication area to receive HTTP
requests, invoke the proper CICS server programs using EXEC CICS LINK, and then
format the results into HTML pages, which are returned as the HTTP response.

Figure 246 « Web-to-CICS Using Web-Aware CICS Programs Example

0SSR

CICS Transaction Server

[ |

| original | GE"C.';Ed Wb

| icati -~ 3 | Generates eh-Aware
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These are some advantages:
o Presentation logic stays on the original platform.
o Flexibility in customizing the user interface.

o Ease of integrating outputs from multiple business components.

These are some disadvantages:

o Multiple versions of presentation logic; one for the web and one for the legacy
users.

o Server resources consumed by the user interface may limit scalability.

o Requires combining web page design expertise with CICS development expertise.
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Approach #3: Web-to-CICS Using Java

Figure 247 shows the structure of an application providing web access to CICS using
CICS Transaction Gateway. CICS Transaction Gateway runs on the same platform as the
web server and communicates with CICS applications running on CICS servers through
ECI or EXCI. The presentation logic in this approach is located on the same platform as
the web server, implemented as HTML pages and Java applets. A CICS Java-class library
is provided to allow the applets to communicate between the web page displayed in the
web browser and the CICS Transaction Gateway.

Figure 247 « Web-to-CICS Using Java Example
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These are some advantages

o Presentation is controlled by web design experts.

e  Multiple options are available in web server platforms.
o Diverse selection of web page and Java design tools.

o Potential of integrating outputs from multiple business components on multiple
platforms.

. Scalable.

These are some disadvantages
o Multiple versions of presentation logic.

. Significant initial development time and effort.
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Available IBM Resources

Each of the approaches outlined in this section requires significant work in planning,
design, implementation, and deployment. These issues must be resolved first:

Proper selection, configuration, and implementation of the middleware (the
communication infrastructures between the presentation layer and the business
logic). Currently, there are a number of alternatives, each with its own strengths and
weaknesses. The choice must be made with careful planning and deliberation.

Proper implementation of the presentation layer. It should be noted that because
external users of an application often have different expectations of the user
interface than the internal users, a mechanical translation of the user interface rarely
provides an acceptable alternative to the need for re-implementing the user
interface.

Security and authorization. Opening up an internal application for external access
exposes an enterprise to new issues in security and authorization. Solving these
issues is not easily automated with today’s technology.

Application development tools, processes, technologies, and expertise. The pace at
which the web is evolving demands solutions that are flexible and quickly
implemented, while remaining durable. Achieving a balance between flexibility and
durability requires resolving issues that are far beyond what a software product can
address.

Most of these issues do not have simple, product-based solutions. IBM’s International
Technical Support Organization (ITSO) has developed a collection of books to deal with
these types of issues. Known as Redbooks, these books cover general concepts, provide
background materials, and offer practical technical guidance on how to solve these
problems. These are some of the documents you may want to review to gain a better
understanding of the issues concerning migration of an existing OS/390 CICS application
to support web access:

CICS Transaction Server for OS/390 Version 1 Release 3: Web Support and 3270
Bridge, SG24-5480-00, last updated July 15, 1999.

Revealed! Architecting Web Access to CICS, SG24-5466-00, published June 9,
1999.

Revealed! CICS Transaction Gateway with More CICS Clients Unmasked,
SG240-5277-00, published December 16, 1998.

Additional reference material may be found in IBM’s product documentation libraries.
One of the most useful guides is CICS Transaction Server for OS/390 - CICS Internet
Guide (SC34-5445-00), published March 1999.
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Abend
Abnormal end of task.

action bar

The line of keywords at the top of a screen. Each keyword represents a category of
actions that may be performed on that screen. An action is selected by moving the cursor
to the desired keyword and pressing Enter.

AKR (Application Knowledge Repository)
A BDAM or VSAM file that contains all analysis information produced by the analyze
function of the Application Analytical Engine.

AKR utility log
File that provides a summary of the commands issued to the Batch AKR Utility.

Alias Of

A field on a pop-up listing entries in the AKR. If the analyzed program contains an Entry
point, Alias Of is the name of the program that contains the Entry point. If the name in the
PROGRAM-ID statement was overridden at the time the analyze job was submitted,
Alias Of is the name that was entered in the AKR program name field on the

File - Analyze Submit pop-up.

analyze
The process by which Encore gathers information about the program, including program
relationships, logic, data and execution paths, and stores this information in the AKR.

analyze options

Run-time options that control the Analyze processing. Many of these options are similar
to the COBOL compiler options. Default values are established at installation time and
can be overridden by editing the Analyzer JCL or by using the analyze screens.

analyze summary report
A summary of the run-time statistics and diagnostic messages that are produced when an

analyze job completes.

anomalies
A deviation or departure from the normal Encore analysis process.

259



ASG-Encore User’s Guide

260

Anomaly Repair facility

An Encore facility that allows you to repair programs already analyzed in an AKR that
contain anomalies. This is accomplished by allowing you to reanalyze the member that
generated the anomaly condition using the File » Anomaly facility pull-down option.

anomaly reports
Reports that contain information beneficial in understanding and diagnosing analysis
problems and anomalies.

anchor
An HTML element that defines a link between Internet resources.

API
Application programming interface. A set of calling conventions defining how a service
is invoked through a software package.

APPC

Advanced program-to-program communication. An implementation of the SNA LU 6.2
protocol that allows interconnected systems to communicate and share the processing of
programs.

application
Any group of programs that a user wants to analyze/view as a whole. These programs
would all be defined within the same application.

asynchronous
Without regular time relationship, unexpected or unpredictable with respect to the
execution of program instructions. See "synchronous" on page 270.

Batch AKR command
Control cards input in the VIASYSIN DD dataset of the Batch AKR Utility.

Batch AKR utility
The facility used to maintain the AKR without using ISPF.

browser
An application that displays World Wide Web documents.

business group
A logical grouping of applications by business function.

business rule
A logical business function that is performed by a COBOL program.

CERN
The Couseil Europeen pour la Recherche Nucleaire (European Particle Physics
Laboratory), which developed hypertext technologies.
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CICS server extract

A CICS server extract locates the necessary statements, files, and data elements required
to create a CICS server extract program. This program is then used to create a
COMMAREA-based server program from a CICS pseudo-conversational program.

client
As in client/server computing, the application that makes requests to the server and,
often, handles the interaction necessary with the user.

client/server computing

A form of distributed processing, in which the task required to be processed is
accomplished by a client portion that requests services and a server portion that fulfills
those requests. The client and server remain transparent to each other in terms of location
and platform. See client above and "server" on page 269 .

COBOL subset
COBOL verbs of a similar nature that have been grouped together. For example, READ,
WRITE, OPEN, and CLOSE are grouped into the IO subset.

command
An option in a menu. A command is selected to perform an action. There are the three
types of commands

e  Primary commands
e  Line commands

o Batch AKR utility commands

command input area
The field on Encore screens where primary commands are entered, indicated by ===> on
the fourth line of a screen, or the second line of a pop-up.

commit
An action that an application takes to make permanent the changes it has made to CICS
resources.

common code extract

The process of identifying the code that is common to two or more previously-extracted
Logic Segments. This includes all statements that appear in a selected Logic Segment, as
well as appearing in all other selected Logic Segments.

Common Gateway Interface (CGl)
The defined standard for the communications between HTTP servers and external
executable programs.

Common User Access (CUA)
A style of graphical interface that features screens, actions bars, pull-downs, and pop-ups
that are designed to provide easy access to all product features.
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complement extract

The process of identifying a set of COBOL statements that do not include a previous
extract. This includes all statements from the original program, excluding statements of
the previously-extracted Logic Segment, but retaining any statements needed by other
functional paths.

complement module

A complement module contains all statements from the original program, excluding
statements of the extracted Logic Segment, but retaining any statements needed by other
functional paths.

computation variable extract

The process of isolating the minimum set of statements that determine the value of a
particular data variable (known as the computation variable) at a particular statement in
the program.

cursor substitution character
A token substitution character that may be used in some primary commands. The cursor
substitution character is set on the Options - Product Parameters pop-up.

conversational

A communication model where two distributed applications exchange information by
way of a conversation. Typically, one application starts (or allocates) the conversation,
sends some data, and allows the other application to send some data. Both applications
continue in turn until one decides to finish (or deallocate). The conversational model is a
synchronous form of communication.

criteria
The information entered that was used to isolate a Logic Segment.

cursor position
The current location of the cursor on the screen, used as a starting point in certain
commands.

database

J A collection of interrelated data stored together with controlled redundancy
according to a scheme to serve one or more applications.

o All data files stored in the system.

J A set of data stored together and managed by a database management system.

data name
A standard COBOL term for fields defined in the DATA DIVISION of a COBOL
program. Variable names, files, groups, array elements, and fully qualified data names.
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data usage
Defines how a data item is used.

. DEF indicates the statements in the DATA DIVISION where the data item is
defined.

. USE indicates the statements where the value is used or tested.
. MOD indicates the statements where the value is set or modified.

o REF indicates any of the above conditions.

dead assignment

A statement that assigns a value to a variable, where the value is not referenced anywhere
in the source code. The assignment is not necessary and may be removed from the code
without affecting program execution.

delimiter
A character or sequence of characters used as a separator in text or data files.

Distributed Computing Environment (DCE)

Adopted by the computer industry as a de facto standard for distributed computing. DCE
allows computers from a variety of vendors to communicate transparently and share
resources such as computing power, files, printers, and other objects in the network.

distributed processing

An application or systems model in which function and data can be distributed across
multiple computing resources connected on a LAN or WAN. See "client/server
computing" on page 261.

Distributed Program Link (DPL)

Enables an application program executing in one CICS system to link (pass control) to a
program in a different CICS system. The linked-to program executes and returns a result
to the linking program. This process is equivalent to remote procedure calls (RPCs). You
can write applications that issue RPCs that can be received by members of the CICS
family.

Distributed Transaction Processing (DTP)

Enables a transaction running in one CICS system to communicate synchronously with
transactions running in other systems. The transactions are designed and coded
specifically to communicate with each other. This method is typically used by banks, for
example in just-in-time stock replacement.

Double Byte Character Set (DBCS)

A character set that uses two bytes to represent each character. Various Double Byte
Character Sets are used with languages such as Chinese and Japanese that cannot be
represented with single byte codes.
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environment
The collective hardware and software configuration of a system.

equate
A substitution name for a character string.

External Call Interface (ECI)

An application programming interface (API) that enables a non-CICS client application
to call a CICS program as a subroutine. The client application communicates with the
server CICS program using a data area called COMMAREA.

External Presentation Interface (EPI)

An application programming interface (API) that allows a non-CICS application program
to appear to the CICS system as one or more standard 3270 terminals. The non-CICS
application can start CICS transactions and send and receive standard 3270 data streams
to those transactions.

File Transfer Protocol (FTP)
A protocol that defines how to transfer files from one computer to another.

forms
Parts of HTML documents that allow users to enter data.

function shipping

Enables an application program running in one CICS system to access resources owned
by another CICS system. In the resource-owning system, a transaction is initiated to
perform the necessary operation. For example, to access CICS files or temporary storage,
and to reply to the requester. The user is unaware of these behind-the-scenes activities,
and need not know where the resource actually exists.

gateway
Software that transfers data between normally incompatible applications, or between
networks.

gopher
Menu-based software for exploring Internet resources.

Graphic Interchange Format (GFI)
256-color graphic format.
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help
Encore provides these three levels of help:

o Long messages

o Notes

) Tutorial screens

Specific command information is available by entering a command, then pressing

PF01/13. The Help facility can also be accessed from the Help pull-down or any Encore
screen.

home page
The default page shown at the first connection to an HTTP server.

host

e  In a computer network a computer providing services such as computation,
database access, and network control functions.

o In a multiple computer installation, the primary or controlling computer.

hypertext
Text that activates connection to other documents when selected.

Hypertext Markup Language (HTML)
Standard language used to create hypertext documents.

Hypertext Transmission Protocol (HTTP)
Standard WWW client/server communications protocol.

Internet Keyed Payment Protocol (IKP)
Proposed protocol for conducting secure commercial financial transactions on the
Internet.

intercommunication

Communication between separate systems by means of Systems Network Architecture
(SNA), Transmission Control Protocol/Internet Protocol (TCP/IP), and Network Basic
Input/Output System (NetBIOS) networking facilities.

internet
A collection of networks.

label name
Any PROCEDURE DIVISION paragraph or section name and the PROCEDURE and
PROC literals. Label name specifies all transfers of control to a paragraph or section.

line command
An instruction entered in the line command area on certain screens.
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list box
A dialog box option containing a list of items the user can select.

list file
The file that is allocated when a request to print is issued.

live exit
An abnormality in program control caused by out of perform range GO TOs and
overlapping perform ranges.

log file
The file that is allocated by Encore and used for error messages and log commands. There
is a separate log file created by the Batch AKR utility.

logic segment

A set of source statements that is the result of a perform range extract, report extract,
computation variable extract, transaction extract, statement extract, complement extract,
server extract, or common code extract. The criteria used to isolate a Logic Segment may
be saved in the AKR.

logic segment complement
See "complement module" on page 262.

logical program unit
A PERFORMed range of code including GO TO code, or a CALLed program.

Logical Unit of Work (LUW)

An update that durably transforms a resource from one consistent state to another
consistent state. A sequence of processing actions (for example, database changes) that
must be completed before any of the individual actions can be regarded as committed.
When changes are committed (by successful completion of the LUW and recording of the
synch point on the system log), they do not need to be backed out after a subsequent error
within the task or region. The end of an LUW is marked in a transaction by a synch point
that is issued by either the user program or the CICS server, at the end of task. If there are
no user synch points, the entire task is an LUW.

long message

A diagnostic or error message that is displayed on line five of a screen or line three of a
pop-up. Long messages are sometimes preceded by short messages that are displayed in
the upper right corner of the screen. Pressing PFO1/PF13 (HELP) after receiving a short
message displays the corresponding long message.

LU type 6.2 (LU 6.2)

A type of logical unit used for CICS intersystem communication (ISC). LU 6.2
architecture supports CICS host-to-system-level products and CICS host-to-device-level
products. APPC is the protocol boundary of the LU 6.2 architecture.
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markup tag
Special character sequences put in text used to pass information to a tool, such as a
document formatter.

member
A member in a PDS or source manager such as Panvalet or Librarian. This can be the
alias name found in the AKR.

menu
A list of available commands in an application window. Menu names appear in the menu
bar of the application window.

menu bar
A bar that contains the menus available for your use.

message box
A box that displays a message (error or otherwise) to inform the user of a particular
condition.

Multipurpose Internet Mail Extension (MIME)
The Internet standard for mail that supports text, images, audio, and video.

NCSA Mosaic
A web browser available on multiple platforms.

online help
See "help" on page 265.

Online Transaction Processing (OLTP)

A style of computing that supports interactive applications in which requests submitted
by terminal users are processed as soon as they are received. Results are returned to the
requester in a relatively short period of time. An online transaction processing system
supervises the sharing of resources to allow efficient processing of multiple transactions
at the same time.

paragraph name
Any PROCEDURE DIVISION paragraph or section name, and the PROCEDURE and
PROC literals. Paragraph name includes the entire paragraph or section.

partial statement

In a generated COBOL module, a statement that has been modified to omit certain data
names or file names that are not required for that statement in the generated module. The
partial statement contains only that portion of the statement required for the generated
module.
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perform range

A perform range consists of the source code contained in a PERFORM statement, and
includes all code that is or could be executed as a result of GO TOs, PERFORMs, etc.
within that PERFORM.

perform range extract

The process of isolating all executable statements of a perform range. This includes not
only the statements within the range, but also all code that is reachable using GO TO or
PERFORM from within the range.

pop-up

A window that appears as the result of selecting an item on a pull-down or pop-up, or as
the result of entering certain commands. It is superimposed on the screen to allow entry
of information for the requested action.

postscript
The standard for presenting text and graphics in a device-independent format.

primary command
An instruction entered in the command input area of the screen.

program
Program source member name, the name specified in the IDENTIFICATION DIVISION
of a COBOL program, or the CSECT name of a program that is not COBOL.

protocol
o A formal set of conventions governing the format and control of data.

e A set of procedures or rules for establishing and controlling transmissions from a
source device or process to a target device or process.

proxy
A gateway that allows Web browsers to pass on a network request (a URL) to an outside
agent.

pseudo conversational
A type of CICS application design that appears to the user as a continuous conversation,
but consists internally of multiple tasks.

pull-down

The list that appears when an action is selected on the action bar. On a pull-down, an
action followed by ellipses (...) displays a pop-up when selected and an action not
followed by ellipsis (...) immediately activates internal commands.

punch file
The file that is allocated when a request to punch is issued.
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recovery
The use of archived copies to reconstruct files, databases, or complete disk images after
they are lost or destroyed.

recoverable resources
Items whose integrity CICS maintains in the event of a system error. These include
individual files and queues.

recursion
A perform range or paragraph that performs itself.

reengineering

The process of renovating an existing program to isolate and extract distinct functions.
Encore can isolate and extract code based on a perform range, report, computation
variable, transaction, or server.

report extract

The process of isolating all WRITE/GENERATE statements for a specific File
Description (FD) or Report Description (RD). Individual statements may be selected. The
extracted unit consists of the statements required to produce the WRITE/GENERATE
statement(s).

SBCS
See "Single Byte Character Set - (SBCS)" on page 270.

screen
A full-width display of information containing an action bar as the first line. Encore
screens are modeled after TSO/ISPF screens.

screen subset
The result of an interactive command.

script
An executable program invoked by HTTP servers.

script file
A dataset containing Encore commands, created when SET SCRIPT is ON, and executed
with the EXECUTE primary command or the File » Execute script pull-down option.

server

Any computing resource dedicated to responding to client requests. Servers can be linked
to clients through LANs and WANS to perform services (such as printing, database
access, fax, and image processing) on behalf of multiple clients at the same time.

server extract

Process used to create a COMMAREA-based server program from a 3270 CICS
pseudo-conversational program.
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shortcut key
A keyboard key or combination of keys that invokes a particular command, such as
CNTL + N.

short message

A diagnostic or error message that is displayed in the upper right corner of Encore
screens. Pressing PF1/PF13 (HELP) after receiving a short message displays the
corresponding long message.

Single Byte Character Set - (SBCS)

A character set that uses one byte to represent each character. Single Byte Character Sets
are used with languages, such as English, where the characters can be represented with a
one-byte code.

Socket Secure (SOCKS)
The gateway that allows compliant client code (client code made socket secure) to
establish a session with a remote host.

Standard Generalized Markup Language (SGML)
The standard that defines several markup languages, HTML included.

statement extract
The process of isolating all user-identified statements from a program.

status bar
The area at the bottom of a main window that lists the status of an action and gives other
information, such as the meaning of a command.

Storage Management Subsystem (SMS)

An operating environment that automates and centralizes the management of storage. To
manage storage, SMS provides the storage administrator with control over data class,
storage class, management class, storage group, and ACS routine definitions.

subset
A grouping of source lines in a program. See "COBOL subset" on page 261, "screen
subset" on page 269, and "tagged line subset" on page 271 .

synchronous

o Pertaining to two or more processes that depend on the occurrence of a specific
event such as a common timing signal.

J Occurring with a regular or predictable time relationship.
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synchpoint

A logical point in execution of an application program where the changes made to the
databases by the program are consistent and complete and can be committed to the
database. The output, which has been held up to that point, is sent to its destination. The
input is removed from the message queues and the database updates are made available to
other applications. When a program terminates abnormally, CICS recovery and restart
facilities do not back out updates prior to the last completed synchpoint.

tagged line subset
Command results displayed in columns 73 through 80 of the Source View screen.

target
The object of a primary command.

transaction

A unit of processing (consisting of one or more application programs) initiated by a
single request. A transaction can require the initiation of one or more tasks for its
execution.

transaction extract

The process of isolating all conditional statements for a specific transaction control
variable. Certain program paths may then be selected or blocked, based on the transaction
code value.

transaction processing

A style of computing that supports interactive applications in which requests submitted
by users are processed as soon as they are received. Results are returned to the requester
in a relatively short period of time. A transaction processing system supervises the
sharing of resources for processing multiple transactions at the same time.

transaction routing

Enables a terminal connected to one CICS system to run a transaction in another CICS
system. It is common for CICS/ESA, CICS/VSE, and CICS/MVS users to have a
terminal-owning region (TOR) that owns end-user network resources.

VIASUB
An edit macro included with Encore that is used to submit an Analyze job.

VIASUBDS
A CLIST included with Encore that is used to submit an Analyze job.
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view method
The manner in which a program is examined in the View facility. These are the three
view methods based on source code:

. Structure view
. Tree view

. Source view
All three views are available concurrently when a program is examined.

work file
A temporary file allocated upon entry to Encore.
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stand-alone modules 41

report extract

business scenario 182

complement module - understanding
the results 198

creating the complement module 194

creating the stand-alone report
module 188,223

definition 44

when to use 44

S

scenario, perform range extract 57

screen
description 10
overview 10

screen subsets
EX or X subset 15
excluded subset 15
HI subset 15
highlighted subset 15
NONE or NX subset 15
NONExcluded subset 15
NONH or NHI subset 15
NONHighlighted subset 15
target 15

SCROLL command 20

self directed server
EXEC CICS SEND code 251
extract 245

server extract 48

set, multiple 14

shortened action bar 6

SmartDoc
accessing from ESW screen xiv
description xii

SmartEdit
accessing from ESW screen xiv
description xiii

SmartTest
accessing from ESW screen xiv
description xiii

statement extract 48

T

table entry 19

tagged line subsets
tags 15
target tags 15

target
data name description 19
description 18
label name description 18
line range description 19
paragraph name description 19
pattern 21
pattern string description 21
perform range name description 18
program name description 19
subset name description 19
target generation, overview 4
transaction extract
definition 43
when to use 43
transaction variable extract
business scenario 157
compilation issues 178
creating the replacement module 165
selecting the variable name 161
start/end usage notes 176

U

user options

how to set online operation
parameters 27

how to setting log, list, punch,
customization and work file 28

setting log, list, punch, customization
processing options 29

setting PF key values 31

\'}

variable, redefined 19

VIARBRWS, CICS demo program 49

VIARDEMO, Encore demonstration
program 49

W

wildcard patterns
member list 14
selection list 14






ASG Worldwide Headquarters Naples Florida USA | asg.com



	CD Contents
	Contents
	Preface vii

	Index
	A
	B
	C
	D
	E
	G
	I
	L
	M
	O
	P
	R
	S
	T
	U
	V
	W

	Publication Conventions
	ASG Support Numbers
	Business Hours Support
	Non-Business Hours - Emergency Support

	ASG Web Site
	Enhancement Fax Form
	Preface
	About this Publication
	Related Publications
	ASG-Existing Systems Workbench (ASG-ESW)
	Invoking ESW Products
	ESW Product Integration
	Examples


	Introduction
	Encore Advantages
	Encore Overview
	Encore Components


	Product Overview
	Introduction
	Encore User Interface
	The Action Bar

	Help Facility
	Multiple Views
	Wildcard Patterns
	Understanding COBOL Terms
	Sets
	Subsets
	COBOL Subsets
	Targets


	Getting Started
	Introduction
	Starting an Encore Session
	Defining User Options
	Setting Online Operation Parameters
	Allocating Log, List, Punch, and Work Files
	Setting Log/List/Punch Processing Options
	Mapping PF Keys
	Options - Generate Pop-Up

	Allocating an AKR
	Verifying AKR Allocation Results

	The Analyze Facility
	Program Analyze Requirements
	Program Analyze Input
	Analyzing a Program through Encore
	Verifying Analyze Results

	Decomposition
	Defining Your Desired Goals
	Selecting a Program for Decomposition
	Program Cleanup
	Choosing a Code Extraction Objective - The Logic Segment
	Establishing a Project Notebook

	Clean-Up Tasks
	Complement Module Contents
	Perform Range Extract
	Report Extract
	Computation Variable Extract
	Transaction Extract
	Statement Extract
	Server Extract

	The Demonstration Program

	Perform Range Extract
	Introduction
	The Business Scenario
	Starting an Encore Session
	Extracting the Perform Range
	Viewing the Logic Segment
	Saving the Logic Segment
	Creating the CALLable Module

	Creating the Complement Module
	Listing of CALCDAYS
	Extracting Multiple Perform Ranges
	Creating the CALLed Module with Multiple Entry Points
	Creating Separate Modules from a Multiple Perform Range Extract
	Reviewing the Generated Modules
	Detecting and Eliminating Multiple Perform Range Common Code
	Creating Complement Modules from Multiple Perform Range Extracts

	Understanding Perform Extracts and Common Code
	Finding Common Code in CALLable Submodules and Complements
	Replacing IO Statements with CALLs to an IO Module
	Generating the IO Module
	Perform Range Extract Compilation Issues
	Condition 1
	Condition 2
	Condition 3
	Condition 4
	Condition 5
	Condition 6
	Condition 7
	Condition 8
	Condition 9

	Complement Module Program Listing
	Example 1 - Complement
	Example 2 - Submodule


	Computation Variable Extract
	Introduction
	The Business Scenario
	Starting an Encore Session
	Extracting the Computation Variable
	Viewing the Logic Segment
	Saving the Logic Segment
	Creating Pseudo Source Modules to Change Logic Segment Results
	Pseudo Source Modules
	Including Non-selected Code in the Logic Segment

	Controlling Extract Boundaries
	Extracting Code from an Existing Logic Segment

	Computation Variable Extract Compilation Issues
	Condition 1
	Condition 2
	Condition 3
	Condition 4


	Transaction Extract
	Introduction
	The Business Scenario
	Starting an Encore Session
	Extracting the Objective
	Creating the Replacement Module
	Changing the Start/End Points
	START/END Usage Notes

	Transaction Extract Compilation Issues
	Condition 1
	Condition 2
	Condition 3
	Condition 4
	Condition 5


	Report Extract
	Introduction
	The Business Scenario
	Starting an Encore Session
	Extracting the Report
	Creating the COBOL Module
	Understanding the Results of the Extract
	Creating the Complement Module
	Complement Module - Understanding Generated Notes
	Using Pseudo Source Modules to Change Logic Segments
	Pseudo Source Modules
	Including Non-selected Code in the Logic Segment

	Controlling Extract Boundaries
	Extracting Code from a Logic Segment

	Report Extract Compilation Issues
	Condition 1
	Condition 2
	Condition 3
	Condition 4
	Condition 5


	CICS Server Extract
	Introduction
	The Business Scenario
	Conversion Process
	Starting an Encore Session
	Extracting the CICS Server Program
	Generating the CICS Server Module
	Understanding the Results of the CICS Server Module Generation
	CICS Server Extract Compilation Issues
	Condition 1
	Condition 2
	Condition 3
	Condition 4

	Extracting the Self Directed Server Program
	Using IBM Solutions
	Approach #1: Web-to-CICS Using 3270 Bridge
	Approach #2: Web-to-CICS Using Web-Aware CICS Programs
	Approach #3: Web-to-CICS Using Java
	Available IBM Resources


	Glossary

